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mentioned in this document are trademarks or registered trademarks of their respective 
companies/holders. 

 
 
 
 
 
 
 
 
 
 
 
 
 
SST Systems, Inc. 
1798 Technology Drive, Ste. 236 
San Jose, CA 95110, USA 
Tel: (408) 452‐8111 
Fax: (408) 452‐8388 

 
info@sstusa.com 
www.sstusa.com 

mailto:info@sstusa.com
mailto:info@sstusa.com
mailto:info@sstusa.com


Table of Contents 
 

i 

INTRODUCTION ..................................................................................................................................... 1 

INSTALLATION ....................................................................................................................................... 2 

MENUS 

MAIN WINDOW MENUS ................................................................................................................................. 12 
File ........................................................................................................................................................ 12 
Help ...................................................................................................................................................... 18 

LAYOUT WINDOW MENUS .............................................................................................................................. 19 
File ........................................................................................................................................................ 19 
Edit ....................................................................................................................................................... 29 
View ..................................................................................................................................................... 54 
Options ................................................................................................................................................. 56 
Loads .................................................................................................................................................... 71 
Misc ...................................................................................................................................................... 83 
Window ................................................................................................................................................ 98 

GRAPHICS WINDOW MENUS ......................................................................................................................... 100 
File ...................................................................................................................................................... 100 
View ................................................................................................................................................... 105 
Options ............................................................................................................................................... 111 

RESULTS WINDOW MENUS ........................................................................................................................... 114 
File ...................................................................................................................................................... 114 
Results ................................................................................................................................................ 122 
View ................................................................................................................................................... 126 

REFERENCE 

ANCHOR .................................................................................................................................................... 134 
BEAM ........................................................................................................................................................ 142 
BELLOWS ................................................................................................................................................... 155 
BEND ........................................................................................................................................................ 157 
BRANCH SIF ............................................................................................................................................... 174 
BURIED PIPING ............................................................................................................................................ 177 
COLD SPRING (CUT PIPE) .............................................................................................................................. 186 
COMMENT ................................................................................................................................................. 188 
COMPRESSOR .............................................................................................................................................. 189 
CONCENTRATED MASS .................................................................................................................................. 192 
CONSTANT SUPPORT ..................................................................................................................................... 193 
DATA TYPES ................................................................................................................................................ 194 
DIRECTION ................................................................................................................................................. 195 
DYNAMIC ANALYSIS ...................................................................................................................................... 198 
DYNAMIC SUSCEPTIBILITY .............................................................................................................................. 205 
ELASTIC ELEMENT ........................................................................................................................................ 207 
FIBER REINFORCED PLASTIC PIPING (FRP) ........................................................................................................ 225 
FLANGE ...................................................................................................................................................... 230 
FLANGE AND BOLT STRESSES .......................................................................................................................... 234 
FORCE ....................................................................................................................................................... 246 
FORCE SPECTRUM ........................................................................................................................................ 248 
FROM (NODE) ............................................................................................................................................ 254 
GENERIC SUPPORT ....................................................................................................................................... 256 
GRAPHICS WINDOW..................................................................................................................................... 259 
GUIDE ....................................................................................................................................................... 269 
HANGER .................................................................................................................................................... 271 
HINGE JOINT ............................................................................................................................................... 276 
HYDROTEST ................................................................................................................................................ 282 



Table of Contents 
 

ii 

JACKET END CAP .......................................................................................................................................... 284 
JACKETED PIPING ......................................................................................................................................... 285 
LAYOUT WINDOW ....................................................................................................................................... 291 
LIMIT STOP ................................................................................................................................................. 301 
LOAD ......................................................................................................................................................... 311 
LOCAL COORDINATE SYSTEM .......................................................................................................................... 315 
LOCATION .................................................................................................................................................. 319 
MATERIAL .................................................................................................................................................. 321 
MISSING MASS CORRECTION ......................................................................................................................... 331 
MITER BEND ............................................................................................................................................... 333 
NODE ........................................................................................................................................................ 342 
NONLINEARITIES .......................................................................................................................................... 343 
NOZZLE ...................................................................................................................................................... 347 
PUMP ........................................................................................................................................................ 355 
REDUCER ................................................................................................................................................... 363 
RESTRAINT ................................................................................................................................................. 370 
RESULTS WINDOW ....................................................................................................................................... 371 
RIGID ELEMENT ........................................................................................................................................... 396 
ROD HANGER .............................................................................................................................................. 398 
SECTION ..................................................................................................................................................... 400 
SKEWED RESTRAINT ..................................................................................................................................... 403 
SLIP JOINT .................................................................................................................................................. 409 
SNUBBER ................................................................................................................................................... 412 
SPIDER ....................................................................................................................................................... 413 
SUPPORTS .................................................................................................................................................. 414 
TEES .......................................................................................................................................................... 417 
TIE ROD ..................................................................................................................................................... 420 
TURBINE .................................................................................................................................................... 422 
USER HANGER ............................................................................................................................................. 426 
USER SIF ................................................................................................................................................... 428 
VALVE ....................................................................................................................................................... 429 
WELD ........................................................................................................................................................ 435 

APPENDICES 

A - CODE COMPLIANCE 

B31.1 (2012) ............................................................................................................................................ 438 
B31.3 (2012) ............................................................................................................................................ 447 
B31.1 (1967) ............................................................................................................................................ 455 
B31.4 (2012) ............................................................................................................................................ 458 
B31.5 (2013) ............................................................................................................................................ 465 
B31.8 (2012) ............................................................................................................................................ 470 
B31.9 (2008) ............................................................................................................................................ 477 
ASME (1980)............................................................................................................................................ 479 
ASME (1986)............................................................................................................................................ 484 
ASME (1992)............................................................................................................................................ 489 
BS 806 (1986) .......................................................................................................................................... 494 
EN 13480 (2012) ...................................................................................................................................... 498 
NORWEGIAN (1983) .................................................................................................................................... 507 
NORWEGIAN (1990) .................................................................................................................................... 515 
RCC-M (1985) .......................................................................................................................................... 526 
CODETI (1985) ......................................................................................................................................... 531 
STOOMWEZEN (1989) ................................................................................................................................. 543 
SWEDISH (1978) ......................................................................................................................................... 545 
Z183 (1990) ............................................................................................................................................. 549 



Table of Contents 
 

iii 

Z184 (1992) ............................................................................................................................................. 553 
FRP STRESS ................................................................................................................................................ 557 
OPERATING STRESS FOR NDE ........................................................................................................................ 558 

B - ROTATING EQUIPMENT REPORTS 

API 610 .................................................................................................................................................... 564 
NEMA SM-23 ........................................................................................................................................... 572 
API 617 .................................................................................................................................................... 574 

C - IMPORT/EXPORT 

IMPORT ..................................................................................................................................................... 578 
EXPORT ...................................................................................................................................................... 600 

D - NOZZLE STIFFNESS CALCULATIONS ................................................................................................ 603 

E - DYNAMIC SUSCEPTIBILITY METHOD ............................................................................................... 618 

F - FLANGE MODULE ........................................................................................................................... 630 

INDEX ................................................................................................................................................ 648 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This page is blank 

 



Introduction 
 

1 
 

Thank you for licensing CAEPIPE (pronounced kay-pipe), the simple yet powerful software 
for solving a variety of piping design and stress analysis problems in several industries such 
as energy, process and aerospace. 

CAEPIPE performs linear and nonlinear static and linear dynamic analyses of piping systems 
by imposing various loads such as deadweight, thermal, seismic, wind, spectrum, time history 
or harmonic, and calculates displacements, forces, moments, stresses, support loads etc. 
Further, it checks whether the piping system is piping code and guideline compliant (ASME, 
B31, European, Swedish, API 610, etc.) and produces concise, formatted and easy to 
understand reports. 

For rapid modeling, CAEPIPE offers you a friendly and productive user interface that 
rigorously adheres to Windows standards. Open up to four windows simultaneously to get 
feedback on different aspects of the model. Extensive graphical display capabilities allow you 
to zoom, pan, rotate the image and see the model from different viewpoints. CAEPIPE uses 
the industry standard OpenGL® to render 3D images realistically for easy visualization. As 
the model is input and modified, CAEPIPE updates the graphics simultaneously to provide 
visual feedback. It animates deflected shapes and mode shapes, and shows color-coded stress 
contours, among others. 

A true powerhouse in its speed of operation, CAEPIPE uses advanced Windows 
programming techniques such as intelligent repainting, scroll box tracking, multithreading, 
memory-mapped files for faster data access, among others, to make your job easier and 
faster. Every effort is made to keep the program and data file sizes small (e.g., program size is 
~2 MB! And a 665-element piping model is 85 KB!). 

Many thoughtful and useful details in the program allow you to work more productively. For 
example, you can annotate your model with copious comments for enhanced 
documentation, or duplicate repetitive input with one hotkey combination or rotate sections 
of the model with one operation. No unnecessary buttons clutter the toolbar nor are you 
forced to use a mouse unnecessarily. The many thoughtful keyboard shortcuts, too, add to 
your productivity. 

Overall, CAEPIPE stands peerless among the tools available today for piping design and 
stress analysis. We invite you to explore the software so that you can make full use of its 
capabilities. Our friendly and knowledgeable support engineers are available to assist you. 
Should you need to reach them, please email:  support@sstusa.com. 

Three sections make up this manual: 

1. Explanation of menus from the different CAEPIPE windows,  
2. An alphabetically arranged Technical Reference section, and  
3. Appendices with related information.  

The manual ends with an index. 
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Installing CAEPIPE takes two easy and quick steps after you connect the hardware key 
securely to a USB port of your computer. 

1. Install the hardware key driver and server software (from the CD or executable), and 
2. Install CAEPIPE software. 

In addition to the software required for steps 1 and 2 above, the supplied Compact Disc 
(CD) also contains other helpful material such as an Information document with a list of 
technical features, a CAEPIPE Tutorial and utilities such as a hardware key finder if you 
have trouble. Feel free to browse and install whichever is required, or contact our support 
staff for assistance. 

When you insert and “Autoplay” the CAEPIPE CD, it will open a window similar to that 
shown below on the left. Click on the CAEPIPE button (on the right). You will be shown 
another window similar to the image shown below on the right. 

 

First, click on “Step 1: Install Driver” button to install the hardware key driver and server 
(Sentinel Protection Installer xxx.exe) and follow all the steps shown until you see 
confirmation of driver installation. 
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Second, click on “Step 2: Install CAEPIPE” button to install CAEPIPE software. 
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You will now see the following interactive screens one after another in which you will have 
to answer the usual installation questions. Respond appropriately. 

 

Click Next to continue. 
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You must accept the terms of the License agreement by clicking on Yes before proceeding. 

 

A copy of the license agreement (PDF file) is available on the distribution CD. 

We recommend installing the software to the default folder shown during installation. If you 
have previous installations of CAEPIPE, it will be helpful to name the Start menu folder 
differently for the new version (e.g., CAEPIPE-681 for version 6.81). 
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Once you have picked your choices, you can now begin to install by clicking on “Install” or 
use the “<Back” button to return to previous screens to change your choices. 
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After installation, you can execute CAEPIPE by double clicking on the Desktop icon or by 
selecting CAEPIPE from the newly created CAEPIPE folder on the Start menu. To uninstall 
CAEPIPE from your computer, select Uninstall CAEPIPE from the CAEPIPE folder on 
the Start menu. 

NETWORK VERSION SETUP 

For a network license too, you need to perform the same two steps as shown earlier in this 
topic. Step 1 is performed, however, on a server or a PC that is always available as it will act 
as the CAEPIPE license server. Once step 1 finishes, connect the USB hardware key, and 
ensure that the LED on the key lights up. Then, using the supplied CAEPIPE CD, install 
CAEPIPE (Step 2) on any PC on your network. 

LICENSE ACCESS ACROSS NETWORK 

To access a CAEPIPE license, for hardware keys marked "SuperProNet", you must define 
an environment variable called NSP_HOST on the client PC and point it to the server or PC 
that has the hardware key connected to it (from Step 1). 

Create a new User/System variable in the Environment Variables dialog with the following 
configuration: 

Variable:  NSP_HOST 
Value:      Computer name or Computer IP Address (of server/PC where key is connected) 

For detailed instructions on CAEPIPE network license installations, go to the following 
support pages on our website:   

http://www.sstusa.com/caepipe-install.php 

http://www.sstusa.com/caepipe-nsphost.php 

http://www.sstusa.com/hardware-key-faq.php   

WAN setup note: For WAN access, you must open any UDP packet communication among 
your routers on UDP port 6001. 

If you don't open the UDP port, or don't set the environment variable (NSP_HOST), there 
may be a packet loss leading to access error. If no NSP_HOST is configured, then 
CAEPIPE's broadcast to the network via the UDP packet looking for the server might get 
lost, timing out the client with the "Status = 3, Key not found." Setting the NSP_HOST to 
the IP address of the machine with the key avoids the packet broadcast, and finds the 
specific machine with the specified IP address quickly. 

http://www.sstusa.com/caepipe-install.php
http://www.sstusa.com/caepipe-nsphost.php
http://www.sstusa.com/hardware-key-faq.php
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Menus 
This section explains the commands under the different menus in the four independent 
CAEPIPE windows: Layout, Graphics, List and Results. Each window contains its own 
menu and toolbar. 

Many commands have keyboard shortcuts, shown next to the Command in the drop-down 
menu and also in online Help. 

The menu items (commands) are shown as 

.Command. 

For the dialogs, the tabs are shown as 

.Tab. 

and the buttons are shown as 

.Button.  
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The Main window is the first window you encounter when you start CAEPIPE. 

 

File Menu 

This menu contains commands to open files and set user preferences. 

 

New (Ctrl+N). 
This command opens a New File type dialog window.  You can create any of the following 
file types associated with CAEPIPE from this window. 
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Model (.mod) - Creates a blank layout in CAEPIPE for a new piping model file. 

Material Library (.lib) - Creates a user-defined material library. 

Spectrum Library (.spe) - Creates a user-defined spectrum library. 

Valve Library (.val) - Creates a user-defined valve library. 

Beam Section (.bli) - Creates a user-defined beam section library 

Flange Model (.flg) - Creates a user-defined flange model. 

.Open (Ctrl+O). 
From the Open command you can open any number of CAEPIPE compatible files. 
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Model files (*.mod) - Opens CAEPIPE model files 
Results files (*.res) - Opens CAEPIPE results files 
Material Library files (*.bli) - Opens CAEPIPE material library files 
Beam Section Library files (*.mod) - Opens CAEPIPE beam section library files 
Material Library files (*.mdb) - Opens CAEPIPE material library files 
Spectrum Library files (*.spe) - Opens CAEPIPE spectrum library files 
Valve Library files (*.val) - Opens CAEPIPE valve library files 
Flange Model files (*.flg) - Opens Flange Module model files 

.Open last model (Enter). 
This command can be useful when you need to open the same model repeatedly. Simply 
pressing Enter from the Main window will open the model for you. There is no need to go 
through the Open File dialog. 

.Import. 
You can import a CAEPIPE neutral file (.mbf, similar neutral file), an Algor (Autodesk) 
PipePak neutral file (.pnf) or a COADE (Intergraph) neutral file (.cii) by using this 
command. 

See Appendix C for details. 

http://www.sstusa.com/downloads/ReadmeSupplement_v65.pdf
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.Preferences. 
Use this command to set your preferences for automatic saving and backup of the model, 
setting text and graphics fonts and toolbar preferences. 

Preferences command has three tabs - Backup, Fonts and Toolbar. 

.Backup. 

 

Make backup copy 

With this checked, every time you save your model, CAEPIPE copies the previously saved 
model data to another file (for backup, with a .bak extension). You can select the location 
where you want these files saved (click on Folder button). To open a backup file, rename the 
file to somename.mod before opening it in CAEPIPE. 

Disable Graphics Editing 

Graphics editing feature (in the Graphics window) can be turned ON/OFF from here. You 
may want to do this if your windows get garbled while using this feature.  

Automatic Save 

With this checked, and a time value entered, CAEPIPE will periodically save model data to a 
file named yourmodelname.sav, in the directory pointed to by Folder, or to untitled.sav. 

If the software or hardware crashes, you can easily retrieve the most recently saved data. 
Locate the file (yourmodelname.sav) and rename the extension from .sav to .mod before 
opening it in CAEPIPE. 

.Folder.  

Select any folder to which you (as a user) have write permission to. Please make sure you 
check with your system administrator. CAEPIPE will try to issue you a warning if the folder 
you select does not have write permission. <Default> points to the folder that contains the model file 
(.MOD). 
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Example: You can specify a new folder called CAEPIPE.BAK as a backup and save folder, 
so that CAEPIPE writes all backup files (.bak) and timed saves (.sav) to this folder. 

Automatic Renumbering of nodes 

When you delete (an) existing node(s) from a model in Layout, CAEPIPE automatically 
renumbers nodes sequentially from the “Starting Node Number” you specify. So, if you do 
not want CAEPIPE to automatically renumber nodes when you delete any node in the 
Layout window, uncheck this option here. Also note that the renumbering operation upon 
node deletion is instantaneous making it hard to identify which rows changed. 

.Fonts. 

 

.Text.  

Select a font face and size to use inside all CAEPIPE text windows (Layout, List and 
Results). 

.Graphics.  

Select a font face and size to use inside the Graphics window. 
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.Toolbar. 

 

Show 

You may choose to display or not display the toolbar in CAEPIPE windows. 

Large Buttons 

Two sizes for toolbar buttons are available. Selecting this command will show the toolbar 
with large buttons. 
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Help Menu 

From any CAEPIPE window - Main, Layout, List, Graphics or Results, you have access to 
the same Help menu. 

 

.Help. 
Clicking on Help command opens the CAEPIPE on-line help file. 

.Tutorial. 
We have three tutorials that are accessible from Start Menu > CAEPIPE: 

1. Basic Pipe Stress Analysis Tutorial (SST-Basic_Pipe_Stress_Analysis_Tutorial.pdf) 
2. Tutorial 1 (Tutorial_1.pdf) 
3. Tutorial 2 (Tutorial_1.pdf) 

The CAEPIPE Tutorials are available separately as an Adobe Acrobat (PDF) file. If you 
can’t locate them inside your CAEPIPE program files folder, then visit our web site 
www.sstusa.com to get a copy. 

.About. 

 

The About command shows the program version number and (your) hardware key serial 
number. Our support staff might ask for this information when you contact them. 

Also from the About dialog, you can access the SST website by clicking on www.sstusa.com 
or send email to SST Technical Support by clicking on support@sstusa.com. 



Layout Window File Menu 
 

19 

File Menu 

 

This menu contains commands for standard file operations with a few special ones to note: 

.Open (Ctrl+O). 
You can open the following CAEPIPE file types from the Open menu. 

1. Model files (*.mod)  

2. Results files (*.res)  

3. Material Library files (*.mat) 

4. Beam Section Library files  (*.bli) 

5. Material Library files (*.mdb) [old format]  

6. Spectrum Library files (*.spe) 

7. Valve Library files  (*.val) 

8. Flange Model files  (*.flg) 

For a description of each file type listed above, see page 14. 

.Open Results. 
This command opens the Results files (*.res). The corresponding model file (.mod) must be 
present in the same directory as the results file (.res). For your convenience, the Open 
Results dialog shows the results filename for the currently opened model if it is already 
analyzed; if not, the name of the last opened results file is filled in the name field. 
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.Merge. 
You can merge two or more piping models into one file using this command. This feature 
merges Materials, Sections, Loads, Beam Materials, Beam Sections, Beam Loads, Pumps, 
Compressors, Turbines and Elements from the selected model into the currently opened 
model. The process, however, skips Analysis Options, Load Cases, Wind Loads, Time 
History, Spectrums and Force Spectrums from the selected model during merging. Also, 
CAEPIPE checks for duplicate nodes and provides an option for renumbering the elements. 
Pressing “Yes” will renumber and merge the model; “No” will merge without renumbering, 
and you will have to manually identify and remove duplicates and/or renumber. See example 
under “From” in Reference for a suggestion on how to model separate files for merging 
later. 

Example: 

Here are two models with the note showing where the common merge point is (node 10 in 
the first model and node 539 in the second model).  
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Open Bigmodel.mod first.  Use menu File > Merge to start the process. 

 

Select the second model as shown below and click on Open. 
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To avoid duplication of node numbers, names of materials, sections, loads, etc., click on Yes 
as shown below. 

 

Choose a starting node number which is clearly not used in the first model.  CAEPIPE will 
use the starting node number to number the nodes sequentially using the increment shown. 

 

Models are merged now.  The second model starts from row 675 (the row with the yellow 
highlight). 
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Notice that node 10 in the first model and node 5000 in the second model start from the same global origin 
(0,0,0).  
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So, you need to change node 5000 to the connecting node number in the first model (i.e., 
node 539). Upon doing so, you are asked 

 

Click on “Yes” to make the change. Also, remove the anchor from the data column on row 
676. 

 

The combined model is shown in graphic view below (with a box – for illustration only - 
around the first model). 
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A zoomed image of the connecting node is shown below. 

 

.Export to .mbf. 

Presently, you can export the model data to CAEPIPE’s neutral file format (called a model 
batch file, .mbf). See Appendix C for format details. 
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.Export to 3D Plant Design. 
This feature exports the 3D CAEPIPE model to PDMS (.mac file) or CADMATIC (.3dd 
file) as structural components (only graphics without attributes). 

 

.Print Model (Ctrl+P). 

The Print command, flexible and customizable, is specific to each window. Here in Layout, 
you can print the model input data only (under the Model tab) to a printer, a PDF file (with a 
free PDF utility or Adobe® Acrobat installed), and change printer settings (under the Printer 
tab). You can customize the look of your report by changing the font, page sizes or margins. 

 

Data can be output to either a text file or a CSV (comma separated values) file that can be 
opened in a spreadsheet software (e.g., MS-Excel). 
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You could change the selected printer and customize other settings in the Printer tab (shown 
next). 

 

.Save (Ctrl+S). 

This command saves model data to a .mod file format.  It will also issue warning(s) if errors 
are found in the layout data. 

.Analyze. 
Once you are done modeling, use this command to analyze the model. At the end of analysis, 
you are asked whether you want to “View results?” Click on OK to see results or Cancel to 
return to the main window. 

.QA Block. 
Type in project-specific information here, which is printable only from the Results window. 
You cannot change this information after analysis in the Results window.  
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If you like to modify any information here, do it from the Layout window. You will then 
need to reanalyze the model because CAEPIPE will have deleted the existing results file for 
this model since the old data may no longer apply. 
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Edit Menu 

 

Using this menu, you can edit properties for elements (under Type column) and data items 
(under Data column), insert and delete rows, split an element, rotate and renumber parts of 
the model, change a few properties like friction coefficient for a range of rows, and generate 
copies of existing rows. 

.Edit type (Ctrl+T). 

Double click on the element name in the Type column or press Ctrl+T to edit properties (if 
applicable) of an element (bend, valve, etc.). The appropriate dialog is shown. 

.Edit data (Ctrl+D). 
Double click on the Data item or press Ctrl+D to edit properties (if applicable) of the item 
(flange, anchor, etc.). The appropriate dialog is shown. 

.Copy (Ctrl+C). 
You can copy a specific item on a row, an entire row or a block of rows, and Paste all, or 
individual parts of a row such as Material, Data or Type column entries.  The copy command 
will copy all row data irrespective of the specific cursor location within that row. To copy, 
move the cursor to a row (with data) and press Ctrl+C (or select Edit menu > Copy 
command) to copy all data in that row.  Multiple rows of Copy and Paste can be done only in  
Layout and NOT for Materials, Loads and Section properties. 
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Example: 

 

To copy the row at #33 (30, Reducer, 1.2ft, , ,1, 9, 1, ), you may position the cursor 
anywhere before you invoke the Copy command. But, to paste ALL of this information, you 
must position the cursor under the Node column of a (new) row. Note that any existing information 
on a row will be overwritten. 

If you want to paste, however, only the type ‘Reducer’ then place cursor under Type, for DX 
of 1.2’, place cursor under DX, and so on. 

 

To copy a block of rows (that represents a section of piping), invoke the command through 
Edit menu > Copy… 

 
You need to specify (a range of) row number(s). Of course, you could accept the default row 
shown (which copies only one row). 
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.Paste (Ctrl+V). 
Once you have copied a row, move your cursor to the location where you want to paste the 
copied information and press Ctrl+V (or select Edit menu > Paste command).  When 
pasting an entire row, move the cursor to the Node column of the row where you will be 
pasting.  To paste an individual part of a copied row, move the cursor to a specific column 
within the row where you wish to paste the specific datum.  The copied information is 
available for only one operation. Also, note that when a row is pasted, it will overwrite the 
existing row (if present). 

.Find and Replace (Ctrl+H). 

Find and replace Element / Data types, Material, Section, and Load by selecting the Find and 
Replace command from the Edit menu or press Ctrl+H.  The Find and Replace dialog box is 
shown below. 

 

In the shown dialog above, all Valves will be replaced with pipes between rows 2 and 674.  
Use this command, for example, to change all LR elbows to SR elbows.  Note that you 
cannot leave the "Replace with" field blank. 
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You could change to different support types while evaluating different “what-if” conditions, 
or remove a specific support type from the model (select “blank” in the Replace with field). 
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You could change to a different material type while evaluating different “what-if” conditions. 
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You could change to a different section while evaluating different “what-if” conditions. 
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You could change to a different load while evaluating different “what-if” conditions. 

.Insert (Ctrl+Ins). 

Use Ctrl+Ins to insert an empty row above the highlighted row in the Layout window. This 
command is also available from the context menu, by right-clicking in the Offsets (DX, DY, 
DZ) columns, or via the Edit menu. 

.Delete (Ctrl+X). 
Use Ctrl+X on a row to delete it. To delete a range of rows, you must select the Delete 
command from the Edit menu, and then type the row numbers to mark the range for 
deletion. If you want to delete till the end of the model, either type in a big number for “To 
#” such as 9999 or type in the (total) number (of rows) shown in the title bar in parentheses. 

This command is also available from the context menu (by right clicking), in the Offsets 
(DX, DY, DZ) columns. You can undelete using the Undo command. 
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.Split. 

Use this command to split a straight element or a curved section of a bend into two parts. 
This can be useful to create nodes for supports, applying forces at intermediate locations or 
introducing intermediate mass points. To split curved sections of bends (including jacketed 
bends), specify intermediate nodes at desired angles in the bend dialog. This command is also 
available from the context menu by right clicking on the Offsets (DX, DY, DZ) columns. 

When you have a long sloping pipe, you can create one long element with the slope built into 
it and then use the Split command to break it down into smaller elements. Or, of course, you 
could use the Slope command. 
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.Multiple Split. 
CAEPIPE can split an element into multiple segments. 

 

 

The above shown command parameters will split the 16’ long element between nodes 23 and 
24 into three equal segments and number them starting from 1500 (with an increment of 1). 
If you split a non-pipe element (such as a bend, valve, reducer, etc.), you will get multiple 
pipe elements and the non-pipe element as the result of this operation. 
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.Slope. 

You can specify the slope of the line you want to model for an element, in terms of its 
direction cosines (DCs). 

This command calculates the offsets automatically for a sloping element (that does not align 
with one of the major global axes). When a pipe slopes (or routes at an angle) with respect to 
the global axes, it becomes necessary to calculate the offsets (DX, DY and DZ) using those 
faithful sine and cosine functions. But, therein lies the problem. Sometimes, calculations get 
tricky and time-consuming. 

 

Let us see a few examples. 

Example 1: A 20° line in the XZ plane, 10 feet long 

Method 1: 

Calculate the offsets: 

DX = 10 cosine (20) = 9.4 (ft.), DZ = 10 sine (20) = 3.42 (ft.). Simple! 

Method 2: 

Find direction cosines (DCs) for the line (vector). Direction cosines are simply cosines of the 
angles the vector makes with the global X-, Y- and Z-axes. In this case, A=20° (X), B=90° 
(Y), C=70° (Z). Cosines of these angles are: X comp=0.94, Y comp=0, Z comp=0.342. 

Now, position the cursor on the sloping element row, right click under DX/DY/DZ. Select 
Slope from the menu, enter these numbers into the X comp, Y comp and the Z comp fields 
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of the Slope dialog that opens, and type the length, 10 ft. Press Enter. CAEPIPE calculates 
the respective offsets using the DCs you input. 

Once you input the slope, follow this pipe with other elements down the line by inputting 
different lengths while you retain the same direction cosines. 

Example 2: A 40° line in the X(-Y) plane 

Method 2: 

Find direction cosines, if the line is at 40 deg. to X-axis in X(-Y) plane, it makes 50° with the 
(-Y) axis. So, the DCs are: cos (40°) = 0.766, cos (50°) = 0.643, So, X comp = 0.766, Y 
comp = -0.643, Z comp = 0.0. Type these DCs and a length into the Slope dialog. Press 
Enter. 

More information about Direction cosines is available under the section on Direction 
(Reference) 

.Rotate. 
You can rotate a model or a part of it about the global axes. CAEPIPE will adjust the offsets 
for new orientation. 

Example 

Let us rotate the branch line of the familiar Sample model. The branch line is between nodes 
30 to 80 (rows 8 to 11 in the Layout window). Say, we wanted to route this branch line in the 
–X direction (i.e., it needs to rotate 180°). 
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Select Rotate from the Edit menu and type in the shown values. 

 

Notice the rotated offsets (now they are in the -X direction). 

Note: The valve additional weight is shown in the negative direction because of the rotation. 
To make it positive, edit the Valve (Ctrl+T) properties and change its DY offset from -18 to 
18 inches. 
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Layout Window Edit Menu 
 

42 

.Change. 
Use this command for block operations such as changing friction coefficient for all guides 
and limit stops within a range of rows, or changing the material, section or load for a range 
of rows. You are asked for the range when you select this command from the Edit menu. 

 

.Combine (Ctrl+B). 
You can combine current PIPE/BEND elements with previous PIPE elements. 
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If you have a Data type (such as a support) defined on one of the “to-be-combined” rows, 
CAEPIPE will alert you to the fact that you will lose that data type definition during the 
Combine process. 

 

If you accidentally combine two elements, you can always UNDO the operation. 

.Renumber Nodes. 
You can renumber existing node numbers in your model using this handy feature; really 
useful when you have a big model and want to adopt a consistent node numbering system 
after multiple edits. You can renumber the whole or parts of the model keeping in mind that 
the greatest node number in a model cannot exceed 99,999. 

Renumbering a segment of a piping system also renumbers all those nodes of the segment 
that appear as “Connected to” nodes in the remaining segments of the piping system. 

Before using this feature, please make a copy of your model and work on the copy. Note:  
This feature is unrelated to “Automatic Renumbering of Nodes” found in the main 
window>Preferences. 

 

Automatic Renumbering in the Main window > Preferences 

When this feature is turned on, deleting row(s) in Layout triggers an automatic (and 
instantaneous) renumbering operation, while the topic being discussed here allows you to 
renumber selectively for a range of rows. 
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Example 

Assume that for the CAEPIPE Sample model, you wanted to change the node numbers for 
the header to begin from 100, and the branch line to begin from 1000. This can be easily 
done as shown next: 

 

1. Changing header node numbers: 

Select the menu Edit > Renumber nodes. The Renumber Nodes dialog will open. In the 
dialog, type in:  

• 2 and 6 for From Row# and To Row#, 
• 100 for Starting node number and  
• 10 for Increase node numbers by. 

 

Press Enter (or click on OK) and CAEPIPE changes the node numbers. 
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2. Changing branch line numbering: 

Again, use the menu Edit > Renumber nodes, in the Renumber Nodes dialog, type in 

• 8 and 11 for From Row# and To Row#, 
• 1000 for Starting node number and 
• 10 for Increase node numbers by. 

 

Press Enter (or click on OK) and CAEPIPE changes the node numbers. 

The final layout looks like the following. Note that CAEPIPE tracks all occurrences of a 
specific node number (e.g., 1000, the hanger node, occurs on two rows 4 and 8) throughout 
the model so you do not have to remember to change every occurrence of the same node 
number in multiple places in your model. 

 

Other reasons you may want to use the Renumbering feature: 

1. In a big model, multiple edits sometimes bring about confusing node numbering. Use 
this feature to organize the numbering system. 

2. You may need to follow a guideline for numbering just to make parts of the piping 
system easily recognizable; all branch lines could get node numbers greater than 1000, all 
bypass lines could get node numbers greater than 2000, and so on. 
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.Generate. 
This powerful command allows you to generate copies of the whole or parts of the model 
while automatically taking care of node numbering and offsets. Its power is best illustrated 
by an example. 

During “Generate” command execution, CAEPIPE issues a warning and stops when it 
encounters a Node number that already exists. 

Example 1: 

Assume that we want to go from the model shown in the first figure to the one shown in the 
second figure. There are two ways to reach the result. The first is by manually modeling 
every line like shown in the second figure. The second is the faster way using the Generate 
command, as you will see. 
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Summary of using the Generate command for the example: 

1. First identify the part of the model that repeats and model it. In this case, it is the part 
comprising of nodes 40 to 70 (rows 5 to 8). 

2. Next, use the Generate command to create four additional branches, each starting with 
say 140, 240, 340 and 440 (these node numbers could be any numbers). 

3. Then, create one connecting element (from node 40 to 140). 

4. Further generate three additional connecting elements. 

That is it. A number of figures follow to depict the above process pictorially. 

 

The above window shows the layout for the starting point of the model. Use the Generate 
command. 
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Notice the four sets that are generated (only the first one marked in the following figure). 

 

Look at the graphics that corresponds to the above Layout window. 
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Next, create one connecting element between 40 and 140, and generate the remaining three. 

 

Type 40 on an empty row, Tab to Type, press “F” for “From,” press Enter (rows 25 and 26 
above). Now, generate the rest. 
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Final model as shown is the desired result. So, as you saw, Generate command allowed us to 
create four branch lines from one existing line in three operations. 

Example 2: 

See example under Beam section in Reference: (Example 1: Pipe Rack using Beams) p. 107. 

.Regenerate. 

Sometimes, owing to multiple edits, the model may be in an indeterminate stage. If you have 
made many edits, use this command to regenerate the model which will reinterpret the input 
and bring the model to a consistent state. 

.Duplicate Last Row (Ctrl+Enter). 
This is another handy feature that increases your productivity. For rows that repeat 
themselves (except for node number), this is a time saver. This is useful in modeling pipe 
racks or straight runs of pipe. Simply input all data on to a row and press Ctrl+Enter to 
duplicate this row on to the next with the node number automatically incremented. 

CAEPIPE cannot duplicate a Location/Comment/Hydrotest row, nor can it duplicate a row 
between two existing rows. This command works only on new empty rows at the end of a 
model. If you press Ctrl+Enter right after a Location/Comment/Hydrotest row, CAEPIPE 
will duplicate the row right before the Location/Comment/Hydrotest row. 

.Undo (Ctrl+Z). 
CAEPIPE can perform an Undo operation over 1000 times (1024)! This operation includes 
most user-input/edit actions through the Layout, List and Graphics windows. 



Layout Window Edit Menu 
 

52 

 

Example 1: In the figure above, if you delete entire rows 10-14 one by one (see 1st col. for 
row #) and the first three guides (on rows 5-7), you can use the Undo command (Ctrl+Z) 
eight times to undo all of these operations.   

Example 2: If you were to change a few of the analysis options (such as piping code, # of 
thermal loads and Bourdon effect through the menus), you can undo these changes by using 
this command three times, even though these changes are not made visible. 

.Redo (Ctrl+Y). 
Conversely, CAEPIPE can perform a Redo operation over a 1000 times (1024), which can 
include most user-input/edit actions through Layout, List and Graphics windows, including 
recently performed Undo operations.  

For example 1 under Undo: You can use the Redo operation to delete what you undid in 
the above example! In other words, delete rows 10-14 and the first three guides. 
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View Menu 

 

A few commands for the Graphics window can be carried out from here. 

.Graphics (F2). 
Use this command to move focus to the Graphics window. If the window is not open, then 
F2 will open the Graphics window and move focus to it. 

.Viewpoint (F4). 

 

Use this command to set the graphics viewpoint. Several useful buttons inside the dialog 
allow you to change viewpoint to a preset one. For example, if you want to see the “plan” 
view (Y-vertical), click on “Y view” button. 

.Previous View (F5). 

Use this command to display the previously viewed graphics (zoom level and image area) in 
the Graphics window. 

.Zoom All (Ctrl+L). 
Use this command to view the whole model inside the Graphics window. Note that this 
command does not move focus to the Graphics window but brings the whole model 
graphics into view. 

.List (Ctrl+L). 
This is one of CAEPIPE’s unique features that allows you to view itemized lists of every 
input data (pipes, bends, materials, valves, spectra, etc.) in a separate window. See more 
detailed explanation under the section Layout Window in Reference. 
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.Find Node (Ctrl+F). 
Use this command to search for a node number inside this window.  You may also search 
for jacket and bend end nodes (e.g., 20A, 30C, 160J), if they are referenced on the layout 
screen. 
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Options Menu 

 

This menu allows you to specify analysis options, units, font and the node number increment 
(for automatic generation of the next node number while inputting a model). 

.Analysis. 
The Analysis Options dialog is shown. Here you can specify analysis options related to 
piping codes, temperature, pressure, dynamic analysis, etc., in various tabs of the dialog. 

.Code. 

On this tab you can choose the piping code and also set options for that piping code. 
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Piping Code 

Select a piping code from the “Piping code” drop-down combo box. The following codes 
are currently available: 

• None 
• B31.1 
• B31.1 (1967) 
• B31.3  
• B31.4  
• B31.5  
• B31.8 
• B31.9 
• ASME Section III Class 2 (1980, 1986 and 1992)  
• BS 806 (British) 
• EN 13480 (European)  
• Norwegian (1983 and 1990)  
• RCC-M (French)  
• CODETI (French)  
• Stoomwezen (Dutch)  
• Swedish  
• Z183 (Canadian)  
• Z184 (Canadian)  

Notes: 

• When the selected piping code is “None,” a “Static analysis” load case, which includes 
weight, pressure, thermal, cold spring, static seismic and wind loads, all applied at the 
same time, is available for analysis. No dynamic loads (time history, response spectrum, 
etc.) are included. For “Piping code = None” and a non-FRP material, the in-plane and 
out-of-plane Stress Intensification Factors (SIF) for a 90° bend/elbow are taken to be 
the same as those computed using ANSI B31.3. For a bend with bend angle less than 
90°, the in-plane SIF is computed using the procedure given in ASME/BPVC Section 
III, Division1, Case N-319-2 “Alternate Procedure for Evaluation of Stresses in Butt 
Welding Elbows in Class 1 Piping.” 

• For some piping codes, you need to select an additional option (such as Design Factor 
for B31.8, equation level for ASME and RCC-M, Location Factor for Z183 and Z184, 
Occasional load factor for EN13480). These are shown below.  
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Include axial force in stress calculations 

By checking or un-checking this box, you can include or exclude axial force in stress 
calculations (F/A term). This option applies to all stresses (Sustained, Occasional and 
Expansion) and is provided since many piping codes do not clearly mandate the axial term’s 
inclusion. When included, CAEPIPE includes the axial term F/A (where F=axial load, 
A=Pipe cross-sectional area) in its calculation of all stress equations, 𝑆𝑆𝐿𝐿, 𝑆𝑆𝑂𝑂 and 𝑆𝑆𝐸𝐸. 

Note that this option is always turned on for codes such as B31.3, B31.4 and B31.8. 

Use Liberal Allowable Stresses 

For B31.1, B31.1(1967), B31.3, B31.5 and CODETI piping codes, the allowable expansion 
stress may be increased by a difference between the allowable sustained stress and the actual 
sustained stress times the stress range reduction factor. See Thermal Expansion Stress Range 
or equivalent under each piping code in Appendix A. 

A piping code committee member opines: Perhaps the term “liberal allowable” is not the 
best to describe the allowable. The allowable stress in B31.1 Eq. 13, i.e., 𝑆𝑆𝐴𝐴 + 𝑓𝑓(𝑆𝑆ℎ − 𝑆𝑆𝐿𝐿), can 
be used anytime. The only prerequisite is knowing the𝑆𝑆𝐿𝐿 stresses, which will only be the case 
after the supports are known or implicit. The Eq. 1 allowable stress, 𝑆𝑆𝐴𝐴, is the allowable stress 
traditionally used in the flexibility analysis when no supports other than the equipment 
anchors are known. The flexibility analysis is used to determine whether the layout of piping 
between the equipment anchors is adequate. The displacements determined in the flexibility 
analysis will allow the designer to devise the pipe weight supports to interfere with the 
flexibility of the pipe as little as possible, i.e., the designer will use rigid supports where the 
piping does not move much, use variable springs where the piping moves a small amount 
(most typically 1/4” to 4”), and use constant springs where the movement is great (again, 
typically over 4”). For lateral loads the same concept as used for the pipe weight supports is 
used for the lateral supports, i.e., if lateral displacements are small, rigid supports may be 
used, for larger lateral movements, gapped or shock suppressor supports are used (although 
shock suppressor supports require considerable maintenance attention and in the long run 
are usually not preferable to gapped supports). 

General Note on Thermal Allowable Calculation for All Piping Codes 

Cold allowable (Sc) and Hot allowable (Sh) stresses used in thermal stress calculations are 
calculated as follows for all piping codes:  

• For Expansion Cases T1 through T10, Cold allowable (Sc) = Minimum (Tref, Tn) and Hot 
allowable (Sh) = Maximum (Tref, Tn), where n = 1 to 10  

• For Thermal Ranges Tx-Ty, Cold allowable (Sc) = Minimum (Tx, Ty) and Hot allowable 
(Sh) = Maximum (Tx, Ty), where x = 1 to 10 and y = 1 to 10 and also x is not equal to y.  

The specifics are listed for each code in the Section Modulus topic (See end of Appendix A).
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.Temperature. 

On this tab you can set options related to thermal loads. 

 

Reference Temperature 

Type in the reference temperature here, usually 70°F (21.1°C). First, CAEPIPE uses this 
temperature to lookup the material properties table for the value of the cold modulus (cold = 
Reference). Second, this temperature’s corresponding coefficient of thermal expansion is 
used for thermal expansion range calculations [e.g., T1 – T2 = (T1 – Tref) – (T2 – Tref)]. 
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Number of Thermal cycles 

CAEPIPE uses this number to determine the stress range reduction factor, f, which is used 
to reduce the allowable expansion stress range, 𝑆𝑆𝐴𝐴. 

Number of Cycles Factor (f) 
   

7,000 and less  1.0 
Over 7,000 to 14,000 0.9 
Over 14,000 to 22,000 0.8 
Over 22,000 to 45,000 0.7 
Over 45,000 to 100,000 0.6 
Over 100,000 0.5 

The typical equation for calculating thermal expansion stress range (e.g., for B31.1 code) is: 

𝑆𝑆𝐴𝐴 = 𝑓𝑓(1.25𝑆𝑆𝑐𝑐 + 0.25𝑆𝑆ℎ) 

where 
𝑆𝑆𝑐𝑐  = allowable stress at cold temperature 
𝑆𝑆ℎ  = hot allowable stress 
𝑓𝑓 = stress range reduction factor (from the above table). 

Number of Thermal Loads 

You can enter up to 10 thermal loads. This feature must be first set through Layout window 
> Options > Analysis > Temperature.  Select the number of thermal loads an element can 
see during operation. Up to 10 temperatures may be applied as part of Load (along with 10 
pressures) under Misc menu > Loads. 

 
This also enables you to enter 10 temperatures under Misc menu > Beam Loads.  
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Additionally, up to 10 specified thermal displacements can be entered for Anchor and 
Nozzle data types (Nozzle dialog not shown). 

 
Thermal = Operating – Sustained 

Thermal load case results can be calculated as the difference between the Operating and the 
Sustained load cases, i.e., the thermal load case is not solved independently. This is the 
recommended procedure to solve thermal cases (T1 through T10) especially when 
nonlinearities (limit stops, friction, etc.) are present. 

When a model has no nonlinearities, the forces, moments and displacements at nodes will 
add up (i.e., Sustained load + Thermal load = Operating load). When a nonlinearity is 
present, each load case can be solved independently, i.e., the numbers are not added from 
Sustained (W+P) to Thermal (T1) to get Operating (W+P+T1); in other words, the results 
do not always add up. In the past, this used to be the only method of solving when 
nonlinearities were present. However, now you can use the new (recommended) option 
called “Thermal = Operating – Sustained.” Use it to solve for the thermal case as the 



Layout Window Options Menu 
 

63 

difference between Operating and Sustained cases, which will also ensure that sustained and 
thermal case results add up to operating case results. 

Solve Thermal case 

Results for the thermal load case are obtained from solving this case independently. See 
above discussion. 

Elastic Modulus 

CAEPIPE will use the elastic modulus at the recommended reference temperature (Cold 
modulus) for code compliance calculations. Or, it will use the temperature-dependent 
modulus (modulus at T1, T2, T3, T4, T5, T6, T7, T8, T9, or T10) for support load 
calculations for Sustained and Operating load cases.  CAEPIPE uses the cold modulus 
always for the thermal load case. 

.Pressure. 

On this tab you can set options related to pressure loads. 

 

Pressure Stress 

The longitudinal pressure stress may be calculated as: 
𝑝𝑝𝑝𝑝/4tor 𝑝𝑝𝑑𝑑2/(𝑝𝑝2 − 𝑑𝑑2), both given as options in a few ASME/B31 Codes. For B31.8, as per code, 
the latter pressure stress term is not an option. 

Peak Pressure Factor 

For occasional loads (seismic, spectrum and wind), the pressure ‘p’ in longitudinal pressure 
stress is multiplied by this factor. 

Bourdon Effect 

Bourdon effect is the tendency of straight pipes to elongate and bends to straighten due to 
internal pressure. This may be included or excluded from the analysis by checking or 
unchecking the box. 
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Internal pressure will expand the pipe cross-section radially outward (i.e., bulge out) thereby 
contracting the length of the pipe due to Poisson’s effect.  On the other hand, external 
pressure will contract the pipe cross-section radially inward (i.e., shrinking inwards) thereby 
elongating the pipe length again due to Poisson’s effect.  In addition, due to end-cap force, 
bends open out due to internal pressure or deform inward due to external pressure.  These 
physical phenomena are included in CAEPIPE calculations when the "Bourdon effect" 
button is turned ON. Pipe stresses and support loads generated due to such "Bourdon 
effect" deformations are generally considered as "Secondary Stresses and Support loads" and 
normally considered as part of the thermal expansion load case. 

Therefore, by default, this effect is treated as an expansion load and included in the expansion and operating 
load cases. It is not applied to the sustained and occasional load cases. 

If an environment variable (“BOURDONP”) is set (to YES), however, the Bourdon effect is 
instead treated as a sustained load and included in the sustained and operating load cases. It 
is not applied to the expansion load case. 

For a straight pipe, the following equation is used. 

𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 𝑑𝑑𝑃𝑃𝑓𝑓𝑑𝑑𝑃𝑃𝑐𝑐𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑 =
𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 × 𝑃𝑃𝑚𝑚 × 𝐿𝐿 × (1 − 2𝜈𝜈)

2 × 𝐸𝐸 × 𝑑𝑑
 

where 
𝑃𝑃𝑚𝑚  = mean radius of the pipe 
𝐿𝐿 = length of the pipe 
𝜈𝜈 = Poisson’s Ratio 
𝐸𝐸 = Elastic Modulus (Axial modulus in the case of FRP pipes) 
𝑑𝑑 = pipe thickness 

Pressure Correction for Bends (Pressure stiffening effect) 

Pressure correction for bends is different from and unaffected by Bourdon effect. In large 
diameter thin-wall bends, pressure can significantly affect the flexibility and SIF. If pressure 
correction for bends is used: the Flexibility of the bend is divided by 
 

1 + 6 × �
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and the SIF for the bend is divided by 

1 + 3.25 × �
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where 
𝑃𝑃 = pressure 
𝐸𝐸 = elastic modulus 
𝑃𝑃 = mean radius of matching pipe 
𝑑𝑑 = nominal wall thickness 
𝑅𝑅 = bend radius 

It is recommended that this option be turned ‘ON’ whenever the internal or external 
pressure is high, so that the stiffening of the bend due to internal or external pressure is 
considered in the analysis.  In other words, when a thin-walled pipe bend is bent by bending 
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moments at its two ends, the bend will ovalize and increase its flexibility.  Internal or external 
pressure will reduce this bend ovalization, thereby increasing its stiffness. 

Pressure correction decreases the flexibility of the piping system (by increasing the stiffness 
of the system because of the stiffened elbows). Hence, the system frequencies (in modal 
analysis) tend to increase. 

Related information can be found in Appendix D of most B31 piping codes. 

.Dynamics. 

On this tab you can set options related to dynamic analysis. 

 

Cutoff Frequency / Number of Modes 

These two options jointly control how the modal analysis routine works to extract the natural 
frequencies. Frequency (Hertz) and the chosen number of modes will determine the 
minimum number of modes extracted. The modal analysis will terminate either when the 
number of modes requested has been extracted or after extracting an additional frequency 
above the specified cutoff frequency value, whichever occurs first.   

For earthquake analysis, a typical value for cutoff frequency is 33 Hz. The maximum 
frequency you can input is 9999 Hz. 

When the selected piping code is “None,” and the model contains nonlinearities (limit stops, 
certain expansion joints), a static analysis for a given model with and without a g-load input 
may produce different frequencies depending upon the status of the nonlinearities due to the 
presence or absence of the g-load in the static load case. 

Include Missing Mass Correction 

Missing mass correction to the response spectrum analysis can be included using this check 
box. See topic by the same name in Reference. 
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Use Friction in Dynamic Analysis 

Friction is optional in dynamic analysis. If friction is included in dynamic analysis, the global 
stiffness matrix arrived at upon completion of the iterative calculations for the first operating 
case (W+P1+T1) is used to compute frequencies and mode shapes for the piping system. 

.Misc. 

On this tab you can set miscellaneous options. 

 

Include Hanger stiffness 
When the checkbox is checked, CAEPIPE adds the hanger spring rates for variable spring 
and user hangers to the overall stiffness matrix (recommended setting).  Hanger spring rates 
for rod hangers (if active) are always included even when this checkbox is not checked. 

If the checkbox is not checked, CAEPIPE does not include the hanger stiffnesses in the 
analysis. Some users prefer this as it more closely matches “hand calculations.” 

In the 1970s, performing pipe stress analysis on mainframe computers was expensive (about 
$1,000/run). So, pipe stress analysts would run a Thermal (T1) case alone first. Then, they 
would run a deadweight (DW) case with rigid supports at chosen hanger locations. Using the 
support loads and the hanger travel, analysts would select appropriate variable spring hangers 
from hanger manufacturer catalogs. To save on computing costs, they would not update the 
global stiffness matrix [K] with the hanger stiffnesses from the newly selected hangers 
because they would have to reanalyze the model which would cost more money. Many 
industrial plants built 30 or 40 years ago in the USA and presumably in other countries have 
pipe stress analyses done in this manner. These plants have archived such analysis reports 
that do not include hanger stiffnesses (as part of the global stiffness matrix [K]). 

In later years, as and when the analysts in these plants needed to reanalyze those piping 
systems, they had to use modern programs like CAEPIPE. But, before they accepted the 
new results, they sometimes liked to verify that the new results (from CAEPIPE) matched 
the results from the old reports generated by the mainframe pipe stress analysis programs. 
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This is why CAEPIPE provides the option “Do not include (or include) hanger stiffnesses.” 
It helps the engineers compare results from CAEPIPE with the old archived reports. 

Today, with cheap PC computing power, there is no reason why hanger stiffnesses should be 
excluded from analysis. In fact, including hanger stiffnesses provides a more accurate picture 
of system behavior. As such, we recommend that you “include hanger stiffnesses” in every 
analysis. 

Vertical Direction 

You may specify either Y or Z as the vertical global axis for the model. Be careful when you 
change this setting on an existing model because all the offsets from the previous vertical 
axis will be transferred to the new vertical axis, and you will have to perform a rotate 
operation on the model to regain the old orientation. 

Yield Displacement Factor 

Soil (in Buried piping analysis) is modeled with an initial stiffness and an ultimate load, after 
reaching which, displacement continues without a further increase in load (i.e., yield stiffness 
is zero). You can change the initial stiffness by changing the Yield Displacement Factor 
(default=0.04, range between0.04to1.0). No changes are recommended unless there is a 
problem with convergence during Buried Piping analysis. 

.Units (Ctrl+U). 

A flexible command, Units allows you to set any combination of units: English, SI or Metric, 
for any item. For convenience “All English,”“All SI” and “All Metric” buttons set all the 
units to that particular choice with a single button click. 

As an example, engineers in the USA sometimes use lb./in. for stiffnesses but use SI units 
for the rest, for their international clients. The specific combination that you create is saved 
with the model so you do not have to reset them every time. You could do your analysis in 
English units and present your results to your client in SI units with the click of a button. 
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.All English.  

All English units are shown below. 

 

.All SI.  

All SI units are shown below. 
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.All Metric.  

All Metric units are shown below. 

 

.Font. 

You can display the text in all CAEPIPE text windows (Layout, List and Results) in a font 
face and size of your choice. Here, the font chosen is Times New Roman, 8 point: 
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.Node Increment. 
You can increase your productivity by having CAEPIPE automatically increment the node 
number when you model a piping system in CAEPIPE. You can turn this feature off by 
specifying a zero (0) increment here. The default is set to 10. 
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Loads Menu 

From this menu, you can specify the load cases for analysis. 

 

.Load cases. 
Click on this command to select the different load cases for analysis. Most of the time, 
selecting a load case is as simple as checking the corresponding checkbox. 

 
For a few others, load cases appear in this dialog only after you input their related data. For 
example, to perform a Response Spectrum analysis, you need to 

• First input Spectrums (under Misc menu)  
• Then, select those spectrums under the menu Loads > Spectrum.  
• Finally, you go back into menu Loads > Load Cases and check the box next to Response 

Spectrum for analysis.  

As another example, the Cold Spring load cases do not appear in this dialog if you have not 
input a “Cut pipe” element in the layout window. 

Further, multiple expansion and operating load cases appear here only when you set multiple 
thermal loads under Options > Analysis > Temperature in the Layout window. 
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.Static Seismic Load. 
Use this load to apply static seismic loads (g-loads) to the model. CAEPIPE applies the input 
g-load to the piping system mass separately for X, Y and Z directions. The computed results 
(displacements, forces and moments) from each of the three (internal) load cases are 
combined using your choice of Absolute sum or Square root of sum of squares (SRSS). 
CAEPIPE performs only an algebraic sum when Piping code = None is selected. 

 

Static seismic is an unsigned case and you will not see a sign (+ or –) in the results for this 
case. 

Under menu Loads > Load cases, check the box next to Static Seismic (g’s) to select this case 
for analysis. This load is treated as an Occasional load. 

This g-load is applied only in the specified direction, i.e., a Z (g-load) of -0.189 is applied only 
in the -Z direction, not +Z. 

A g-load input may affect the extracted natural frequencies when no piping code is selected 
(i.e., Piping code = None). See under “Dynamics > Cutoff Frequency” for how. 

Acceleration in the vertical direction is generally taken to be 75% of the g-load in the 
horizontal direction. 

The g-load can be calculated from any of the several sources available (ASCE A58.1, UBC, 
etc.). Guidelines from ANSI A58.1-1988, “Minimum Design Loads for Buildings and Other 
Structures” are used in the example below. 

Piping is assumed to be equivalent to equipment thus giving a force coefficient, Cp as 0.3. 

1. First, based on the map below (Contiguous 48 States+Alaska/Hawaii/Puerto Rico), 
identify the seismic zone and its corresponding coefficient (Z).  
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Seismic Zone Coefficient Z 
4 1.0000 
3 0.7500 
2 0.3750 
1 0.1875 
0 0.1250 

Determine the Importance Factor, I as follows:  

I = 1.5,  For piping required in an emergency or piping with contents representing 
significant hazard to human life  

I = 1.0, For other piping  

Calculate the acceleration (g’s) as 0.3 × Z × I 

Example: 

For a power plant required to operate in an emergency, located in Anchorage, Alaska, 
calculate the design earthquake load coefficient for piping required to operate the plant. 

1. From the map above, seismic zone is 4; from the table above, corresponding coefficient 
is 1.0.  

2. For piping required to operate in an emergency, the Importance factor is 1.5. = 

3. Calculate horizontal acceleration as 0.3 × 1.0 × 1.5 = 0.45g, Vertical g-load (g) = 0.75 * 
horizontal acceleration = 0.34g. 

The above accelerations need to be applied in the desired horizontal and vertical directions 
as long as the piping system is predominantly routed at grade level. 
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Static Seismic Analysis 

CAEPIPE computes the inertia force (as mass * acceleration) for each direction and applies 
it as an occasional load. From the example above, assume we applied 0.45g in X, Y and Z 
directions. CAEPIPE applies an X acceleration (of 0.45g) first and solves the case. This 
procedure is then applied independently to the accelerations in Y and Z directions. 

The above procedure results in three sets of solutions (displacements, element forces and 
support loads) to acceleration loads in X, Y and Z directions, which are typically combined in 
some manner. In CAEPIPE, two directional combination methods are available: SRSS 
(Square root of sum of squares) and ABS (Absolute). 

In the SRSS method, displacements, element forces, and support loads from the three X, Y 
and Z accelerations are squared individually and added. The square roots of these respective 
sums are the displacement, element force and moment, and support load at the given node. 
In the ABS method, all absolute values of displacements, element forces and moments, and 
support loads are added to get the total displacements, element forces and support loads. 

The occasional stresses (𝑆𝑆𝑂𝑂) are added to sustained stresses (𝑆𝑆𝐿𝐿) and shown under Occasional 
stresses (𝑆𝑆𝐿𝐿 + 𝑆𝑆𝑂𝑂). 

CAEPIPE does not include the weight of the piping system in Seismic load case. A few 
reasons being: 

1. The weight is already included in Sustained load case, and  
2. Piping codes such as B31.3 specifically mention that MA and MB calculations (moments 

due to sustained and occasional loads respectively) be done separately before combining 
them to calculate SO (Occasional stress). 

If you can, avoid nonlinearities such as gaps and friction when you model seismic loads. As it 
is, Static Seismic is an approximation of Response Spectrum, which is an approximation of 
Time History analysis! So, the result you get from a static seismic analysis is a gross 
approximation. 

CAEPIPE adds the support loads from a seismic case to those from Sustained and 
Operating to produce the combination loads. Look under the Support load summary to get 
the different combination loads at each support. 

To evaluate different directional seismic analyses: 

In linear analysis (i.e., no gaps nor friction), the results from a seismic load in +X and –X 
directions should be the same. So, the combination ranges can be seen by studying support 
load summary (e.g., Sustained+Seismic, Sustained–Seismic).  

In nonlinear analysis, however, the results from a seismic load in +X may NOT be the same 
as those from –X. In such a case, you will have to make two runs, i.e., analyze the original 
(say, model1.mod) with +X g-load; copy the model to model2.mod, specify a –X g-load and 
compute results. Now you have two sets of results, one from each model. Compare the two 
carefully to identify the range (least to the most). 

Or, for further post processing, export the results from each model to a CSV file via the 
Print > Print to File command (select file type as: CSV). Import each file into a spreadsheet 
(e.g., MS-Excel) and combine the results of interest manually. 
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In summary, you can set up as many runs as required for the g-loads (+ or –), depending on 
whether your model is linear or non-linear, and export results for those runs that you cannot 
combine inside CAEPIPE.  

As another example, for a nonlinear model with g-loads only in the X-Y plane, you can 
analyze four runs (or four identical models with different seismic loads) thus: 

Run 1. Specify +X/+Y g-load 
Run 2. Specify -X/-Y g-load 
Run 3. Specify -X/+Y g-load 
Run 4. Specify +X/-Y g-load 

Examine the seismic and combination forces and moments from all runs, or in a spreadsheet 
(using the .CSV files CAEPIPE exports for each model) to determine the most conservative 
of results (and range) for further interpretation. 

As another example, in a linear model with g-loads only in the X-Y plane, the two runs 

Run 1. Specify +X/-Y g-load  
Run 2. Specify -X/+Y g-load 

are the same. So, either case (run) alone is adequate. 

Or, another example, for a nonlinear model with g-loads in all three global directions, you 
could set up eight runs/models: 

Run 1. Specify +X/+Y/+Z g-load 
Run 2. Specify +X/+Y/-Z g-load 

Run 3. Specify +X/-Y/+Z g-load 
Run 4. Specify +X/-Y/-Z g-load 

Run 5. Specify -X/+Y/+Z g-load 
Run 6. Specify -X/+Y/-Z g-load 

Run 7. Specify -X/-Y/+Z g-load 
Run 8. Specify -X/-Y/-Z g-load 

Each of these runs may yield different results. So, a careful evaluation of all eight runs is 
necessary to identify the most conservative solution and/or determine a range. 
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 Wind Load. 
You can enter up to four separate wind load profiles named Wind, Wind 2, Wind 3 and 
Wind 4. 

 

Load Combinations  

With 10 thermal and four wind loads, you can analyze a total of up to 95+ load combinations 
(including 55 thermal load cases). 

 

You can apply a wind load to the whole or parts of the model. CAEPIPE applies it as a 
lumped (concentrated force) load at the nodes (i.e., it is not a distributed load along the 
element). A wind profile is required for the region in which you (plan to) have the system 
installed.  
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Shape factor 
Input a shape factor value here. CAEPIPE uses a constant value for shape factor. See ANSI 
A58.1, “Minimum Design loads for Buildings and other Structures” for more information. 

For Pressure versus Elevation, one needs to multiply (or build) the shape factor into the 
input value for pressure. CAEPIPE does not use the shape factor when user selects Pressure 
versus Elevation. 

Direction 

Input the direction of the wind using the direction cosines (examples: for wind in Z 
direction, Z comp = 1; for wind in 45° X-Y plane, X comp=1, Y comp=1, Z comp=0). See 
section on Direction in Reference. 

Wind Profile 

You need to input values for wind velocity or pressure at different elevations. CAEPIPE 
interpolates the wind load on an element from these values based on its elevation. 

Units 

You can specify any combination of units for elevation, pressure and velocity. 
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Wind Pressure 

The wind pressure in (lb/ft2) is calculated as: 
Wind pressure = 0.0032 × Wind velocity2× Shape factor 
where Wind velocity is in (mph). 
To exclude an element(s) from wind loading, the Load definition dialog for that element 
should not have Wind load checked. See dialog below that shows “Wind load” unchecked. 

 

.Spectrum Load. 
Shock waves (due to a seismic event), sometimes hundreds of feet long, travel through the 
soil causing ground motion at all supports in a piping system. Every support connected to 
the ground in a piping system will see the same excitation (hence uniform). These excitations 
are specified using a response spectrum, which is a table of maximum response versus 
natural frequency (with damping) for single degree-of-freedom systems. 

A "Spectrum”  load specified here will be applied simultaneously at all supports during a 
“Uniform response spectrum” analysis, following which, CAEPIPE will compute the modal 
and directional responses (to this uniform excitation), which are further combined in a 
manner you specify. 

The spectrum load can only be input after at least one spectrum is defined (under menu Misc > Spectrums). 
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X, Y and Z spectrums 
Select a spectrum from the drop-down combo box, which should have been input in the 
spectrum table for each direction. 

Factor 

The multiplying (scale) factor for the spectrum is input here. The same spectrum may be 
multiplied by different (Scale) factors to apply spectrum loads for different dynamic events. 

Mode Sum 

Pick one of three choices, SRSS (square root of sum of squares), Closely spaced or Absolute. 
See section on Dynamic Analysis in Reference for more information. 

Direction Sum 

Pick one of two choices, SRSS (square root of sum of squares) or Absolute. See section on 
Dynamic Analysis in Reference for more information. 

See topic on Dynamic Analysis for more information. 

.Time History Load. 
A phenomenon that causes loads to vary with time can be applied in CAEPIPE for time 
history analysis. You may hand-calculate these values or use a simulation program (such as a 
transient fluid flow program for fluid hammer analysis) to get the variation of forces or 
moments in time at different points in the piping system. These loads are then input into 
CAEPIPE as time functions, which are later applied at the corresponding nodes of the 
piping system as “Time Varying Loads.” 

Time functions (input under menu Misc > Time Functions) are a series of nondimensional 
values versus time, which describe the variation of the forcing function with time. The actual 
value of the time function at any time is found by linear interpolation between time points. 

When you input a “Time Varying Load” at a node, you may apply a scale factor, if necessary, 
along with the direction of the force or moment. 
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CAEPIPE will then apply these loads to compute the response of the piping system by 
performing a time history analysis. 

Various parameters for time history analysis are specified in the Time History Analysis 
Control dialog under menu Loads > Time History. 

 

Time step 

The time step (time interval) at which the analysis is performed should be typically no more 
than 10% (smaller the better) of the period of the highest frequency of interest, i.e., higher 
the frequency, smaller the time step, e.g., for a 33 Hz maximum frequency, the time step 
would be less than 0.003 seconds. 

Number of time steps 

The time history response is calculated for a total time (seconds) of Time step × Number of 
time steps. This is how long you want to study system response. The total time may exceed 
the range of available data in the time function. The time function is only a forcing function. 
But, CAEPIPE can compute system response to it well after the forcing function ceases. For 
example, the effect of a heavy steam hammer could linger on for a minute while your forcing 
function data could span only 8s (seconds). 

Output interval 

The output interval is a multiple of time step at which you want CAEPIPE to save (and later 
display) results. For example, assuming a time step of 0.001s, if you wanted to see results at 
every 100th time step (0.1s, 0.2s, 0.3s, and so on), enter 100 for output interval. You need to 
check the “Save Results” checkbox to see these time varying results which are saved in the 
file modelname.rth. If the “Save Results” checkbox is not checked, only the enveloped results 
are available but not their variation in time. The .RTH files may be big for large models with 
many time steps (so ensure that you have adequate storage and permission settings). 

Damping 

Express the damping factor as a percentage (not as a fraction). Enter 5, not 0.05, for 5% 
damping. 

Example: 

Input: Time step = 0.01s, Number of time steps: 1000, Output interval: 10, Damping: 5%, 
Save Results checkbox Checked. 
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CAEPIPE calculates the solutions at every 0.01s up to 10s. The results are saved every 0.1s 
in the .rth file. Note however, that CAEPIPE calculates the enveloped (maximum) results at 
every time step interval and not the output interval. The output interval is strictly for display 
purpose in the results and does not affect analysis. 

The Time Varying Load dialog is shown below: 

 

The Time Varying Load at a node is specified by its direction, units, the associated time 
function and a scale factor. This scale, factor is a scalar value, which when multiplied by the 
nondimensional time function will give the actual magnitude of the forcing function in the 
unit selected in the above dialog. 

.Harmonic Load. 

 

Harmonic loads can be loads from any sinusoidal loading, such as from rotating equipment 
or reciprocating pumps on a line. The magnitude of the loading should be determined before 
analysis. If only one compressor is on a line, then only one harmonic load is input. If more 
than one load is acting on the same line, then the phase (angle) or the separation in timing of 
application of each harmonic load becomes important (consider for example that the two 
loads may be equal and opposite thus canceling out any dynamic imbalance, or the two loads 
can be in the same direction, say +X and separated by 30° phase angle). So, the situation 
must be carefully analyzed before imposing these loads. 

Harmonic analyses of linear structures are generally performed to determine the steady-state 
response to long-duration loads,  which vary sinusoidally (harmonically) with time, thus 
enabling you to verify whether your designs will successfully overcome resonance, fatigue, 
and other harmful effects of harmonic vibrations. In a harmonic analysis, all long-duration 
loads and the structural response vary sinusoidally at the same frequency.  
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Various parameters for harmonic analysis are specified in this dialog shown above. 

Damping 

CAEPIPE applies this factor to all the modes. Enter value of critical damping as a percent, 
not as a fraction (Example: For 5%, enter 5, not 0.05). 

Combination 

CAEPIPE combines modal responses using one of two methods: Root mean square (RMS) 
or Absolute sum (which may be too conservative). Pick one. 

After you input the data here, then apply Harmonic loads at nodes of interest. Then, select 
Harmonic under the menu Loads > Load cases for analysis. 

The Harmonic Load dialog is shown below: 

 

The harmonic load can be imposed as a Force (FX/FY/FZ) at a specified frequency and 
phase angle. You may be able to get more information on the harmonic loading (mass, rpm, 
eccentricity, etc.) from the manufacturer of the equipment. 

Since a harmonic load response is unsigned, results do not have signs (+ or –). 
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Misc Menu 

A few utilities such as Check bends and connections, sundry items such as opening the list 
screens for materials, sections, loads, pumps, compressors and turbines, and commands to 
enter data for spectrums, time functions, etc., are among the commands on this menu. When 
Piping code is set to None under menu Options > Analysis, all items from Pumps to Soils 
(inclusive) are disabled. 
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.Coordinates (Ctrl+Shft+C). 
This command lists the coordinates of all the nodes (including internally generated nodes 
such as A, B nodes) in the model. 

 

 

Straight line distance between two nodes can be found by using the menu View > Distance 
command (Ctrl+D) in the coordinates window. 
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Also shown are the angles the straight line (between the two nodes) makes in the X-Y plane (phi) 
and from the X-Y plane (beta). 

.Element types (Ctrl+Shft+T). / .Data types (Ctrl+Shft+D). 
You can open these dialogs that contain the different elements or data items you can input at 
a node. You can also open the same dialogs by clicking on the header row in the Layout 
window or right clicking in the Type or Data column on an empty row. 

More information about these commands is available under Layout Window in Reference. 

.Check Bends. 
CAEPIPE can identify incorrectly and incompletely modeled bends. If you have any, you 
must correct them before analysis.  

Case 1 (Incorrect modeling) 

An “Invalid Bend” occurs if the bend geometry is input incorrectly in the layout. For 
example, for 90° bends, the bend radius should be less than or equal to the shorter of the 
lengths (from the previous node to the bend node or from the bend node to the next node). 

Case 2 (Incomplete modeling) 

A bend needs to be given a change in direction from the previous direction on the row 
below it. If this change is either not specified or incorrectly specified, CAEPIPE flags this 
bend as an invalid bend. An example follows. 
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When you select the Check bends command under the Misc menu, you get the following 
message for this model. 

 

By studying the image and the Layout window above, you can see that the bend at node 20 
turns from X direction into Z direction, and the bend at node 30 turns from Z direction into 
Y direction. But, the bend at node 40 incorrectly turns from Y direction into Y direction. To 
correct this, this bend needs to turn into any direction other than Y. The following screen 
shots show the correction. The bend at node 40 now turns into Z direction. 
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When you run the same Check bends command again, you get the following message. 
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.Check Connections. 
While not foolproof, this command checks for missing connections between pipes. By 
studying the following two figures, can you identify what is wrong with the modeling shown 
below? Check connections command will. 

 

 

By studying the previous Layout window, you will notice that even though node 50 appears 
to be on the header (node 10 to node 25), it actually is not. Node 10 connects directly to 
node 20 which further connects to node 25. The loop begins from node 20 and goes up to 
node 50. But 50 is not defined on the header. So, there is no connection between the loop 
and the header! 
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When you run the Check connections command, you get the following message. 

 

So, you might want to run this command on complicated models with loops just to ensure 
that all such connections are properly modeled. 

Corrected modeling is shown next. Notice that node 50 is now defined as part of the header 
from node 10 to node 25. 

 

.Materials, Sections and Loads. 
Please see the respective sections with the same titles in Reference. 

.Beam Materials, Beam Sections and Beam Loads. 
These three can be found under Beam in Reference. 

.Pumps, Compressors and Turbines. 

Please see the respective section with the same title in Reference. 
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.Spectrums. 
A (uniform response) spectrum is a table of maximum response versus natural frequency for 
a specific excitation in single degree-of-freedom systems. You can input spectrums in three 
ways: 

1. Input spectrums directly into the model.  

2. Create a spectrum library and load spectrums from it.  

3. Input spectrums from a text file.  

When you use the first two methods, you may use menu Options > Spectrum command to 
set the different units for the X- and the Y-axes, and also choose the interpolation method. 

 

1. Input spectrums directly into the model 

Select Spectrums from the Misc menu. You are shown the List window for spectrums. Start 
typing pairs of values into it. The frequencies or periods do not have to be in any order; 
CAEPIPE will sort them later. You can input as many pairs of values as required. 
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2. Create a spectrum library and load spectrums from it 

From the Main, Layout or Results window, select menu File > New. 

 

Select Spectrum library. The spectrum library List window is shown. Start typing pairs of 
values into it. 

 

The frequencies or periods you type can be in any order. CAEPIPE will sort them later. You 
can input as many pairs of values as required. Be sure to save the file (it will be saved to a 
filename you specify, with a .spe extension) using the Save command in the File menu. 

Now, open the CAEPIPE model that needs these spectrums. Open the saved library (menu 
File > Library) and input spectrums into the model from the shown list. 
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3. Input spectrums from a text file 

This method involves creating a separate text file (in the format shown below) for each 
spectrum you want to input. The steps are given below. 

a) For each spectrum, on the first line, type the Name of the spectrum (up to 31 
chars).  On the second line, type units for Abscissa (X-axis) and Ordinate (Y-axis) 
axes, separated by a space.  

b) After these two lines, on each line, you can input a value pair. You can input as 
many of these value pair lines as required.  

c) Each spectrum should be saved to a separate text file. More than one spectrum 
should not be input in one text file as it cannot be read into CAEPIPE.  

d) Now, open the CAEPIPE model that needs these spectrums. Select Read 
Spectrum from the File menu, read all text files you created one after the other.  

 

The format of a spectrum text file is shown below. The spectrum that is read appears on the 
row where the yellow highlight is placed (under the Name column). You can use the Edit 
menu commands to insert an empty row or delete an existing spectrum. Ensure that no two 
spectrums share the same Name. CAEPIPE issues a warning should such occur. 

The spectrum text file should be in the following format: 

Name  (up to 31 characters 
Abscissa units Ordinate units 
Abscissa value1 Ordinate value1 
Abscissa value2 Ordinate value2 

. . 

. . 

. . 
Where  
Abscissa units 0 = Frequency (Hz) 

 1 = Period (Sec) 
 

Ordinate units 0 = Displacement (inch) 
 1 = Displacement (mm) 
 2 = Acceleration (in/sec2) 
 3 = Acceleration (mm/sec2) 
 4 = Acceleration (g’s) 
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Example file 

Test Spectrum 
0 2 
1 190 
2 220 
3 250 
4 1932 
5 1000 
6 1800 
. . 
. . 

Analysis note: 

While analyzing the response spectrum case, when a mode (frequency or period) falls outside 
the spectrum table, CAEPIPE issues a warning and uses the value corresponding to the 
closest frequency or period in the spectrum table (for example, CAEPIPE uses the value 
corresponding to the lowest frequency if the calculated frequency is lower than the lowest in 
the spectrum table or uses the value corresponding to the highest frequency if the calculated 
frequency is higher than the highest in the spectrum table). 

Once you are done inputting the different spectrums using any one of the three methods, 
you need to input the Spectrum load itself under the menu Loads > Spectrum in the Layout 
window.  Details on inputting the Spectrum Load are provided earlier under the Loads 
menu. 

 

.Force Spectrums. 

See topic on Force Spectrum in Reference on page 248. 
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.Time functions.  
Time functions are nondimensional tables (i.e., a series of time versus value pairs) which 
describe the variation of the forcing function with time. Usually, a transient fluid flow 
analysis program computes forces as a function of time at all changes in directions 
(bends/tees) and other points of interest. These forces/moments result from a transient 
event such as a fluid hammer. Separate force-time histories are then input as time functions 
and applied as Time Varying Loads within CAEPIPE at the corresponding nodes of interest 
in the piping model. 

In CAEPIPE, the time function you define can have any interval between two time values. 
You can make that table as fine as you want it to be. 

You must have a zero entry for the Value next to the first Time input. Time history analysis 
begins at time t=0.0. You can input as many time-value pairs as required. 

There are two methods for inputting time functions. 

1. Input time functions directly into the model.  
2. Create a text file for each function and read it into CAEPIPE.  

1. Input time functions directly into the model  

Click on menu Misc > Time functions to type in time functions. Time is measured in 
seconds. Value is nondimensional. You can assign units to these Values when you input a 
Time varying load at a node. For now, simply start typing the time-value pairs. Next, input 
parameters for the Time History Analysis Control dialog, and then input Time Varying 
Loads at nodes of interest. 
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2. Create a text file for each function and read it into CAEPIPE 

Read these text files into CAEPIPE using the menu File > Read Time Function command. 
For each function, you need to type a Name (up to 31 characters) on the first line, type time 
followed by a Value (separated by a space) on the following line. You can input as many 
time-value pairs (one pair on each line) as required. 

 

The format of the time function text file is shown below. The time function that is read from 
a file appears on the row where the yellow highlight is placed (under the Name column). You 
can use the Edit menu commands to insert an empty row or delete an existing time function. 
Ensure that no two time functions share the same Name. CAEPIPE issues a warning should 
such occur. 

Time Function 
0.0 0 
0.1 0 
0.2 0.025 
0.3 26.65 
0.4 112 
0.5 806 
0.6 7984 
0.7 1882 
0.8 2531 
0.9 2480 
1 2109 
. . 
. . 

Once you are done entering time functions, specify the parameters in the Time History 
Analysis Control dialog under menu Loads > Time History, details of which are provided 
earlier under the Loads menu topic. 
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Then, specify Time Varying Loads at applicable nodes in the model. The following figure 
shows the time function as a time-varying force applied in the Y direction (FY) at node 100. 
Under Units, you can specify one of several depending on whether you are applying the 
Values in the time function as a force (FX, FY, FZ) or a moment (MX, MY, MZ). For more 
details, please see discussion under menu Loads > Time History. 

 

.Soils. 
See Buried Piping Example in the topic on Buried Piping in Reference. 

.User-Defined Allowables.  
CAEPIPE allows you to define "User Allowables" for Anchors, Generic Supports, Nozzles and 
Restraints through Misc > User Allowables. 

 

The allowables thus defined are compared against calculated loads and printed in Support 
Load Summary outputs. 
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If the calculated loads exceed the input allowables, they are highlighted in red. 
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Window Menu 

For a single model file, CAEPIPE can keep up to four open windows simultaneously for 
your enhanced understanding of the presented information.  

The windows are:  
• Layout  
• Graphics  
• List, and  
• Results  

From any window, you can move focus to any other window (such as Graphics or List) 
using the F2 and F3 hotkeys. F2 will move focus between text (Layout, List or Results) and 
Graphics windows, and F3 between open text windows (between Results and Layout or 
Results and List). 

Users who have a smaller monitor and work with maximized windows for input, list, 
graphics and results, will see more the advantage of these hotkeys (F2 and F3). In such a 
setting, one key press (F2 or F3) will quickly move the focus to another window (without 
having to either minimize the one where the focus is or switch to another window through 
the taskbar). 

From the Layout window: 

 

From the List window: 

From the Graphics window: 

 

From the Results window: 
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Note: In the above Window menu from the Results window, if you moved focus to the 
Layout window, then the hotkey F3 would be assigned to Layout (not List as shown). So, the 
Window menu would look like: 
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File Menu 

This menu has commands for printing and copying graphics images to the clipboard. You 
can also set the drawing size for a printer/plotter/DXF file and type in a new title for the 
image (different from the Title entered on row 1 of the Layout window). 

 

.Print (Ctrl+P). 

The Print command here opens the Print Graphics dialog which allows you to select a 
printer and customize other print settings. 

 

.Printer. 

On the Printer tab, you can setup the printer and the graphics print page as well as select the 
font for printing graphics. 

.Font.  

The font you select here is different from the Font selected in the Graphics Font dialog 
under the Options menu. The Font command here sets the font for printing only, and the 
one under the Options menu sets the font to use for Graphics display only as explained on 
p. 111. 
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.Preview.  

Before you print an image, you can preview it by clicking on this button. 

 

While in the Preview mode, click on Close to return to the Graphics window or click on 
Print to send the job to the printer. 

.Print to File.  

This can be a useful command to convert the line drawing (vector) graphics to other vector 
formats such as Encapsulated Postscript (EPS), Windows Enhanced Metafile (EMF), 
AutoCAD’s DXF or HPGL’s PLT. You can specify a filename for the graphics file. 
CAEPIPE can also convert other vector graphics such as non-rendered stress and stress 
ratio plots, deflected and mode shapes to the above vector formats. 
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Note on DXF output 

CAEPIPE sends only the model information including the line drawing into a DXF file in 
different layers. It does not send any results (like stresses or deflected shapes) to a DXF file. 

Print Dialog for OpenGL Rendered Images 

For rendered images, you will see a different Print dialog.  Here, as in the earlier Print dialog, 
you can select a printer and customize certain print settings. The resolution and image 
background can be set, too. A black background will consume more of your printer ink. 
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Setting the resolution to High might take up a lot of system memory and slow your system 
down. Should such happen, use the Low or Medium setting. 

.Preview.  

Preview the OpenGL graphics rendering by clicking on this button. 

 

.Copy (Ctrl+C). 

You can copy the displayed graphics image to the clipboard and then paste this image into 
any other program that accepts it. For example, you can copy the rendered view of a model 
and paste it into your paint or a graphics processing program so that you can use the finished 
image (possibly with your annotations) in a word processing program of your choice to 
generate a report. 

.Drawing Size. 
The drawing size command applies only to DXF and PLT files. Before you generate a DXF 
or a PLT from menu File > Print > Print to File, you need to set the drawing size here. The 
default is set to US A size (Letter – 8.5” x 11”). 
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There are several US and ISO sizes available. 

 

.Plot Title. 
For the graphics image printout (or for the image copied through the Copy command), you 
may type in an image title different from the model title (in the Layout window). Clicking on 
Reset will restore the title to the original model Title from row 1 in the Layout window. 
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View Menu 

This menu contains commands for graphics operations. 

 

.Viewpoint (F4). 

 

Use this command to set the graphics viewpoint. Several useful buttons inside the dialog 
allow you to change viewpoint to a preset one. 

For example, if you want to see the “plan” view (Y-vertical), click on “Y view” button. 

.Previous View (F5) . 

Use this command to display the previously viewed graphics image in the Graphics window. 
The last used viewpoint, zoom level and area of the image are brought back into view. 
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.Center (Ctrl+Shift+C) . 
Use this command for centering the image around a particular location. When you select this 
command, the mouse pointer turns into a crosshair. It can be moved around by moving the 
mouse. Position the crosshair at the image location that you want centered and then left-click 
on the mouse to center the whole image around that point. 

.Turn (Ctrl+T) . 

Use this command to rotate the image about the horizontal or the vertical axis. Move the 
thumb on the scroll bar to rotate the image, or use the arrow keys on the keyboard. 

Or, use  

Shift + Mouse Scroll Button Up and Down for horizontal rotation of model 

Ctrl + Mouse Scroll Button Up and Down for vertical rotation of model 

In Translation mode, use: 

Shift + Mouse Scroll Button Up and Down for horizontal translation of model 

Ctrl + Mouse Scroll Button Up and down for vertical translation of model 

.Zoom All (Ctrl+A) . 
Use this command to view the whole model in the Graphics window. 

.Zoom In, Zoom Out. 
Use these commands to increase or decrease the magnification level for the image. Hotkeys 
are Page Up (for Zoom in) and Page Down (for Zoom out).  You can also use the mouse 
wheel button to Zoom in and Zoom out. 

.Show. 

Use this command to either display or suppress display of various items in the Graphics 
window. This feature helps in reducing clutter in the displayed image. In addition, it enables 
you to display selectively one or more items in the Graphics window. Select or deselect items 
and click on OK or Apply (to see the effect immediately while keeping the dialog open). 
Click on All or None button to select all or deselect all the items with one click. 

 

The Local Coordinate system can be shown for all the elements while viewing Results. 
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.Show/Hide Dots and Numbers (F3). 
Use the hotkey F3 to remove Dots and Node numbers from the graphics display. 

.Show Nodes. 

 

Use this feature to show node numbers selectively at different locations (such as anchors, 
limit stops, valves, etc.) to check your input or to display node numbers selectively for one or 
more items (anchors, hangers, etc.) in the Graphics window. To show node numbers, select 
or deselect the required items and click on OK or Apply (to see the effect immediately while 
keeping the dialog open). Click on All or None button to select all or deselect all the items 
with one click. 

.Redraw (Ctrl+D). 
Use this command to redraw the entire graphics image. This will refresh the window with the 
existing image. This feature is useful when you are working with a two-monitor system. 

.Render (Ctrl+R). 

Use this command to generate a realistic 3-D image of the model. Once you have a rendered 
image, you can use the Zoom All, Zoom in, Zoom out, Turn and other graphics commands 
on it. You can use the Show and the Show Nodes commands too to show specific items 
and/or node numbers. This image can be printed to a (color) printer. 

Materials, Sections and Loads are shown graphically using Color Codes in rendered graphics. 
Press the “Color Graphics” icon available in Materials, Sections and Loads List windows to 
execute the command. 
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.Hide Current Element (F6). 
With the graphics cursor flashing on the element of interest, press F6 (or select this 
command) to hide it from view (in rendered mode). 

.Show All (F9). 
Press F9 (or select this command) to display all elements in the Graphics window including 
those that were hidden using the “Hide Current Element” command. 

.Make Transparent (F7). 
Press F7 (or select this command) to make an element transparent so you can see what is 
behind it; useful in congested models. 

.All Transparent (F10). 

Press F10 (or select this command) to make all elements transparent. F11 will make them 
opaque. 
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.All Opaque (F11). 
This is the opposite of the previous command in that it makes all transparent elements 
opaque. F10 will make all elements transparent. 

.Show/Hide Selected Elements (F12). 

This command works on showing or hiding a group of elements defined in a range. See 
figure for the different choices. 

.Freeze View (F8). 
This key is a toggle. Pressing F8 freezes or unfreezes the display so you do not lose your 
point of view while modeling. 

You may still perform the Zoom, Pan, Rotate, etc., with the frozen view. Also, the option 
“Freeze View” disables the dynamic updating of view (i.e., view remains unchanged) when 
you scroll in the Layout window. 

.Show/Hide Dots and Numbers (F3). 
Use the hotkey (F3) to remove the Dots and Node numbers from the Graphics window 
simultaneously. Pressing F3 (toggle) again will bring them back. 
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Options Menu 

This menu contains commands to change the axes symbol location, color of graphics 
background, OpenGL rendering quality and the graphics font. 

 

.Axes. 
The axes symbol can be displayed in any one of the four corners of the Graphics window or 
not at all. 

 

.Background. 
The default background color for the Graphics windows is black. You can change it to white 
if you like. Changing so will also use less printer ink when you print a graphics image. 

 

 Rendering Quality. 
This feature allows you to set the quality of the rendered image. It is best to set this to High 
unless your computer renders images noticeably slowly. 

 

.Font. 
You can select any available font for graphics display here. Note: Font for printing graphics 
is selected in the Print Graphics dialog as explained on p. 100. 
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The text in the image below is shown in Impact font. 
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.Recover Graphics. 
If CAEPIPE terminates abnormally, the graphics image may get garbled. You can recover 
the graphics image, however, using one of two methods: 

a) Open the model, enter the data to complete the inputs and save.  Re-open the 
model to recover the graphics, OR 

b) Open the model, enter the data to complete the inputs and save.  Select the 
command "Recover graphics" through Graphics Window > Options. 
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File Menu 

 

The File menu here is similar to the File menu in the Layout window. You can open or close 
any CAEPIPE model, material, spectrum library or CAEPIPE results file from here. 

.Print (Ctrl+P). 
This is a comprehensive command that lets you print all model input and computed results. 
This dialog has five tabs and six buttons. 

.Model. 

On this tab, check those input data items that you would like to print. 
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.Load cases. 

On this tab, check the different load cases for which you want to print results. 

 

.Results. 

On this tab, check the different results items that you want to print. 
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.Misc. 

On this tab, select the items of interest that you want to print. 

 

.Printer. 

On this tab, you can customize your printer settings such as selecting a different printer, 
setting different margins, and the print font. By selecting a custom Adobe Acrobat-
compatible printer (if available on your system), you can generate an Adobe PDF (Portable 
Document Format) file that contains the whole model input and output. 
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Print Dialog Buttons 

.Print.  

After selecting the items you want to print, click on Print button to send output to the 
printer selected under the Printer tab. 

.Cancel.  

You can click on Cancel to exit the dialog without printing. 

.Preview.  

Before printing, you can preview how the printed output will appear by clicking on Preview. 
If necessary, you can adjust the printer settings (under the Printer tab) to change the print 
font and margins, and preview again. 
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.To File.  

If you want to send all of your selected items (input and results) click on the To File button. 

 

You can export the data to a .txt file or to a .csv file. 
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Here's an example of what the .csv file looks like with the exported data. 

 

.All.  

To select all items, click on the All button. 

.None.  

To deselect all items, click on the None button. 

.Input. 
This useful command allows you to go to the model Layout window quickly without having 
to go through a model File > Open… command. 

.QA Block. 

This command shows you the QA information you input in the Layout window. As the 
shown information is not editable here, to make changes to it, you need to go back to the 
Layout window and use the same command under the File menu. After you make edits, you 
need to save the model and reanalyze. 
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Results Menu 

 

You can open the list of all results computed by selecting Results command (Ctrl+R). Press 
Tab or Shift+Tab to move forward or backward through the different results items, each of 
which will be shown in the same Results window. 

This menu may change with the displayed results item. For example, the menu shows like in 
the above figure for Sorted Stresses, Code Compliance and Hanger Report. 

For Support Load summary, the menu shows similar to the following figure. The first set of 
commands is for showing the support load summary for other supports, one at a time. The 
second set of commands is as before. 

 

 

For Support Loads, the menu changes to show related commands for the new results item.
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The first set of commands is for showing the support loads for other supports (hangers, limit 
stops, etc.), one at a time (you can also click on the white right or left arrow). 

 

The second set of commands (Load cases, etc.) is for changing the load case for the 
displayed support. For example, the title bar of the figure shows Loads on Anchors: 
Sustained. You can change the load case to Expansion load case for this support by selecting 
the Next load case command (you can also click on the black right or left arrow). The last set 
of commands is as before, moving through different Results screens. 

For Element forces, the menu changes to show related commands. 

 

The first set of commands is for showing other forces (at other elements such as expansion 
joints and valves), one at a time (you can also click on the white right or left arrow). 
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The second set of commands (Load cases, etc.) is for changing the load case for the 
displayed support. For example, if the title bar of the figure showed Sustained load case, then 
by selecting the Next Load case command, you can display forces for the Expansion load 
case (you can also click on the black right or left arrow). The last set of commands is as 
before, moving through different Results screens. 

For Displacements, the menu changes to show related commands as follows: 

 

The first set of commands is for showing other displacements (such as minimum and 
maximum displacements and at other supports) you can also click on the white right or left 
arrow. 

  

The second set of commands (Load cases, etc.) is for changing the load case for the 
displayed displacements. For example, if the title bar of the figure showed Sustained load 
case, then you can show displacements for the Expansion load case by selecting the Next 
Load case command. (You can also click on the black right or left arrow). The last set of 
commands is as before. 

For Mode Shapes, the menu changes to show two commands specific to the new results. 
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They are to move forward or backward through the available mode shape details. The last set 
of commands is as before. 

So, depending on the displayed results item, the Results menu (Ctrl+R) will show different 
menus with at least one common set of commands for moving forward or backward through 
the different results. 
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View Menu 

 

This menu contains commands mostly for graphics operations. The List and Find Node 
commands function like they do in Layout window > View menu. Center of Gravity 
command is covered later in this section. As with the Results menu, this menu too changes 
its offerings depending on the results item being viewed. 

The first menu shown here is available from the Sorted Stresses results. The first set of 
commands helps you view stresses graphically in the Graphics window. 

.Color code stresses. / .No color coding. 
Displays or removes the color coded stress (or stress ratio) contour in the Graphics window. 
To display a color coded contour, place the yellow highlight on the type of stress you want to 
see graphically, for example, on Expansion stress. Then, select Color code stresses. Next, 
click on Show stresses or stress ratios button on the toolbar. The Graphics window will 
show the color coded contour plot, also available for jacketed piping. 
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When you select No color coding, numeric values for stresses or stress ratios are shown see 
next image). 
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.Thresholds. 

Use this command to display stresses (or stress ratios) over a specified stress or stress ratio 
value.  

.Hide Allowables. 
Selecting this command will remove the Allowables columns from the Results display. For 
some codes that have too many columns, this command helps by lessening the number of 
columns displayed. 

All commands (except Hide Ratios and Center of Gravity) function like they do under the 
Layout window > View menu. 

Under the Code Compliance results display, the View menu shows only one command to 
Hide (stress) ratios (such as SL/SH, SE/SA). The remaining commands are the same as 
before. 
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For the Pipe element (or Other element) forces display, the following View menu is shown. 

 

The only item new here is a command to Show LCS (Local Coordinate system)/Hide LCS in 
the Graphics window for each element. As you keep scrolling through the different elements 
in the results display, the corresponding element in the Graphics window will show a small 
coordinate symbol that depicts the element’s LCS. The remaining commands are the same as 
before. 
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For Displacements results display, two commands to show and animate the deflected shape 
are shown. The remaining commands are the same as before. 
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For Frequencies and Mode Shapes results display, two commands to show and animate the 
mode shape are shown. The remaining commands are the same as before. 

 



Results Window View Menu 
 

132 

 

.Center of Gravity. 

This command displays the center of gravity and total weight of the piping system as 
modeled. This information can be useful when you are comparing the weight of this model 
with total weight obtained from another source. 

 

The Total weight is the sum of empty, insulation, content and lining weights. 
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An Anchor is a support that restrains the movement at a node in the three translational and 
the three rotational directions (each direction is a degree of freedom). In a physical piping 
system, this node may be on an anchor block or a foundation, or a location where the piping 
system ties into a wall or a large piece of equipment like a pump.  

 

An Anchor is input by typing “A” in the Data column or selecting Anchor from the Data 
Types dialog. A rigid anchor is entered (i.e., an anchor with rigid stiffnesses in all six 
directions) by default. To change the default settings, edit the anchor by double-clicking on 
the anchor or pressing Ctrl+D in the row that has the anchor. An Anchor dialog is shown 
next. 

 

Uncheck the “Rigid” checkbox to make the anchor non-rigid (i.e., a flexible anchor), and 
enter numerical values for stiffnesses for the six degrees of freedom. An anchor can be 
oriented along its local coordinate system (LCS) by checking “Anchor in LCS”, which will be 
useful if you have to input anchor movements in LCS.  

Stiffness 

The stiffness for a direction may be rigid (specified by typing the letter “r” in the stiffness 
field), or some value or be left blank. If it is left blank, there is no stiffness in that direction, 
i.e., the pipe is free to move in that direction. Internally, the rigid stiffness value is set to 
1×1012 (lb./inch) for translational stiffness and 1×1012 (in.-lb./radian) for rotational stiffness. 

Releases for Hanger Selection 

These selections apply only during the automatic selection of a hanger by CAEPIPE.  They 
do not influence the anchor stiffness in the released direction (if you checked any of the 
Release checkboxes).  An Anchor by default acts in the six directions. You may release any 
combination of directions during (the automatic) hanger design. This feature is useful when
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hangers are used around equipment, where you want the hangers to take most of the weight 
load and thus reduce the load acting on the nearby equipment. CAEPIPE, during hot load 
calculation (preliminary sustained load case) in hanger design, releases the anchors (if you 
selected any of the Release checkboxes) so that the loads are taken by the hangers rather than 
by the anchors (which are modeling the equipment). 

After the hot load calculation, CAEPIPE restores the original values to the released anchors 
before continuing analysis. Release anchors when they are (typically) within four (4) pipe 
diameters away from the hangers. 

You may release any combination of translations or rotations. Typically, either the vertical 
translation or all translations and rotations are released. To release the Anchor in a particular 
direction, uncheck the corresponding checkbox. 

.Displacements.  

The Specified Displacements for Anchor dialog is shown. 

 

Three types of translations and/or rotations at an anchor in the global X, Y and Z directions 
may be specified:    

1. Thermal (10 displacements can be specified, one each for thermal loads T1 through 
T10). Applied only to the Expansion and Operating load cases.  

2. Seismic (available for B31.1, ASME Section III Class 2, RCC-M and EN 13480 codes 
only). Solved as a separate internal load case and added absolutely to static seismic and 
response spectrum load cases.  

3. Settlement (available under ASME Section III Class 2, RCC-M and EN 13480 codes 
only). Applied to a separate load case called Settlement.  
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You may specify a displacement only if you also specify a corresponding non-zero or rigid 
stiffness in that direction, i.e., the corresponding stiffness should not be left blank.  

Check “Displacements in LCS” if you want to enter anchor movements in the local 
coordinate system. These local movements are transformed into the global coordinate system 
and displayed in results.  

Settlement 

For certain piping codes (ASME Section III Class 2, RCC-M and EN13480), an anchor 
settlement, which is a single non-repeated anchor movement (e.g., due to settlement of 
foundation), may be specified. This is applied to the Settlement load case. For those codes 
that do not have a provision for settlement (like B31.1), specify the anchor settlement as a 
thermal displacement (which tends to be a conservative approach). 

Example 1: Flexible Anchor 

Nodes on most large equipment are modeled as rigid anchors. If you need to specify a non-
rigid (i.e., flexible) anchor (for example at a nozzle to include vessel flexibility), you can input 
those stiffnesses by editing the anchor. 

Double click on the anchor to show the anchor dialog. 

 

By default the anchor has all stiffnesses rigid, no releases for hanger selection and no 
specified displacements. The stiffness fields are grayed, i.e., non-editable and the Rigid 
checkbox is checked. Click on the Rigid checkbox to uncheck it. The stiffness fields now 
become editable. 

 

Type in the required stiffness values and press Enter or click on OK. The anchor definition 
shown in the next figure is now modified to be a flexible anchor. 
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Example 2: Rigid Vertical Support with Foundation Settlement 

Assume that you need to model a vertical support on a foundation that has settled using 
ASME Section III Class 2 (1980) code for code compliance. 

Vertical settlement (–Y) = 6 inches. 

First, set the piping code to ASME Section III, which has a provision for Settlement load 
case, using the menu Options > Analysis > Code in the Layout window. 

Next, create a rigid vertical support at the required node. Press “a” in the Data field to input 
a default anchor. 

Next, edit the anchor so that it acts as a vertical support only, by modifying the stiffnesses 
similar to Example 1 so that only a Rigid stiffness KY in the Y direction remains. 

 

Now the anchor is modified to act as a Vertical 2-way rigid support. Click on the 
Displacements button and type in –6 (inch) for Settlement under Y. You could also input 
thermal and seismic displacements if required. 

 

The anchor is now modified to be a rigid vertical support with a specified settlement 
displacement. 
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Check the box “Anchor in LCS” if you want to orient the anchor along a skewed line using 
its local coordinate system (LCS), which also aids you in specifying Displacements in LCS. 
Notice the naming convention changes (Kxx changes to kxx, X changes to x, and so on). 

Example 3: Anchor Release during Hanger Design 

 

CAEPIPE lets you model equipment nozzles as anchors. Assume that you had one on a 
turbine, as shown above, and that you have placed a hanger nearby. The main purpose of 
this hanger would be to take most of the load coming on the nearby turbine nozzle. To let 
CAEPIPE do that, you will have to release all directions of the Anchor so that the hanger 
will be designed to take most of the load. 

First, enter an anchor for the node and then double click on it to edit it. 

 

Click on the checkboxes for Releases for hanger selection in the required directions (X, Y, Z, 
XX, YY, ZZ). The anchor will be released in the specified directions during hanger design. 

CAEPIPE restores the anchor to its original state (of no releases) after the preliminary hot 
load calculation during hanger design. See Hanger Design Procedure on p. 273. 
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A ball joint is a zero-length pipe element that allows rotations about the three orthogonal 
global axes (similar to a universal coupling joint in the rear axle of a motor vehicle) while still 
allowing the fluid to flow through it.  If you do not want rotation in the torsional or (the 
two) bending directions, input “Rigid” for the respective stiffnesses. Since the ball joint is a 
zero-length element, the “From” and “To” nodes are coincident. Hence, you should leave 
the DX, DY and DZ fields in the Layout window blank (CAEPIPE will not let you enter a 
value). 

A ball joint is input by typing “Ba” or “Ball” in the Type column or selecting Ball joint from 
the Element Types dialog. 

 

The Ball joint dialog is shown. 

 

The rotational stiffnesses, rotation limits and the friction torques are specified independently 
in the bending and torsional directions. The torsional direction (local x) is determined by the 
preceding element’s local x. If a preceding element is unavailable, the following element is 
used to determine the torsional direction. The bending directions (local y and z) are 
orthogonal to the torsional direction (local x). Bending friction is determined by a resultant 
of torques in local y and z directions. Similarly, bending rotation is determined by a resultant 
of rotations in local y and z directions. 

The stiffness, rotation limit and friction torque values are available from the manufacturer of 
the ball joint or from their test results. Otherwise, you must use engineering judgment. 

The stiffness values may be left blank, in which case CAEPIPE uses a very small value (1 in.-
lb./deg) internally to avoid dividing by zero during internal computation. 
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A rotation limit of zero (0.0) means that the ball joint cannot rotate (i.e., it is rigid) in that 
direction. A rotation limit of “None” or Blank means that rotation is not limited to a finite 
value.  

 

When the applied torque is less than the friction torque, there is no rotation. When the 
applied torque exceeds the friction torque, rotation is calculated as shown above. When 
rotation limit is reached, there is no further rotation irrespective of the applied torque. 

When the option “Use friction in dynamic analysis” is selected, for modal analysis, 
CAEPIPE uses three different stiffnesses for a ball joint depending on the magnitude of the 
applied moment/torque in comparison to the user-specified friction torque. They are as 
follows: 

Case 1: When the applied moment at the ball joint (for the first operating load case when a 
piping code is selected or for the static case when “Piping code=None” is selected) is 
less than the friction torque, the friction is not overcome and the ball joint stiffness 
is internally set to a large number (in effect, infinity). 

Case 2: When the applied moment is more than the friction torque, the friction is overcome 
and the ball joint starts rotating (with the user-specified rotational stiffness being 
applied). This rotational deformation takes place until the user-specified rotational 
limit is reached. 

 So, from the time friction is overcome to the time when the rotational limit is 
reached, CAEPIPE internally sets an “equivalent stiffness” for the ball joint as given 
below. 

 If Kb is the user-specified stiffness for the ball joint,  

 Rotation = (applied moment – friction torque)/ Kb ……… (1) 

 The “equivalent stiffness” chosen by CAEPIPE is the slope of the straight line from 
origin to the point (rotation, applied moment) in the figure given above. In other 
words, 

 Kbe = (applied moment/rotation) …….. (2)  

 Combining (1) and (2), you get 

 Kbe = (applied moment) x Kb / (applied moment – friction torque) ……. (3) 
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Case 3: When the actual rotation reaches the user-specified rotational limit for the first 
operating load case/static case, the ball joint stiffness is again set to "infinity.” 

CAEPIPE uses “equivalent stiffness” for ball joints as described under Case 2 above, when 
the friction torque is exceeded and the computed rotation is yet to reach the specified 
rotational limit, as long as the option “Use friction in dynamic analysis” is selected. When this 
option is NOT selected, CAEPIPE ignores the nonlinearities of the ball joint (namely, 
friction torque and rotational limit) and uses only the user-specified stiffnesses. That is why, 
despite very small moments, large rotations may be computed (i.e., a check against user-
specified rotational limit is not performed). 

See the topic Expansion Joints for examples. 
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You can model elaborate structural systems inside CAEPIPE alongside the piping to be 
supported. In simple situations, if the structure is stiffer than the piping is, you may not need 
to model the structure at all but simply treat it as rigid (for example: input Rigid for Stiffness 
in Limit stop when simulating a stiff beam using a Limit stop). But, in cases where you need 
to account for structural flexibility, use the Beam element to model structural support 
systems alongside piping systems. 

The material, section and load for a beam are different from those for a pipe. Just as you 
would define a material/section/load for a pipe, so too should you define a separate 
material/section/load for a beam.  Look for Beam Material, Beam Section, and Beam Load 
(under Misc menu). 

Upon analysis, CAEPIPE reports forces and moments for beam elements. 

A beam is input by typing “bea” in the Type column or by selecting “Beam” from the 
Element type dialog. 
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The Beam dialog is shown. 

 

Beta angle 

Beta angle is used to define the orientation of a beam’s local axes. See Beam orientation later 
in this section. 

Beam End Releases 

Each end of the beam (From and To ends) can be released to simulate the type of structural 
support you want to model. That is, you can use a combination of releases to specify whether 
a beam end is fixed, pinned, etc. 

Beam material 

Before you input a beam element, you must define a beam material, section and load. Select 
Beam materials from the Miscellaneous (Misc) menu in the Layout or List window. 
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A beam material list window is shown. Double click on an empty row to input a new beam 
material. 

 

A dialog for inputting beam material is shown. 
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The material name can be up to three alpha-numeric characters to identify the beam material. 
A more complete description can be entered under Description. Enter modulus of elasticity, 
Poisson’s ratio (Nu), density of the material and mean coefficient of thermal expansion 
between Tref and T1/T2/T3 in beam load. 

Beam section 

Select Beam Sections from the Misc(ellaneous) menu in the Layout or List window. 

 

A list of beam sections is shown. Double click on an empty row to input a new beam 
section. 
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A dialog to input beam sections is shown. 

 

You can either input the data yourself or click on the Library button for a listing of different 
AISC I-beams, channels, tees, etc., that are built into CAEPIPE. Be sure to verify the 
properties that are shown in the fields after you select a section from the library. 

The name can be up to three alpha-numeric characters to identify the beam section. A more 
complete description can be entered in the Description field. 

The axial area, major and minor moments of inertia must be input. Input of torsional inertia 
is optional. If it is not input, it defaults to the sum of major and minor moments of inertia. 
Input of shear areas is optional. If it is not input, shear deflection is not included. Input of 
depth and width are optional. Presently, they are used only for rendered plots of the beam. 

Dialogs for selecting a beam section from the AISC library are shown below: 
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The type of the beam section (e.g., I beam, W (Wide Flange)) is selected from this dialog. 

Another dialog which shows various available sections for the particular beam section type is 
then shown. 

 

After selecting the section, click on OK and the section properties will be entered in the 
Beam section dialog. 
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Beam load 

Select Beam Loads from the Misc menu in the Layout or List window. 

 

A list of beam loads is shown. 
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Double click on an empty row to input a new beam load through the beam load dialog or 
start typing into the fields. 

 

The Load name can be up to five alpha-numeric characters to identify the beam load. You 
can enter up to 10 temperatures depending on the preset number of thermal loads. The 
additional weight is a uniform weight per unit length added to the weight of the beam. This 
could for example be used to add snow load to the beam. Wind load may or may not be 
applied to the beam element by using the check box for Wind load in the dialog or typing 
“Y” or “N” for Wind load in the List window. 
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Beam orientation 

The Beam orientation is determined by the locations of the “From” and “To” nodes and the 
beta angle of the beam element. The local x-axis of the beam is always from the “From” 
node to the “To” node. The reference orientation corresponds to beta = 0.0. 

A nonzero beta angle (measured from the reference position) rotates the local y- and z-axes 
of the beam about the local x-axis of the beam in the counter clockwise direction. 

The local coordinate system for beams can be displayed for each beam element through the 
List window (Ctrl+L, select Beams, menu View > Show LCS [for Local Coordinate System]). 

Global vertical axis is Y 

Beam is not Vertical 

 

The local y-axis of the beam lies in the local x - global Y plane (i.e., vertical plane) and is 
in the same positive direction as the global Y axis. The local z-axis is the cross product of 
the local x and y-axes. Major bending plane is local x-y, that is, Izz = Major moment of 
inertia and Iyy = Minor moment of inertia. 

Beam is Vertical 

 

The local z-axis of the beam is in the global Z direction. The local y-axis is in the global –
X direction. Major bending plane is x-y, i.e., Izz = Major moment of inertia and Iyy = 
Minor moment of inertia. 
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Global vertical axis is Z 

Beam is not Vertical 

 

The local z-axis of the beam lies in the local x - global Z plane (i.e., vertical plane) and is 
in the same positive direction as the global Z-axis. The local y-axis is the cross product of 
the local z and x-axes. Major bending plane is x-z, that is, Iyy = Major moment of inertia 
and Izz = Minor moment of inertia. 

 

The local y-axis of the beam is in the global Y direction. The local z-axis is in the global –
X direction. Major bending plane is x-z, i.e., Iyy = Major moment of inertia and Izz = 
Minor moment of inertia. 
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Example 1: Pipe Rack using Beams 

Here, you see how to use a beam element to construct a pipe rack and connect the beam to 
the pipe so that CAEPIPE can account for the rack’s flexibility. The procedure is simple. 
First, you need to create a beam material, section and load in addition to pipe material, 
section and load. 

As the Layout window shows, model the piping (nodes 10 to 40) and the first beam support 
(nodes 100 to 140). Then, create the second beam support (nodes 150 to 190) using the 
Generate command (under Edit menu in the Layout window). Finally, connect piping at 
nodes 20 and 30 to beam nodes 120 and 170 using limit stops. 
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The “Generate” dialog is shown below: 

 

The “Limit Stop” dialog is shown below: 

 

The graphics is shown below: 
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Example 2: Base Supported Bend using a Beam 

See Example 7 in the Bend section for modeling a base supported bend using a beam on 
page 170.  
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Bellows expansion joints are flexible elements included in high temperature piping systems to 
absorb primarily thermal movement. A Bellows contains one or more convolutions designed 
to withstand the internal pressure while still flexible enough to absorb the axial, lateral and 
bending deflections. Before use, you should note the critical pressure at which the bellows 
becomes unstable. The B31.1 piping code suggests that expansion joints may be employed 
only “when piping bends, loops, and offsets are not able to provide adequate flexibility.” 
(Para. 11.5, 2010).  

Usually manufacturers of these expansion joints publish product catalogs that contain 
technical information about the joints you could use in your systems. The EJMA (Expansion 
Joint Manufacturers Association) also publishes a standards catalog with guidelines that 
“assist users, designers, and others in the selection and application of expansion joints for 
safe and reliable piping and vessel installation.” 

A Bellows joint is input by typing “bel” in the Type column or selecting “Bellows” from the 
Element Types dialog. 

 

The Bellows dialog is shown. 

 

Expansion joints are mainly modeled using the above shown four types of stiffnesses – axial, 
bending, torsional and lateral. The required stiffness values, pressure thrust area and weight 
should be taken from the manufacturer’s catalog. 
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 For a rigid stiffness (for example, torsional), enter “r” for Rigid; if highly flexible, enter 1 
(lb./in.) as a minimum, to avoid dividing by zero during internal computation. 

 
 

Axial: Refers to axial extension (as in cryogenic systems) or compress (as in high-
temperature systems) axially along its centerline while in operation. 

Bending (angular): Refers to the bellows bending about its center point on the centerline. 
Bending can be in any plane that passes through the centerline. 

Lateral: Refers to the direction perpendicular to the centerline of the bellows. The two ends 
of the bellows remain parallel to each other while their centerlines are displaced causing an 
offset. This direction is also called transverse or parallel offset direction. 

Torsional: Usually very stiff, refers to a twisting moment at one bellows end while the other 
end either relatively is stationary or twists in the other direction, about the bellows centerline.  

The pressure thrust area will impose a thrust load of: (pressure × thrust area), on both nodes 
of the bellows. Even if the bellows is tied, it is recommended that the pressure thrust area be 
input. The weight is the empty weight. CAEPIPE adds the weight of the contents, insulation 
and additional weight to the empty weight. 

Pipe guides are needed adjacent to the bellows because of its inherent flexibility and the 
compressive loading on the adjacent pipes due to the pressure thrust of the joint. Moreover, 
proper guiding is necessary to direct thermal movement into the joint and prevent buckling 
of the line.  Depending on the bellows behavior, you should place the first guide no farther 
than four pipe diameters from the joint. Place additional ones appropriately after studying 
the nearby deflections and loads.  

Also, consider vessel and anchor movements, which may cause a misalignment at the joint. 

See the topic on Expansion Joints for examples. 
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In CAEPIPE, the term Bend refers to all elbows and bends (custom-bent pipes). An elbow 
comes prefabricated with a standard bend radius (short or long radius) whereas a bend is 
custom- made from bending a straight pipe with a specified bend radius. Geometrically, a 
bend is a curved pipe segment which turns at an angle (typically 90° or 45°) from the 
direction of the run of the pipe. Some of the items associated with a bend are shown below. 

 

Node 20 is the Bend node, also referred to as the Tangent Intersection Point (TIP). As you 
can see from the figure, it is not physically located on the bend. Its only purpose is to define 
the bend. CAEPIPE automatically generates the end nodes of the curved portion of the 
bend (nodes 20A and 20B, called the near and far ends of the bend. The bend end nodes 
(20A and 20B in the figure) may be used to specify data items such as flanges, hangers, 
forces, etc. 

A bend is input by typing “b” in the Type column or selecting “Bend” from the Element 
Types dialog. 
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If you need to modify an existing bend, double click on it or press Ctrl+T (Edit type) to 
bring up the Bend dialog. 

 

Bend Radius 

The radius of a bend (measured along the centerline of the bend) can be specified as Long, 
Short, or User (defined) by one of the radio buttons for Bend Radius. CAEPIPE has long 
and short radii built-in for standard ANSI, JIS, DIN and ISO pipe sizes. For nonstandard 
pipe sizes, Long radius is equal to 1.5 times the pipe OD and Short radius equal to the pipe 
OD. 

Bend Thickness 

Input the wall thickness of the bend if different from the preceding pipe’s thickness. If 
specified, the Bend Thickness applies only to the curved portion of the bend (node 20A to 
node 20B in the figure above). 

Bend Material 

If the material of the bend is different from that of the adjoining pipe, select the Bend 
Material from the drop down combo box. The Bend Material, if specified, applies only to the 
curved portion of the bend (node 20A to node 20B in the figure above). 

Flexibility Factor 

This factor is automatically calculated for standard elbows according to the piping code 
chosen. If you have your own Flexibility Factor, enter it here instead of the piping code 
specified Flexibility Factor. A value of 2.0, for e.g., will mean that the bend is twice as flexible 
as a pipe of the same length. 
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SIFs 

These factors are automatically calculated for standard elbows according to the piping code 
chosen. If you have your own, specify them here (useful for FRP bends, for example), which 
will be used instead of the piping code specified SIFs. If User SIFs are also specified at bend 
nodes (A and/or B nodes), they will be used instead of the bend SIFs or code specified SIFs. 

Intermediate Nodes 

An intermediate node, located in between the ends of the bend, may be required in some 
situations to specify data items such as flanges, hangers, forces, etc. You can create an 
intermediate node by giving a (new) node number and an angle for it, which is measured 
from the near end of the bend (node 20A in figure). Up to two such nodes may be input. 
Note that the intermediate nodes 13 and 16 shown below are at angles of 30° and 60° 
respectively from node 20A (near end). The intermediate nodes can be used for specifying 
data items such as flanges, hangers, forces, etc. 

 

Bend Examples 

Some examples follow. They illustrate some common modeling requirements. 

Example 1: 90° Bend 
Example 2: 45° Bend 
Example 3: 180° Bend 
Example 4: Flanged Bend 
Example 5: Reducing Bend 
Example 6: Bend Supported by a Hanger 
Example 7: Base Supported Bend 

To simplify the discussion of bend modeling, it is assumed that the material, section (8” 
STD), load and the first node (10) are already defined. It is also assumed that the bend has 
long radius (12”) and the cursor is placed in row #3. 

 



Bend 
 

160 

Example 1: 90° Bend 

 

 Press Tab in row #3. Node 20 will be automatically assigned and the cursor will 
move to the Type column, type “B” (for Bend), Tab to DX, type 2. Enter material, 
section, load and press Enter. The cursor moves to the next row (#4).  

 Tab to the DY column. The next Node 30 is automatically assigned. In DY column, 
type -2 and press Enter. This completes the bend input.  
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Example 2: 45° Bend 

 

 Press Tab in row #3. Node 20 will be automatically assigned and the cursor will 
move to the Type column. type “B” (for Bend), Tab to DX, type 1’6”. Enter 
material, section, load and press Enter. The cursor moves to the next row (#4). 

 Tab to the DX column. The next Node 30 is automatically assigned. In the DX 
column, type 1, Tab to DY and type -1, then press Enter. This completes the bend 
input.  
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Example 3: 180° Bend 

A 180° bend or U-bend, is often used in an expansion loop to relieve thermal stresses in the 
piping system. It is modeled as two 90° bends back-to-back. 

 

 Press Tab in row #3. Node 20 will be automatically assigned and the cursor will 
move to the Type column. type “B” (for Bend), Tab to DY, type –1’6”. Enter 
material, section, load and press Enter. The cursor moves to the next row (#4).  

 Press Tab. Node 30 will be automatically assigned and the cursor will move to the 
Type column. type “B” (for Bend), Tab to DX, type 2. (DX is 2’ because 8” std long 
radius bend has 12” radius and since these two bends are back to back, DX = 2R). 
Press Enter and the cursor moves to the next row (#5).  

 Tab to the DY column. The next Node 40 is automatically assigned. In DY column, 
type 1’6”, then press Enter. This completes the bend input.  
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Example 4: Flanged Bend 

Bends are often connected to the adjacent pipe sections with flanges. A flange may exist on 
one or both sides of the bend. Flange weight may have a significant effect on the pipe 
stresses. Also, the stress intensification and flexibility factors for a bend will decrease if one 
or both of the ends are flanged. 

 

Model the bend as in Example 1. Then input flanges at nodes 20A and 20B. Since these are 
internally generated nodes, i.e., they do not normally appear in the Layout window, it is 
necessary to specify input at these nodes using the Location type. To input the flange at node 
20A, in row #5, type 20A for Node, Tab to Type column and type “L” for Location. This 
opens the Data Types dialog. 
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Select Flange as the data type and click on OK. This opens the Flange dialog. 

 

Select the Type of the flange from the drop-down combo box, e.g., Single welded slip-on 
flange. To get the weight of the flange, click on the Library button. 

 

Select the pressure rating for the flange (e.g., 600) and press Enter. The weight of the flange 
is automatically entered in the Flange dialog. Press Enter again to input the flange. 

Repeat the same procedure for the flange at node 20B. 
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The graphics is shown below: 

 

The rendered graphics is shown below: 
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Example 5: Reducing Bend 

CAEPIPE does not have a reducing bend element. A reducing bend may be modeled using 
an average OD (outside diameter) and average thickness of the large and small ends of the 
bend. The bend radius of the reducing bend should input as user bend radius. The stress 
Intensification Factor (SIF) of the reducing bend, if available, should be input as Bend SIF. 

 

 The 8” std pipe (OD = 8.625”, Thk = 0.322”) with Name = 8 is already defined. 
Now define a 4” std pipe (OD = 4.5”, Thk = 0.237”) with Name = 4.  

The average OD of the two sections is (8.625 + 4.5) / 2 = 6.5625” and the average 
Thickness is (0.322 + 0.237) / 2 = 0.2795”.  

Define a Non std section with Name = AVG, OD = 6.5625” and Thickness = 0.2795”. 

The list of sections is shown below.  

 

 Note that the section specified on the Bend row in the Layout window applies to the 
curved portion of the Bend (between the A and B nodes) as well as to the straight 
portion from the preceding node to the A node. In this case, we want to assign the 
section “AVG” only to the curved portion and assign the section “8” to the straight 
portion. This can be done by defining an additional node that is coincident with the 
A node thus making the straight portion of the bend zero length.  

 In row #2, the first node (10) is already defined and the cursor is placed in row #3. 
Type 15 for Node, Tab to DY, type -8”. Enter material (1), section (8), load (1) and 
press Enter. The cursor moves to the next row (#4). 

 Press Tab. Node 20 is automatically assigned and the cursor will move to the Type 
column, type “B” (for Bend), Double click in the Type column to edit the Bend. 
Click on the User Bend Radius button and type 16 for bend radius. Press Enter to 
modify the Bend and return to the Layout window. Tab to DY, type -1’4”. Tab to the 
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section column and type “AVG”. Then press Enter. The material and load are copied 
from the previous row and the cursor moves to the next row(#5). 

 Tab to the DX column. The next Node 30 is automatically assigned. In DX column, 
type 2’. Tab to section column, type 4 and then press Enter. This completes the 
reducing bend input. 

The Layout window is shown below: 

 

The graphics is shown below: 

 

The rendered graphics is shown below: 
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Example 6: Bend Supported by a Hanger 

Assume that the bend is supported in the middle by a hanger. 

 

Model the bend as in Example 1. The hanger is input at node 15, which is in the middle of 
the bend. Node 15 is created as an intermediate node on the bend as follows: 

Double click on the bend (in the type column of the Layout window) to edit it. The bend 
dialog is shown. 

 

Under intermediate nodes, type 15 for node and 45 for its angle, then click on OK. This 
creates an intermediate node 15 at 45° from the node 20A (near end of the bend) as shown 
in the figure above. 
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Since node 15 does not show in the Layout window, it is necessary to specify data input at 
this node using the Location type. To input the hanger at this node, in row #5, type 15 for 
Node, Tab to Type column and type “L” for Location. This opens the Data Types dialog. 

 

Click on Hanger, the hanger dialog is shown. 

 

Click on OK to accept the default hanger and a hanger is entered at node 15. 
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Example 7: Base Supported Bend 

Two examples of base supported bends are shown below. In the figure on the left, the 
support is modeled using a rigid vertical restraint. In the figure on the right the support is 
modeled using a beam element. 

 

Vertical Restraint Support 

 Model the bend at node 20 as before.  
 To put a vertical restraint at node 20B, type 20B for node and “L” for Location. This 

will open the Data types dialog. 
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Double click on Restraint. This will open the Restraint dialog. 

 

 Click on the Vertical button to check the Y or Z restraint (depending on the vertical 
axis) and click on OK.  

The Layout window is shown below: 
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The graphics is shown below: 

 

Beam Support 

 Model the bend at node 20 as before.  
 Create a beam material, section and load as described in the Beam section earlier in 

the Reference.  
 Input a beam element from node 20B to node 100.  

Type 20B in the Node column and “f” (for From) in the Type column to create a starting 
point. Press Enter to move to the next row.  

Type 100 in the Node column and “bea” (for Beam) in the Type column. In the DY 
column, type the beam length with a negative sign (since the beam is going downward 
from node 20B to node 100). Type the beam material, beam section and beam load names 
in the Matl, Sect and Load columns. In the Data column type “a” to input an Anchor.  

The Layout window is shown below: 
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The graphics is shown below: 
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A tee is modeled using three pipes that come together at a node, which should be designated 
as a “Tee” using the Branch SIF data type.  If not, then CAEPIPE cannot calculate a code-
specified SIF for the tee to use in stress calculations. 

A Stress Intensification Factor (SIF) type for a tee can be input by typing “br” in the Data 
column or selecting “Branch SIF“ from the Data types dialog. 

 

The Branch SIF dialog is shown. 

 

The type of the branch SIF can be selected from the Type drop-down combo box. 
Depending on the piping code different types of branch SIFs may be available. Typical 
branch SIF types (for B3.1 piping code) are shown below. 

 

A few branch SIFs may need additional input; for example, in the case of a reinforced 
fabricated tee, a pad thickness is required. 
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CAEPIPE differentiates between a header (run) and a branch line based on their ODs. So, 
when CAEPIPE finds two lines with ODs of 8 inches and 6 inches, it designates the 8 inch 
line as the header (or main) line with the 6 inch line designated as the branch line (this is also 
how you would model a reducing tee). 

When the header and the branch lines have the same ODs, reduce the branch OD slightly so 
that the header and the branch lines are properly designated (e.g., ODheader = 168.4 mm, 
ODbranch = 168.3 mm). 

Examples: 

Say you want to model a reducing tee as shown in the provided “Sample.mod”.  It’s an 8”x6” 
reducing tee.  First, we need to model the three pipes – two for the run (nodes 20 to 30 and 
30 to 40), one for the branch (nodes 30 to 60), which will be assigned the 6” section. Each 
pipe section can have its own OD/Thickness. Lastly, designate the common node as a (Butt) 
Welding Tee. 
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The Tee is as shown at node 30 in the graphics window below. 

 

A “latrolet” or a lateral tee (commonly, the branch is at a 45° angle from the header) or a Y-
joint is modeled like a regular tee (as above).  But, the SIF for this joint needs to be input by 
you after consultation with the tee/joint manufacturer.  Use a “User-SIF” data type at the 
common node to specify the SIF.  See topic on Tees for more information. 
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Soil in Buried piping analysis is modeled by using bilinear restraints with an initial stiffness 
and an ultimate load. After the ultimate load is reached the displacement continues without 
any further increase in load, i.e., the yield stiffness is zero. The initial stiffness is calculated by 
dividing the ultimate load by the yield displacement which is assumed to be D/25 where D is 
outside diameter of the pipe. 

Soil modeling is based on Winkler’s soil model of infinite closely spaced elastic springs. Soil 
stiffness is calculated for all three directions at each node. Pressure value in the load is 
suitably modified to consider the effect of static overburden soil pressure. Model is analyzed 
for operating (W+P1+T1) condition and the displacements in the three directions are noted. 
A check is made for whether skin friction is mobilized and the soil has attained the yield 
state. If true, then the spring is released in that direction indicating that soil no longer offers 
resistance in that direction. This modified model is again analyzed and checked for yield 
stage. The iterative process is continued till the percentage difference between displacements 
at each node for two successive iterations is less than 1%. The final stiffness is the true 
resistance offered by the soil to the pipe. 

General Procedure to model buried piping 

1. First define soils using the command Misc > Soils in the Layout or List window.  
2. Next, tie these defined soils with pipe sections (Ctrl+Shft+S to list Sections, double click 

on an empty row, you will see the field Soil in the bottom right corner. Pick the soil 
name from the drop-down combo box).  

3. Use this modified section for each element on the Layout window that is buried with this 
soil around it.  

CAEPIPE presently does not discretize long sections of buried piping. A future release is 
anticipated to provide more comprehensive soil modeling. Discretization is required near 
“regions of discontinuities.” These regions are changes in directions (bends, tees), or where 
piping exits to open space, or piping enters the buried region. In these areas, you need to 
subdivide long spans into smaller ones as much as possible. This will contribute to lowering 
vertical deflections. 

It is possible to specify different soil characteristics for different portions of the pipe model. 
Here is how. 

1. Define different soils using the command Misc > Soils.  
2. Then, create as many pipe sections as the number of soils.  
3. Associate each soil type with a section (to be used for the different portions).  
4. Model piping using the different sections for different portions of the model.  

Note: For vertical sections of pipe with varying buried depths, you can use only one soil tied 
to one section and CAEPIPE will calculate appropriately 
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Ground Level 

Ground level for a soil is the height of the soil surface from the global origin (height could 
be positive or negative). It is NOT a measure of the depth of the pipe’s centerline. 

In the figure, the height of the soil surface is 3 feet from the global origin. Pipe node 10 
[model origin] is defined at (0,-5,0). So, the pipe is buried 8’ (3’ - [-5’]) deep into the soil. 
Define similarly for the other soil. 

The pipe centerline is calculated by CAEPIPE from the given data 

 

Two Soil types 

Two types of soils can be defined - Cohesive and Cohesionless. Soil density and Ground 
level are input for both cohesive and cohesionless soils. The Ground level is used to calculate 
depth of the buried section. For cohesive soil, Strength is the un-drained cohesive strength 
(Cs). For cohesionless soil, Delta (δ) is angle of friction between soil and pipe, and Ks is 
Coefficient of horizontal soil stress. See nomenclature below for more information. 

Highlight buried sections of the model in graphics 

If your model contains sections that are above ground and buried, then you can selectively 
see only the buried sections of piping in CAEPIPE graphics by highlighting the section that 
is tied to the soil. Use the Highlight feature under the Section List window and place 
highlight on the buried piping section (see Highlight under List window>View menu, or 
press Ctrl+H). The Graphics window should highlight only that portion of the model that is 
using that specific section/soil. 
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Nomenclature 

D = Outside diameter of pipe  

Ks = Coefficient of horizontal soil stress which depends on the relative density and state of 
consolidation of soil. Ks is empirical in nature and may be estimated from Nq/50. Ks 
can vary depending on the compaction of the soil from 0.25 (for loose soil) to 1.0 
(really compacted soil). 

Nq = Bearing capacity factor = 0.98414e(0.107311φ) 

φ = δ + 5° 

δ = angle of friction between soil and pipe 
  Normal values for delta ranges between 25° – 45° (for sand). 
  Clean granular sand is 30° . With a mix of silt in it, the angle is 25° 

Sp = soil pressure = soil density × depth 

Cs = Undrained cohesive strength (input for cohesive soil), (Cs in kN/m2) ≤ 1.0 

Af = Adhesion factor = 1.7012775 e(-0.00833699 Cs) 

kp = Coefficient of passive earth pressure 
 = (1 + sin φ) / (1 – sin φ) 

bottom depth = depth + D/2 
top depth = depth – D/2 

Nr = (Nq – 1.0) tan (1.4 φ) 

dq = dr = 1.0 + 0.1 tan (π/4 + φ/2) × depth / D, for d > 10° , otherwise dq = dr = 1.0 

Calculation of Ultimate Loads 

The ultimate loads (per unit length of pipe for axial and transverse directions and per unit 
projected length of pipe for vertical direction) are calculated as shown below. 

Different equations are used for cohesive (clayey) and cohesionless (sandy) soils. 

Axial direction 

Cohesive soil:   Axial load = π × D × Af × Cs 
Cohesionless soil: Axial load = π× D × Ks × Sp × tan δ 
Transverse direction 
Cohesive soil:   Transverse load = D × (2 Cs + Sp + 1.5 Cs × depth / D) 
Cohesionless soil:  Transverse load = kp × kp × Sp × D 
Vertically downward direction 
Cohesive soil:   Downward load = D × (5.7182 Cs + Soil density × bottom depth) 
Cohesionless soil:  Downward load = D × (Soil density × bottom depth × Nq × dq 

 + 0.5 Soil density × D × Nr × dr) 
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Vertically upward direction 
Cohesive soil:   Upward load = D × Soil density × top depth + 2 Cs × top depth 
Cohesionless soil:  Upward load = D × Soil density × top depth 

Buried Piping Example 

Ultimate Loads and Stiffnesses computed by CAEPIPE for this example are verified later in 
this section. 

Example data: 

A 12” Std pipe 6’ long is buried, 3’ in cohesionless and 3’ in cohesive soils. 

Soil properties are as follows: 

Cohesionless (Name of soil: S1, associated with pipe section 12A): 

Density = 120 lb / ft3 
Delta (δ) = 20° 
Ks = 0.29 (calculated from Nq/50, where Nq = 14.394) 
Ground level = 3’ 

Cohesive (Name of soil: S2, associated with pipe section 12B): 

Density = 150 lb / ft3 
Strength = 100 psi 
Ground level = -1’ 

1. Define soils using the command Misc > Soils. 
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A List window for soils will be displayed. Double click on an empty row to define a new soil. 

For our example, define two soils - one cohesive and the other cohesionless with properties 
as shown in the following dialogs. 

Dialog for cohesionless soil: 

 

Dialog for cohesive soil: 

 

After you define the soils, you should see the two soils listed in the List window. 
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2. Define pipe sections and then associate the soils with these sections. 

Define two pipe sections, both 12”/STD pipe sections (name them 12A and 12B), and select 
the correct soil in the pipe section dialog box using the Soil drop-down combo box. 

Soil S1 is associated with section 12A: 

 

Soil S2 is associated with section 12B: 
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3. Define the layout from 10 to 20 to 30; the first pipe element from 10 to 20 uses section 
12A (Cohesionless soil type S1), and the next pipe element 20 to 30 uses section 12B 
(Cohesive soil type S2). Check Operating load case under Loads menu > Load cases for 
analysis. 

 

Save the model and analyze. Choose yes to view the results. From the Results dialog, pick 
Soil Restraints. The different loads and stiffnesses will be shown. The numbers found here 
below are the ones that are verified later in this section. 

 

Example Verification 
Verification of cohesionless restraints (for pipe element 10 to 20) 
Sp = soil pressure = soil density × depth 
depth = 3’ - (-5’) = 8’ (since the pipe centerline is at -5’ and ground level is at 3’).  
Sp = 120 lb/ft3 × 8 ft = 960 lb / ft2 = 6.6667 lb/in2 
Axial direction 
Axial load = π× D × Ks × Sp × tan δ 
=  π ×12.75×0.29×6.6667×tan (20) 
= 28.1861 lb/in  
= 1014.7 lb (for 36”, length of pipe) (CAEPIPE: 1014.7)  

Assuming yield displacement = D/25, 
Axial stiffness  =  25 × 1014.7 / 12.75  =  1989.6 (lb /in) (CAEPIPE: 1989.6) 
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Transverse direction 
φ = δ+ 5° = 20° + 5° = 25° 
kp = Coefficient of passive earth pressure  
= (1+ sin φ) / (1 - sin φ) 
= 2.4639 

Transverse load = kp × kp × Sp × D 
= 2.4639 × 2.4639 × 6.6667 × 12.75  
= 516.0239 lb /in  
= 18576.88 lb (for 36”) (CAEPIPE: 18577)  

Transverse stiffness = 25 × 18576.88 / 12.75 
= 36425 lb / in (CAEPIPE: 36425) 
Vertically downward direction 
bottom depth  =  96” + 12.75”/2  =  102.375” 

Nq = Bearing capacity factor = 0.98414 e (0.107311 φ)= 14.39366 
Nr = (Nq – 1.0) × tan (1.4 φ) = 9.37834 
since δ> 10° 
dq  =  dr  =  1.0 + 0.1 × tan(π/4 + φ/2) × depth / D  =  2.18188 

Downward load = D × (Soil density × bottom depth × Nq × dq + 0.5 × Soil density × D × 
Nr × dr) 
= 12.75 × ((120/1728) × 102.375” × 14.39366 × 2.18188 + 0.5 × (120/1728) × 12.75” 
×9.37834×2.18188) 
= 12.75 × 232.3305 lb / in  
= 106639.7 lb (for 36”) (CAEPIPE: 106640 lb)  

Downward stiffness = 25 × 106639.7 / 12.75 
= 209097 lb/in (CAEPIPE: 209098) 
Vertically Upward Direction 
top depth = 96” – 12.75”/2 = 89.625” 
Upward load  =  D × Soil density × top depth  
= 12.75” × (120/1728) × 89.625  
= 79.35547 lb / in  
= 2856.7968 lb (for 36”) (CAEPIPE: 2856.8) 
Upward stiffness  =  25 × 2856.7968 / 12.75  =  5601.56 lb/in (CAEPIPE: 5601.6) 

Verification of cohesive restraints (for pipe element 20 to 30) 
Sp = soil pressure = soil density × depth 
depth = –1’ – (–5’) = 4’ (since the pipe centerline is at -5’ and ground level is at 3’). 
Sp = 150 lb/ft3 × 4 ft = 600 lb / ft2 = 4.16667 lb/in2 



Buried Piping 
 

185 

Axial direction 
Soil strength = Cs = 100 psi = 100 × 6.89476 KN/M2 = 689.476 KN/M2 

Af = Adhesion factor = 1.7012775 e(-0.00833699 Cs) 
= 5.424795E-3 

Axial load = π× D × Af × Cs 
= π×12.75”×5.424795E-3×100 psi 
= 21.72982 lb / in  
= 782.25 lb (for 36”) (CAEPIPE: 782.3)  
Axial stiffness = 25 × 782.25 / 12.75 = 1533.82 lb /in (CAEPIPE: 1533.8 lb/in) 
Transverse direction 
Transverse load = D × (2 Cs + Sp + 1.5 Cs × depth / D) 
= 12.75” × (2.0×100 + 4.166667 + 1.5×100×48/12.75)  
= 9803.125 lb/in  
= 352912.5 lb for 36” (CAEPIPE: 352913)  
Transverse stiffness = 25 × 352912.5 / 12.75  
= 691985.3 lb /in (CAEPIPE: 691985) 
Vertically Downward direction 
bottom depth = 48” + 12.75”/2 = 54.375” 

Downward load = D × (5.7182 Cs + Soil density × bottom depth) 
= 12.75” × (5.7182×100 + (150/1728) × 54.375”)  
= 7350.8857 lb/in  
= 264631.88 lb for 36” (CAEPIPE: 264632) 
Downward stiffness = 25 × 264631.88 / 12.75  
= 518886 lb / in (CAEPIPE: 518886) 
Vertically Upward Direction 
top depth = 48” – 12.75”/2 = 41.625” 

Upward load  =  D × Soil density × top depth + 2 Cs × top depth 
= 12.75” × ((150/1728) × 41.625” + 2×100×41.625”)  
= 8371.069 lb / in 
= 301358.49 lb for 36” (CAEPIPE: 301359)  
Upward stiffness = 25 × 301358.49 / 12.75  
= 590899 lb / in (CAEPIPE: 590899) 
References 
1. Tomlinson, M. J., Pile Design and Construction Practice. Fourth Edition. London: E & 
FN Spon, 1994. 

2. Fleming, W.G.K., et al. Piling Engineering. Second Edition. Blackie Academic and 
Professional. (Chapters 4 and 5).  
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Cold spring (cut short or cut long) is used to reduce thermal forces on equipment connected 
to the piping system. When lengths of pipes are cut short or extended by design, they are 
pulled together or pushed apart to join them during installation, giving rise to a “cold-
sprung” system. 

Such an installation process (cold condition) obviously introduces stresses, which are relieved 
when the system starts up (hot condition).  Note however, that the piping codes do not allow 
credit for stresses since the displacement range is unaffected (similar to self-springing. See 
B31.1 para. 119.2 for details).  But, allowance is made for the support loads due to cold 
spring (which can be helpful at the equipment). 

This feature should be used only with a proper understanding of the implications. 

Cold spring for a straight pipe is input by typing “c” in the Type column or selecting “Cut 
pipe“ from the Element Types dialog. 

 

The Cut pipe dialog is shown. 

 

Select “Cut short” or “Cut long” using the radio buttons. The amount of cut (short or long) 
should be positive. 

Since the piping codes do not allow credit for cold spring in stress calculations, a cold spring 
is used in additional sustained and operating load cases (designated “Cold Spring (W+P), 
Cold Spring (W+P1+T1)” etc.) which are not used in stress calculations but are used for 
support loads and rotating equipment reports. 

Cold Spring load cases appear in the Loads menu (under Load cases) after a cold spring (Cut 
pipe element) is input into the model. The Load cases menu is shown next: 
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For analysis, select the desired Cold Spring load cases from those shown. The Hanger 
selection procedure does not consider the cold spring since the selection is based on the first 
Operating (W+P1+T1) load case. However, if Cold Spring is used, the hanger loads for the 
Cold spring load cases [for example, Cold Spring (W+P1+T1)] will include the effect of the 
Cold spring. 
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Most piping models and projects undergo many changes over their lifeycycle including the 
engineers who work on them. CAEPIPE allows you to document each and every change 
within the model file so that anyone in the future can benefit from your notes, changes and 
their reasons, design decisions, and comments on the piping system modeled in the file. Use 
the Comment feature to write as many notes and comments as required anywhere in the 
CAEPIPE Layout window. They are saved with the model, and can be printed along with 
the layout data. 

Two ways for putting in a comment are:  

1. Simply press “c” first (in the Node column) on an empty row, or  
2. On an empty row, select “Comment” from the Element Types dialog (Ctrl+Shft+T).  

Use menu Edit > Insert (Ctrl+Ins) to insert an empty row between two existing rows of 
data. 

 

 

Rows 11, 12, 15 and 17 are the comment lines (highlighted with a light green background). 
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Pumps, compressors and turbines in CAEPIPE, referred to as rotating equipment, are each 
governed by an industry publication — API (American Petroleum Institute) publishes an 
API 610 for pumps and an API 617 for compressors while NEMA (National Electrical 
Manufacturers Association) publishes the NEMA SM-23 for turbines. These publications 
provide guidelines for evaluating nozzles connected to equipment among other technical 
information including the items relevant to piping stress analysis – criteria for piping design 
and a table of allowable loads. 

Modeling the equipment is straightforward since it is assumed rigid (relative to connected 
piping) and modeled only through its end points (connection nozzles). 

1. In your model, anchor all the nozzles (on the equipment) that need to be included in the 
analysis. 

2. Specify these anchored nodes during the respective equipment definition via Misc. menu 
> Pumps/Compressors/Turbines in the Layout window. 

CAEPIPE does not require you to model all the nozzles nor their connected piping. For 
example, you may model simply one inlet nozzle of a pump with its piping. Or, you may 
model one pump with both nozzles (with no connected piping) and impose external forces 
on them (if you have that data). Further, there is no need to connect the two anchors of the 
equipment with a rigid massless element like required in some archaic methods. 

A compressor (like a turbine or a pump) is input by selecting “Compressors” from the Misc 
menu in the Layout or List window. Upon analysis, an API 617 compressor compliance 
report is produced. See Appendix B (API 617, for Compressors) for related information. 
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Once you see the Compressor List window, double click on an empty row for the 
Compressor dialog and enter the required information. 

 

A short description to identify the compressor may be entered for Description. The nozzle 
nodes must be anchors and the shaft axis must be in the horizontal plane. Some of the 
nozzle nodes may be left blank if they are not considered as a part of the piping system being 
analyzed (e.g., extraction nodes). 
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If you have input multiple temperatures, corresponding reports for additional operating load 
cases will be shown.
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A concentrated mass is input by typing “conc” in the Data column or selecting “Conc. 
Mass” from the Data Types dialog. 

 

The Concentrated Mass dialog is shown. 

 

The weight of the concentrated mass should be input for Weight. The concentrated mass is 
located at the offset (DX, DY, DZ) from the node. Deadweight, seismic and dynamic loads 
due to concentrated masses are applied to the model. 
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A constant support hanger exerts a constant vertical supporting force on the piping. The 
constant support load is automatically calculated by CAEPIPE. To analyze an existing 
constant support with a known load, input it as a user hanger with a zero spring rate. 

A constant support is input by typing “cons” in the Data column or selecting “Constant 
Support” from the Data Types dialog. 

 

The Constant Support dialog is shown. 

 

Number of Hangers 

The number of hangers is the number of separate hangers connected in parallel at this node. 

Connected to Node 

By default the hanger is connected to a fixed ground point which is not a part of the piping 
system. A hanger can be connected to another node in the piping system by entering the 
node number in the “Connected to node” field. This node must be directly above or below 
the hanger node. 
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Items such as anchors, hangers and external forces, which are defined at nodes, are input in 
the Data column as Data types; different from inline elements such as pipes, bends and 
valves that connect nodes, and are input in the Type column as Element types. 

The Data items can be selected from the Data Types dialog which is opened when you click 
on the Data header in the Layout window. 

 

You may also use the command: Misc > Data types, 

 

or press Ctrl+Shift+D to open the Data Types dialog. 

 

You can select the data type by clicking on the radio button or pressing the underlined letter 
of the item, e.g., press “f” for Flange, Force or Force spectrum load. Or, you may simply 
start typing the first few letters of the item in the Data column.  (For example, typing “fo” 
automatically opens a Force data type dialog). 
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Direction is required for several items such as Pump, Compressor, Turbine, Nozzle (for 
vessel axis), Limit Stop, Skewed restraint, Elastic element and Hinge joint. 

The axis or the orientation of an item (listed above), is called the direction vector which is 
described in terms of the vector’s global X, Y and Z components. 

The angles the vector makes with the X, Y and Z axes are called Direction angles, whose 
cosines are called Direction cosines (or global X, Y and Z components used in CAEPIPE). 

There are two methods of computing the X, Y and Z components. 

First method: When you know the direction angles (see examples 1, 2 and 3). 

Second method: When you know the coordinates of the end points of the vector (see 
example 4). 

Example 1: Vertical Vessel 

Assume a vertical vessel with axis in the Y direction, and α, β, γ as the direction angles the 
axis of the vessel makes with global X, Y and Z axes. 

The angles are α = 90° , β = 0° (since axis is parallel to Y axis) and γ = 90° . 

So, the direction cosines or X, Y and Z components are 

X comp = cos (α = 90° ) = 0, 
Y comp = cos (β = 0° ) = 1, 
Z comp = cos (γ = 90° ) = 0. 

For Z vertical: X comp = 0, Y comp = 0 and Z comp = 1. 

Example 2: Limit Stop at 45° from the X-axis in the X-Y plane 

For a limit stop whose axis is oriented at 45° from the X-axis in the X-Y plane, the angles are 
α = 45°, β = 45° and γ = 90°. 

So, the direction cosines or X, Y and Z components are 

X comp = cos (α = 45° ) = 0.70711, 
Y comp = cos (β = 45° ) = 0.70711, 
Z comp = cos (γ = 90° ) = 0.0 
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Example 3: Hinge axis at 30° from the Z-axis in the Y-Z plane 

 

From the above figure, we have the angles α = 90°, β = 60° and γ = 30°.  Assuming L = 1 
(or any length), the direction cosines or X, Y and Z components are 

X comp = cos (α = 90° ) = 0.0, 
Y comp = cos (β = 60° ) = 0.5, 
Z comp = cos (γ = 30° ) = 0.866 

Example 4: Skewed Support 

 

Assume that we have a skewed support along P1P2 (which is the direction vector) shown in 
the figure above, Assume that the coordinates of these two points are P1 = (12’,12’,12’) and 
P2 =(15’,16’,14’). 

Let us calculate this vector’s global X, Y and Z components. There are two methods here 
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Short method 

X comp = (X2 − X1) = (15 − 12) = 3  
Y comp = (Y2 − Y1) = (16 − 12) = 4 
Z comp = (Z2 − Z1) = (14 − 12) = 2 

Long method 

First, let us calculate the length of the vector, L. 

𝐿𝐿 = �(X2 − 𝑋𝑋1)2 + (Y2 − 𝑌𝑌1)2 + (Z2 − 𝑍𝑍1)2 = 5.385′ 

The angles α, β and γ which the vector makes with the global X, Y and Z axes are called the 
Direction angles of the vector; The cosines of these angles are called Direction cosines. 

cos𝛼𝛼 =  
X2 −  X1

𝐿𝐿
,  cos𝛽𝛽 =  

Y2 −  𝑌𝑌1

𝐿𝐿
,  cos 𝛾𝛾 =  

Z2 −  𝑍𝑍1

𝐿𝐿
, 

The direction cosines are 

X comp = cos α = 0.55709, Y comp = cos β = 0.74278, Z comp = cos γ = 0.37139 

For information, the direction angles are α = 56° 8”, β = 42° 1” and γ = 68° 11”. 

To verify the results, the sum of the squares of the direction cosines must be 1.0. Thus,  

cos2α + cos2β + cos2γ = 0.5570922 + 0.7427822 + 0.3713922 = 1.0 
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Modal Analysis 

The equations of motion for an undamped lumped mass system may be written as:   

[𝑀𝑀]{�̈�𝑃}  +  [𝐾𝐾]{𝑃𝑃} = {𝐹𝐹(𝑑𝑑)} 
Where [𝑀𝑀]= diagonal mass matrix 

 {𝑃𝑃} = displacement vector 
 {�̈�𝑃} = acceleration vector 
 [𝐾𝐾] = stiffness matrix 
 {𝐹𝐹(𝑑𝑑)} = applied dynamic force vector 

If the system is vibrating in a normal mode (i.e., free not forced vibration), we may make the 
substitutions 
 
 {𝑃𝑃} =  {𝑎𝑎𝑑𝑑} sin𝜔𝜔𝑑𝑑𝑑𝑑 
 {�̈�𝑃} =  −𝜔𝜔𝑑𝑑2{𝑎𝑎𝑑𝑑} sin𝜔𝜔𝑑𝑑𝑑𝑑 
 {𝐹𝐹(𝑑𝑑)} = 0 

to obtain 

−𝜔𝜔𝑑𝑑2[𝑀𝑀]{𝑎𝑎𝑑𝑑} + [𝐾𝐾]{𝑎𝑎𝑑𝑑} = 0 
or 

[𝐾𝐾]{𝑎𝑎𝑑𝑑} = 𝜔𝜔𝑑𝑑2[𝑀𝑀]{𝑎𝑎𝑑𝑑} 

where {𝑎𝑎𝑑𝑑} is the vector of modal displacements of the n𝑑𝑑ℎ  mode (eigenvector). 

Thus we have an eigenvalue (characteristic value) problem, and the roots of equation (2) are 
the eigenvalues (characteristic numbers), which are equal to the squares of the natural 
frequencies of the modes. 

In CAEPIPE, the eigenvalue problem is solved using a determinant search technique. The 
solution algorithm combines triangular factorization and vector inverse iteration in an 
optimum manner to calculate the required eigenvalues and eigenvectors. These are obtained 
in sequence starting from the lowest eigenpair 𝜔𝜔1

2,{𝑎𝑎1}. An efficient accelerated secant 
procedure which operates on the characteristic polynomial 

𝑝𝑝(𝜔𝜔2) = 𝑑𝑑𝑃𝑃𝑑𝑑([𝐾𝐾] − 𝜔𝜔2[𝑀𝑀]) 

is used to obtain a shift near the next unknown eigenvalue. The eigenvalue separation 
theorem (Sturm sequence property) is used in this iteration. Each determinant evaluation 
requires a triangular factorization of the matrix [𝐾𝐾] − 𝜔𝜔2[𝑀𝑀]. Once a shift near the 
unknown eigenvalue has been obtained, inverse iteration is used to calculate the eigenvector. 
The eigenvalue is obtained by adding the Rayleigh quotient correction to the shift value. The 
eigenvector {𝑎𝑎𝑑𝑑}, has an arbitrary magnitude and represents the characteristic shape of that 
mode. 

(1) 

(2) 
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Orthogonality 

For any two roots corresponding to the nth  and mth modes, we may write equation (2) as 
which is the orthogonality condition for eigenvectors. 

[𝐾𝐾]{𝑎𝑎𝑑𝑑} = 𝜔𝜔𝑑𝑑2[𝑀𝑀]{𝑎𝑎𝑑𝑑} 
[𝐾𝐾]{𝑎𝑎𝑚𝑚 } = 𝜔𝜔𝑚𝑚2 [𝑀𝑀]{𝑎𝑎𝑚𝑚 } 

If we postmultiply the transpose of (3) by {𝑎𝑎𝑚𝑚 }, we obtain 

([𝐾𝐾]{𝑎𝑎𝑑𝑑})𝑇𝑇{𝑎𝑎𝑚𝑚} = (𝜔𝜔𝑑𝑑
2[𝑀𝑀]{𝑎𝑎𝑑𝑑})𝑇𝑇{𝑎𝑎𝑚𝑚} 

{𝑎𝑎𝑑𝑑}𝑇𝑇[𝐾𝐾]𝑇𝑇{𝑎𝑎𝑚𝑚 } = 𝜔𝜔𝑑𝑑2{𝑎𝑎𝑑𝑑}𝑇𝑇[𝑀𝑀]𝑇𝑇{𝑎𝑎𝑚𝑚 } 

Premultiplying (4) by {𝑎𝑎𝑑𝑑}𝑇𝑇 , {𝑎𝑎𝑑𝑑}𝑇𝑇[𝐾𝐾]{𝑎𝑎𝑚𝑚 } = 𝜔𝜔𝑚𝑚2 {𝑎𝑎𝑑𝑑}𝑇𝑇[𝑀𝑀]{𝑎𝑎𝑚𝑚 } 

Since [𝑀𝑀] is a diagonal matrix, [𝑀𝑀] = [𝑀𝑀]𝑇𝑇 .  Also, since [𝐾𝐾] is a symmetric matrix, [𝐾𝐾] =
[𝐾𝐾]𝑇𝑇 . The left sides of equations (5) and (6) are therefore equal. 

Subtracting (6) from (5), 
(𝜔𝜔𝑑𝑑2 − 𝜔𝜔𝑚𝑚2 ){𝑎𝑎𝑑𝑑}𝑇𝑇[𝑀𝑀]{𝑎𝑎𝑚𝑚 } = 0 

Since 𝜔𝜔𝑑𝑑 ≠ 𝜔𝜔𝑚𝑚 , 
{𝑎𝑎𝑑𝑑}𝑇𝑇[𝑀𝑀]{𝑎𝑎𝑚𝑚 } = 0 

which is the orthogonality condition for eigenvectors.  

Modal Equations 

Since the eigenvectors (modal displacements) may be given any amplitude, it is convenient to 
replace {𝑎𝑎𝑑𝑑} by {∅𝑑𝑑} such that 

{∅𝑑𝑑}𝑇𝑇[𝑀𝑀]{∅𝑑𝑑} = 1 
The eigenvectors are evaluated so as to satisfy equation (9) and at the same time keep the 
displacements in the same proportion as those in {𝑎𝑎𝑑𝑑}. The eigenvectors are then said to be 
normalized. Note that equation (7) is still satisfied since, if n = m,𝜔𝜔𝑑𝑑2 − 𝜔𝜔𝑚𝑚2 = 0, and the 
remaining terms may be given any desired value. 

Equation (2) now may be written for the nth mode as 
[𝐾𝐾]{∅𝑑𝑑} = 𝜔𝜔𝑑𝑑2[𝑀𝑀]{∅𝑑𝑑} 

Let [Φ]be a square matrix containing all normalized eigenvectors such that the nth column is 
the normalized eigenvector for the nth mode. We can therefore write the matrix equation so 
as to include all modes as follows: 

[𝐾𝐾]{Φ} = [𝑀𝑀][Φ][𝜔𝜔𝑑𝑑2] 
Where [𝜔𝜔𝑑𝑑2] is a diagonal matrix of eigenvalues. We now premultiply both sides of (10) by 
[Φ]Tto obtain 

[𝛷𝛷]𝑇𝑇[𝐾𝐾][𝛷𝛷] = [𝛷𝛷]𝑇𝑇[𝑀𝑀][𝛷𝛷][𝜔𝜔𝑑𝑑2] 

(4) 
(3) 

(5) or 

(6) 

(7) 

(8) 

(9) 

(10) 

(11) 
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It may be shown that 
[𝛷𝛷]𝑇𝑇[𝑀𝑀][𝛷𝛷] = [𝐼𝐼] 

Where 𝐼𝐼is the unit diagonal matrix. equation (12) can easily be verified by expansion and 
follows from the orthogonality condition and the fact that [Φ] has been normalized. 
equation (11) therefore can be written as 

[𝛷𝛷]𝑇𝑇[𝐾𝐾][𝛷𝛷] = [𝜔𝜔𝑑𝑑2] 

Returning now to the equation of motion (1), 

let {𝑃𝑃} = [𝛷𝛷]{𝐴𝐴𝑑𝑑} 

         and {�̈�𝑃} = [𝛷𝛷]��̈�𝐴𝑑𝑑� 

Where {𝐴𝐴𝑑𝑑} is the modal amplitude of the nth mode. This merely states that the true 
modal displacements equal the characteristic displacements (eigenvector displacements) 
times the modal amplitude determined by the response calculations and, further that the total 
displacements are linear combinations of the modal values. If we now premultiply equation 
(1) by [Φ]Tand substitute equations (14), we obtain 

[𝛷𝛷]𝑇𝑇[𝑀𝑀][𝛷𝛷]��̈�𝐴𝑑𝑑� + [𝛷𝛷]𝑇𝑇[𝐾𝐾][𝛷𝛷]{𝐴𝐴𝑑𝑑} = [𝛷𝛷]𝑇𝑇{𝐹𝐹(𝑑𝑑)} 

Substituting from equations (12) and (13) in equation (15), 

��̈�𝐴𝑑𝑑� + [𝜔𝜔𝑑𝑑2]{𝐴𝐴𝑑𝑑} = [Φ]T{𝐹𝐹(𝑑𝑑)} 

which represents the modal equations of motion. 

Support Motion 

Solutions for support motion may be obtained if {𝐹𝐹(𝑑𝑑)}is replaced by−�̈�𝑃𝑃𝑃(𝑑𝑑){𝑀𝑀}where 
�̈�𝑃𝑃𝑃(𝑑𝑑)is the prescribed support acceleration. Thus the modal equations of motion may be 
written as 

��̈�𝐴𝑑𝑑� + [𝜔𝜔𝑑𝑑2]{𝐴𝐴𝑑𝑑} = −�̈�𝑃𝑃𝑃(𝑑𝑑)[Φ]T{𝑀𝑀} 

Where 𝐴𝐴𝑑𝑑 is the relative modal displacement for the nth mode with respect to the support. 

The participation factors for the modes are given by 

{Γ𝑑𝑑} = [Φ]T{𝑀𝑀} 

Then the modal amplitude for the nth mode is given by 

𝐴𝐴𝑑𝑑 = Γ𝑑𝑑𝑃𝑃𝑑𝑑0  

where 𝑃𝑃𝑑𝑑0  is the response of a single degree of freedom system having circular frequency𝜔𝜔𝑑𝑑 . 
Using equations (14) and (19), the displacements are given by 

{𝑃𝑃} = [Φ]{𝐴𝐴𝑑𝑑} = [Φ]{Γ𝑑𝑑𝑃𝑃𝑑𝑑0} 

(12) 

(13) 

(14) 

(15) 

(16) 

(17) 

(18) 

(19) 

(20) 
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Effective Modal Mass 

Effective modal mass is defined as the part of the total mass responding to the dynamic 
loading in each mode. When the participation factor is calculated using normalized 
eigenvectors as in equation (18), the effective modal mass for the nth mode is simply the 
square of the normalized participation factor, 

𝑀𝑀𝑑𝑑 = Γn
2 

Effective modal mass is useful to verify if all the significant modes of vibration are included 
in the dynamic analysis by comparing the total effective modal mass with the total actual 
mass. 

Response Spectrum 

The concept of response spectrum, in recent years has gained wide acceptance in structural 
dynamics analysis, particularly in seismic design. Stated briefly, the response spectrum is a 
plot of the maximum response (maximum displacement, velocity, acceleration or any other 
quantity of interest), to a specified loading for all possible single degree-of-freedom systems. 
The abscissa of the spectrum is the natural frequency (or period) of the system, and the 
ordinate, the maximum response. 

In general, response spectra are prepared by calculating the response to a specified excitation 
of single degree-of-freedom systems with various amounts of damping. Numerical 
integration with short time steps is used to calculate the response of the system. The step-by-
step process is continued until the total earthquake record is completed and becomes the 
response of the system to that excitation. Changing the parameters of the system to change 
the natural frequency, the process is repeated and a new maximum response is recorded. 
This process is repeated until all frequencies of interest have been covered and the results 
plotted. Typically the El Centro, California earthquake of 1940 is used for this purpose. 

Since the response spectra give only maximum response, only the maximum values for each 
mode are calculated and then superimposed (modal combination) to give total response. A 
conservative upper bound for the total response may be obtained by adding the absolute 
values of the maximum modal components (absolute sum). However this is excessively 
conservative and a more probable value of the maximum response is the square root of the 
sum of squares (SRSS) of the modal maxima. 

To calculate response of the piping system, for each natural frequency of the piping system, 
the input spectrum is interpolated (linearly or logarithmically). The interpolated spectrum 
values are then combined for the X, Y and Z directions (direction sum) either as absolute 
sum or SRSS sum to give the maximum response of a single degree-of-freedom system:  
𝑃𝑃max

0 at that frequency. 

From equation (20), the maximum displacement vector for the nth mode can be calculated 
from the maximum response of a single degree-of-freedom system, 

{𝑃𝑃𝑑𝑑}𝑚𝑚𝑎𝑎𝑚𝑚 = {ϕn}Γn𝑃𝑃𝑑𝑑  𝑚𝑚𝑎𝑎𝑚𝑚
0  

The maximum values of element and support load forces per mode are calculated from the 
maximum displacements calculated per mode as above using the stiffness properties of the 
structure. 
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The total response (displacements and forces) is calculated by superimposing the modal 
responses according to the specified mode sum method which can be absolute sum, square 
root of sum of squares (SRSS) or closely spaced (10%) modes method. 

Closely Spaced Modes 

Studies have shown that SRSS procedure for combining modes can significantly 
underestimate the true response in certain cases in which some of the natural frequencies of 
a structural system are closely spaced. The ten percent method is one of NRC approved 
methods (Based on NRC Guide 1.92) for addressing this problem. 

𝑅𝑅 = ��𝑅𝑅𝑑𝑑2
𝑁𝑁

𝑑𝑑=1

+ 2��𝑅𝑅𝑑𝑑𝑅𝑅𝑗𝑗 � 

where 𝑅𝑅 = Total (combined) response 
 𝑅𝑅𝑑𝑑  = Peak value of the response due to the nth mode 
 𝑁𝑁 = Number of significant modes 

The second summation is to be done on all i and j modes whose frequencies are closely 
spaced to each other. Let 𝜔𝜔𝑑𝑑and 𝜔𝜔𝑗𝑗be the frequencies of the ith and jth modes. The modes are 
closely spaced if: 

𝜔𝜔𝑗𝑗 −  𝜔𝜔𝑑𝑑

𝜔𝜔𝑑𝑑
≤ 0.1  and 1 ≤ 𝑑𝑑 ≤ 𝑗𝑗 ≤ 𝑁𝑁 

Time History 

Time history analysis requires the solution to the equations 

[𝑀𝑀]{�̈�𝑃} + [𝐶𝐶]{�̇�𝑃} + [𝐾𝐾]{𝑃𝑃} = {𝐹𝐹(𝑑𝑑)} 

where [𝑀𝑀] = diagonal mass matrix 

 [𝐶𝐶] = damping matrix 

 [𝐾𝐾] = stiffness matrix 

 {𝑃𝑃} = displacement vector 

 {�̇�𝑃} = velocity vector 

 {�̈�𝑃} = acceleration vector 

 {𝐹𝐹(𝑑𝑑)} = applied dynamic force vector 

(21) 
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The time history analysis is carried out using mode superposition method. It is assumed that 
the structural response can be described adequately by the p lowest vibration modes out of 
the total possible n vibration modes and p < n. Using the transformation𝑃𝑃 = Φ𝑋𝑋, where the 
columns in Φ are the p mass normalized eigenvectors, equation (21) can be written as 

�̈�𝑋 + ∆�̇�𝑋 + Ω2X = Φ𝑇𝑇𝐹𝐹 

Where ∆ = diag (2𝜔𝜔𝑑𝑑𝜉𝜉𝑑𝑑) 
 Ω2 = diag (𝜔𝜔𝑑𝑑

2) 

In equation (22), it is assumed that the damping matrix [𝐶𝐶]satisfies the modal 
orthogonalitycondition 

{𝜙𝜙𝑑𝑑}𝑇𝑇[𝐶𝐶]�𝜙𝜙𝑗𝑗 � = 0     (𝑑𝑑 ≠ 𝑗𝑗) 

Equation (22) therefore represents p uncoupled second order differential equations. These 
are solved using the Wilson 𝜃𝜃 method, which is an unconditionally stable step-by-step 
integration scheme. The same time step is used in the integration of all equations to simplify 
the calculations. 

Harmonic Analysis 

A harmonic analysis is performed to analyze the response to sinusoidal loads. Harmonic 
forces can arise from unbalanced rotating equipment, acoustic vibrations caused by 
reciprocating equipment, flow impedance, and other sources. These forces can be damaging 
to a piping system if their frequency is close to the system’s natural frequency, thereby 
introducing resonant conditions. The equation of dynamic equilibrium associated with the 
response of the structure subjected to harmonic forces is: 

[𝑀𝑀]{�̈�𝑃} + [𝐶𝐶]{�̇�𝑃} + [𝐾𝐾]{𝑃𝑃} = sin(𝜔𝜔𝑑𝑑)𝐹𝐹 

where [𝑀𝑀] = diagonal mass matrix 

 [𝐶𝐶] = damping matrix 

 [𝐾𝐾] = stiffness matrix 

 {𝑃𝑃} = displacement vector 

 {�̇�𝑃} = velocity vector 

 {�̈�𝑃} = acceleration vector 

 𝜔𝜔 = frequency of the applied force 

 𝑑𝑑 = time 

 𝐹𝐹 = maximum magnitude of the applied force 

More complex forms of vibration, such as those caused by the fluid flow, may be considered 
as superposition of several simple harmonics, each with its own frequency, magnitude, and 
phase. 

A harmonic analysis uses the results from the modal analysis to obtain a solution. A single 
damping factor is used for all modes. 

(22) 

(23) 
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First, the maximum response of each harmonic is obtained separately. Then the total 
response of the system is determined by combining the individual responses. The 
combination method may be specified as the Root Mean Square (RMS) or Absolute Sum. 
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Dynamic Susceptibility feature is a screening tool for potentially large alternating stresses. 
The dynamic stresses are the dynamic bending stresses associated with vibration in a natural 
mode. In other words, the modal analysis result has been generalized to include the 
alternating bending stresses associated with the vibration in a natural mode. The dynamic 
susceptibility for any mode is the ratio of the maximum alternating bending stress to the 
maximum vibration velocity. This “susceptibility ratio” provides an indicator of the 
susceptibility of the system to large dynamic stresses. Also, the associated animated mode 
shapes include color-spot-markers identifying the respective locations of maximum vibration 
and maximum dynamic bending stress. The susceptibility ratio and the graphics feature 
provide incisive insights into the reasons for high susceptibility and how to make 
improvements. 

The “Modal Analysis” output load case in CAEPIPE has been enhanced. In addition to the 
modal frequencies and mode shapes, you will see two new results items called “dynamic 
stresses” and “dynamic susceptibility.” 

In case you do not see these two items in the results dialog, you need to activate this feature 
by defining an environment variable. See Appendix E for a detailed discussion. 

First method: 

An environment variable “HARTLEN” needs to be declared under My Computer > 
Properties > Environment > Variable (HARTLEN), and its Value set to (YES). Please check 
with your System Admin because different versions of Windows have slightly different 
methods of doing it. 
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Second method:  

Open the MS-DOS Command Prompt. Type “SET HARTLEN=YES” (enter), change 
directory (using CD command) to where CAEPIPE program files are located, start 
CAEPIPE.EXE. 

Upon (modal) analysis, the Results dialog will display the required results (dynamic stresses 
and dynamic susceptibility). 

 

 



Elastic Element 
 

207 

The elastic element is a general 6 × 6 stiffness matrix, with nonzero diagonal terms and zero 
off-diagonal terms. Use this element to model the stiffness of a component unavailable in 
CAEPIPE. 

An elastic element is input by typing “e” in the Type column or selecting “Elastic element” 
from the Element Types dialog. 

 

The Elastic element dialog is shown. 

 

The stiffnesses are in the local coordinate system defined by the directions of the local x-, y- 
and z-axes. The local y-axis should be perpendicular to the local x-axis (i.e., their dot product 
should be zero). The local z-axis is internally calculated as cross product of the local x- and y-
axes. 

The elastic element is not subjected to any sustained or thermal expansion loads. 

See Slotted Hinge joint example under Expansion Joints topic. 
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CAEPIPE provides the following types of expansion joints: 

1. Ball joint, 
2. Bellows, 
3. Hinge joint and 
4. Slip joint  
Using these types, you can also model tied bellows, a gimbal, a dual gimbal, a pressure-
balanced elbow and a tee, a slotted hinge joint and a universal joint among other complex 
arrangements. 

Before selecting the types of and locations for the expansion joints, you must study a piping 
system for the direction and magnitude of the thermal movements to be absorbed, 
availability of support structures for anchoring, and guiding of the piping. EJMA and 
manufacturer catalogs contain technical information that can guide you through this process. 
CAEPIPE becomes an ideal “what-if” tool for such rapid studies. 

This topic will show how to model the following types of joints: Tied bellows, universal, 
gimbal, dual gimbal, pressure balanced joints and a slotted hinge joint. Also see discussion on 
Bellows. 

Tied Bellows: 

Tie rods around bellows allow lateral deflection and absorb the full pressure thrust force in 
the event of an anchor failure. During normal operation, the adjacent equipment will see the 
pressure thrust force. Pressure thrust area must be input. One way of modeling the tie rods is 
to lump all four tie rods into a single limit stop (with limit stop stiffness = 4 x stiffness of tie 
rod = 4 x EA/L) at the center of the bellows. The reason for modeling the four tie rods as a 
single limit stop is that these rods act only in tension and not in compression. Simpler tie rod 
element could also be used. See last example in this section. 
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An elaborate method of modeling the above is to create four limit stops (instead of one) 
placed at their actual locations with rigid elements. As noted before, instead of using Limit 
stops, you could also use the simpler tie rod element(s). See next example. 
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The limit stops at nodes 21 (shown below), 22, 23 and 24 should be modeled thus. 

 

 

Universal joint: 

This joint is composed of two single bellows with a center spool, with tie rods (90° apart) 
across the whole assembly (end to end). This is commonly used in multi-plane Z bend 
configurations to absorb large lateral deflections. Axial growth in the vertical leg (that 
contains the joint) will introduce bending in the horizontal legs which may require other 
supports. 
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The amount of lateral deflection can be increased by increasing the length of the center pipe 
section or the spool piece.  The angulation or bending of the bellows can be controlled by 
the number of tie rods around the joint. See a manufacturer’s catalog for details. 

If a joint comes with no tie rods, then the thermal movement of the piping must be properly 
guided so as to have the joint behave as expected. 

As mentioned in the earlier example, you can use tie rod elements instead of limit stops. 

 

Limit stops are modeled as before. 
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Gimbal, Dual Gimbal Joints: 

These allow angular motion in all planes and resist axial and pressure thrust forces. These are 
modeled in CAEPIPE as two back to back hinge joints with perpendicular axes. The 
minimum distance between the adjacent gimbal joints is a function of the required angular 
and rotational deformation. The 4” shown in the next two examples is only for graphical 
depiction, and not representative of any functional requirement. 

A gimbal joint example follows. 
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A Dual gimbal joint example follows: 
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Pressure-balanced Elbows and Tees: 

These joints are used to absorb small amounts of axial and lateral movement at a change in 
direction while restraining the pressure thrust by means of tie rods. It is often used to reduce 
the pressure thrust forces coming on nearby equipment (rotating) whose allowable nozzle 
loads necessitate elimination of pressure thrust forces. You can use tie rods instead of limit 
stops. Two examples follow - a pressure-balanced tee followed by a pressure-balanced elbow.
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Pressure-balanced Tee: 

 

Limit stops are modeled as before.  
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Pressure-balanced Elbow: 

A pressure-balanced elbow absorbs axial and lateral movements at a change in direction 
while it restrains the axial pressure thrust on nearby (rotating) equipment. 

The joint comprises of two bellows, one on either side of the elbow. Flow bellows, as the 
name suggests, is on the flow side, while the balancing bellows extends from the elbow out, 
subject to the same line pressure, secured to the flow bellows by tie rods. The balancing 
bellows expands by the same amount that the flow bellows compresses (because of the tie 
rod arrangement), with no volume change thus keeping the pressure forces in balance; hence 
the name pressure-balanced elbow. 

To allow a larger lateral movement, one should use a pressure-balanced universal expansion 
joint. The difference here is that there are two bellows on the flow side instead of one, with 
still one balancing bellows. 

Modeling either of these joints is simple once you become aware of the above information. 
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A few points to note: 

1. The Bend node (35) is NOT on the pipe element 30-40. Notice the rows in the layout 
window. The bellows modeling is from nodes 20-30-40-50. Bend modeling starts on row 
7 “From” 30-35-135. 

2. Depending on how precise you want to be in your modeling of the tie rods, you have 
three choices: 

a) Simply input one tie rod from 20-50. Input the combined stiffnesses of all the tie 
rods around the bellows, or 
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b) As shown in the model graphics, use massless rigid elements to model the offsets 
(such as from 20-21, 20-24 etc.) on both sides of the joint, and tie corresponding 
nodes with Limit stops. Note that a limit stop takes only one stiffness input for 
both in tension and in compression, or 

c) Replace limit stops in item b. with tie rods. A tie rod allows stiffness inputs for 
tension and compression, allowing for more flexibility in input. Note that 
CAEPIPE does not require Section and Material input for tie rods. 

Slotted Hinge joint: 

In CAEPIPE, this joint is modeled using an elastic element, a limit stop and a hinge joint. 
The limit stop models the slot (+ and – 1 inch, for example) thereby allowing for limited 
axial travel. The elastic element has very low axial stiffness and all other stiffnesses rigid to 
model the slot. The hinge provides rotational stiffness about the Z axis. Due to the slots, 
these joints will not resist any pressure thrust forces thereby necessitating anchoring. 
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Modeling Tie Rods: 

A tie rod’s chief function is to restrain the axial pressure thrust at an expansion joint (e.g., 
bellows). A tie rod between the ends of an expansion joint could be modeled to allow for 
axial compression but prevent axial expansion due to pressure thrust. To create this effect, 
you would need to model a tie rod and enter pressure thrust area for the bellows expansion 
joint.  

For a tie rod, enter stiffnesses in tension and compression. To prevent the expansion joint 
from going into tension, input a Rigid stiffness (1E12 lb/in) for the Tension Stiffness field. 
Leave the Compression Stiffness blank if you want to allow the expansion joint to freely 
compress. Instead of making the Tension stiffness rigid, you could calculate the total 
stiffness of all the rods and enter it for Tension Stiffness, too. 

In some cases, the expansion joint may extend or contract a specific amount before it stops 
completely. To model this behavior, i.e., if you want to prevent the expansion joint from 
extending or contracting freely in a direction, input a gap in that direction and a 
corresponding stiffness. 

How to model: 

A tie rod is modeled between the same nodes as the expansion joint is. Next, go to a new 
row, type in the starting node number of the joint, specify “From” under “Type” followed 
by Enter. On the next new row, type the other node number of the joint, followed by “Tie 
Rod” under “Type”. There is no need to input the offsets (DX, DY or DZ) as CAEPIPE 
already has the coordinates of these nodes from the previous expansion joint definition. 
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FRP piping has gained wide acceptance in many industries due to its lightweight nature, 
superior corrosion resistance, temperature capabilities and mechanical strength. Several 
manufacturers produce different types of FRP pipes and fittings and provide technical 
assistance to their customers on 

 design matters through installation. You can model FRP materials in CAEPIPE and have it 
calculate deflections, forces, moments and stresses.  

To define the FRP material, click on “Matl” in the header row in the Layout window. 

 

In the Material List window that is shown, double click on an empty row to input a new 
material or on a material description to edit the material properties. 

 

The Material dialog will be shown. 
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The material name can be up to three alpha-numeric characters. Enter description and 
density. You need to select “FR: Fiber Reinf. Plastic (FRP)” from the Type drop-down 
combo box before you click on the Properties button. The Poisson’s ratio (Nu) is the ratio 
of the strain in the axial direction resulting from the stress in the hoop direction. 

When you click on the Properties button, you are shown the table below where you enter 
temperature-dependent properties.  Additionally, you can define the Axial and Torsional 
allowable stresses so that CAEPIPE can use them to compare with calculated stresses under 
the FRP "Sorted Stresses” results. 

 

FRP Material Moduli 

CAEPIPE requires three moduli for an FRP material: 

 

• Axial or Longitudinal (this is the most important one)  
• Hoop (used in Bourdon effect calculations). If this modulus is not available, use axial 

modulus.  
• Shear or Torsional. If this modulus is not available, use engineering judgment in putting 

1/2 of axial modulus or a similar value. Note that a high modulus will result in high 
stresses, and a low modulus will result in high deflections. 

For FRP bends, a Flexibility factor of 1.0 is used unless you override it by specifying a 
Flexibility factor inside the bend dialog. Also for FRP bends, CAEPIPE uses a default SIF of 
2.3. You can override this too by specifying User-SIFs at the bend end nodes (A and B 
nodes). 

Stiffness matrix 

The stiffness matrix for an FRP material is formulated in the following manner: 

The stiffness matrix for a pipe is calculated using the following terms: 

Axial term = L / EA 
Shear term = shape factor x L / GA 
Bending term = L / EI 
Torsion term = L / 2GI 

where L = length, A = area, I = moment of inertia 
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E = Elastic modulus, G = shear modulus 
 
For an isotropic material, 
G = E / 2(1 + 𝜈𝜈) 
where 𝜈𝜈 = Poisson’s ratio, 

For an FRP material, however, 
E = axial modulus and G is independently specified (i.e., it is not calculated using E and 𝜈𝜈). 

The hoop modulus and FRP Poisson’s ratio are only used in Bourdon effect calculation 
where, 
Poisson’s ratio used = FRP Poisson’s ratio input x axial modulus / hoop modulus 

Results 

CAEPIPE calculates deflections, forces, moments and stresses. Each item can be seen under 
the respective title in Results. FRP element stresses can be seen, sorted or unsorted. These 
different stresses are computed as per formulas given towards the end of Appendix A. 
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Axial and Torsional allowables may be entered under material properties so that they can be 
used to compare against calculated stresses in “FRP Sorted Stresses.” Forces, Stresses and 
Sorted stresses for FRP piping may be printed to a .CSV file (spreadsheet-compatible). 

CAEPIPE renders FRP piping in golden color. 
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Flanges are used to stiffen the ends of pipes/valves/bends/etc. and act as connections to 
adjacent elements. ASME B16.5 is a standard in the USA to which flange manufacturers 
produce flanges for ½” to 23” NPS (nominal pipe size), while the B16.47 standard is used 
for 26” to 60” NPS. These are classified according to (pressure) classes, flanges in which are 
further classified according to materials with different pressures and temperatures. 

 
A flange is input by typing “fl” in the Data column or selecting “Flange” from the Data 
Types dialog. If flanges are located at the bend end nodes (A, B nodes), or jacketed bend 
nodes (C, D nodes), the bend flexibility and SIF are modified. 

 

The Flange dialog is shown. 

 

Several flange types are available – weld neck, socket welded, threaded, lap joint, etc. Use the 
Type drop-down combo box to select one. 

Gasket
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Weight 

The weight you provide should be the total weight of flanges, i.e., if there are two flanges the 
weight should be the weight of two flanges. 

Gasket Diameter 

The gasket diameter is used in calculating equivalent flange pressure in the flange report. 

Allowable Pressure 

CAEPIPE provides an approximation for the tendency of a flange to leak by calculating an 
“equivalent flange pressure” and comparing it to the (user-input) allowable pressure for the 
flange in the flange report. Often, the allowable pressure may be conservatively set to the 
flange rating. The allowable pressure can come from B16.5 (or a similar standard) for the 
flange class, material, pressure and temperature.  

Flange Library 

You may access the flange library by clicking on the Library button of the flange dialog. The 
default weight in the Flange Library is for two Flanges.  However, each library dialog has an 
option to include weight for a single flange.  See checkbox in the Flange library dialog below 
to include weight for a single flange. 
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ANSI Library  

 

European Library 

 

The default weight in the library is the weight of two weld neck flanges (including bolts). 

Flange Report 
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CAEPIPE lists every flange in a model in the flange report. The “Flange Pressure” is an 
equivalent pressure calculated from the actual pressure in the piping element, the bending 
moment and the axial force on the flange from the first operating case (W+P1+T1), as 
follows: 

𝐹𝐹𝑑𝑑𝑎𝑎𝑑𝑑𝐹𝐹𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 = 𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 +
16 × 𝐵𝐵𝑃𝑃𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝐹𝐹𝑀𝑀𝑑𝑑𝑚𝑚𝑃𝑃𝑑𝑑𝑑𝑑

𝜋𝜋 × 𝐺𝐺𝑎𝑎𝑃𝑃𝐺𝐺𝑃𝑃𝑑𝑑𝑑𝑑𝑑𝑑𝑎𝑎3 +
4 × 𝐴𝐴𝑚𝑚𝑑𝑑𝑎𝑎𝑑𝑑𝐹𝐹𝑑𝑑𝑃𝑃𝑐𝑐𝑃𝑃
𝜋𝜋 × 𝐺𝐺𝑎𝑎𝑃𝑃𝐺𝐺𝑃𝑃𝑑𝑑𝑑𝑑𝑑𝑑𝑎𝑎2 

The Gasket diameter is at the gasket loading location (if it is not input, it is conservatively 
assumed to be the internal diameter of the pipe). 

The above shown equation is based on the article NC3658.1 of ASME Section III Class 2, 
1992 or later editions, around page 176. The computed equivalent flange pressure is 
compared with the allowable pressure. 

If you have input more than one temperature load, the flange equivalent pressure is 
calculated for all the applicable operating load cases, the worst of which is reported in the 
Flange report. 

A flange report is generated even when no piping code is chosen. The flange report is shown 
in the results. 

Suggestions for dealing with high flange pressure to allowable ratios 

The Flange report in the CAEPIPE results window shows the loads at each flange location 
for the operating case (W+P+T). 

The “equivalent” flange pressure is the sum of three terms from the flange equation as 
shown above. The last column in the Flange report shows a ratio of this equivalent flange 
pressure to a user-input allowable pressure. This ratio is flagged in red when greater than 1.0. 

There are several ways of dealing with a high ratio, as suggested below. 

• Ensure that you input an allowable pressure for the flange by looking up B16.5 or a 
similar code (as a function of design temperature and pressure). 

• The equation from the previous page is generally regarded as a conservative equation. 
Being so, you can discard the axial stress term in it to arrive at a new “equivalent flange 
pressure.” This should be done outside CAEPIPE, maybe in a spreadsheet program. 

• If the fluid within the pipe is non-hazardous, you can increase the allowable pressure by 
10-20%, depending on your judgment. 

• Since a flange is unlikely to fail by collapse, the key idea of the flange report is to 
“quantify” the tendency of a flange to leak its contents. Engineering judgment will play an 
important role in interpreting this report.  

• If none of the above work, then you will have to reduce the bending moment at those 
flange locations. Be sure to examine all load cases, but frequently the excessive moments 
come from the expansion case. If so, consider introducing loops, bends and offsets as 
required. 
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Flange joints are essential components in all pressurized systems; they are also one of the 
most complex. Many factors are involved in determining the successful design and operation 
of a bolted flange joint service, namely, the interaction between the bolting, flange, and 
gasket as well as important non-linear variables such as friction and gasket properties. The 
Pressure Vessel and Piping Codes were developed with safety in mind; they provide a 
method for sizing the flange and bolts to be structurally adequate for the specified design 
conditions.  

This Flange module implemented in CAEPIPE addresses the design rules contained in the 
ASME Section VIII, Division 1, Appendix 2 on bolted flange connections with gaskets. 

These design rules will help you to obtain better insight into a flange joint's tendency to leak, 
beyond that provided by the rudimentary (yet indicative) flange report produced by a piping 
analysis, as seen in the earlier topic.  You can examine the flange and bolt stresses arising 
from the bolt tightening loads required for a leakage-free joint. 

This module assumes that you already have flanges and gaskets picked out for your system 
and performed a piping flexibility analysis using them, which will have produced a flange 
report as shown below. 

 

Note that this flange stress module to calculate flange and bolt stresses is separate from a 
piping model file and can be accessed from File Menu > Open/New command. 

Because this module accepts axial load and bending moment at a flange as input among many 
others, you will need to first create your piping model that includes flanges (which you need 
to validate) and generate a Flange Report as shown above. Such a report will contain the 
information you can now use in the Flange stress module to calculate stresses. 

When you first create a new flange model file, it comes populated with default values for a 
sample flange (see example 1 later on in this topic). 
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Double-clicking anywhere in the previous screen (or Edit menu > Edit (Ctrl+E)) opens a 
dialog with input fields (with default values) you can edit. You will need to enter all of your 
flange data in this dialog. A legend of the different parameters you see here are explained in 
detail in Appendix F of this manual. 

 

 

Required flange input information is organized into three Property tabs – Flange Details, 
Bolt and Gasket Details, and Load Data, the last of which accepts data from a piping model’s 
Flange Report. Once all the data is input, save the model (flange model filenames will have a 
.flg extension). Now, select File menu > Analyze to calculate flange stresses, which will be 
shown right below the input information. 
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There are three main sections in the shown results:  

• Flange Equivalent Pressure (same as the one shown in piping model results > Flange 
Report),  

• Flange stresses in the Operating condition, and 

• Flange stresses in the Gasket seating condition 
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Flange Stress Module Menus 

Use these numbers in accordance with the ASME Section VIII publication and your 
engineering judgment to qualify these flanges for use in your piping systems. 

File Menu 

 

.Analyze. 
Analyze command calculates the flange and bolt stresses and compares them to the input 
allowable stresses. 

 Print. 

 

You can print a Flange Report by using the Print command.  You can also preview the report 
by clicking the Preview button on the print dialog. 
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Edit Menu 

.Edit. 

You can edit the Flange, Bolt, and Gasket Details, as well as Load Data by clicking the Edit 
command. 
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Flange Model Window 

You can edit the Flange, Bolt, and Gasket Details, as well as Load Data by clicking the Edit 
command. 

Flange Details Tab 

Modify the flange details using this window. 
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Bolt and Gasket Details Tab 

Modify the bolt and gasket details using this window. 
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Load Data Tab 

Modify the load data using this window. 

 

Options Menu 

 

.Units. 

See Units in the Layout Window Options Menu section at the beginning of this manual. 

.Font. 
See Font in the Layout Window Options Menu section at the beginning of this manual.
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Sample Problem 

Problem 1: 

(Example on page 19 Chapter 40 “Bolted-Flange Joints and Connections” by William J. 
Koves on “Companion Guide to the ASME Boiler & Pressure Vessel Code” by K .R. Rao 
[2001], American Society of Mechanical Engineers, U.S.) 

Flange Details: 

Flange Type : Integral Flanges 
Flange Outside Diameter [A] = 39.125 (inch) 
Flange Inside Diameter [B]  = 32 (inch) 
Flange Thickness [t] = 2 (inch) 
Small End Hub Thickness [g0] = 0.5 (inch) 
Large End Hub Thickness [g1] = 1.125 (inch) 
Hub Length [h] = 2.75 (inch) 
All. Stress @ Design Temp [sf] = 19600 (psi) 
All. Stress @ Ref. Temp [sfa] = 20000 (psi) 
Modulus @ Design Temp [E] = 2.7E+7 (psi) 
Modulus @ Ref. Temp [Ea] = 2.92E+7 (psi) 

Bolting Information: 

Bolt Circle Diameter = 37 (inch) 
Number of Bolts = 36 
Bolt Diameter = 1 (inch) 
All. Stress @ Ref. Temp [sa] = 25000 (psi) 
All. Stress @ Design Temp [sb] = 25000 (psi) 

Gasket Information: 

Gasket Outside Diameter = 35.5 (inch) 
Gasket Inner Diameter = 33.5 (inch) 
Leak Pressure Ratio [m] = 3.00 
Gasket Seating Stress [y] = 10000 (psi) 
Facing Sketch = 1 
Facing Column = 1 

Load Data: 

Design Pressure = 414 (psi) 
Design Temperature = 500 (F) 
Axial Force = 1000 (lb) 
Bending Moment = 200 (ft-lb) 
Allowable Pressure = 665 (psi) 
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Comparison of Results 

Flange Stresses Text Book Results 
(psi) 

CAEPIPE 
(psi) 

CAESAR II 
(psi) 

Operating condition    
Longitudinal Hub (SH) 24150 24152 24227 
Radial Flange (SR)              11590 11590 11636 
Tangential Flange (ST) 7230 7232 7205 
0.5(SH + SR) 17870 17871 17932 
0.5(SH + ST) 15690 15692 15716 
Gasket Seating Condition    
Longitudinal Hub (SH) 15270 15269 15292 
Radial Flange (SR)              7330 7327 7345 
Tangential Flange (ST) 4570 4572 4547 
0.5(SH + SR) 11300 11298 11318 
0.5(SH + ST) 9900 9921 9920 

Legend for the different parameters and more examples are given in Appendix F.
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External forces and moments on the piping system in the global X, Y and Z directions may 
be input at any location. Type “fo” in the Data column or select “Force” from the Data 
Types dialog. 

 

The Force dialog is shown. 

 

If you select “Add to W+P”, the specified forces and moments are applied to the sustained 
and operating load cases. 

If you select any of the thermal cases (“Add to T1”, “Add to T2”, “Add to T3”, all the way 
up to “Add to T10”), the specified forces and moments are applied to the selected thermal 
load case (T1/T2/T3) and its operating load case counterpart (for e.g., T1 and W+P1+T1, 
or T2 and W+P2+T2, or T3 and W+P3+T3). 

You may use this data type to apply external forces and moments (from other sources) on 
specific nodes.  Or, you may use this to apply the pre-calculated relief valve force at the end 
of a valve.  If you use it for the latter, then input: 

1. A dummy 0.01g-load, under menu Load > Static Seismic 
2. Check the Static Seismic case for analysis under menu Load > Load Case 
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Upon analysis, you may study the effect of the relief valve force under the occasional stresses 
– which are due to the combination of Sustained and occasional loads (relief valve force) as 
most B31.x Codes stipulate.
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Force spectrum analyses (different from harmonic analyses) are generally performed to 
determine the response of the piping system to short-duration impulsive loads such as fluid 
hammer, safety relief valve (SRV) and slug flow loads. For an actual short-duration impulsive 
dynamic load exerted on a piping system, a fluid transient analysis is first carried out in order 
to arrive at the “time-history loads” (i.e., force vs. time) acting in the three global directions 
(namely global X, Y and Z) at all affected points in the piping system. The time-history load 
sets so computed are then applied, one time-history load set at a time, on a single degree-of-
freedom (dof) spring-mass system with a pre-set natural frequency, to determine the 
maximum dynamic response of this single dof system with that natural frequency. Such 
dynamic analysis for that time-history load is repeated on the same single dof system with 
different pre-set natural frequencies. The force spectrum for that time-history load would 
then be a table of maximum dynamic response computed for the single dof system with 
different natural frequencies. In other words, the force spectrum is a table of force spectral 
values vs frequencies that captures the maximum intensity and frequency content of that 
time-history load. Similarly, force spectrum tables are determined for all other time-history 
load sets. The above force spectrum tables (i.e., maximum dynamic force vs frequency) are 
then applied as inputs at the respective piping nodes of the CAEPIPE stress model to 
compute displacements, forces and stresses. 

For any piping system, there are as many natural modes of vibrations as the number of 
dynamic degrees of freedom for that system. The force spectral value corresponding to a 
natural frequency of the piping system is arrived at by interpolating the force spectrum vs 
frequency table as determined above. For better understanding, as an example, refer to the 
graph shown next as well as the natural frequencies computed for a piping system at 10 Hz, 
14 Hz, 21 Hz, 29 Hz and 33.8 Hz.  
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From the above graph, to arrive at a force value corresponding to a natural frequency of 14 
Hz, CAEPIPE interpolates the force spectral values between 13 and 15 Hz. Similarly, to 
arrive at a force value corresponding to a natural frequency of 21 Hz, CAEPIPE interpolates 
the force spectral values between 20 Hz & 25 Hz. Since force spectral values above 25 Hz are 
not defined in the graph shown above, CAEPIPE arrives at a force value of 1650 lb. (i.e., the 
spectral value corresponding to the maximum frequency of 25 Hz in the above plot) even for 
natural frequencies of 29 and 33.8 Hz. Similarly, CAEPIPE arrives at a force value of 900 lb. 
for a natural frequency of 10 Hz (i.e., the spectral value corresponding to the minimum 
frequency of 13 Hz in the above plot). 

If only one set of force versus frequency is input (for example, 1000 lb. at 14 Hz) in the force 
spectrum table for your model, CAEPIPE applies the same force (1000 lb.) for all natural 
frequencies computed for that piping system. Note that the displacement produced at a node 
will remain unchanged even when the sole frequency in the force spectrum table is changed 
from 14 Hz to any other frequency. 

Here, the results of the modal analysis are used with force spectrum loads to calculate the 
response (displacements, support loads and stresses) of the piping system. It is often used in 
place of a time-history analysis to determine the response of the piping system to sudden 
impulsive loads such as water hammer, relief valve and slug flow. The force spectrum is a 
table of spectral values versus frequencies that captures the intensity and frequency content 
of the time-history loads. It is a table of Dynamic Load Factors (DLF) versus natural 
frequencies. DLF is the ratio of the maximum dynamic displacement divided by the 
maximum static displacement. Note that Force spectrum is a non-dimensional function 
(since it is a ratio) defining a curve representing force versus frequency. The actual force 
spectrum load at a node is defined using this force spectrum in addition to the direction (FX, 
FY, FZ, MX, MY, MZ), units (lb, N, kg, ft-lb, in-lb, Nm, kg-m) and a scale factor.  

The Force spectrums are input from the Layout or List menu: Misc > Force spectrums. 
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The Force spectrum list appears. 

 

Enter a name for the force spectrum and spectrum values versus frequencies table. In 
addition to inputting the force spectrum directly, it can also be read from a text file or 
converted from a previously defined time function. 
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To read a force spectrum from a text file: 

use the List menu: File > Read force spectrum. 

 

The text file should be in the following format: 

Name (up to 31 characters) 
Frequency (Hz)   Spectrum value 
Frequency (Hz)   Spectrum value 
Frequency (Hz)   Spectrum value 

. . 

. . 

. . 

The frequencies can be in any order. They will be sorted in ascending order after reading 
from the file. 

To convert a previously defined time function to force spectrum: 

use the List menu: File > Convert time function. 

 

The Convert Time Function dialog appears. 
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Select the time function to convert from the Time function name drop down combo box. 
Then input the Force spectrum name (defaults to the Time function name), Maximum 
frequency, Number of frequencies and the Damping. When you press Enter or click on OK, 
the time function will be converted to a force spectrum and entered into the force spectrum 
list. 

The time function is converted to a force spectrum by solving the dynamic equation of 
motion for a damped single spring mass system with the time function as a forcing function 
at each frequency using Duhamel’s integral and dividing the absolute maximum dynamic 
displacement by the static displacement. 

Force Spectrum Load 

The force spectrum loads are applied at nodes (in Data column in Layout window). At least 
one force spectrum must be defined before a force spectrum load at a node can be input. 

To apply the force spectrum load at a node click on the Data heading or press Ctrl+Shift+D 
for Data Types dialog. 

 

Select “Force Sp. Load” as the data type and click on OK. This opens the Force Spectrum 
Load dialog. 

 

Select the direction, units and force spectrum using the drop down combo boxes and input 
appropriate scale factor. The scale factor can be a scalar value, which, when multiplied by the 
non-dimensional force spectrum, will give the actual magnitudes of the force versus 
frequency in the global direction and unit selected in the above dialog.  Then click on OK to 
enter the force spectrum load at that node. 
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Input force spectrum loads at other nodes similarly. Then select the force spectrum load case 
for analysis using the Layout menu: Loads > Load cases. 

 

Note that Modal analysis and Sustained (W+P) load cases are automatically selected when 
you select Force spectrum load case. The force spectrum load case is analyzed as an 
Occasional load. 

A Relief Valve Analysis may be performed by first obtaining the data about valve opening 
and subsequent behavior, as a force versus time history profile.  Enter the profile as a time 
function. See under Time History Load for how to. 

 
Then under Force Spectrum, use “Convert time function” to convert the force-time history 
profile into a Force-Spectrum.  Input loads and analyze.  

(a) (b)

Time

Fo
rc

e

Valve opening time Valve closing time
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“From” is a special Element Type used to start a new (branch) line. For a new node number, 
any values you type in under the DX, DY and DZ columns are taken to be coordinates (and 
not offsets). If you use “From” for an existing node number, then you do not have to specify 
values for the DX, DY and DZ fields.  

If you specify a new node number other than the global origin [that has coordinates (0, 0, 0)], 
then you must specify the coordinates for the new node using “From” and DX, DY and DZ 
fields. If you do not, then the new node number will have the same location as the node that 
is the global origin. 

“From” is input by typing “f” in the Type column or selecting “From” from the Element 
Types dialog. 

 

The first node of a model is always a fixed “From” node since you have to start the model 
from a point. The DX, DY, DZ fields for this node may be left blank to mean the global 
origin (0,0,0) or coordinates may be specified in the DX, DY and DZ fields to have a 
nonzero reference point for the model. 

Values specified for DX, DY and DZ for any other node other than a “From” node are 
interpreted as offsets (not as coordinates) unless the node is suffixed with an asterisk “*”. See 
the topic “Node” for more information. 

It is helpful to create a model from the global origin and continue in an orderly manner from 
there, especially when you plan to merge (see File menu) two models later. 
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Example: 

 

Assume you had two separate models you wanted to combine later.  

First model: In this first model, you would start modeling from node 10 up to node 100.   

Second model: You would model from node 100 up to node 130, which is a better way to 
model rather than modeling from node 130 to node 100, which would complicate the 
“Merge” process. 
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A generic data type called “Generic support” is available to define a complex support fitting 
for which the support stiffnesses are obtained from an external source, using a reduced 6x6 
stiffness matrix. An example would be a support assembly as shown below. 

 

 

A reduced 6x6 stiffness matrix representative of this support at a single interface node (as 
shown in figure above) will first need to be arrived at using any general purpose FEA 
software package (such as ANSYS, NASTRAN, etc.) Then, those stiffness values 
representing the support assembly can then be input into CAEPIPE model for further 
analysis. 

“Generic Support” is input by typing “ge” in the Data column or selecting “Generic 
Support” from the Data Types dialog. 

Interface Nodes (at 
center of circular 
clamps) 



Generic Support 
 

257 

 

Units for Groups A and C are controlled centrally through the Units command (Ctrl+U in 
Layout window). Units for Group B need to be set in this dialog. 

Each stiffness field in the dialog is editable. The default “rigid” stiffness is shown for all the 
diagonal terms. If you have a stiffness value for any of these including the off-diagonals, enter 
them here (ensure units integrity).Graphically, the support is shown as a solid block (330 in 
the next figure). 

 

Displacements, support loads and support load summaries are shown for this support type.
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When you open a model, CAEPIPE automatically opens the Layout and the Graphics 
windows. Many commands to manipulate the image such as zoom, turn (rotate), pan and 
print are available in this window. 

 

You could opt to display the image with a white background too (use menu Options > 
Background > White). 

When a model is opened, CAEPIPE displays the last saved model view in the Graphics 
window.
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Context Menu 

Right-clicking anywhere inside this window displays the context menu. 

 

In addition to a few commands constantly available on this menu, other commands appear 
on the menu depending on the results item shown in the Results window. For example, 
when Sorted stresses are shown, the context menu shows three commands specific to Sorted 
stresses (Show Stresses, Show stress ratios and [set stress/ratio] Thresholds). 
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Editing in Graphics Window 

Clicking on an editable element or data item brings up the related dialog (same as that you 
see opened in the Layout window). You can enter or modify properties inside the dialog just 
as if you were editing in the Layout window. This feature gives you more flexibility during 
editing your model. See next page for illustrative images.  

Modified or newly entered data is immediately updated in the Layout and the List windows. 
When you click on any graphics symbol, CAEPIPE automatically synchronizes the highlights 
in the Layout and the List windows to the row that contains the element/data item you 
clicked on, so that you see all the pertinent data about that element at the same time. 

This feature works in Render mode too. Sometimes when symbols are closely grouped, you 
may want to zoom in on that area before clicking on a symbol. That way, CAEPIPE presents 
you the correct dialog box. Dialog boxes are opened only for elements/data that have 
editable data. For example, clicking on a pipe element will do nothing but will still 
synchronize the highlights anyway in the other windows to the same pipe element. 

When you are viewing results, you can still click on an element/data item, except now the 
data you see presented are read-only (you cannot edit them). 
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Clicking on a valve (as shown above) will open the dialog in the window shown next. You 
may modify any value inside the dialog and have it updated across all open windows. 
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Hotkeys You Can Use 

In addition to conventional MS-Windows hotkeys (such as Ctrl+P for Print, Ctrl+C for copy 
image, etc.), you may use the following keys. 

Ctrl+A Zoom All 
Ctrl+Shift+C Center image around a chosen point 
Ctrl+T Turn (rotate) image 
Ctrl+S Show 
Ctrl+N Show node numbers 
Ctrl+D Redraw image 
Ctrl+R Render image 
 
Page Up Zoom in 
Page Down Zoom out 
 
F2 Move focus to Layout or List window (wherever the focus was before) 
F3 Show/Hide Dots + Numbers 
F4 Viewpoint 
F5 Previous view 
F6 Hide Current Element 
F7 Make Transparent 
F8 Freeze View 
F9 Show All 
F10 All Transparent 
F11 All Opaque 
F12 Show/Hide Selected Elements 

Dynamic Resizing of Window Image 

When you resize the Graphics window, CAEPIPE will automatically resize the image 
proportionately isotropically. Dynamic scaling makes it unnecessary for you to “Zoom All” 
every time you resize the window. 
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Using Scroll Thumbs 

When you want to move or pan the image, simply drag the scroll thumbs in the scrollbar and 
the image moves accordingly. If you have activated the Turn command (menu View > Turn, 
or Ctrl+T), then the scroll thumbs when moved using the mouse will rotate the image. 

Graphics Synchronization with Open Text Windows 

The graphics image has a flashing cursor (such as on an anchor or bend) that always 
synchronizes with the text window that has the focus. In congested models, the flashing 
cursor points precisely to the location of the element you are working on by acting as a 
flashing beacon. Example: Move the highlight in Layout to an anchor. The Graphics and the 
List windows (if open) automatically show or highlight the same anchor. 

Dynamic Updating of Data in All Open windows: Layout, Graphics and List 

Example: Delete an Anchor or change a Material name in the List window. The Layout and 
the Graphics windows are automatically updated immediately, showing the changes. You are 
not forced to perform edits from any one given window. You can get instant feedback. 

Simultaneous Visual Updates of Deflected and Mode Shapes 

Simply switch between different load cases (or mode shapes) in the Results window to see 
the respective deflected/mode shape change too in the Graphics window. 
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Zoom Window 

To enlarge an area of image, simply use the mouse to draw a window (a box) around an area 
you are interested in.  CAEPIPE enlarges the image (inside the drawn box) when you release 
the mouse button. 

 
The zoomed image is shown next. 
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Menus and Toolbar 

The different menus in this window are explained in detail in the Menus section. A summary 
is given here. 

 

File menu: 

• You may print the image to a printer or a file (formats supported are Windows Enhanced 
Metafile (EMF), Encapsulated Postscript (EPS), HPGL plot file (PLT) and AutoCAD 
DXF). You can change the printer font from here.  

Before printing to a printer or a file, you can change the title for the printout using the 
Plot Title command. Before printing a rendered image, you may want to select a white 
background and a quality of rendering (default is High).  For DXF & PLT files use the 
“Drawing Size” command to change size. 
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View menu: 

• Mainly for Graphics operations (Viewpoint, Previous view and Zoom All). 

• Selective display of node numbers and graphic symbols makes CAEPIPE flexible and 
powerful (use Show and Show Nodes commands). In addition, other standard graphical 
operations such as pan, zoom, previous view, viewpoint change, center image, etc., are 
available through the menus or a readily available context menu. 

• Selective display of elements is possible.  Use the commands such as “Make Transparent”, 
“All Opaque”, etc.  

• Render Mode: Use this mode for realistic visualization of your model using OpenGL®. 

Even in this mode, you can selectively display symbols and/or node numbers. Use a 
combination of Show and Show Nodes commands available in the context menu (or from 
View menu). Image can be printed, too. 

Options menu: 

• Customize the display image by choosing a display font, repositioning the Axes symbol, 
and changing the size of the toolbar icons. 

Window menu: 

• From here, you can move the focus to the text window from which it came. F2 will move 
focus between text and Graphics windows. The real advantage of this hotkey (F2) is for 
users who have a small monitor and work with maximized windows for input, list, 
graphics and results. In such a setting, one keystroke (F2) will quickly move the focus to 
another window (without having to either minimize the one where the focus is or switch 
windows through the taskbar).  

Help menu: 

• For on-line help. For on-line help and information pertaining to the remaining period of 
your yearly Maintenance, Enhancement and Support (ME&S) agreement with SST.  
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A guide is used in the field to control or direct pipe movement due to thermal loads. 
Likewise, its CAEPIPE equivalent allows axial movement while restraining the pipe against 
lateral translations (but not rotations). A guide restricts the translational movement normal to 
its axis, i.e., displacements are restrained in the local y and z directions.  

A guide is input by typing “g” in the Data column or selecting “Guide” from the Data Types 
dialog. 

 

The Guide dialog is shown. 

 

Friction Coefficient 

When a friction coefficient is entered, a nonlinear analysis is performed. In each iteration, the 
friction force is calculated which is friction coefficient times the normal force (the vector 
sum of y and z reaction forces). This force is applied in the local x direction opposing the 
axial motion of pipe. The solution converges when the displacement changes by less than 1% 
between successive iterations. 

Stiffness 

The default stiffness is rigid which is input by typing “r” or “Rigid” in the Stiffness field. A 
non-rigid stiffness may be entered by typing the value of the stiffness in the Stiffness field. 

Gap 

A clearance between the pipe and the guide, if present, may be entered as a Gap. The gap is 
assumed to be symmetric about the guide axis. This gap must be closed before any restraint 
forces can develop. If there is no gap leave this field blank or enter it as 0.0. 
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Connected to Node 

By default the guide is assumed to be connected to a fixed ground point which is not a part of 
the piping system. A guide can be connected to another node in the piping system by 
entering the node number in the “Connected to Node” field. 

Local Coordinate System (LCS) 

A guide’s local x-axis is based on the preceding element. If a preceding element is 
unavailable, the following element is used to calculate the guide’s axes. The local coordinate 
system (LCS) may be viewed graphically from the Guide List window using the menu: View 
> Show LCS. 

 

 

Guide forces in global coordinate system are “Print(ed) to file” (in addition to forces in local 
coordinate system), accessible from the Print command dialog.
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Variable spring hangers support a specific load while allowing vertical and lateral thermal 
movement from the installed to the operating condition. CAEPIPE assumes a spring hanger 
to always act in the vertical direction.  

Also called a “To be designed” hanger, it is input by typing “h (Enter)” in the Data column 
(or typing “Han”) or selecting “Hanger” from the Data Types dialog. The Hanger dialog is 
shown. 
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Type 

The type (i.e., manufacturer) of the hanger can be selected from the drop-down combo box 
“Type.” The following hanger types are currently available: 

 Hanger Types  
ABB-PBS Fee & Mason Nordon 
Basic Engineers Flexider (30-60-120) NPS Industries 
Bergen-Paterson Flexider (50-100-200) Piping Services 
Bergen-Paterson (L) Fronek Piping Tech & Products 
BHEL Hyderabad Grinnell Power Piping 
BHEL Trichy Hydra Sanwa Tekki(30-60-120) 
Borrello Lisega Sanwa Tekki(85-170) 
Carpenter & Paterson Mitsubishi (30-60-120) Sarathi 
Comet Mitsubishi (80-160) Spring Supports 
Corner & Lada Myricks SSG 
Dynax NHK (30-60-120)  
Elcen NHK (80-160)  

   

 

Number of Hangers 

The number of hangers is the number of separate hangers connected in parallel at this node. 
The stiffness and load capacity of each hanger are multiplied by the number of hangers to 
find the effective stiffness and load capacity of the hanger support at this node. 

Load Variation 

The load variation (in percent) is the maximum variation between the cold and hot loads. 
Typical value is 25%. 

Hanger Below 

Changes the graphical depiction only. 

This should be used to specify whether the Hanger is connected below the pipe. Graphical 
symbol changes accordingly. This selection is valid only for Hanger and User Hanger and not 
for Constant Support Hanger nor Rod Hanger. 

Short Range 

Short range hangers are used if the available space is not enough for installing mid-range 
hangers. They are considered, however, a specialty item and generally not used. If a short 
range hanger is to be designed, check the Short Range check box. 

Connected to Node 

By default the hanger is connected to a fixed ground point which is not a part of the piping 
system. A hanger can be connected to another node in the piping system by entering the 
node number in the “Connected to node” field. This node must be directly above or below the 
hanger node. 
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Hanger Design Procedure 

1. Calculate Hot Load 

Hot load is the load which balances the piping system under sustained loads. To calculate 
hot load, a preliminary sustained load analysis is performed in which all hanger locations 
are restrained vertically. If any anchor is to be released (so that the hanger rather than the 
nearby equipment takes the sustained load), it is released. The reactions at the hanger 
locations from this preliminary sustained load analysis are the hanger hot loads.  

2. Calculate Hanger Travel 

Vertical restraints (applied in step 1) at hanger locations are removed. Released anchors 
(if any) are restored. A preliminary operating load case analysis is performed. If multiple 
thermal load cases are specified only the first thermal load is used for this operating load 
case. The hot loads (calculated in step 1) are applied as upward forces at the hanger 
locations. Vertical displacements at the hanger locations obtained from this operating 
load case analysis are the hanger travels. If limit stops are present, the hot loads are 
recalculated with the status of the limit stops at the end of the preliminary operating load 
case. Then the hanger travels are recalculated using the recalculated hot loads. 

3. Select Hanger  

The hanger is selected from the manufacturer’s catalog based on the hot load and hanger 
travel. The cold load is calculated as: cold load = hot load + spring rate x hanger travel. 
The hanger load variation is calculated as: Load Variation = 100 x Spring rate x travel / 
Hot load. The calculated load variation is checked against specified maximum load 
variation. The hanger for which both the hot and cold loads are within the hanger’s 
allowable working range and the load variation is less than the allowed load variation is 
selected. The hanger is selected such that the hot load is closest to the average of the 
minimum and maximum loads. 

4. Install Hangers 

If “Include hanger stiffness” is chosen in the Analysis options: The hanger spring rates 
are added to the overall stiffness matrix. The hanger cold loads are used in the sustained 
and operating load cases. If “Do not include hanger stiffness” is chosen in the Analysis 
options: The hanger spring rates are not added to the overall stiffness matrix. The hanger 
hot loads are used in the sustained and operating load cases. 

For Lisega hangers, size column will report as Hanger Number, Type and Range instead of 
Hanger Number, Range and Type. For example, hanger having a spring rate of 2.1 N/mm, 
vertical travel of 30mm with load 440N will be reported as 21D.193 instead of 21D319. 

Sustained Displacement During Hanger Selection 

An Example Application 

Sometimes, rotating equipment vendors (e.g. turbine vendors) require that there be no 
weight load imposed on the turbine connections after welding/bolting the pipe to the nozzle 
but prior to plant start-up. This can be accomplished only if the pipe is hung by variable 
spring hangers like a swing at the nozzle and if the pipe end of such “hung” pipe is almost 
perfectly aligned with the turbine nozzle prior to welding or bolting that pipe end to the 
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turbine nozzle. In other words, the spring hangers that carry the weight of the “hung” pipe 
near the nozzle are to be sized and placed such that the resulting displacements (i.e., 3 
translations and 3 rotations) at the pipe end are nearly zero, so that the pipe end need not be 
forcibly deformed in order to weld/bolt it to the turbine nozzle. This, in turn, makes sure 
that the weight load of the pipe is not imposed on the turbine nozzle prior to plant start-up.  

CAEPIPE can be used to perform the above study by carrying out the following steps. 

a) During Step 1 of the Hanger Design procedure given above, release all 6 degrees 
of freedom of the anchor corresponding to that turbine nozzle, so that piping 
weight load will not be transferred to the nozzle during the initial Sustained load 
analysis (in which all hangers are pinned, thereby restraining the pipe vertically at 
the hanger locations). 

b) Review the preliminary Sustained Load Displacements computed during Hanger 
Selection via Results > Displacements > Mouse right click > Show sust. disp. 
during hanger selection. If the Sustained Load translations and rotations at the 
concerned pipe end are NOT nearly zero, try out different hanger locations till 
the preliminary Sustained Load displacements are nearly zero. 

c) When the Preliminary Sustained Load displacements at the concerned pipe end 
are nearly zero, the Support Loads at that Nozzle reported by CAEPIPE for 
Sustained Load case would be close to zero. 

In results, the sustained displacements during hanger selection when hangers are pinned can 
be shown via Results >Displacements>Mouse right click>Show sust. disp. during hanger 
selection. 
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And here is the Results Window for Displacements after selecting this feature. 
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Hinge joint is an expansion joint designed to permit angular rotation in a single plane by use 
of a pair of pins that pass through plates attached to the expansion joint ends. Hinge joints 
are used in sets of two or three to absorb pipe movement in one or more directions in a 
single-plane piping system. A pair of hinge joints, separated by a section of piping, will act 
together to absorb lateral deflection. Hinge joints are designed to take the full pressure thrust. 

The two sides of the hinge joint shown are joined 
by hinge pins which are along the hinge axis shown 
in the figure. A hinge is modeled by two nodes, 
one on each side of the hinge joint. The two nodes 
of the hinge joint are coincident. So, it is a zero 
length element, i.e., the “From” and “To” nodes 
are coincident. Hence, the DX, DY and DZ fields 
in the Layout window should be left blank. 

 

 

 

 

A hinge joint is input by typing “h” in the Type column or selecting “Hinge joint” from the 
Element Types dialog. 
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The Hinge joint dialog is shown. 

 

Rotational Stiffness 

Also called Angular stiffness. Input the stiffness around the rotational (hinge) axis. The 
stiffness value may be available from the manufacturer of the hinge joint or from test results. 
Otherwise engineering judgment may be used. The stiffness values may be left blank. In that 
case a very small value (1 in.-lb./deg.) is used internally to avoid dividing by zero. 

Rotation Limit 

Rotation limit is an upper limit on the rotation of hinge joint in the plus or minus directions. 
Rotation limit of 0.0 (zero) means it is unable to rotate (i.e., it is rigid). Rotation limit of 
“None” or Blank means that there is no limit. 

Friction Torque 

The hinge joint will rotate only if the external torque exceeds the friction torque. Beyond that 
the rotation is proportional to the rotational stiffness of the hinge joint. The friction torque 
value may be available from the manufacturer of the hinge joint or from test results. 
Otherwise engineering judgment may be used. If you do not want friction in the hinge joint, 
the friction torque value may be left blank. 
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When the applied torque is less than friction torque, there is no rotation. When the applied 
torque exceeds friction torque, the rotation is calculated as shown above. When rotation limit 
is reached, there is no further rotation irrespective of the applied torque. See discussion for 
Kbe under Ball joint for additional information. 

Weight 

This is the total weight of the Hinge joint assembly. 

Axis direction 

The hinge axis is specified by the “Axis direction.” See “Direction,” for more information on 
specifying a direction using X comp, Y comp and Z comp. 
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Example 

Assume that we had the model shown below (with an exaggerated deflection) containing 6” 
piping with a pair of Hinge joints. Each Hinge joint has the following data: rotational 
stiffness of 66 in.-lb./degree, and weight of 35 lb. 

 

The following steps describe the modeling procedure (with auto node incrementing, you do 
not have to type in the node numbers below): 

 The first node 10 is already defined as an anchor. Press Enter to move to the next 
row.  

 Type 20 for Node, 3’6” for DX, enter material, section and load names, Guide for 
Data. Press Enter to move to the next row.  

 Input bend at node 30: Type 30 for Node, press Tab to move to the Type field. Type 
“b” and Tab to next column to enter a bend, 2’ for DX, press Enter to move to the 
next row.  

 Type 40 for Node, enter –1’6” for DY (as the offset from node 30 to node 40), press 
Enter to complete the bend and move to next row.  

 Type 50 for Node. Type “h” in the Type column. This shows the hinge dialog.  
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Enter 66 (in.-lb./deg.) for Rotational stiffness, 35 (lb.) for Weight, 1.0 for Z comp (axis 
direction), press Enter or click on OK to close the dialog. This completes the hinge input. 
Since there cannot be any offsets (DX, DY, DZ) for the hinge node from the previous node, 
the cursor automatically moves to the next row. 

 Type 60 for Node, enter –1’6” for DY (as the offset from node 50 to node 60), press 
Enter to move to next row.  

 Type 70 for Node. Type “h” in the Type column. This shows the hinge dialog. Enter 
the hinge data as before and click on OK to move to the next row.  

 Input bend at node 80: type 80 for Node, press Tab to move to Type field, type “b” 
for Type and Tab to next column to enter a bend. Type –1’6” for DY (offset from 
node 70 to bend node 80), press Enter.  

 Complete the model through nodes 90 and 100 similar to steps 1 and 2 above.  

The Layout window is shown below: 
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The rendered graphics is shown below: 

 

See under Expansion Joints for more examples. 
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Use this load to analyze loading from a hydrostatic test which is performed by filling the 
piping system with a pressurized fluid (typically water) to check for leaks, etc., before putting 
the system in service.  

During hydrotest, all hangers are assumed pinned (i.e., they act as rigid vertical supports). 
The hydrotest load is defined by the specific gravity of the test fluid (1.0 for water), test 
pressure and whether to include or exclude the insulation weight (because many times the 
hydrotest is performed before applying the insulation).  

The hydrotest load is input by pressing “h” on an empty row in the Layout window (similar 
to pressing “c” for a comment) or on an empty row, selecting “Hydrotest load” from the 
Element Types dialog (Ctrl+Shft+T). 

 

The “Hydrotest Load” dialog appears. 

 

After the hydrotest load is input by pressing Enter or clicking on OK, the hydrotest load 
appears in the Layout window. 
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If you need to modify an existing hydrotest load, double click on the row that defines the 
hydrotest load to bring up the Hydrotest Load dialog. The hydrotest load is applied to the 
rows that follow until changed by another hydrotest load. The hydrotest load can be constant 
over the whole model or can be changed or even excluded in parts of the model. 

To analyze the hydrotest load case, the Hydrotest load case must be selected using the 
command Loads > Load cases from the Layout window. 

 

The hydrotest load case is analyzed as a Sustained load. 
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Use a jacket end cap to rigidly connect all six degrees of freedom of the coincident nodes of 
a jacketed pipe (i.e., the node on the core pipe and the corresponding node on the jacket pipe 
(“J” node) are tied together so that both nodes have the same displacements and rotations). 

A jacket end cap is input at a jacketed pipe node by typing “j” in the Data column or 
selecting “Jacket End Cap” from the Data Types dialog. 

 

 

You will need this to secure the jacket pipe to the core pipe rigidly.  Sometimes (depending 
on the combination of restraints), you may get a “Stiffness Matrix not positive definite” 
error, which may be corrected by inserting a jacket end cap. 
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Jacketed piping is used when the primary state of the pipe contents (fuel, chemicals such as 
resins, etc.) needs to be maintained during transport. An outer (jacket) pipe surrounds the 
inner (core) pipe that contains the fluid or the chemical. The jacket provides external heating 
or cooling as required along the length of the core pipe. 

The terminology used here is as follows: 
• Jacketed piping refers to the entire assembly, i.e., a core pipe with a jacket on the 

outside. 
• Jacket pipe refers only to the outside pipe. 
• Core pipe refers only to the inside pipe that contains the fluid. 

In CAEPIPE, jacketed piping need only be modeled once, not twice (as in some other 
programs). CAEPIPE models the outer jacket pipe along with the inner core pipe on the 
Layout window. Each row defines a jacketed piping element. The jacket and the core pipes 
may have different materials, sections and (P, T) loads. 

Jacketed Pipe 

A Jacketed pipe is input by typing “JP” under Type or selecting “Jacketed pipe” from the 
Element types dialog. The material, section and load specified in the Jacketed Pipe dialog 
apply to the jacket pipe while the ones mentioned on the layout row (next to offsets) apply to 
the core pipe. 

 

The Jacketed Pipe dialog is shown. 
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The jacket’s material, section, and load names are input here (1, 2 and 1 as shown). 
CAEPIPE retains the properties of a jacket pipe until changed so there is no need to retype 
the names of the jacket properties every time you input a jacketed pipe. 

The ends of the jacket and core pipes need to be rigidly connected using the “Jacket End 
cap” data type (see previous topic). Also, “Spiders” need to be input at locations found in the 
physical assembly. You may have to break up the piping into smaller elements to insert 
spiders at appropriate locations. See example given later in this section. 

In case you are analyzing for wind, it may be more accurate to specify a different load for the 
core pipe alone that does not specify the Wind load since the core pipe is not exposed. Same 
applies to the core pipe insulation if the core pipe does not have insulation. 

Internal nodes 

CAEPIPE generates a “J” node for jacket pipes. For example, if you had a jacketed pipe 
from node 10 to 20, CAEPIPE generates 10J and a 20J as (internal) jacket nodes (that may 
be referenced on the layout screen). 

These internally generated nodes may be used to specify data items such as a spider, jacket 
end cap, support (hanger, restraint), forces on the jacket. See example later in this topic. 

Jacketed Bend 

A Jacketed bend consists of a core bend (with a straight portion) surrounded by a jacket 
bend (with a straight portion of jacket pipe). 

A Jacketed bend is input by typing “JB” in the Type column or by selecting “Jacketed bend” 
from the Element types dialog. 
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The Jacketed Bend dialog is shown. 

 

Jacket (properties) 

The jacket’s material, section, and load names are input here. The properties of a jacketed 
pipe are retained until changed. So, there is no need to retype the names of the jacket 
properties every time you input a jacketed pipe. 

Core (properties) 

Presently these properties are disabled. You need to enter them on the layout row under 
Material, Section and Load. 

Bend radius 

Separate bend radii may be specified for the core and the jacket pipes. 

Note that CAEPIPE does not check for interference between the core and the jacket arising 
out of differently specified bend radii. 

The bend radius for the core pipe is the same as that of the jacket pipe, since the two bends 
are generally concentric. Use the Render feature in the Graphics window to check visually 
for interference, however. 

Bend thickness 

Separate bend thicknesses may be specified for the core and the jacket bends, if they are not 
default jacket and core section thicknesses. 
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Intermediate nodes 

You can define additional nodes on the outside jacket of a jacketed bend for locating 
supports. You may also use internal nodes generated by CAEPIPE. See Internal nodes 
below. 

Internal nodes 

CAEPIPE generates “C” and “D” nodes for the Jacketed bend on the jacket at the near and 
far ends of the bend. The core pipe (bend) has its own “A” and “B” nodes. Example: When 
you define a Jacketed bend from node 20 to node 30, 30A, 30B (nodes on core bend), 30C 
and 30D (nodes on jacket) are generated. Nodes (30A, 30C) and (30B and 30D) are 
coincident only if the core and the jacket pipes have the same bend radii. See figure. 

These internal nodes may be used to specify data items such as a spider, jacket end cap, 
supports, forces, etc. 

Split a Bend/Pipe 

A jacketed pipe/bend may be split by using the Split option in the Edit menu in the Layout 
window. 

Contents Weight 

The weight of the contents between the jacket and the core pipes is calculated in the 
following manner: 

(a) Twice the insulation thickness on the core pipe is added to the outer diameter of the core 
pipe. (b) Area is calculated by using the above diameter (a). (c) The internal area of the jacket 
pipe is calculated. (d) The area (b) is subtracted from the internal area of the jacket pipe (c) 
and this result is further used to compute weight. 

Jacketed Reducer 

See modeling procedure in topic on the Reducer. 

Example: Jacketed Pipe/Bend 

The figure below shows a Jacketed pipe with a Jacketed bend (at node 20-TIP). Observe the 
spider at the far end of the bend (node 20B). 
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The nodes 10J, 20C, 20D, 30J, 20A, 20B are internally generated nodes. You may use them 
for specifying data items such as spiders, supports (hanger, restraint), forces, etc. 

The nodes (10, 10J), (20A, 20C), (20B, 20D) and (30, 30J) are coincident. The nodes 20A and 
20B are coincident with 20C and 20D respectively only if the core and the jacket pipes have 
the same bend radii. 

Note that the core and jacket nodes are not connected even though they are coincident. The 
pipes have to be supported and connected using supports and jacket connections. An anchor 
each at nodes 10 and 10J is specified. The hanger is at node 30J since it is attached to the 
jacket. 

A jacket connection of the type spider at node 20B acts as an internal guide between the core 
pipe and the jacket pipe, that is, it prevents any radial movement but allows sliding, rotating 
and bending movement between core and jacket pipes. 
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In case forces transmitted from core pipe to jacket through spiders are required, then spiders 
specified on core pipe can be replaced by guides with “connected to” nodes specified as the 
corresponding nodes on the jacket pipe. 

The end cap at node 30 connects the core and jacket pipes rigidly. 

Jacketed Piping Stresses/Ratios 

CAEPIPE provides an option for you to display the color-coded stress/ratio contour for 
jacketed piping in the graphics window context menu. The default stress contour is for the 
core piping. Upon selecting the command for Jacket stresses as shown below: 
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The text window displayed (that contains the piping layout) when you open a piping model is 
called the Layout window. 

A Layout window, as the name indicates, allows you to create or modify the layout of your 
piping system. 

Other things you can do here are: 

• Specify material types, pipe sections and loads. 
• Use some graphics features (zoom all, viewpoint, etc.) to view the model. 
• Define analysis options such as piping code to use, reference temperature, cutoff 

frequency for mode extraction, as well as set units, etc. 
• Define load cases (Sustained, Expansion, Response Spectrum, etc.) for analysis.  

In the Layout window, the row you are working on is highlighted by the yellow highlight bar 
(in figure below, the highlight is on the Title row). The following illustration names the 
different fields in the Layout window. Presently, there are ten fields (columns) in the Layout 
window. 

The Header row with column headings (see “Clickable Header row” in the illustration) is a 
special row that allows you to click on it to perform a related operation. For example, you 
can click on Type to show Element types. 

 

Description of Fields (numbers in parentheses refer to numbers in the illustration above). 

# (Row Number) 

The first field contains the row number, automatically incremented and non-editable. 

(1) Node 

This is the node number field where you type in node numbers as you model the piping 
system. The numbers should be numeric except when you are using internally generated 
nodes (A, B, C, D, & J). 

To change an existing node number, click in this field and use Backspace or Delete key. Type 
in a new node number. Press Tab or Enter and confirm the change. 
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You need not enter each node number. It is automatically generated when you press Tab to 
move to the next field. You can set an increment under the menu Options > Node 
increment command. 

(2) Type 

This is the element type field. An element (in-line) is a fitting or a component between two 
nodes. This could be a pipe, a bend, a valve, an expansion joint or most items listed under 
the Element types dialog. See a description later in this section under Element Types. 

(3) DX, DY, DZ 

These fields are offsets (also called relative coordinates) in the three global X, Y and Z 
directions. They are measured from the previous node’s location. 

Offsets are components of lengths of elements (exceptions are zero-length elements like a 
ball and a hinge joint). For example, to specify the offsets of a 6 feet long pipe routed 30 
degrees to global X-axis (in X-Y plane), the offsets are: DX=5.196 ft. (6 * Cosine 30°), 
DY=3 ft. (6 * Sine 30°). 

If the element is in a skewed direction, then calculate the X, Y and the Z components (using 
basic trigonometry) and input them here, or use the Slope command to have CAEPIPE 
calculate the components. 

When you specify values for the DX, DY and DZ fields for a “From” element type row, 
they are treated as (absolute) coordinates of the node rather than (relative) offsets from the 
previous node. If the model begins at the global origin (0,0,0), you do not need to specify 
coordinates for the first From node. For any other From row with a previously defined node 
number, you do not need to enter coordinates either because CAEPIPE already knows the 
coordinates of this node (for example, node 30 on row 8 in the previous figure). 

The offsets can be negative depending on the way you route your piping.  

The default number of decimals you can input for a length value is four. With an 
environment variable “INCREASE_DIGITS” set to “YES”, the number of digits you can 
input after the decimal can be increased to seven. This data can be printed other than to 
TXT and CSV formats.  

(4) Matl (Material) 

Type in the material name of the material you want to use for this element.  See Find and 
Replace command under Layout window > Edit menu, for editing options.  

(5) Sect (Section) 

Type in the section name of the pipe section you want to use for this element.  See Find and 
Replace command under Layout window > Edit menu, for editing options. 

(6) Load 

Type in the load name of the load you want to use for this element.  See Find and Replace 
command under Layout window > Edit menu, for editing options. 
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(7) Data 

Use this field to enter data items at a node such as anchors, flanges, nozzles, hangers, SIFs, 
etc. See Data types below for how to specify an item. 

(8) Comment 

You can create a comment anywhere you like in the Layout window by simply pressing “c” 
(first) on an empty row. You can use this feature to annotate the model with notes. 
Comments print along with the layout data so you can use this feature to document 
(revisions to) the model. 

You can specify a specialized form of a comment to input a Hydrostatic test load by pressing 
“h” first on an empty row. The load is applied to the model from that row onwards until 
modified again (in the next figure, the Hydrostatic load is applied to model from row 8 
onwards). 

 

Menu bar 

 

File menu: 
• Standard file operations with a few special ones to note - Open Results (model 

file(.MOD) must be present for this operation), Print (to file), Analyze (model), QA 
Block, Recently opened file list. You can open not only the CAEPIPE model file, but 
also material and spectrum library files, and the CAEPIPE Results files. 

Edit menu: 
• You can edit all types of data (elements, supports, range of rows) from here. Use Ctrl T 

to edit element (bend, valve), Ctrl D to edit Data (flange, anchor). You can change 
properties for groups of elements, split elements and generate copies of existing rows.  

View menu: 
• Mainly for Graphics (Viewpoint, Previous view and Zoom All). Other functions are to 

open the List window (Ctrl L) by selecting one of the displayed items, and search for a 
node number. 

Options menu: 
• For setting Analysis options such as Piping code, Reference Temperature, Pressure 

correction, cutoff frequency for mode extraction, etc., set Units (SI, Metric, English or a 
combination), and customize the look of CAEPIPE by choosing a display font. 
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Loads menu: 
• Set the load cases for analysis, and specify loads for the model such as static seismic, 

wind, spectrum, time history, etc.  
Misc menu: 
• View model coordinates, define/view materials, sections, loads (also for beams), pumps, 

compressors and turbines, time functions and spectra. 
Window menu: 
• From here, you can move the focus to another window (such as Graphics or List). F2 

will move focus between text and Graphics windows and F3 between open text 
windows. The real advantage of these hotkeys (F2 and F3) is for users who have a 
smaller monitor and work with maximized windows for input, list, graphics and results. 
In such a setting, one key press (F2 or F3) will quickly move the focus to another 
window (without having to either minimize the one where the focus is or switch 
windows through the taskbar).  

Help menu: 
• For on-line help and information pertaining to the remaining period of your yearly 

Maintenance, Enhancement and Support (ME&S) agreement with SST.  
Toolbar 

 

The toolbar presently is organized into three groups: File, Window and Graphics operations. 

• File operations are New (model), Open (a model), Save (model), and Print.  
• Window operations are (move focus to) Graphics window, List window, and display a 

dialog of List of items to show an item in the List window.  
• Graphics operations are Viewpoint and Zoom all.  

In the opening window (when you first start CAEPIPE), there is a button to open the last 
opened model file (hotkey: Enter). This is not available from other windows. 

Hotkeys You Can Use 

You can use following hotkeys in the Layout window: 

Tab Move cursor from field to 
field (left to right 

Home Move cursor to the first 
character in a field 

Shift Tab Same as Tab but right to left End Move cursor to the last 
character in a field 

Page Up Move highlight up one page Ctrl+Home Top of model 
Page Down Move highlight down one 

page 
Ctrl+End End of model 

Delete/BkSp Delete characters Arrow keys Move highlight one 
row/field at a time 

Ctrl+Insert Insert an empty row Ctrl+X Delete a row 
Ctrl+Enter Duplicates last layout row F1 Help 
F2 Graphics window F3 List window 
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Other hotkeys listed under menus.  

Hotkey combination: CTRL+ENTER (for duplicating the last layout row), works for Beam 
Elements (in addition to PIPE and JPIPE). 

Function Keys 

F1: Opens on-line help. 

F2: This key moves the focus to and from the Graphics window. 

F3: This key moves focus to and from the List window. 

F4: Opens the Viewpoint dialog which you can set for the Graphics window. 

F5: This function key restores the Graphics window to the previous graphics view. 

List (Ctrl+L) 

List is a powerful feature that helps you see itemized lists of information in the model. All 
input data can be viewed through this command. For example, you can view all element and 
data types specified in the model, list Coordinates of the nodes of the model, Specified 
displacements, Nozzle stiffnesses, Branch nodes, Threaded joints, Pumps, Turbines, 
Compressors, Materials, Sections and Loads, etc. 

This is a useful tool to verify information after modeling is finished, for example, to check 
whether all bends have the same bend radius or whether limit stops are aligned in the correct 
directions or how many anchors have been specified in the model and so on. 

This command is “intelligent” in that the list dialog shows only those items that exist in the 
model. Consequently, List can display as small a list as in the first figure below or as 
comprehensive a list as shown in the next figure. 
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You can navigate through the different itemized lists by clicking on the two blue-colored 
arrows on the toolbar. 

Element types 

How to input an Element 

To input an element (between two nodes) in a new row, either right click in the Type field of 
the row or left-click on Type (in the Header row) to display the Element types dialog (or 
press Ctrl+Shft+T). Select the element you want from this dialog to insert into the model. 

 

Notice the different types of elements available. Any of these can be input for “Type.” Some 
of these are strictly not elements such as From, Location, Comment and Hydrostatic test 
load but need to be input from here anyway. All of these have keyboard shortcuts. You do 
not have to necessarily open this dialog to input any of these. You can type the first letter or 
the first few letters (example: Be for bend, M for miter, V for valve, etc.) to input an element 
type. 
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Shortcut keys for Element types 

b (Tab) Bend  
ben Bend (no Tab required, and typing “ben” moves the cursor over to the DX field.) 
bea Beam 
bel Bellows 
ba Ball joint 
c Cut pipe (Cold spring) 
e Elastic element 
f From 
h Hinge joint 
j Jacketed pipe 
jb Jacketed Bend 
l (L) Location 
m Miter Bend 
P Pipe (you don’t have to type this because a Pipe is the default element type) 
r (Tab) Reducer 
re Reducer 
ri Rigid element 
s Slip joint 
v Valve 
t Tierod 
Once input, each element name appears under the Type field. The only exception is the Pipe 
element which is indicated by a blank (see the first annotated figure in this section). The field 
under Type is blank on the row that contains Node 30 signifying a pipe. 

How to change the Element type 

If you wanted to change a Valve element to an Elastic element, then you have to do the 
following: Move the highlight bar to the row that contains the Valve (or click once on 
Valve). Delete the word “Valve” (Backspace) and press “E”, confirm the change; 

or 

Assuming the highlight is on the Valve row, click on Type (in the header row) to display the 
Element types dialog and then select Elastic element from it. The Valve changes to an Elastic 
element after you confirm the change. 

How to change Element properties 

From the keyboard: Press Ctrl+T (from anywhere on the row) to edit the element. Note: A 
pipe has no editable property, and Ctrl+T does nothing. 

Mouse: Right clicking on the element gives you applicable choices. For example, for a Bend, 
you are shown Edit Bend and List Bends as the choices. 

Notes: 

1. A pipe element is the default element type. So, leave the element type field blank for that 
row.  

2. An existing element type (say, a bend) cannot be changed to a Location type.  
3. To change the element type, you can erase (use Backspace or Delete key) the existing 

element and specify a new one (using an accelerator key), or use the mouse to specify 
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another element by clicking on Type in the header row.  Or, use Ctrl+X to delete the 
entire row. 

Data types 

How to input a Data item 

When you want to input a support, a restraint, a flange, an SIF, etc., at a node, use the mouse 
or the keyboard (several key accelerators are available to make your job easy) to open the 
Data types dialog and select an item from it. 

Keyboard: Press Ctrl+Shift+D to open the Data types dialog to select an item, or, type one 
of the following keys (under Shortcut keys) that will automatically enter the respective Data 
type (press Ctrl D to position the cursor in this field): 

Mouse: To open the Data types dialog, 

• Left click on Data (in the header row), or  
• Right click in the Data column, or  
• Select Misc menu >> Data Types.  

 

Shortcut keys for Data types 

a Anchor (rigid) 
br Branch SIF (Welding tee, Branch connection, etc.) 
c (Enter) Concentrated Mass 
conc Concentrated Mass 
cons Constant Support 
f (Enter) Flange 
fl Flange 
fo Force 
gu Guide 
ge Generic Support 
h (Enter) Hanger (to be designed) 
han Hanger (to be designed) 
har Harmonic load 
j Jacket end cap 
l (L) Limit stop 
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n Nozzle 
r (Enter) Restraint (2-way), see also X, Y, Z below 
ro Rod hanger 
s (Enter) Skewed restraint 
sk Skewed restraint 
sn Snubber 
sp Spider 
th Threaded joint 
t (Enter) Time varying load 
ti Time varying load 
u (Enter) User hanger 
user s User SIF 
w Weld 
x X restraint (2-way) 
y Y restraint (2-way) 
z Z restraint (2-way) 

Notice the different types available. For example, press “a” in the Data field to input an 
Anchor (you do not have to go through the long-winded mouse method of clicking on Data 
in the header row to display the Data types dialog, and then selecting Anchor from it). 

How to change the Data type 

Assume that you wanted to change an Anchor to a Nozzle. Before you change an existing 
Data type (Anchor), you have to delete it. A deletion cannot be undone presently. 

To delete, click on Anchor, delete the word “Anchor” (backspace) and then type “n”, or 
right click on the Anchor, and select “Delete Anchor.” 

Alternately, with the cursor placed on the row for which you need to change the Anchor, 
click on Data on the header row, and pick Nozzle and confirm the change. 

How to edit the Data item’s properties 

To edit properties for anchors, flanges, etc. 

Keyboard: Press Ctrl+D (from anywhere on the row) to edit the item. Note: A Threaded 
Joint has no editable property, and Ctrl D does nothing. 

Mouse: Right clicking on the item gives you applicable choices. Example: For an Anchor, 
you are shown Edit Anchor. 

Notes: 

1. You cannot specify a data item for a Bend, a Miter Bend or a Jacketed Bend, as the node 
number is a tangent intersection point, and does not exist physically on the element. 
Instead, create an intermediate node for the Bend or Jacketed Bend and then specify a 
data item at the new node using Location type. You cannot create an intermediate node 
for a miter bend. 

2a. You can delete an existing data item at anytime: 
- Use the Delete or the Backspace key to erase the item and press Enter. 

 - Right click on the item and select Delete Item.  
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2b. Alternately, to change the data type, you can erase (use Backspace or Delete key) the 
existing item and type a new one (accelerator), or use the mouse to specify another data 
item by clicking on Data in the header row. 

A deletion (whether a row or a field entry) cannot be undone presently. 

Context Menus 

Context menus (right click menus) can be found everywhere in CAEPIPE. For example, 
when you right click on an Anchor, or a Bend, you are shown the following context menus. 
You can perform any listed action that more than often is a shortcut (e.g., Delete Anchor or 
List Anchors). 

 

 

Right clicking on DX/DY/DZ shows you, for example, Insert, Delete (rows), Split (an 
element ) and (specify) Slope for an element. Right click in the Matl, Sect or Load column to 
see the respective context menu. 
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In CAEPIPE, a limit stop is capable of modeling several types of physical supports including 
a guide, an anchor, a resting support, a two-way rigid restraint and a rod hanger. Using a 
combination of upper and lower gaps (limits), friction coefficient, support stiffness and a 
direction for its axis, you can model the above mentioned physical support types. 

A limit stop prevents a node from moving beyond a certain distance (called a gap or a limit) 
in a certain direction. The node can move freely within the gap. After the gap closes, a limit 
stop acts as a rigid or flexible restraint (depending on your input for stiffness) resisting 
further movement of the node in the specified direction. If friction is specified, after the limit 
is reached, the friction force will oppose movement in the plane normal to the limit stop 
direction. 

 

A limit stop is input by typing “l(L)” in the Data column or selecting “Limit Stop” from the 
Data Types dialog. 
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The Limit Stop dialog is shown.  

  

Limits 

Also called gaps, these limits, upper and lower, are the gaps present on either side of the 
node. The gap in front of the node in the direction of the vector is called the upper limit, and 
the gap to the rear of the node is called the lower limit. The gap is measured from the 
undeflected position of the node. 

Typically, the upper limit is positive and the lower limit negative. In some situations, it is 
possible to have a positive lower limit or a negative upper limit, which is the same as 
forcefully displacing the node in that direction by the gap specified. 

The algebraic value of the upper limit must be greater than the lower limit. For example, 
upper limit = –0.125”, lower limit= –0.25”, or upper limit = 0.25”, lower limit = –0.25”. 

If a particular limit does not exist (that is, a node can move freely on that side of the node), 
then that limit should be left blank (as in the case of a resting support, the upper limit should 
be blank assuming Y-vertical and Y comp = 1, as in the figure shown). 

If there is no gap at all, then the corresponding limit should be explicitly input as zero. When 
zero is entered, the limit stop acts as a one-way restraint in that direction. 

Direction 

The direction in which the limit stop is oriented must be specified in terms of its global X, Y 
and Z components. Or use one of the preset buttons to orient the limit stop axis (see above 
image):  

1. Vertical: To set the axis in the (global) vertical direction 

2. Axial: To set the axis along the local-x direction (pipe axis) 

3. Shear y: To set the axis in the local-y direction 

4. Shear z: To set the axis in the local-z direction 
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If you have connected the limit stop node to another node in the same piping model, then 
unless the connected node is coincident with the limit stop node, the direction must not be 
input. It is calculated from the locations of the connected node and the limit stop node, and 
its direction oriented from the connected node to the limit stop node. 

Friction coefficient 

If friction coefficient is specified, a friction force will oppose the movement in the plane 
normal to the limit stop direction when the gap is closed. This friction force is displayed in 
results under Limit stop support loads. 

If you had several limit stops with friction coefficients specified, and you wanted to change 
all of those friction coefficients to the same value, use the Change command under the Edit 
menu. 

Stiffness 

The default is set to Rigid stiffness. Other values may be input by estimating the stiffness of 
the support.  (e.g., for a rod, stiffness = AE/L). 

where 
𝐴𝐴 = Cross-sectional area of rod 
𝐸𝐸 = Young’s modulus 
𝐿𝐿 = Length of rod 

Connected to Node 

You can connect a limit stop node to another node in the same piping model. During gap 
and friction calculations, the relative displacements of the limit stop node are calculated with 
respect to the connected node. If you connect the limit stop node to an external fixed point 
(Ground point), leave the “Connected to Node” blank. See “Direction” above for 
information about how the direction is calculated depending on whether the connected node 
is coincident or not with the limit stop node. 
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Solution procedure 

Limit stops require a nonlinear iterative solution. If you specify a friction coefficient, the 
following procedure is used for convergence: If the lower or upper limit is reached, the 
corresponding reaction force is calculated. The maximum friction force is the product of 
friction coefficient and the reaction force. The solution converges when the displacement 
varies by less than 1% between successive iterations. 

Limit stops are included in dynamic analysis. The status of the limit stops at arrived at upon 
completion of all iterative calculations for the first operating case (W+P1+T1) is used during 
dynamic analysis. If the limit is reached at the end of iterations for the first operating case, 
then the limit stop is treated as a rigid two-way restraint in the direction of the limit stop 
during dynamic analysis. 

Example 1: Vertical 1-way restraint 

Assume that you have a vertical 1-way support with the following data: Upper limit = None, 
Lower limit = 0, Friction coefficient = 0.3, Direction vector of the limit stop is vertical along 
+Y axis. 

Model the pipe up to the Limit stop node 30. At node 30, type “l(L)” in the Data column. 
The limit stop dialog will be shown. 



Limit Stop 
 

305 

 

In the limit stop dialog, press “Vertical” button. The data is automatically entered [0.000 for 
Lower limit, No Upper limit (blank), 1.000 for Y comp (vertical)]. Enter 0.3 for friction 
coefficient (this acts in the X-Z plane which is perpendicular to the direction of the limit 
stop). 
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Example 2: Pipe Slide/Shoe Assembly 

 

The assembly is modeled using three limit stops, one in each direction. 

 When you start a new model file, node 10 and an Anchor are automatically input, 
press Enter to move cursor to next empty row. 

 Press Tab in the Node column which puts the node number 20 automatically. Type 
5’ for DX, enter material, section and load names, press Enter. 

 Press Tab in the Node column which puts the node number 30 automatically. Type 
5’ for DX, Tab to Data column and type “l(L)” to open limit stop dialog. Input line 
stop with gap (0.5”) along X axis (Notice that this is a one-way restraint, there is only 
one stop block along +X). Type Upper limit 0.5”, leave lower limit blank, Direction 
as (X comp = 1, Y comp = 0, Z comp = 0), Friction coefficient=0.3, press Enter. 
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 Create a limit stop in the Y direction. Type 30 for Node, press Tab to move to Type 
field, type “L” for Location, choose Limit stop from the Data Types dialog, in the 
Limit stop dialog, type Upper limit = 0.5”, Lower limit = 0.0, Direction (X comp =0, 
Y comp = 1, Z comp = 0), Friction coefficient=0.3, press Enter. 

 

 Create a limit stop in the Z direction. Type 30 for Node, press Tab to move to Type 
field, type “L” for Location, choose Limit stop from the Data Types dialog, in the 
Limit stop dialog, type Upper limit = 0.25”, Lower limit = –0.25”, Direction (X 
comp =0, Y comp = 0, Z comp = 1), Friction coefficient =0.3, press Enter. 
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The Layout window is shown below. 

 

The Graphics window is shown below. 
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Example 3: Limit Stop Connected to Another Node 

As shown in the figure below, two 300” long cantilever pipes are connected with an 8” 
separation between center lines. 

 

The gap between the bottom of the top pipe and the top of the bottom pipe is 

8” – (6.625” + 8.625”) / 2 = 0.375”. 

If pipes were free to deflect downward due to deadweight, the top pipe will deflect 1.908” 
and the bottom pipe will deflect 1.116” at the free ends. The relative deflection between 
them will be 1.908” – 1.116” = 0.792”. This however is not possible because when the 
relative deflection exceeds 0.375” the pipes will touch. This situation can be modeled using a 
limit stop connecting the free ends of the pipes. In this case the top pipe deflects 1.608”, i.e., 
less than the 1.908” free deflection because it is resisted by the bottom pipe. The bottom 
pipe deflects 1.233”, i.e., more than the 1.116” free deflection because additional load is 
imposed on it by the top pipe when they touch. The difference between the deflections is 
1.608 – 1.233 = 0.375” as expected. 

 When you start a new model file, node 10 and an Anchor are automatically input, 
press Enter to move cursor to next empty row.  

 Press Tab in the Node column which puts the node number 20 automatically. Type 
300” for DX, enter material, 6” section and load names, press Enter.  

 For the bottom pipe, start with node 30 of Type “From” at DY = –8” and make it 
an anchor. On the next row enter node 40 with DX = 300” and 8” section. Press 
Enter to go to the next row.  

 Enter the limit stop at node 20. Type 20 for Node, press Tab to move to Type field, 
type “L” for Location, choose Limit stop from the Data Types dialog, in the Limit 
stop dialog, leave the Upper limit blank and input Lower limit = -0.375”. Input the 
Connecting Node as 40. Since this limit stop connects two nodes, the direction 
should be left blank. The direction is implicitly from node 40 to node 20. 
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Alternatively the limit stop could be specified at node 40 connected to node 20. The 
direction now would be from node 20 to 40. The limits would still be no upper limit and 
lower limit = –0.375” since the direction is now reversed compared to the previous case. 
Both these cases will give identical results. 

The Layout window is shown below. 

 

The Graphics is shown below. 
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Loads on a piping system can be many and varied along its routing. Different piping 
segments may experience different pressures and temperatures depending on process 
requirements, different loads (snow, wind, etc.) depending on their physical locations and 
carry different states of a fluid between different points in a piping system. CAEPIPE offers 
a flexible method to input as many loads as required for as many segments or elements as 
needed with the least effort.  

So, Load allows you to apply a temperature and pressure, specify weight of the fluid and add 
additional weight (e.g., due to snow load) on each element (if required) or for a range of 
elements in the model. Also the wind load can be turned “on” or “off” for each element (if 
required) or for a range of elements in the model. 

After specifying the requested information here, including a name, use it under the Load 
column on the Layout window to associate the load information with an element. 

Each load allows up to 10 operating conditions for Temperature and Pressure depending on 
the “Number of Thermal Loads” under Options > Analysis > Temperature. This Load is 
not to be confused with Load cases [which are combinations of load(s)] found under the 
Loads menu in the Layout window. Load cases are analysis cases (Sustained case, Thermal 
case, Operating case, Static Seismic case, etc.) for which CAEPIPE computes a set of results. 

To define a new load, click on Load in the Header row in the Layout window (or select 
Loads under the Misc menu, hotkey: Ctrl+Shift+L). This opens a List window that displays 
currently defined loads. 

 

 

Either you can start typing the load data directly here into the fields or double click on an 
empty row to enter data through a dialog. 

Depending on the number of thermal loads specified (under Options > Analysis > 
Temperature), up to 10 temperature/pressure load sets (T1/P1, T2/P2, T3/P3,…,T10/P10) 
are available which correspond with the 10 operating load cases for each element. 
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Up to 10 specified thermal displacements can be entered for Anchor and Nozzle data types. 
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Load Name 

Type an alphanumeric name (up to five characters) in this field. The name can be changed 
later. 

Temperatures 

Type up to 10 operating temperatures. The maximum of the 10 temperatures is the Design 
temperature, used to look up the corresponding allowable stress (Sh) for the material. 

The other quantities looked up using these temperatures are the thermal expansion 
coefficients (alpha) and the temperature-dependent moduli. 

Make sure to select number of thermal loads equal to two, three or 10 under Options > 
Analysis > Temperature, when you have more than one set of temperature and pressure. 

Pressures 

Type up to 10 operating pressures that correspond to the 10 operating temperatures above. 
The maximum of the 10 pressures is the Design pressure, used to calculate the pressure 
stress term [𝑃𝑃𝑝𝑝/4𝑑𝑑 𝑑𝑑𝑃𝑃 𝑃𝑃𝑑𝑑2/(𝑝𝑝2 − 𝑑𝑑2)]�, specified under Options > Analysis > Pressure. 

Specify gauge pressures for Pressures input. Negative (external) pressures may be specified, 
too. But, the longitudinal pressure stress term (pD/4t) will still be positive according to the 
piping codes. Internal pressure will expand the pipe cross-section radially outward while 
external (negative) pressure will contract the pipe cross-section radially inward due to 
Poisson’s effect.  
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Specific Gravity 

Specific gravity is the ratio of the density of a fluid to the density of a reference substance (in 
this case, water). Type in the specific gravity of content inside the pipe. This input is used to 
calculate the weight of the contents, which is added to the weight of the pipe. Specific gravity 
is with respect to water.    

Additional weight 

The value you enter here is taken as weight per unit length of the element and this total 
additional weight is added to the weight of the pipe. (Total additional weight = Length x 
Additional weight per unit length). 

For example, this could be used to apply the weight of the snow on the pipe. 

Wind load 

Type Y(es) or N(o) to apply or not apply the wind load for this element. When you press 
Y(es), the wind load (entered as a separate load under Loads menu) is applied to this element. 
The default is Y(es). 

For example, this is useful when you have a part of a piping system exposed to wind with the 
remaining part inside a building. In such a case, you should define two Loads, all data the 
same except that one has Wind load and the other does not. The Load with the wind load is 
applied to those elements that are affected by wind. 
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CAEPIPE allows you to create your physical piping system in a mathematically equivalent 
3D Cartesian coordinate space with a global origin, which is the point of intersection of three 
planes orthogonal to each other, with three axes commonly denoted X, Y and Z (with either 
of the latter two vertical). 

        

  Y Vertical         Z Vertical 

Once you begin creating your system from a given point (usually the global origin), you route 
your piping system one element at a time until you get to the end of the line(s). An element’s 
orientation could be different from another element’s, thereby necessitating an element’s 
own “elemental coordinate system,” which is commonly referred to as the Local Coordinate 
System (LCS), provided for the purpose of understanding the local forces and moments on 
each element. This system can be turned on (graphically) through the View menu > Show 
LCS command while you are viewing “Element Forces in Local Coordinates” in the Results 
window. 

For a straight element (such as a pipe or a beam), the “local x” axis is along the element, 
from the “From” node to the “To” node. For a node location such as a guide, the local axes 
are based on the previous connected element. If such an element does not exist, the 
following element is used. The local y- and z-axes are calculated differently depending on 
whether the vertical direction is Y or Z and also depending on whether the element is in the 
vertical direction. 

The local coordinate system may be displayed graphically (for beams and guides in the input 
processor and for all the elements in the output processor) by selecting the “Show LCS 
(Local coordinate system)” command from the View menu. 

In CAEPIPE, the local coordinate system is indicated by lower case x, y and z letters. The 
global coordinate system is indicated by upper case X, Y and Z letters. 

Global vertical axis is Y 

Element is not Vertical 

 

The local y-axis of the element lies in the local x - global Y plane (i.e., vertical plane) and 
is in the same positive direction as the global Y axis. The local z-axis is the cross product 
of the local x and y-axes. 
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Element is Vertical 

 

The local z-axis of the element is in the global Z direction. The local y-axis is in the 
global –X direction. 

Global vertical axis is Z 

Element is not Vertical 

 

The local z-axis of the element lies in the local x - global Z plane (i.e., vertical plane) and 
is in the same positive direction as the global Z-axis. The local y-axis is the cross product 
of the local z and x-axes. 

Element is Vertical 

 

The local y-axis of the element is in the global Y direction. The local z-axis is in the 
global–X direction. 
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Local Coordinate System for a Bend 

For a bend, at the “From” node, the local x axis is along the tangent from the “From” node 
to the tangent intersection point. The local y-axis is along the radius and points to the center 
of curvature. The local z-axis is cross product of the local x- and y-axes. 

Similarly, at the “To” node, the local x-axis is along the tangent line from the tangent 
intersection point to the “To” node. The local y-axis is along the radius and points to the 
center of curvature. The local z-axis is the cross product of the local x- and y-axes. 
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Element Forces and Moments 

The sign conventions for the element forces and moments in the local coordinate system 
follow strength of materials conventions, i.e., forces and moments are positive in the positive 
local axes directions at the “To” node and they are negative in the positive local axes 
directions at the “From” node. 

 

Positive sign conventions for local forces and moments are shown above at the “From” and 
“To” nodes of an element. Note that positive directions at the “From” node are reversed 
compared to the positive directions at the “To” node. 
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Several times, you may need to put in more than one data item at a node, e.g., a hanger and a 
Branch SIF to designate the type of tee. At those times, use Location (press “L” in the Type 
field or pick Location from the Element types dialog) to input more than one data item at a 
node. For example, you may want to input a force at an existing hanger (see Example 1 
below) or three limit stops (in different directions) at one node. See Example 2 under Limit 
stop. 

Another use for Location is when you want to input a data item at an internally generated 
node. Nodes are internally generated by CAEPIPE for bends (A, B nodes, e.g., 20A) and 
Jacketed pipes/bends (J, C, D nodes, e.g., 10J). 

By design, each row in the Layout window allows only one data item to be inserted under the 
Data field. Additional data items can be input only through Location. 

Ensure that the node you use for Location has already been defined on an earlier row: 
defined earlier as an intermediate node for a bend or is an internally generated node. In other 
words, you cannot use Location on an undefined node. 

Example 1: Pipe and Shoe assembly 

See example 2 under the topic Limit Stop on page 306. 

Example 2: Data at internally generated nodes 

Let us take the example given under Jacketed pipe/bend. For a Jacketed pipe, CAEPIPE 
internally generates the J node on the jacket. For a Jacketed Bend, CAEPIPE generates the C 
and D nodes on the jacket. 

There are four data items in this example: 

1. Node 10J is the starting Jacket node which is anchored (node 10 is separately anchored, 
since it is the node on the core pipe).  

2. There is a hanger at node 30J since the hanger is connected to the Jacket.  
3. There is a spacer (spider) at the far end of the bend, node 20B (which is on the core 

pipe). Remember that the bend has a jacket on the outside.  
4. Node 30 has a jacket end cap  
The following sample Layout window contains all these data as Location data. 
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Example 3: Bend supported by a Hanger 

See Example 6 in the Bend section for an example of using Location at an intermediate node 
on p. 168. 
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For a project, a piping material engineer usually produces different material lists for different 
process and utility systems based on process design conditions, list of components, fluid type 
(corrosivity, viscosity), end conditions and temperature, pressure and size ranges. 

As a result, a piping system will have its materials list, which will specify the materials a stress 
analyst will have to define inside CAEPIPE before analysis. CAEPIPE is so flexible that it 
allows each element (such as a pipe, beam, elbow, valve, jacket, bellows, etc.) to have its own 
material definition.  

Once you define and name a material type, you type in that name on the Layout window 
under the column “Matl” to specify the material for an element. A material may be metallic 
or not (FRP).  You need to obtain properties (density, Poisson’s ratio, Young’s modulus, 
mean coefficient of thermal expansion and allowable stress as a function of temperature) for 
a new material not found in the supplied libraries. You will need properties for at least two 
temperatures (reference and design) for each material you define. Subsequently, the 
temperatures you specify for an element that uses this material must fall within this 
temperature range. 

The material name you specify on the layout applies to the piping element on that row. For 
jacketed piping, you must specify two materials - one for the core pipe (on the Layout 
window), and the other for the jacket pipe in its own dialog. The material you specify for a 
bend, a jacketed bend, and for a miter bend applies only to that specific element on that 
input row. 

There are two ways in which you can define materials: 

1. By defining a material inside the CAEPIPE model, or  
2. By picking a material from an existing material library.  
For the sake of convenience, we suggest that you create a separate material library for your 
piping system project so that you can share it with your team members. 

Below, you will see how to create a material inside a model and how to create a new or 
modify an existing material library. 

Define a Material inside a CAEPIPE model 

From the Layout window, click on “Matl” on the header row (or select Materials from the 
Misc menu, Ctrl+Shift+M). 
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The List window for materials is shown. 

 

In the Material List window, you can edit inside both panes - the left pane contains Name, 
Description, Type of material, Density, Poisson’s ratio (nu) and Joint factor and the right 
pane contains material properties (usually modulus of Elasticity, mean Coefficient of Linear 
thermal expansion [Alpha], not instantaneous nor total thermal, and the code-specific 
Allowable stress) as a function of Temperature. While entering the temperature-dependent 
material properties, you do not need to necessarily enter temperatures in an ascending order, 
although recommended. CAEPIPE will sort the entries later. 

After you are done entering properties for one material, be sure to press Enter when the 
cursor is in the left pane, to move it to the next row so you can start entering the next 
material. You can insert, delete and edit any material (see under Edit menu). 

These panes may change depending on the piping code chosen. For example, for the 
Swedish and Norwegian codes, the following window is displayed. This window contains 
additional columns for Tensile strength and instead of a single Joint factor, it has 
Longitudinal and Circumferential joint factors. 
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The European (EN 13480) code has a column for Tensile strength and temperature-
dependent properties have an additional column for fCR (allowable creep stress). 
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To Input a New Material 

You can input a new material in three ways: 

1. Start typing directly into the fields in the Materials List window.  
2. Input through dialogs (shown below for some but not all piping codes). 

 

 

For the Swedish and Norwegian piping codes, the Material dialog has Longitudinal and 
Circumferential joint factors and a Tensile strength field. 
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For the European (EN 13480) code, the Material dialog has a single Joint factor and a 
Tensile strength field, while the properties window has fCR (creep stress allowable). 
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3. Pick a material from an existing material library (supplied with CAEPIPE or your own). 
Click on the Library button on the toolbar to open the library:  

 

(or select Library command under the File menu):  

 

You will have to open a library file first if it was not previously opened. Select the one of 
interest. Note that the libraries with filenames ending with “_Full” (e.g., B313-
2010_Full.mat) have approx. 200 materials each (from the respective piping code). 

 

You can select a material from the opened library by double clicking on it or highlighting 
it and clicking on OK. 
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Name 

Type a Material name, up to five alpha-numeric characters. 

Description 

Type a description for the material, up to 31 characters. 

Type 

AL for Aluminum 
AS for Austenitic Stainless Steel 
CA for Copper alloys annealed 
CC for Copper alloys cold worked 
CS for Carbon Steel 
FR for Fiber Reinforced Plastic piping 
FS for Ferritic steel 
NA for   Nickel alloys 800, 800H, 825 
SS for Stainless Steel 
TI for Titanium 

These material types are used in calculation of the Y factor for allowable pressure at high 
temperatures for certain piping codes. Swedish and Norwegian piping codes also use it for 
calculating allowable expansion stress range. These codes also need tensile strength. 

For Fiber Reinforced Plastic piping, you need to select the material type “FR” to enter FRP 
material properties. More information can be found under the section Fiber Reinforced 
Plastic. 

Density 

Density of the material is used to calculate weight load and also mass for dynamic analysis. 
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Nu 

The Poisson’s ratio (Nu) defaults to 0.3 if not input. 

Joint factor 

The joint factor is the longitudinal weld joint factor used to calculate allowable pressure. For 
Swedish and Norwegian piping codes, a circumferential joint factor is also input to calculate  
longitudinal pressure stress. 

Tensile strength 

For Swedish, Norwegian and European (EN13480) piping codes, tensile strength is used in 
the calculation of the allowable expansion stress range. For Stoomwezen piping code, tensile 
strength is used in the calculation of hot allowable stress. 

To create or modify a material library 

CAEPIPE offers you flexibility in creating your own material libraries (user-defined 
libraries). That way, you do not feel restricted by the offered choices in materials and can 
continually keep updating the material libraries with your own materials. To create a library: 
From the Main window, select File > New and click on Material Library. 

 

A List window for materials is shown. 

 

You must select a piping code first, using the menu command Options > Piping code, 
before you start entering properties. 

You can, as before, start typing directly into the fields, or enter properties through a dialog. 
The only difference is that materials in the library do not have names whereas those in a 
model have names. 
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After you are done entering materials, you must save to a material library file by using the 
File > Save command. 

 

Give the file a suitable name. The file will be saved with a .mat extension. 

 

Should you need to change the piping code, then you will need to update all materials’ 
properties (in this library) according to the new code, or load a new file. Better yet, if you do 
not see the library among the supplied files, create a new library for the new code. 
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Therefore, first make sure that you have selected the correct piping code (under Options > 
Analysis > Piping code) in the Layout window. Then, ensure that you use the correct 
properties from that code. 

CAEPIPE comes with many libraries from several piping codes. When inside a CAEPIPE 
model, you can open any library and pick a material from it. Make sure to pick the proper 
library (with the proper year), especially between B31.1 and B31.3 libraries because they have 
significantly different allowable stresses for the same materials. Also verify the material 
properties in these libraries before you use them. 
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In dynamic analysis using modal superposition, usually an approximate solution is obtained 
because only a limited number of modes is considered. (For seismic analysis, typically all 
modes up to 33 Hz). The errors in pipe displacements and stresses are usually small because 
they are affected relatively little by high modes. The error in support loads may be substantial 
because the influence of high modes on support loads can be important. In stiff piping 
systems with few low frequency modes, stresses may also be affected significantly. 

Using limited number of modes results in some mass of the system being ignored. The 
distribution of this “missing mass” is such that the inertia forces associated with it will 
usually produce small displacements and stresses. However these forces will often produce 
significant support loads, and in stiff systems can produce significant stresses. 

A correction can be made by determining the modal contributions to the mass of the system 
and obtaining the “missing mass” as the difference between these contributions and the 
actual mass. 

The inertial force vector for the nth mode is given by 

{𝐹𝐹𝑑𝑑} = −[𝑀𝑀]{�̈�𝑃𝑑𝑑} = 𝜔𝜔𝑑𝑑2[𝑀𝑀]{∅𝑑𝑑}𝐴𝐴𝑑𝑑  

Where  [𝑀𝑀] = diagonal mass matrix 
 {�̈�𝑃𝑑𝑑} = acceleration vector 
 𝜔𝜔𝑑𝑑  = circular frequency 
 {∅𝑑𝑑} = mass normalized eigenvector 
 𝐴𝐴𝑑𝑑  = modal displacement for mode n 

For X seismic excitation 

𝐴𝐴𝑑𝑑 = {∅𝑑𝑑}𝑇𝑇[𝑀𝑀]{𝑃𝑃𝑚𝑚}
𝑆𝑆𝑑𝑑𝑚𝑚𝑎𝑎

𝜔𝜔𝑑𝑑2
= 𝛤𝛤𝑑𝑑𝑚𝑚

𝑆𝑆𝑑𝑑𝑚𝑚𝑎𝑎

𝜔𝜔𝑑𝑑2
 

Where  {𝑃𝑃𝑚𝑚} = displacement vector due to a unit displacement in the X direction 
 𝑆𝑆𝑑𝑑𝑚𝑚𝑎𝑎  = spectral acceleration for the nth mode for excitation in the X direction 
 Γnx  = mass participation factor in the X direction for mode n 

Let 𝑚𝑚 = number of modes used in analysis 
 𝑁𝑁 = total number of modes 

If it is assumed that the higher modes: m+1 through N are in phase and have a common 
spectral acceleration𝑆𝑆𝑑𝑑𝑚𝑚𝑎𝑎  (conservatively taken as the maximum spectral acceleration after the 
mth mode), the total inertial force contribution of these higher modes (also known as “Rigid 
body force” or “Left out force”) is 

{𝐹𝐹𝑚𝑚𝑅𝑅} = 𝑆𝑆𝑑𝑑𝑚𝑚𝑎𝑎 [𝑀𝑀] � {𝜙𝜙𝑑𝑑}
𝑁𝑁

𝑑𝑑=𝑚𝑚+1

𝛤𝛤𝑑𝑑𝑚𝑚  

(1) 

(2) 

(3) 



Missing Mass Correction 
 

332 

It can be shown that 

{𝑃𝑃𝑚𝑚} = �{𝜙𝜙𝑑𝑑}
𝑁𝑁

𝑑𝑑=1

𝛤𝛤𝑑𝑑𝑚𝑚 = �{𝜙𝜙𝑑𝑑}
𝑚𝑚

𝑑𝑑=1

𝛤𝛤𝑑𝑑𝑚𝑚 + � {𝜙𝜙𝑑𝑑}
𝑁𝑁

𝑑𝑑=𝑚𝑚+1

𝛤𝛤𝑑𝑑𝑚𝑚  

Substituting from (4) for the summation in (3) 

{𝐹𝐹𝑚𝑚𝑅𝑅} = 𝑆𝑆𝑑𝑑𝑚𝑚𝑎𝑎 [𝑀𝑀] �{𝑃𝑃𝑚𝑚} −�{𝜙𝜙𝑑𝑑}
𝑚𝑚

𝑑𝑑=1

𝛤𝛤𝑑𝑑𝑚𝑚 � 

Note that there will be missing mass inertia forces in the Y and Z directions, in addition to 
the X direction, for X excitation. 

The missing mass force vectors for the Y and Z directions are similarly calculated. The 
response to each of these three force vectors is calculated and these additional response 
vectors are combined with the responses of the first “m” modes. 

This feature is currently not available for Time History and Harmonic analyses. 

The above described method is based on the technical paper by Powell.  See below for 
details. 

Powell, G.H. “Missing Mass Correction in Modal Analysis of Piping Systems.” Transactions 
of the 5th International Conference on Structural Mechanics in Reactor Technology. August 
1979: Berlin, Germany. 

(4) 

(5) 
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Miter bends are typically used when space limitations do not allow the use of regular bends 
(elbows), or when a miter is more economical to use than a regular bend. Miters are not 
fittings. They are fabricated from pipe, to requirements. “The use of miters to make changes 
in direction is practically restricted to low-pressure lines, 10-inch and larger if the pressure 
drop is unimportant...” (Sherwood 1980). 

See figure below for Miter bend parameters. 

 

In this figure, r = mean radius of pipe 
 S = miter spacing at center line 
 θ = one-half angle between adjacent miter axes (≤ 22.5°) 

Before modeling a miter bend, you should determine whether it is closely or widely spaced. 

Closely Spaced Miter 

A miter bend is closely spaced when S < r(1 + tan θ). 

 

A closely spaced miter bend is input as a single miter bend element. 

The Bend Radius (R) is calculated as: R = 0.5 S cot θ. 
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Widely Spaced Miter 

A miter bend is widely spaced when 𝑆𝑆 ≥ 𝑃𝑃(1 +  𝑑𝑑𝑎𝑎𝑑𝑑 θ). 

 

A widely spaced miter bend is modeled with as many miter bend elements as there are miter 
cuts. 

The Bend Radius (R) is calculated as: 𝑅𝑅 = 0.5 𝑃𝑃 (1 + 𝑐𝑐𝑑𝑑𝑑𝑑 𝜃𝜃). 

A miter bend is input by typing “m” in the Type column or selecting “Miter bend” from the 
Element types dialog. 
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The Miter bend dialog is shown. 

 

Bend Radius 

The bend radius (R) depends on the type of miter (Closely or Widely spaced). It is calculated 
as explained previously and input in this field. 

Bend Thickness 

Input the wall thickness of the miter bend if it is different from that of the adjoining pipe 
thicknesses. The Bend Thickness, if specified, applies only to the curved portion(s) of the 
equivalent bend(s) of the miter bend. 

Bend Material 

If the material of the miter bend is different from that of the adjoining pipe, select the Bend 
Material from the drop down combo box. The Bend Material, if specified, applies only to the 
curved portion(s) of the equivalent bend(s) of the miter bend. 

Flexibility Factor 

Specify a flexibility factor for the miter bend if different from the piping code’s factor. If you 
specify one, CAEPIPE uses it instead of the piping code specified Flexibility Factor. A value 
of 2.0, for e.g., will mean that the miter bend is twice as flexible as a pipe of the same length. 

Closely spaced 

To specify the miter bend as closely spaced, click on the “Closely spaced” radio button. 

Widely spaced 

To specify the miter bend as widely spaced, click on the “Widely spaced” radio button. 

Parameters for 90° Miter Bends 

The parameters (dimensions) for 90° miter bends (with 2, 3, 4 miter cuts) in terms of 
dimension (A), mean pipe radius (r) and number of miter cuts (N) are shown in the following 
table. 
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Use the table to determine whether the miter bend is Closely spaced or Widely spaced, and if 
it is Widely spaced and has 2, 3 or 4 miter cuts, to calculate the dimensions B, C, D, E and R 
(equivalent miter bend radius) before modeling it. 

A closely spaced miter requires only the miter bend radius (same as dimension A shown in 
the figures). 

   Dimensions for Widely spaced miters only 
N S Closely spaced if B C D E R 
2 0.828427 A A < 1.707107 r 0.414214 A 0.585786 A - - 1.707107 r 
3 0.535898 A A < 2.366025 r 0.267949 A 0.464102 A - - 2.366025 r 
4 0.397825 A A < 3.013670 r 0.198912 A 0.367542 A 0.281305 A 0.152241 A 3.013670 r 

N = Number of miter cuts 
Half angle θ = 90° /(2N) 

 The following pages show the details of how dimensions B, C, D and E were calculated, and 
are provided only for your information. The above table is important for your modeling 
requirements. For miters with more than 4 cuts, you have to calculate the required 
dimensions similar to those shown on the following pages. The next table outlines the 
modeling procedure for either miter type. 

Miter Modeling Procedure 

 Determine Miter Type   
Closely Spaced Miter  Widely Spaced Miter   
Any number of cuts  2 cuts  3 cuts  4 cuts  

Model miter as a single 
Closely spaced miter 
with Bend radius as 
dimension A.  

Calculate R, B and C from above table. 
Calculate offsets of nodes using B and C. See 
Example 2 Widely spaced miter.  

Calculate R, B, C, D 
and E from above ta-
ble. Calculate offsets 
of nodes using B, C, 
D and E.  

Model this miter as 2  Model this miter as 3  Model this miter as 4  
See Example 1, Closely  widely spaced miters  widely spaced miters  widely spaced miters  
spaced miter.  with R as the bend  with R as the bend  with R as the bend  
 radius.  radius.  radius.  
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Two Miter Cuts (N=2) 

θ = 90° / ( 2 x 2 ) = 22.5° 
S = 2 A tan θ = 0.828427 A 
B = A tan θ = 0.414214 A 
C = 2 A tan θ cos 2θ = 0.585786 A 
Closely Spaced 
The miter is Closely spaced if, 
S < r ( 1 + tan θ ) 
Substituting for S, 
2A tan θ < r ( 1 + tan θ ) 
A < 1.707107 r 
Bend radius, R = 0.5 S cot θ = A 
Widely Spaced 
R = 0.5 r ( 1 + cot θ ) = 1.707107 r 

 

Three Miter Cuts (N=3) 

θ = 90° / ( 2 x 3 ) = 15° 
S = 2 A tan θ = 0.535898 A 
B = A tan θ = 0.267949 A 
C = 2 A tan θ cos 2θ = 0.464102 A 
Closely Spaced 
The miter is Closely spaced if, 
S < r ( 1 + tan θ ) 
Substituting for S, 
2A tan θ < r ( 1 + tan θ ) 
A < 2.366025 r 
Bend radius, R = 0.5 S cot θ = A 
Widely Spaced 
R = 0.5 r ( 1 + cot θ ) = 2.366025 r 
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Four Miter Cuts (N=4) 

θ = 90° / ( 2 x 4 ) = 11.25° 
S = 2 A tan θ = 0.397825 A 
B = A tan θ = 0.198912 A 
C = 2 A tan θ cos 2θ = 0.367542 A 
D = 2 A tan θ sin 4θ = 0.281305 A 
E = 2 A tan θ sin 2θ = 0.152241 A 
Closely Spaced 
The miter is Closely spaced if, 
S < r ( 1 + tan θ ) 
Substituting for S, 
2A tan θ < r ( 1 + tan θ ) 
A < 3.013670 r 
Bend radius, R = 0.5 S cot θ = A 
Widely Spaced 
R = 0.5 r ( 1 + cot θ ) = 3.013670 r 
 

Example 1: Closely Spaced Miter 

Example Data 

Pipe OD = 8.625”, thickness, t = 0.322” 
Mean pipe radius, r = (8.625 - 0.322) / 2 = 4.1515”, 
Number of miter cuts = 3, 
Dimension A = 8”, See 3-cut miter figure. 

Look up table (Miter modeling procedure), for an outline of the modeling procedure. 

First, determine the type of miter (Closely or Widely spaced) before modeling it. 

Look up Summary of Miter parameters, for N = 3. A miter is Closely spaced if A < 
2.366025r. This condition is true for r = 4.1515”. Hence, this is a Closely spaced miter. 

Steps for Example 1 

 Create From node: When you start a new model file, node 10 and an Anchor are 
automatically input, press Enter to move cursor to next empty row.  

 Construct miter bend: type 20 for Node (simply pressing Tab puts this node number 
automatically for you), type “m” under the Type column, type 8” for bend radius, 
select Closely spaced, click on Ok. Type 10” for DX, enter material, section and load 
names, press Enter.  

 Finish the miter bend: type 30 for Node and -10” for DY, press Enter. 
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Example 2: Widely Spaced Miter 

Let us assume the same data as in Example 1 (Closely spaced miter) with only one change, 
namely, dimension A (see next figure). 

Pipe OD = 8.625”, thickness, t = 0.322” 
Mean pipe radius, r = (8.625 - 0.322) / 2 = 4.1515”, 
Number of miter cuts = 3, 
Dimension A = 12”. 

Look up table (for Miter modeling procedure) for an outline of the modeling procedure. 

 

It is essential to determine the type of miter (Closely or Widely spaced) before modeling it. 
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Determine miter type 

Look up table, Summary of Miter parameters, for N = 3. A miter is Closely spaced if A < 
2.366025r. This condition is false for r = 4.1515”. Hence, this is a Widely spaced miter. This 
miter bend has to be modeled as a series of 3 miters. Next, observe in this table that 
dimensions B, C and R (Equivalent miter bend radius) can be calculated for N = 3 cuts. 

Calculate required dimensions 

With r = 4.1515”, 
Equivalent miter bend radius, R = 2.366025 × r = 9.8225”, 
Dimension B = 0.267949 × A = 3.2154”, 
Dimension C = 0.464102 × A = 5.5692” 

See previous figure. After calculating B, C and R, let us now calculate the offsets of nodes 20, 
30 and 40 (the 3 nodes correspond with the 3 miter cuts). 

Calculate Offsets 

Offsets of node 20 from 10: (First miter cut) 
DX = B = 3.2154” 
DY = 0” (because node 20 is on the horizontal axis). 

Offsets of node 30 from 20: (Second miter cut) 
DX = C = 5.5692” 
DY = -B = -3.2154” 

Offsets of node 40 from 30: (Third miter cut) 
DX = B = 3.2154” 
DY = -C = -5.5692” 

Offsets of node 50 from 40: 
DX = 0” (because node 50 is on the vertical axis). 
DY = -B = -3.2154” 

Now, start to build the model in CAEPIPE as shown in Example 1 but with different data 
(bend radius = 9.8225”, select Widely Spaced miter, and offsets as shown above). 

Steps for Example 2 

 Create From node: When you start a new model file, node 10 and an Anchor are 
automatically input, press Enter to move cursor to next empty row.  

 Construct first miter bend: type 20 for Node (simply pressing Tab puts this node 
number automatically for you), type “m” under the Type column, type 9.8225” for 
bend radius, select Widely spaced, click on Ok. Type 3.2154” for DX, enter material, 
section and load names, press Enter.  

 Construct second miter bend: type 30 for Node (simply pressing Tab puts this node 
number automatically for you), type “m” under the Type column, type 9.8225” for 
bend radius, select Widely spaced, click on Ok. Type 5.5692” for DX, -3.2154” for 
DY, press Enter.
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 Construct third miter bend: type 40 for Node (simply pressing Tab puts this node 
number automatically for you), type “m” under the Type column, type 9.8225” for 
bend radius, select Widely spaced, click on Ok. Type 3.2154” for DX, -5.5692” for 
DY, press Enter.  

 Finish the miter bend: type 50 for Node and -3.2154” for DY, press Enter. 

 

 

 

Sherwood, David. R., and Dennis J. Whistance. THE “PIPING GUIDE” A Compact 
Reference for the Design and Drafting of Industrial Piping Systems. First Edition (revised). 
San Francisco: Syentek Books Co., 1980. 
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A Node refers to a connecting point between two elements such as pipes, reducers, valves or 
expansion joints.  The maximum # of nodes in a model cannot exceed 9,999, while the 
maximum node number itself cannot be greater than 99,999.  Usually, a node has a numeric 
designation. In CAEPIPE, occasionally, you may have a need to reference a node followed 
by a letter such as A/B/C/D/J. These are automatically generated internal nodes. A and B 
nodes (e.g., 20A, 20B) designate the near and far ends of a Bend node (see section on Bend). 
J, C and D (e.g., 10J, 10C, 10D) designate a Jacketed pipe and a Jacketed bend (see section 
on Jacketed Piping).  

In the Layout window, node numbers are typed under the column titled Node. A node 
number may be typed as an integer or an integer followed by one of the letters A/B/C/D/J. 
Use “Location” type to specify more than one data item at a node (See section on Location). 

The starting node in a piping system is always a node of type “From,” which is usually 
anchored. 

Nodes not only act as connect points for elements but also act as locations for providing 
supports or applying restraints/external forces and moments to the piping system. Each 
node has six static degrees of freedom (three dynamic), three translational (in x, y and z 
directions) and three rotational (about x, y and z axes). Any or all of them may be restrained 
using supports. 

Specifying Coordinates 

The values typed in the DX, DY and DZ fields on the Layout window are interpreted as 
offsets from the previous node. If required to specify absolute coordinates for a node (i.e., 
fix the location of a point in space), the node has to be of type “From” or should have an 
asterisk (*) at the end of it (e.g., 20*). In these cases, the numbers entered in the DX, DY and 
DZ fields are interpreted as absolute coordinates of the node rather than offsets from the 
previous node. If the coordinates for a particular node are duplicated the second set of 
values is ignored. An asterisk (*) for a “From” node is ignored too. 

You can list all coordinates by selecting Coordinates under Misc menu (or click on the Node 
header or right click on any node number). This feature can be helpful for verifying 
correctness of the input. 

In the Layout window, you can search for a node by using the “Find node” command (under 
the View menu, or use Ctrl+F), specify a “Node increment” for automatic node numbering 
(under Options menu), and renumber nodes for a range of rows (under Edit menu) 

Automatic Renumbering 

When you delete a row with a node number in the Layout window, CAEPIPE automatically 
renumbers nodes from the top starting with the number you have specified under the main 
window > File > Preferences > Automatic Renumbering. Note that this is different from the 
user-performed selective renumbering of a range of rows from the Edit menu.  

When turned on, deleting a row triggers an automatic renumbering operation inside the 
Layout window.  So if you do not want such to happen, turn the feature off from the main 
window.
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There are several types of nonlinearities in CAEPIPE: 

1. Gaps in limit stops, guides.  
2. Rotational limits in ball and hinge joints.  
3. Rod hangers as one-way restraints.  
4. Tie rods with different stiffnesses and gaps in tension and compression.  
5. Friction in limit stops, guides, slip joints, hinge joints and ball joints.  
6. Buried piping.  

An iterative solution is performed when nonlinearities are present. At each iteration, the 
stiffness matrix and the load vector are reformulated because both of these depend on the 
solution (displacements) from the previous iteration. 

Limit stop 

Limit stops are input by specifying direction, the upper and lower limits and optionally a 
friction coefficient. The upper and lower limits are along the direction of the limit stop and 
measured from the undeflected position of the node. Typically the upper limit is positive and 
the lower limit negative. The upper limit should be algebraically always greater than the lower 
limit. In some situations it is possible to have a positive lower limit or a negative upper limit. 
If a particular limit does not exist (i.e., a node can move unrestrained in that direction), that 
limit should be left blank. If a gap does not exist then the limit should be explicitly input as 
zero. 

Solution Procedure 

At each iteration, the displacements at the limit stop node are resolved along the limit stop 
direction. The resolved displacement is compared with the upper and lower limits. If the 
displacement exceeds the upper limit or is less than the lower limit the gap is closed 
otherwise it is open. The solution is converged when the displacement is within 1% of 
previous displacement. 

If the gap is open, no stiffness or force is applied due to the limit stop at the node. 

If the gap is closed, a high stiffness (1×1012 lb./inch) along with a force = gap x high 
stiffness is applied in the direction of the limit stop at the node. The limit stop in this case 
acts like a specified displacement. 

After the solution has converged and if the gap is closed, the support load at the limit stop is 
calculated by: (resolved displacement - gap distance) x high stiffness. During hanger design, 
the hot loads are recalculated with the status of the limit stops at the end of the preliminary 
operating load case. Then the hanger travels are recalculated using the recalculated hot loads. 

In dynamic analysis, the status of the limit stops for the first operating case (W+P1+T1), is 
used. If either the upper or lower limit is reached for the first operating case, the limit stop is 
treated as a rigid two-way restraint in the direction of the limit stop. If the limit is not 
reached, then it is treated as having no restraint. 
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Friction 

Friction is specified by entering coefficient of friction for limit stop and guide, entering 
friction force and/or friction torque for slip joint, entering friction torque for hinge joint and 
entering bending and/or torsional friction torque for ball joint. 

Friction is modeled using variable equivalent stiffnesses (fictitious restraints) in CAEPIPE. 
The stiffness of these fictitious restraints is estimated from the results of previous iteration. 
If friction is included in dynamic analysis, the values of the equivalent stiffnesses from the 
first operating case are used in modal and dynamic analyses. 

Friction in Limit Stop 

If the gap is not closed there is no normal force and hence no friction. If the gap is closed, 
the normal force (limit stop support load) is calculated as explained above. The maximum 
friction force is friction coefficient * normal force. The displacement of the limit stop node 
is resolved into a plane normal to the limit stop direction (let us call this resolved 
displacement: y). Also let ky = equivalent friction stiffness which is assumed to be zero for 
first iteration. 

If y is non zero or y * ky > maximum friction force 

then ky = maximum friction force / y 

otherwise ky = high stiffness ( 1×1012 lb/inch) [This is the case of no sliding] 

In the next iteration the equivalent friction stiffness is added to the stiffness matrix. The 
iterations are continued till the displacement y is within 1% of displacement from the 
previous iteration. The friction force is y * ky. 

Friction in Guide 

A guide is modeled by adding high stiffnesses perpendicular to the direction of the pipe. The 
normal force in the guide is calculated by the vector sum of the local y and z support loads. 
Maximum friction force is friction coefficient * normal force. The displacements at the guide 
node are resolved in the direction of the guide. Let us call this displacement: x. Also let kx = 
equivalent friction stiffness which is assumed to be zero for first iteration. 

If x is non zero or x * kx > maximum friction force 

then kx = maximum friction force / x 

otherwise kx = high stiffness (1×1012 lb/inch) [This is the case of no sliding] 

In the next iteration the equivalent friction stiffness is added to the stiffness matrix. The 
iterations are continued till the displacement x is within 1% of displacement from the 
previous iteration. The friction force is x * kx. 
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Friction in Slip Joint 

The relative displacements (From node, To node) for the slip joint are resolved in the 
direction of the slip joint. Let us call this relative displacement: x. Also let kx = equivalent 
friction stiffness which is assumed to be zero for first iteration. 

If x is non zero or x * kx > friction force 

then kx = friction force / x 

otherwise kx = high stiffness (1×1012 lb/inch) [This is the case of no sliding] 

In the next iteration the equivalent friction stiffness is added to the stiffness matrix. The 
iterations are continued till the displacement x is within 1% of displacement from the 
previous iteration. 

Similar technique is used for friction torque (using rotations instead of translations). 

Friction in Hinge Joint 

The relative rotations (From node, To node) for the hinge joint are resolved in the direction 
of the hinge axis. Let us call this relative rotation: x. Also let kx = equivalent friction stiffness 
which is assumed to be zero for first iteration. Maximum friction torque = friction torque + 
hinge stiffness * x. 

If x is non zero or x * kx > maximum friction torque 

then kx = maximum friction torque / x 

otherwise kx = high stiffness [This is the case of no sliding] 

In the next iteration the equivalent friction stiffness is added to the stiffness matrix. The 
iterations are continued till the displacement x is within 1% of displacement from the 
previous iteration. 

Friction in Ball Joint 

For a ball joint friction in bending (transverse) and torsional (axial) directions is treated 
independently. For the bending case, the resultant of the local y and z directions is used. 
Otherwise a procedure similar to the one used for hinge joint is used. 

Friction in Dynamic Analysis 

Friction is optional in dynamic analysis. Friction is mathematically modeled by using 
equivalent stiffnesses. If friction is included in dynamic analysis, the values of the equivalent 
stiffnesses from the first operating case are used. 
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Misconvergence 

During the iterative solution procedure for nonlinearities, a misconvergence is reported in 
the following manner: 

 

You have three options: 

• Continue the iterative procedure for 5000 more iterations to see whether the solution 
converges, or 

• Accept the misconvergence (maximum misconvergence is reported, 100% in the above 
dialog), or  

• Exit the analysis processor completely.  

An environment variable “CPITER” may be defined to change number of iterations from 
the default 5000. For example, when “CPITER=10000”, iterations will continue up to 
10,000 before showing the dialog: Continue, Accept or Exit if there is nonconvergence. 

The shown misconvergence in the solution is really a quantification of how much off the 
results will be, IF you accept it. The maximum misconvergence (100%) is shown along with 
its location where such is happening. For example, a misconvergence of 100% could mean 
that the results at that location (say support loads etc.) may be off by 100%. So, for example, 
if the support load is 1,200 lb., the true range could be within a bracket of (1200 +/– 192 
lb.); similarly with other results. Results at the other nonconverged locations (191 more in 
this example) will be below this reported number (100%). 

So, the results are not necessarily unusable. If the support load were 27,000 lb., then either 
the support should be designed to handle the true range, or other changes should be made to 
the model to reduce the amount of misconvergence. Sometimes, you may observe during 
analysis that the misconvergence reported begins to oscillate among a few values for # of 
nonlinearities not converged (e.g., 32, 8, 16, 4, 32, 8, 16, 4, ad infinitum) in which case, you 
will know that this process will not converge. Now you have, as before, two options: 1. 
Change parameters (mainly gaps and friction values, or removal of unneeded supports) inside 
the model to influence the convergence routine, or, 2. Increase the # of iterations. In case 
neither works, then use engineering judgment to accept or reject the merit of such a solution 
with variations as described above. 
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Nozzles are integral attachments of vessels (such as a storage tank) which connect with 
external piping. Nozzles transmit the shell (vessel) flexibility to the piping system and hence 
included in piping stress analysis. 

Two types of nozzles can be modeled: A nozzle attached to a cylindrical vessel relatively far 
from the ends of the cylinder, and a nozzle attached to a cylindrical shell with a flat bottom 
and close to the flat-bottom. CAEPIPE calculates the nozzle stiffnesses (local flexibility 
components) according to WRC 297 and API 650 guidelines. See Appendix D for the 
procedures. 

 

The coordinate system is as shown in the figure. The six components of the forces and 
moments at the nozzle-vessel interface are: 

P = Radial load MC = Circumferential moment 
VC = Circumferential load MT = Torsional moment 
VL = Longitudinal load ML = Longitudinal moment 

Of the six components of stiffnesses, only three stiffnesses, axial (Kx), circumferential (Kyy), 
and longitudinal (Kzz), are computed. The remaining three are assumed to be rigid. 
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A nozzle is input by typing “n” in the Data column or selecting “Nozzle” from the Data 
Types dialog. 

 

The Nozzle dialog is shown. Note that the Displacements button is disabled. It is only 
enabled after the nozzle is input (i.e., existing nozzle). 

 

Nozzle 

OD:  Outside diameter of the nozzle. 
Thk: Thickness of the nozzle. 

Vessel 

 
OD: Outside diameter of the vessel. 
Thk: Thickness of the vessel. 
L1, L2: Distances from the nozzle to the nearest stiffening ring, tubesheet or the vessel end. 
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Vessel axis direction 

The orientation of the vessel axis in terms of its global X, Y and Z components are entered 
here. See example under “Specifying a Direction.” 

Flat-Bottom Tanks 

For a nozzle on a flat-bottom tank and close to the flat-bottom, check the Flat-bottom tank 
checkbox. 

 

A slightly modified Nozzle dialog is displayed. 
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All the input fields are the same as before except: 

L 

L is the distance from the flat-bottom to the nozzle centerline. 

Reinforcing pad 

If the nozzle is reinforced, check this box. 

Stiffness Calculation 

Here again, only three stiffnesses, axial, circumferential and longitudinal are computed 
according to API 650 guidelines. See Appendix D for the procedure. 

The flat-bottom tank nozzles are subject to the following limitations (API 650): 

Limitations 

 Nozzle OD/Vessel OD ratio must be between 0.005 and 0.04.  
 L/Nozzle OD ratio must be between 1.0 and 1.5. See graphs in Appendix D, Figures 

D-3 through D-14.  
Displacements 

Displacements (translations and/or rotations) in the global X, Y and Z directions may be 
specified for nozzles (for thermal, settlement and seismic cases). Click on the Displacements 
button. You will see a dialog similar to one shown below. Type in specified displacements 
and press Enter. 
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There are three types of displacements which can be specified: 

1. Thermal (up to 10 displacements can be specified, one each for thermal loads T1through 
T10). Applied only to the Expansion and Operating load cases.  

2. Seismic (available for B31.1, ASME Section III Class 2, RCC-M and EN 13480 codes 
only). Solved as a separate internal load case and added absolutely to static seismic and 
response spectrum load cases.  

3. Settlement (available under ASME Section III Class 2, RCC-M and EN 13480 codes 
only) Applied to a separate load case called Settlement.  

Settlement 

For certain piping codes (ASME Section III Class 2, RCC-M and EN 13480), a settlement, 
which is a single nonrepeated movement (e.g., due to settlement of foundation), may be 
specified. This is applied to the Settlement load case. For those codes which do not have a 
provision for settlement (like B31.1), specify the settlement as a thermal displacement (a 
conservative approach). 

Example 1: Nozzle on a cylindrical vessel 

Assume the following data: 
Vessel OD = 1800 in. 
Vessel Thickness = 1.0 in. 
Nozzle OD = 26 in. 
Nozzle Thickness = 0.5 in. 
L1 = L2 = 1200 in. 
Elastic modulus for vessel material = 28×106  psi. 

The first node (10) is already defined as an anchor. To replace the anchor by a nozzle, right 
click on the Anchor in the Data column, then select Delete Anchor. Then type “n” in the 
Data column to input the nozzle. The Nozzle dialog will be shown. Input the nozzle data in 
the dialog. The Layout window looks like the following: 

 

The graphics is shown next. 
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Nozzle Stiffnesses 

The three stiffnesses computed can be viewed using the List command (Ctrl+L in the Layout 
window). In the List dialog, select Nozzle Stiffnesses. The following window is displayed. 

 

The nozzle/vessel data may be edited here (double click to edit). 

Example 2: Nozzle on a flat-bottom storage tank 

Assume the following data: 

Vessel OD = 1800 in. 
Vessel Thickness = 1.0 in. 
Nozzle OD = 26 in. 
Nozzle Thickness = 0.5 in.  
L = 36 in. 

Elastic modulus of the vessel material = 28×106psi. 
No reinforcing pad on the vessel. 

Create the piping till the nozzle node. At the nozzle node, enter a Nozzle by typing “n” and 
provide the required data. Check the Flat-bottom tank checkbox. 

The Layout window looks like the following. 
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The graphics is shown next. 

 

The three nozzle stiffnesses computed can be viewed as before by using the List command 
(Ctrl+L) and selecting Nozzle Stiffnesses. 

LCS (Local Coordinate System) is now shown for Nozzle element. It can be accessed a few 
ways: 

1. List (Ctrl+L) > Nozzles > View menu > Show LCS, -OR- 
2. List (Ctrl+L) > Nozzles > Mouse Right Click on the listed Nozzle > Show LCS, -OR- 
3. Results window > Support Loads > Other Support Loads > Nozzles > View menu > 

Show LCS, -OR- 
4. Results window > Support Loads > Other Support Loads > Nozzles > Mouse Right 

Click > Show LCS. 
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Pumps, compressors and turbines in CAEPIPE, referred to as rotating equipment, are each 
governed by an industry publication — API (American Petroleum Institute) publishes an 
API 610 for pumps and an API 617 for compressors while NEMA (National Electrical 
Manufacturers Association) publishes the NEMA SM-23 for turbines. These publications 
provide guidelines for evaluating nozzles connected to equipment among other technical 
information including the items relevant to piping stress analysis – criteria for piping design 
and a table of allowable loads. 

Modeling the equipment is straightforward since it is assumed rigid (relative to connected 
piping) and modeled only through its end points (connection nozzles). 

1. In your model, anchor all of the nozzles (on the equipment) that need to be included 
in the analysis. 

2. Specify these anchored nodes during the respective equipment definition via Misc. 
menu > Pumps/Compressors/Turbines in the Layout window. 

CAEPIPE does not require you to model all of the nozzles nor their connected piping. For 
example, you may model simply one inlet nozzle of a pump with its piping. Or, you may 
model one pump with both nozzles (with no connected piping) and impose external forces 
on them (if you have that data). Further, there is no need to connect the two anchors of the 
equipment with a rigid massless element like required in some archaic methods. A flange and 
an anchor may coexist. 

A pump is input by selecting “Pumps” from the Misc menu in the Layout or List window. 
CAEPIPE produces an API 610 pump compliance report after analysis. You may model two 
types of pumps: Horizontal or Vertical inline. See Appendix B (API 610, for Pumps) for related 
information. 
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Once you see the Pump List window (as shown above), double click on an empty row for a 
new Pump definition dialog that allows you to enter the required information. 

 

Type a short description to identify the pump in Description. You must designate the pump 
nozzles as anchors, and the shaft axis must be in the horizontal plane. The nozzle locations 
(top, side or end) should be specified for suction and discharge nodes. 

See section on specifying a Direction for information on X comp/Y comp/Z comp. 

For horizontal pumps, you must enter coordinates for the center of the pump with respect 
to global origin. For pumps with two support pedestals, API 610 defines the center by the 
“intersection of the pump shaft centerline and a vertical plane passing through the center of 
the two support pedestals.” For pumps with four support pedestals, the center is defined by 
the “pump shaft centerline and a vertical plane passing midway between the four pedestals.” 
See Appendix B for illustrative figures. 

You might find it helpful to first model the nozzles as anchors. In some situations, you might 
not have the discharge or suction side piping. In that case, here is how you can fix the 
location of the other side. Look up the coordinates of the nozzle (anchor) you have already 
modeled. 
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Then, use the coordinates command (menu Misc > Coordinates) to note the (X, Y, Z) 
coordinates of this pump nozzle node number. Using its coordinates, you can now arrive at 
the required coordinates of the other side’s nozzle and the center of the pump. 

Example 
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In the above image, suction side piping ends at node 380. Discharge piping starts at node 
500. In the Pump definition dialog (shown next), you can see that the center of the pump 
is just behind the suction nozzle (node 380) coordinates.  The reducer between nodes 370 
and 380 is a vertically offset eccentric reducer; hence the graphics at the reducer shows a 
break. 
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A simpler example is when you do have piping on both sides of the pump. Consider the 
network below consisting of two pipe segments connected by a pump. 

(suction side) 10-20-30-…-90-100→PUMP←200-210-…-280-290-300 (discharge side) 

The suction side of the pump ends at node 100. The discharge side begins at node 200. Make 
nodes 100 and 200 as anchors so that equipment loads can be calculated. A similar method 
applies to turbines and compressors too. 

A different dialog is shown for vertical inline pumps. Only Description, Suction and 
Discharge nodes are required. 
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API 610 REPORT 

Upon analysis, you will see CAEPIPE produce API 610 reports under “Rotating Equipment 
Reports” in Results. 

 

In addition to the input details, for a specific load case, the calculated forces and moments 
(on the nozzle and those at the center of the pump), API allowables, ratios (of calculated to 
allowable) and status for all of them are reported.  

When you see “Failed” entries in this report, you will need to examine the cause of the high 
force or moment for that line item. Generally, the high numbers come from the expansion 
load but may well come from the weight load. You must reduce these excessive forces and 
moments by making the system or intersections more flexible before this pump can become 
compliant.  

Note: If you have input multiple temperatures and pressures, corresponding reports for 
additional operating load cases will be shown. Use the black right arrow key to see them.
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Use a reducer to join a larger pipe to a small pipe to meet hydraulic flow requirements. A 
reducer is Concentric when the axes at the reducer ends are collinear; Eccentric, when they 
are not. Use an eccentric reducer only when necessary to keep the top or bottom of the line 
level.  

In the figures shown below, observe that the two ends of the reducers are of different 
diameters. The larger end (at node 20) has the outside diameter and thickness as OD1 and 
Thickness 1 (Thk1) with the smaller end (at node 30) having OD2 and Thickness 2 (Thk2). 
In case of the eccentric reducer, the eccentricity as shown is between the two axes of the 
ends of the reducer. The cone angle, α, is also as shown in the following figure. 

 

An eccentric reducer’s eccentricity is modeled by a change in offsets of the “To” node (node 
30 in Figure (b) above). Eccentricity is (ID1–ID2) / 2. See example 2 later in this topic. 

A reducer (concentric or eccentric) is input by typing “re” in the Type column or selecting 
“Reducer” from the Element Types dialog. 
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The Reducer dialog is shown. 

 

OD1, OD2, Thk1, Thk2 

These are the cross-sectional properties at the two ends of the reducer. OD stands for 
outside diameter and Thk stands for thickness. By default, OD1 and Thk1 contain preceding 
section’s outside diameter and thickness, but different values may be typed here. The 
Section1 and Section2 buttons can be used to quickly input OD and Thk values from 
previously defined sections. 

Cone angle 

Shown in Figure (a), it is used to calculate SIF at the ends of the reducer for certain piping 
codes (B31.1, ASME Section III Class 2, RCC-M, Swedish and Norwegian). For these codes, 
if the cone angle is left blank, the maximum value of the SIF (2.0) is used. For all other 
piping codes in CAEPIPE, the cone angle is not used. 

SIF Calculation 

For B31.1, ASME Section III Class 2, EN 13480, RCC-M, Swedish and Norwegian, as 
mentioned above, the cone angle (if input) is used to calculate the SIF. If the cone angle is 
not input, the maximum value of the SIF (2.0) is used. 

For Swedish and Norwegian piping codes, additional input is required which affects the 
calculation of SIF. 

 

Knuckles 

If the reducer is with knuckles check this box. 
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Delta 

If the reducer is without knuckles, specify delta, which is the mismatch (difference in mean 
radii across the weld at the smaller end of the reducer). If the reducer is with knuckles, delta 
is not used. 

For other codes, if the code is not specific about a reducer’s SIF, then a value of 1.0 is used. 

Weight, Stiffness and Stress Calculation 

The properties such as weight of the reducer, stiffness, contents weight and insulation weight 
are based on the average diameter (of OD1 and OD2) and average thickness (of Thk1 and 
Thk2). 

The stresses at each end, however, are calculated using the actual dimensions at each end. 

Example 1: Concentric Reducer 

To model a concentric reducer as shown in Figure (a) with the following data: 8”x4” reducer, 
OD1=8.625”, Thk1=0.322”, OD2=4.5”, Thk2=0.237”. 

Create two sections, 8”/STD and 4”/STD. 

 The first node (10) is already defined. Press Enter to move to the next row.  
 Complete pipe run till node 20: type 20 for Node, type 1 (ft.) for DX, enter material, 

8” section and load names, press Enter.  
 Input reducer: Type 30 for Node, press Tab to move to the Type field, type “Re” (to 

open the Reducer dialog box, note that CAEPIPE displays the preceding 8” section’s 
properties for OD1 and Thk1).  

 

Press the “Section 2” button to select the section at “To” node. 

 

Highlight the 4” section and press OK. 4.5” for OD2 and 0.237” for Thk2 will be entered in 
the Reducer dialog. 
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Press OK, type 11” for DX (reducer’s length) and press Enter. Now you are asked if you 
want to change section, press Yes. “Select Section” dialog will be shown. Highlight the 4” 
section and press Enter. Press Enter again on Layout to move to the next row. 

Type 40 for Node, 1 (ft.) for DX, press Enter. 

 

 

 

Example 2: Eccentric Reducer 

To model an eccentric reducer (as shown in Figure (b) earlier in the topic) with the following 
data: 8”x6” reducer, OD1=8.625”, Thk1=0.322”, OD2=6.625”, Thk2=0.28”, eccentricity = 
(ID1–ID2) / 2 = 0.958” which is modeled as change in elevation. 

Create two sections, 8”/STD and 6”/STD. 

 The first node (10) is already defined. Press Enter to move to the next row.  
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 Complete pipe run till node 20: type 20 for Node, type 12” for DX, enter material, 8” 
section and load names, press Enter.  

 Input reducer: Type 30 for Node, press Tab to move to the Type field, type “Re” (to 
open the Reducer dialog box, note that the preceding 8” section properties are 
already displayed for OD1 and Thk1).  

 

Press the “Section 2” button to select the section at “To” node. 

 

Highlight the 6” section and press OK. 

6.625” for OD2 and 0.28” for Thk2 will be entered in the Reducer dialog. 

 

Press OK, type 11” for DX (reducer’s length along X axis), -0.958” for DY (this is the 
eccentricity), then press Enter. Now you are asked if you want to change section, press 
Yes. “Select Section” dialog will be shown. Highlight the 6” section and press Enter. Press 
Enter again on Layout to move to the next row. 

 Type 40 for Node, 12” for DX, press Enter. 
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The graphics is shown below: 

 

Example 3: Jacketed Reducer 

A jacketed reducer may be modeled in the following manner: Calculate the averages of OD1 
and OD2, and of Thk1 and Thk2 of the reducer. Create a new pipe section with these 
averages as OD and Thickness. Insert a pipe at that location which has the calculated average 
OD and thickness.  You may have to input an SIF (at the two ends) using code guidelines for 
a reducer. 

Alternate Method:  In a jacketed piping system (e.g., 10-20 is a JPIPE, model a reducer next as 
you would normally do in a non-jacketed system, i.e., 20-30 is a reducer, followed by a JPIPE 
between 30-40). Then, connect the jacket nodes (nodes with the suffix J) together (on either 
side of a reducer) with an outside reducer (shown below) or a JPIPE (jacket pipe). In other 
words, on new rows, connect 20J to 30J with a reducer or a JPIPE. 
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This support type is a convenient way to specify a translational two-way rigid restraint in the 
global X, Y and Z directions. This is most commonly used to specify a rigid 2-way vertical 
restraint. 

A restraint is input by typing “re” in the Data column or selecting “Restraint” from the Data 
Types dialog. Alternately, simply typing “X” or “Y” or “Z” in the data type field inputs a 
restraint in the respective direction and moves the cursor to the next row.  

 

The Restraint dialog is shown. 

 

Use the check boxes to apply the restraint in a particular direction (both ways). Click on the 
vertical button for a rigid vertical restraint. All three directions may be checked too. 

Rigid restraint has a stiffness of 1×1012 (lb./in.). 
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CAEPIPE opens the Results window, one among the four independent windows, either 
after analysis of a model or after you open a results file (.res) from the File menu in the Main, 
Layout or Results windows. 

On successful completion of model analysis, CAEPIPE asks you whether you want to see 
results. Click on Yes to continue.  

 

When you do so, the Results window opens, in which you can view every computed result 
for the piping model. This window displays results in an organized manner conducive to easy 
understanding of the results. The other windows (Layout and List) may be opened from here 
in read-only mode for better comprehension, i.e., any detail in these windows may be viewed 
but cannot be modified. To modify the input data, you must open the Layout window in 
input mode (by selecting menu File > Input). 

A dialog listing the different results for a model is shown below. Select an item to see it. 
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While viewing results, it is helpful to be aware of the following: 

• The name of the results item and the load case (if applicable) are always shown in the title 
bar of the Results window.  See image below. 

 

• Synchronized highlight: When you move the highlight to a node number (or an element) 
in the Results window, the highlight in the Graphics window is automatically synchronized 
to the corresponding node number (or element). 

• One key navigation: By merely pressing the Tab key, you can move forward through the 
different results one at a time (Sorted stresses, Code Compliance, Support Loads, Element 
forces, etc.). Move backward by using Shift+Tab, or by clicking on the cyan colored 
arrows (left and right). In this window, the display order of results is circular, i.e., if you 
press Tab from Sorted Stresses, you will see Code compliance next, or if you press 
Shift+Tab, you will see Time History results (or whichever is the last item on the list of 
computed results).  

• Changing Toolbar and Menus: As you move forward or backward through the results, the 
toolbar changes with the displayed result. Also, the menu commands in Results and View 
menus change. They will contain commands relevant to the displayed result.  

• Simultaneous graphics: You can view graphics simultaneously with results (and input).  
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• For a few items, you will notice left and right black arrows. By clicking on these arrow 
buttons (or pressing the corresponding arrow keys on the keyboard), you can change the 
load case. Similarly, in some other results, you will notice left and right white arrows. By 
clicking on these arrow buttons (or pressing the corresponding arrow keys on the 
keyboard with the CTRL key), you can display results for other related items (for example, 
while viewing Support loads, you can change over to other supports [like limit stops, 
hangers, restraints, etc.]).  

 

Depending on the model configuration, you might see more choices within a topic. For 
example, you might see the Other Forces dialog from Pipe Forces results screen. You might 
also see the Other Supports dialog from Support Loads results. 

Each results item has a context menu as shown in the sorted stresses window (see previous 
image). Right-click in the results window to see what the context menu offers.  

Sorted Stresses 

For sorted stresses, you are shown Show stresses, Show stress ratios, Thresholds and Hide 
Allowables (see image on previous page). The resulting actions of the first three commands 
apply to the Graphics window and the last one applies to the Results window. CAEPIPE 
removes four columns (1.5SH, SA, SH+SA and 3.0SC) when you Hide Allowables thereby 
allowing you to reduce the information presented. See next figure (in which “Allowables” are 
hidden). 
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A few screenshots of Results window with the different results items are shown next. 

Code Compliance 

Here, CAEPIPE displays the stresses on an element-by-element basis. Sorted stresses screen 
(i.e., the previous results item) shows stresses at nodes sorted in the descending order of 
stress ratios. In this results item, CAEPIPE displays stresses for each element (highlight is on 
element 19, nodes 120 and 122). 

 

Branch Connection Stresses 

Branch connection stresses are available for only a few piping codes such as ASME Section 
III. You can change the load case by pressing the left or right black arrow key. 
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Hanger Report 

 

Flange Report 

 

See the end of the “Flange” section for suggestions on how to reduce the ratio in the last 
column. 

Rotating Equipment Reports 

The rotating equipment reports are produced for all Operating load cases. The example 
model shown below has several cold spring operating load cases and hence you see the left 
and right black arrow keys. 

The left and right white arrow keys advance (or go back) to the next (or previous) rotating 
equipment report.  



Results Window 
 

376 

 

Soil Restraints 

Soil restraints are shown when you have buried piping in your model. 

 

Support Load Summary for 150+ Load Combinations 

This gives you a summary of many combinations of different load cases by showing the 
algebraically minimum and maximum loads at each support. This table can be of use to a 
support designer (not all are shown below). 
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The supports at which a load summary is available can be shown by clicking on the Other 
Supports button (immediately to the left of the left white arrow button). Select the support 
from the list of available supports. 

 

 

Here, support load summaries are available for the four supports shown. Summaries may be 
included in the “Print to file” option (in addition to inclusion in formatted reports). 

Support Load Summary includes Global displacements at each support for load cases and 
combinations. 

 
To clearly show the direction of each limit stop among multiple at the same node, the 
direction is shown alongside the limit stop (see node 60 below). 
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Support Loads 

Support Loads are shown for all support types. For a support type, the support loads can be 
shown for all load cases by clicking on the black right/left arrow or simply press arrow keys 
on the keyboard. A list of load cases can be shown by clicking on the Load cases button. 

 

 

Support loads on all the supports in the model are shown in the next window. The window 
first shows anchor loads, if present. Then, when you click on the left or right white arrow, it 
shows you loads at different supports. 
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You can find out which other supports are in the model by clicking on the Other Supports 
button (immediately to the left of the left white arrow button). When you click on this 
button, the list of available support types is shown. Select the type. 

 

 

Results from Multiple Thermal and Wind Loads  

Displacements, Support Loads, Element Forces, etc., are calculated for the below shown 
thermal and wind load cases, among others. Expansion stresses under the Sorted Stresses 
screen will show the worst thermal case. Similarly, if any of the four wind load cases happens 
to be the worst among all occasional loads, then it will be shown under occasional stresses. 
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Element Forces 

Forces and moments on all pipe elements are shown next. If you had other elements such as 
a valve, you can display forces and moments for them too by clicking on the Other Forces 
button on the toolbar. 
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The default view for forces and moments is in the local coordinate system. They can be 
shown in the global coordinate system too by clicking on the Global forces button (or 
selecting Global Forces command from the Results menu, hotkey: F7). When you select 
Global forces, the forces and moments are shown in global coordinates and the button 
changes in the same location (on the toolbar) to an “L” for Local forces. So, should you 
want to return to pipe forces in local coordinates, simply click again at the same location on 
the Local forces button. 

 

The convention in CAEPIPE is to display the headings for global forces and moments in 
uppercase (FX, FY, FZ, etc.) while display the headings for local forces in lower case (fx, fy, 
fz, etc.). 

Sorted FRP Stresses 
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The various FRP stresses such as hoop, maximum and minimum longitudinal and torsional 
are sorted here by descending order of stress ratios assuming you have input the material 
allowables. 

Displacements 

Displacements for all load cases can be shown (operating load case shown here). Click on the 
black left/right arrow to show displacements for other load cases. You can show the 
deflected shape in the graphics window for any load case by clicking on the button to the left 
of the “A” button. 
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You can animate the same deflected shape by clicking on Show animated deflected shape 
(last) button in the toolbar. 

You have the option of showing the deformed state coordinates in the global coordinate 
system along with the displacements at each node. 

 



Results Window 
 

386 
 



Results Window 
 

387 

Also, you can show Minimum/Maximum displacements, displacements at flexible joints (if 
any) by clicking on the Other displacements button and selecting the item of interest (or by 
clicking on the left/right white arrows). 

 

Displacements in local coordinates for all flexible joints (bellows, ball, hinge, etc.) are shown 
under Flex joints. 

 

Minimum/Maximum displacements for each load case can be shown (Sustained load case 
shown below). You can show minimum/maximum displacements for other load cases by 
clicking on the black arrows. 
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Displacements at “Other supports” can be shown (limit stops shown here). 

 
 
Frequencies 

A list of natural frequencies, periods, modal participation factors and modal mass fractions is 
shown next. You can show each frequency’s mode shape graphically or animate it by clicking 
on Show mode shape or Show animated mode shape button in the toolbar. 
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Each frequency’s mode shape detail is shown in the next window. As in the earlier window, 
you can show graphically the mode shape or animate it by clicking on the appropriate button.  
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Dynamic Susceptibility 

Please see topic by this name in Reference and also Appendix E. 
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Time History 

For time history results, you are shown the following dialog from which you need to select 
an item. 

 

Then, you are shown a list of supports in the model from which you need to select one. 

 
Once you select a support from the list, then you are shown the time history at that location. 
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While viewing these results, you can export time history results to a comma separated values (.csv) file that can 
be read by a spreadsheet program such as MS-Excel (see menu File > Export) for charting, etc. 

Hotkeys You Can Use 

For keyboard operations, the following list of hotkeys (in addition to MS-Windows keys for 
open, print, exit, etc.) can make you more productive. 

Tab Next results item 
(Shift) Tab Previous results item 
Right Arrow Key Next load case or mode shape 
Left Arrow Key Previous load case or mode shape 
Ctrl+Right Arrow Key Next item of same type (e.g., next support) 
Ctrl+Left Arrow Key Previous item of same type (e.g., previous support) 
Ctrl+F Find node 
Ctrl+L List 
Ctrl+U Units 

Ctrl+A Graphics - Zoom all 
F2 Move focus to Graphics window 
F3 Move focus to Layout, List or Results window 
 (wherever the focus was before) 

F4 Graphics - Set Viewpoint 
F5 Graphics - Previous view 

F6 Show list of Other supports, forces, displacements, etc. 
F7 Show forces, displacements in global/local coordinates 
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Open Other Windows 

You can open the remaining text windows from here - List and Layout - to have all four 
windows open at the same time to enhance your understanding of the model results. Use the 
Window menu to open the other windows.  They are displayed in non-editable mode. 

Menus and Toolbar 

These items are explained in detail under Menus. A summary is given here. 

 
File menu 

This menu contains commands for file operations including starting a new model, opening a 
Results file, printing, etc. 

Results menu 

This is one of the menus that changes with the displayed result. At all times, it contains 
commands for 

• Display list of Results  
• Move forward to Next Result (Tab key)  
• Move backward to Previous Result (Shift+Tab key) 

An example of the additions to the Results menu: 

When Support Loads are displayed, the menu displays, in addition to the above, the 
following commands: 

• Other supports  

• Next Support  

• Previous Support  

• Load cases  

• Next Load case  

• Previous Load case  

All of the above commands also appear on the (context-sensitive) toolbar. 

View menu 

Commands for graphics operations are available from here. This menu, like the Results 
menu, changes with displayed results. 

An example of the changes: 

When Sorted Stresses are displayed, the menu displays, in addition to the above, the 
following commands: 
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• Show stresses in the Graphics window  

• Show stress ratios in the Graphics window  

• Set stress or stress ratio thresholds (to display stresses or stress ratios that are above a 
specific threshold value). 

You do not have to move focus to the Graphics window to execute these commands. 

Options menu 

You can change units or font from the options menu. Any change here in units or font will 
affect all text windows. But the change in units is not saved when you close the Results 
window (they will be saved when you change units in input mode and save the model). 

Window menu 

You can move focus to other windows. Use F2 to move between text and Graphics 
windows, and F3 to move focus between open text windows. This is helpful to those who 
work with maximized windows (perhaps, because of a lower monitor resolution). 

Help menu 

For on-line help and information pertaining to the remaining period of your yearly 
Maintenance, Enhancement and Support (ME&S) agreement with SST.  
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Use this element to model any “stiff” (relative to pipe) inline component. 

The stiffnesses of 1 x 1012(lb/inch) in translational directions (axial and shear), and 1 x 1012 
(inch-lb./rad.) in rotational directions (bending and torsional) are used. 

A rigid element is input by typing “ri” in the Type column or selecting “Rigid element” from 
the Element Types dialog. 

 

The Rigid element dialog is shown. 

 

Weight 

The only required input is weight. It is applied as a distributed load along the length of the 
rigid element. To this weight, the Additional weight from Load is added. Contents and 
insulation weight are not used. Material density does not affect the weight of the rigid 
element. 

Thermal expansion of the rigid element is calculated using the coefficient of thermal 
expansion from the material and temperatures from the load. Wind load is calculated using 
the section properties. 

Rigid, weightless Elements 

These may be needed when you want to account for some hard-to-model element’s thermal 
growth, or to connect the center line of a huge pipe to its outside surface, again to account 
for its (radial) thermal growth/contraction (which impacts the branch line), or to model a 
rigid link between two points (such as the arms around bellows, which can be tied using tie 
rods. See the second modeling method under “Tied Bellows” example under Expansion 
Joints topic).
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To model any of these, input a rigid element, type zero for weight and ensure that the 
corresponding Load (specified on the Layout window under the Load column) used for this 
element does not have any Additional weight specified. 
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A rod hanger is a rigid one-way vertical support. The rod hanger node is rigidly supported 
against downward movement but able to move freely in the upward direction. That is, the 
rod hanger is rigid in tension (downward movement) and has no stiffness in compression 
(upward movement). A rod hanger always acts in the vertical direction. 

A rod hanger is input by typing “ro” in the Data column or selecting “Rod Hanger” from the 
Data Types dialog. 

 

By default, one rod hanger without a connected node is input. The number of hangers and 
the node to which it may be connect to may be specified in the Rod Hanger dialog. 

 

Number of Hangers 

The number of hangers is the number of separate hangers connected in parallel at this node. 

Connected to Node 

By default the hanger is connected to a fixed ground point which is not a part of the piping 
system. A hanger can be connected to another node in the piping system by entering the 
node number in the “Connected to node” field. This node must be directly above the hanger 
node. 

A rod hanger in CAEPIPE functions as a limit stop, that is, it functions as a nonlinear one-
way restraint. It is rigid in -Y direction and fully flexible in +Y direction (in a Y-vertical 
system). The rod hanger offers no resistance in +Y direction. 

Rod hanger results are included in the hanger report, which reports results for the first 
operating case (W+P1+T1). In the hanger report, a rod hanger’s spring rate may be shown 
either as Rigid or zero, the latter potentially confusing to the user. 
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It simply means that there is possibly liftoff at the hanger location for the first operating case. 
You can confirm this by studying vertical displacement (Y or Z) at the support for the first 
operating case (which will be 0 or positive). You can find reports for other operating load 
cases under Support Loads > Other Supports > Rod Hangers. 

Liftoff (i.e., zero spring rate and a zero or positive operating condition displacement) 
indicates that the support may not be needed and hence could be removed. You will need to 
study the effect on the system at other supports after removing the rod hanger.  

 

In dynamic analysis, the status of the rod hanger from the first operating case (W+P1+T1) is 
used, i.e., if the rod hanger is in tension in the first operating case, a rigid vertical restraint is 
used in dynamic analysis. If the rod hanger is in compression in the first operating case 
(possible liftoff), no vertical restraint is used at that location in dynamic analysis. 
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A Section denotes the cross-sectional properties of a pipe used to build a piping model. You 
may define as many sections as needed. To define each section, you will need properties such 
as outside diameter (or Nominal Dia.), thickness of pipe, corrosion allowance, insulation, 
inside lining, and a name that is used under the Section column on the Layout window while 
building your model. 

Click on “Sect” on the Header row or select Sections from the Misc menu. 

 

CAEPIPE presents a List window that lists all defined sections in the model (none defined 
yet in the image below). Double click on an empty row to define a new one. 

 

The section dialog is shown. 
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Section name 

Type an alpha-numeric name (up to five characters long) in this field. Example: If you have 
three 8” sections with different schedules, you could name them thus: 8-STD, 8-80 and 8-
80S. 

Nominal Dia, Schedule 

Four databases of pipe sizes are built-into CAEPIPE — ANSI (American National 
Standards Institute, default), DIN (Deutsche Industrie Norm), JIS (Japanese Industrial 
Standard) and ISO (International Organization for Standardization).  

When you click on the drop-down combo box for pipe sizes, CAEPIPE shows the list of 
pipe sizes that pertains to the selected database (ANSI, DIN, JIS or ISO). ANSI pipe sizes 
range from 1/8” to 48”, DIN from 15 to 1600, JIS from 8A to 1500A, and ISO from 15 to 
1000. Select the required nominal pipe size and schedule (wall thickness). To change to a 
different database (JIS, DIN or ISO), click on the appropriate radio button. On selection, 
CAEPIPE populates the correct OD and Thickness. 

For pipe sizes you do not see on the list, each database allows you a nonstandard definition 
(“Non std” in the pipe sizes list) too. In other words, you are not restricted only to the 
choices available in the databases. You may define any size and thickness as needed. You will 
need to enter the Outside diameter and Thickness of such a nonstandard pipe, in addition to 
the other parameters. 

Corrosion Allowance 

The corrosion allowance reduces the wall thickness of the pipe and used to calculate the 
allowable pressure for the pipe section. Additionally, for some piping codes (B31.3, B31.4, 
B31.5, B31.8, B31.1 (1967), CODETI, Canadian Z183 and Z184), corrosion allowance is 
used for reducing the section modulus and axial area only for calculating sustained and 
occasional stresses. 

Mill Tolerance 

The mill tolerance (in percent) is also used to reduce the wall thickness of the pipe while 
calculating allowable pressure. For example, if the mill tolerance is input as 12.5 (%), the pipe 
thickness (while calculating allowable pressure) is = 0.875 x nominal thickness. 

Reduced thickness = (1 − Mill tolerance/100) × nominal thickness − Corrosion allowance 

If defined while modeling, corrosion allowance, mill tolerance, insulation and lining densities 
are carried forward only for a new section definition.



Section 
 

402 

Insulation 

Type the pipe insulation density and thickness here. Click on the Insulation button for the 
insulation library, or enter your own. 

 

Highlight the desired insulation material and press Enter. The insulation density is entered on 
the section property dialog. CAEPIPE uses these values to calculate the insulation weight 
which is added to the weight of the pipe. 

Lining 

Lining is used to prevent internal corrosion that might occur during transportation of a gas 
or a fluid. CAEPIPE has the ability to model these protective coatings inside the pipe. 

 

Lining is different from insulation. Insulation is around and outside of the pipe. Lining is on 
the inside of the pipe. Both have respective thicknesses and densities. See previous figure. 

While calculating the weight of the fluid/gas inside the pipe, CAEPIPE accounts for lining 
thickness by reducing the pipe’s internal diameter by twice the lining thickness. 
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A Skewed Restraint is a two-way support that resists translation along or rotation about any 
specified direction at a node. You have to use either a manufacturer-supplied stiffness or 
calculate it for the support you want to model. 

Use this restraint to model sway braces, sway struts and similar supports. You can also use 
this to model vertical/horizontal supports, though it is used more commonly to resist lateral 
forces. 

The figure below shows an application. 

 

A skewed restraint is input by typing “sk” in the Data column or selecting “Skewed restraint” 
from the Data Types dialog. 
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The Skewed Restraint dialog is shown. 

 

Type 

Translational: Use this type to restrain translation along the specified direction.  

Rotational: Use this type to restrain rotation about the specified direction. 

Stiffness 

Type in the translational or rotational stiffness of the support. As an illustration, assume that 
you had a rod (in tension only) which you were modeling as a skewed restraint. You can 
calculate the stiffness (required to be input) in the following manner: Assume a 2.5 in. dia. 
rod 2 feet long, modulus of elasticity of rod material = 30×106 psi. 

The translational (axial) stiffness is 𝐴𝐴𝐸𝐸/L= 𝜋𝜋
4

(2.5)2 × 30 × 106/24=6,135,925 lb./in. 

The rotational stiffness is 𝐺𝐺𝐺𝐺/L = 𝐸𝐸
2(1+𝜈𝜈)

× 𝐺𝐺
𝐿𝐿

= 1,843,727 in.-lb./rad., where 𝐺𝐺 is the shear 

modulus, 𝜈𝜈 is the Poisson’s ration and 𝐺𝐺is polar moment of inertia. 

Direction 

If you have no “connected to node,” the direction in which the skewed restraint is oriented 
must be specified in terms of its global X, Y and Z components. See topic on specifying a 
Direction. 

Or use one of the preset buttons to orient the skewed restraint axis:  

1. Axial: To set the axis along the local-x direction (pipe axis) 

2. Shear y: To set the axis in the local-y direction 

3. Shear z: To set the axis in the local-z direction 

If you have connected the skewed restraint node to another node, then the direction must 
not be input. It is calculated from the locations of the skewed restraint node and the 
connected node, and it is oriented from the skewed restraint node towards the connected 
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node. In order for CAEPIPE to calculate the direction, the skewed restraint node and the 
connected node must not be coincident. 

Connected to node 

If the skewed restraint node is connected to an externally fixed point (ground), leave the 
“Connected to node” blank. You may connect a skewed restraint node to another node that 
is not coincident with the skewed restraint node. Note that during skewed restraint force 
calculations, the relative displacement of the skewed restraint node is calculated with respect 
to the connected node. 

Example: Modeling a Sway Brace 

Assume that we need to model two sway braces in the same arrangement as shown in the 
figure at the beginning of this section. The translational stiffness of the sway braces is given 
as 894 lb./in. As can be surmised from the figure, the orientation of the sway braces (sway 
struts in the figure) is at 45° from the X- and Y-axes. We shall model the support on the 
right hand side first followed by the support on the left hand side. 

The following steps describe the modeling procedure: 

 Create node (on pipeline) where support is required. In this case, the node is 50. 
Position highlight on this row.  

 First support (right): Type “sk” in the Data column to open the skewed restraint 
dialog box.  

Ensure that Type is set to Translational; if not, click on the Translational radio button. 
Type 894 for Stiffness, type 1 for Y comp and –1 for Z comp, press Enter.  
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 Second support (left): type 50 for Node on an empty row, press Tab to move to next 
field, press “l(L)” for Location. This will open the Data types dialog.  

 

Select Skewed restraint by clicking on it to open the skewed restraint dialog. Enter the 
skewed restraint dialog similar to the first skewed restraint except in this case type 1 for Z 
comp, press Enter. 

The Layout window is shown below: 

 

The graphics is shown below: 
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The rendered graphics is shown below: 
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A slip joint allows for axial (through telescopic action) and torsional movement between 
adjacent pipes (due to thermal expansion or contraction). The joint itself can be fixed using 
an anchor if so designed. Slip joints are susceptible to lateral buckling due to internal 
pressure, and may become less effective when subjected to small bending loads. Proper 
guiding to prevent buckling and keeping the two telescopic parts concentric are therefore 
necessary. 

Since the primary purpose of a slip joint is to absorb axial growth, the joint is ideal for 
placing it towards the end of long pipe runs, while its growth is directed axially by the use of 
one or more guides. 

A Slip Joint is input by typing “s” under the Type column or by selecting “Slip joint” from 
the Element types dialog. 

 

The Slip joint dialog is shown. 

 

A slip joint manufacturer should be able to provide you the required data for a slip joint. 

A slip joint will have axial deflection or rotation only when the external forces exceed the 
friction force or friction torque respectively. If the pressure thrust area is input, CAEPIPE 
imposes a thrust load of: Pressure x Thrust area on both nodes of the slip joint. The weight 
is the empty weight of the joint. The contents, insulation and additional weight are added to 
the empty weight. A slip joint is rigid in lateral directions. 
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Example: 

Assume that we want to model a (telescoping action) slip joint that allows only axial 
movement with no torsion. The outer sleeve of the joint is anchored to hold it in place while 
the other end is free to translate axially. The axial (friction) force has to exceed 1,100 lb. (you 
will need to get this datum from a manufacturer’s catalog) to make the slip joint move and 
the slip joint cannot rotate about the axial direction. So, the data would look similar to that 
shown next between nodes 30 and 40. 

 

And, the modeling on the layout screen would look thus: 
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See the topic on Nonlinearities for related information. 



Snubber 
 

412 

A snubber provides only translational restraint in a specified direction for seismic and 
dynamic cases only.  In other words, a snubber engages only during movements caused by a 
dynamic load.  It does not restrain against static loads such as weight and thermal. 

A snubber is input by typing “sn” in the Data column or selecting “Snubber” from the Data 
Types dialog. 

 

The Snubber dialog is shown. 

 

The stiffness defaults to Rigid, however a stiffness may be input for flexible snubbers. See 
section on specifying a Direction for information on X comp, Y comp, Z comp.  A snubber 
can be made active in any direction by using this combination of Direction Cosines (X comp, 
Y comp, and Z comp). 



Spider 
 

413 

Use a spider (also called a spacer) to connect the coincident nodes of a jacketed pipe (i.e., the 
node on the core pipe and the corresponding node on the jacket pipe). The spider acts as an 
internal guide. At the spider location, the local x-axis is calculated along the pipe direction. 
The spider connects the local y and z translations for the core and jacket nodes. It prevents 
any radial movement but allows sliding, rotating and bending movement between core and 
jacket pipes. No gap is allowed between the core pipe and the spider. See section on Jacketed 
pipe for related information. 

A spider is input at a jacketed pipe node by typing “sp” in the Data column or selecting 
“Spider” from the Data Types dialog. 
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CAEPIPE provides many support types, which enable you to model available support 
hardware. These support types are available under the Data types menu (See section on Data 
Types).  

 

You can use one or more types of supports to simulate a real-world support.  For example, 
you could use two lateral limit stops with unequal gaps to simulate a pipe shoe (see example 
under Limit Stop). 

To input more than one support at a node, use the “Location” data type. 

Anchor 

An anchor can be modeled as a flexible or rigid support which by default restrains the three 
global translations and rotations at the applied node (six degrees of freedom). Use this to 
model all anchor blocks, and nodes where piping connects to equipment (pumps, 
compressors, turbines, etc.).  

Restraint 

A restraint is a two-way rigid support which restrains the translations (negative and positive 
directions) along the specified global directions. You can apply a restraint in all the three 
directions at the same time. 

Skewed Restraint 

This is a flexible two-way support that can be oriented in any direction. Use this support to 
resist either translational movement along or rotational movement about the specified 
direction (as in a pipe sleeve which resists nonaxial rotation). Use this to model rigid or 
flexible sway struts and sway braces. 

Hanger, User hanger, Rod hanger, Constant support 

These should be used as vertical supports only. Use a Hanger when you want to design a 
variable spring hanger(s) for your piping system (there are 30+ hanger catalogs built-in to 
CAEPIPE for your convenience). Use a User hanger when you want to analyze hangers in an 
existing piping system. Use a Rod hanger for a rod hanger assembly. Use a Constant support 
to design a constant support or a constant effort hanger. 
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“Bottomed-out” Springs 

To analyze this situation, use a spring hanger and a limit stop at this node. Type in the 
maximum allowable hanger travel for one of the limits of the limit stop. Once the hanger 
traverses the maximum distance allowed, the limit stop becomes active. 

Guide 

A Guide is a rigid or flexible restraint which resists lateral pipe movements (in directions 
perpendicular to the axis of the pipe). You can specify an annular gap, if required, inside the 
guide. A friction coefficient is optional. Use a Guide to model U-straps, U-Bolts, pipe guide 
assemblies, pipe slides and similar supports. 

Limit stop 

A limit stop, a nonlinear restraint, can be oriented in any direction with a gap specified on 
both sides of the pipe. A limit stop allows free movement for the distance of the gap and 
then acts as a rigid or flexible restraint.   

A Line Stop is a support that restricts axial movement of pipe. This support can be modeled 
using a limit stop with its direction oriented along the pipe’s axis. Use this support to model 
pipe slide assemblies, pipe skirts and similar arrangements. See topic on Limit Stop for an 
example. 

A limit stop can be used to model 1-way supports for pipe racks where vertical downward 
movement is restrained while upward movement is not. See example for pipe rack modeling 
in the Beam topic. 

Refer to the respective CAEPIPE support term in Reference for a detailed explanation on it. 
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Physical tees, even though integral components, are not modeled as such in CAEPIPE.  
Instead, they are modeled as three pipes coming together at a common node. 

 

In this figure, you can see that three pipe elements (20-30, 30-40, and 30-60) come together 
at node 30 to form a tee. 
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Modeling 

The method of modeling is as simple as its representation. 

Step 1: 

You could model the pipe run first from 20 to 30 (1st element), then from 30 to 40 (2nd 
element), and finally, from 30 to 60 (3rd element).  See example layout window below. 

 
Alternately, you could model from 20 – 30 – 60, and then 30 – 40.  Or from 60 – 30 – 20, 
and then 30 – 40.  Modeling order is immaterial to analysis (but sometimes complicate the 
merge files process. See Merge under Layout window > Merge). 

Step 2: 

There is one final step remaining.  You need to designate the type of tee connection it is.  In 
this example, the tee is a “Welding Tee”.  So, on any row that contains node 30 (i.e., row #4 
or #8), type “Br” (Branch SIF) and select “Welding Tee” from the drop down list. 

 

The shown list is piping code-dependent.  In other words, the list of tee types shown comes 
from the selected piping code that dictates how an SIF for each of the listed tee types is 
calculated.  See Appendix D of B31 codes for more information (or see Appendix A in this 
manual which contains the same information from the B31 codes). 
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Based on a more rigorous analysis, if you have another more accurate SIF value for a joint 
you want to insert (instead of the code’s), then skip this step (2) and use User-SIF data type 
at the same node to input your own SIF. 

 

For 45° laterals, a piping code committee member opines: Use the SIF for an unreinforced 
fabricated tee and evaluate the branch stress using the section modulus of the branch. The 
connection footprint on the run pipe itself has a section modulus greater than the branch 
section modulus and this will compensate for the unreinforced fabricated tee SIF which 
should be lower than the unreinforced fabricated lateral SIF. Ignore the fact that a reduced 
outlet branch connection requires an “effective section modulus” in accordance with B31.1 
Para. 104.8.4(C) or B31.3 Para. 319.4.4(c) and just calculate the intensified stress as the 
unreinforced fabricated tee SIF x the branch moment / branch section modulus (whether 
you use the SIF times the resultant moment approach of B31.1 or the in-plane and out-plane 
SIFs times the in-plane and out-plane moments, respectively, approach of B31.3, use the 
same philosophy of ignoring the “effective modulus.” 

Pay particular attention to the fabrication of the lateral making sure that the Code required 
cover fillet dimensioned t(c) in B31.1 Fig. 127.4.8(D)(a) or B31.3 Fig. 328.5.4D(1) meets the 
required size. If the cover fillet is larger than t(c), that improves the lateral SIF. The figures 
and dimensions shown are a bit unfortunate, especially for a lateral because a strict reading of 
the Code would seem to require a bigger weld on the obtuse side of the branch and a smaller 
weld on the acute side of the branch when just the opposite is true. Having a constant cover 
fillet weld leg length all around the branch would improve the requirement and the 
committee has been working on that. Personally, I think the larger the run and branch pipes 
are, the larger the cover fillet should be. Ask for or calculate whether area replacement 
requirements B31.1 Para. 104.3.1(D) or B31.3 Para. 304.3.3 are met noticing that the required 
reinforcement for a lateral is greater by the factor (2 - sin alpha). 
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Tie rod is a nonlinear element with different stiffnesses and gaps in tension and compression, 
used to model tie rods in bellows, chains, etc. The force versus displacement relationship for 
a tie rod is shown below. Around expansion joints, a tie rod continuously restrains the full 
pressure thrust while allowing only lateral deflection,  bending and torsional rotation.  

 

When the tie rod is in tension, and the displacement is greater than the tension gap, tension 
stiffness is used. If the displacement is less than the tension gap, zero stiffness is used. 
Similarly when the tie rod is in compression, and the displacement is greater than the 
compression gap, compression stiffness is used. If the displacement is less than the 
compression gap, zero stiffness is used. A Tie rod is input by typing “t” in the Type column 
or selecting “Tie rod” from the Element Types dialog. 

 

The Tie Rod dialog is shown. 



Tie Rod 
 

421 

A tie rod can be made “Tension only” by setting the compression stiffness to zero. Similarly 
it can be made “Compression only” by setting the tension stiffness to zero. Both Tension 
and Compression stiffnesses cannot be zero. If there is no tension or compression gap, leave 
it blank or specify it as zero.  See the earlier “Expansion Joints” topic for examples. 
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Pumps, compressors and turbines in CAEPIPE, referred to as rotating equipment, are each 
governed by an industry publication — API (American Petroleum Institute) publishes an 
API 610 for pumps and an API 617 for compressors while NEMA (National Electrical 
Manufacturers Association) publishes the NEMA SM-23 for turbines. These publications 
provide guidelines for evaluating nozzles connected to equipment among other technical 
information including the items relevant to piping stress analysis – criteria for piping design 
and a table of allowable loads.  

Modeling the equipment is straightforward since it is assumed rigid (relative to connected 
piping) and modeled only through its end points (connection nozzles). 

1. In your model, anchor all of the nozzles (on the equipment) that need to be included in 
the analysis. 

2. Specify these anchored nodes during the respective equipment definition via Misc. menu 
> Pumps/Compressors/Turbines in the Layout window. 

CAEPIPE does not require you to model all of the nozzles nor their connected piping. For 
example, you may model simply one inlet nozzle of a pump with its piping. Or, you may 
model one pump with both nozzles (with no connected piping) and impose external forces 
on them (if you have that data). Further, there is no need to connect the two anchors of the 
equipment with a rigid massless element like required in some archaic methods. A flange and 
an anchor may coexist. 

A turbine (like a pump or a compressor) is input by selecting “Turbines” from the 
Miscellaneous (Misc) menu in the Layout window. CAEPIPE, upon analysis, produces a 
NEMA SM-23 turbine compliance report. See Appendix B (NEMA SM-23, for Turbines) 
for related information. 

 

Once you see the Turbine List window, double click on an empty row for the Turbine dialog 
and enter the required information. 
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A short description to identify the turbine may be entered for Description. The nozzle nodes 
must be anchors and the shaft axis must be in the horizontal plane. Some of the nozzle 
nodes may be left blank if they are not on the turbine (e.g., extraction nodes). 

See under Pumps for related modeling tips and under Specifying a Direction for information 
on how to specify X comp/Y comp/ Z comp for Shaft axis. 
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NEMA SM-23 Report 

 

See Appendix B, NEMA SM-23 for more information on how to interpret the report. 

Note: If you have input multiple temperatures and pressures, corresponding reports for 
additional operating load cases will be shown. Use the black left/right arrow key to see them. 
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Use the “User hanger” type for analyzing existing hangers different from hangers that need 
“to be designed” (for which you use the “Hanger” data type). For a hanger already designed 
and working, the spring rate and load are known and should be input here.  If not, leave 
them blank so that CAEPIPE can calculate them.  A user hanger is input by typing “u” in 
the Data column and pressing Enter or selecting “User Hanger” from the Data Types dialog. 

 

The User Hanger dialog is shown. 

 

Spring Rate 

The spring rate is required. For a constant support user hanger, input the spring rate as zero. 

Number of Hangers 

Type in the number of separate hangers connected in parallel at this node. The stiffness and 
load of each hanger are multiplied by the number of hangers to find the effective stiffness 
and load of the hanger support at this node. 

Hanger Load 

Input the hanger load, if known. Otherwise, leave it blank and CAEPIPE will calculate the 
load. 

Hanger Load 

The hanger load may be specified as hot or cold using the Load type radio buttons. 
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Connected to Node 

By default the hanger is connected to a fixed ground point which is not a part of the piping 
system. A hanger can be connected to another node in the piping system by entering the 
node number in the “Connected to node” field. This node must be directly above or below 
the hanger node. 
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User SIF (Stress Intensification Factor) may be used to specify SIF at a node where there is 
normally no SIF (i.e., non bend or non tee node) or to override calculated SIF at the node. 

Use this for any component that needs an SIF value – nonright angle tees, nonstandard tee 
or branch connection, flanges, etc. – for which the chosen piping code does not specify an 
SIF, or you want to override the code’s SIF. For example, in case of a bend or a tee, 
CAEPIPE calculates the SIF according to the selected piping code. To override the 
calculated SIF, specify a User SIF. Note that a User SIF is applied to all elements that come together at 
this node. 

A User SIF is input by typing “user s” in the Data column or selecting “User SIF” from the 
Data types dialog. 

 

Depending on the piping code, either a single value (B31.1) or both in-plane and out-of-
plane values of SIF (B31.3) may be required. The corresponding dialog will be shown. 

B31.1 code 

 

B31.3 code 
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Use this element to model any type of valve.  A valve is relatively more rigid than a pipe.  
CAEPIPE uses the data input to calculate the rigidity. 

A Valve is input by typing “v” in the Type column or selecting “Valve” from the Element 
Types dialog. 

 

The Valve dialog is shown. 

 

Weight 

The weight is the empty weight (without contents, insulation, etc.). CAEPIPE applies this 
weight as a uniformly distributed load along the length of the valve. Additional weight, if 
specified, is treated as a concentrated weight offset from the center of the valve. 

Length 

If the valve length is input, the DX, DY, DZ in Layout is adjusted to match the valve length. 
If the valve length is left blank, the valve length is calculated from DX, DY, DZ input in 
Layout.
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Thickness X 

The thickness multiplier (Thickness X) is used for stiffness calculation (i.e., the thickness of 
the pipe section is multiplied by Thickness multiplier in the calculation of the valve stiffness). 
Typical value for Thickness multiplier is 3 which is the default value if left blank. 

Insulation weight X 

The insulation weight multiplier (Insulation weight X) is used if the valve has additional 
insulation compared to adjacent pipe (i.e., weight of insulation calculated from the insulation 
thickness of the pipe section is multiplied by Insulation weight X multiplier). Typical value 
for insulation weight multiplier is 1.75 which is the default value if left blank. 

Additional weight 

The additional weight is a concentrated weight which may be specified at an offset from the 
center of the valve, such as for a valve operator.  

Valve Library 

Cast Iron, Steel and Alloy valve (Flanged and Butt Welding ends) libraries are provided. The 
Type of Valve, Connection Type and Rating are indicative in the filenames listed in the 
libraries. You need to input only the weight of a valve. If necessary, you may create your own 
user-definable valve library. A new valve library can be created from menu File > New > 
Valve Library in the main opening CAEPIPE window. 

Cast Iron, Steel and Alloy valve (Flanged and Butt Welding ends) libraries are provided. The 
Type of Valve, Connection Type and Rating are indicative in the filenames listed in the 
libraries. Valve weights are included for different categories of valves. If necessary, you may 
create your own user-definable valve library. A new valve library can be created from menu 
File > New > Valve Library in the main opening CAEPIPE window. 
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The valve library may be accessed by clicking on the Library button of the Valve dialog. 
Navigate to the folder called “Valve_Library” or similar under your CAEPIPE program files 
folder. 
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Selecting one of these valve types will display a list of valves for you to select from. 

 

Select one from the displayed list. The weights of the valves (in the Extended Library) are 
provided. If a valve is flanged, the flanges at the two ends must be separately input using the 
Flange data type and their weight accounted for. If you however import a flanged valve from 
the library, it may already have that weight built-in. Please confirm the data with your valve 
manufacturer’s catalog, and input the correct weight. 
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Calculation of Moment of Inertia: 

The inside diameter of the valve is calculated from the section O.D. (outside dia.) and the 
section thickness. 

I.D. = O.D. − 2 × Thickness 

Then a new O.D. is calculated as: 

New O.D. = I.D. (inside dia.) + 2 × Thickness × Multiplier 

The moment of inertia is based on the new O.D. and Thickness x Multiplier. For a thin-
walled pipe, Thickness and Inertia multipliers are approximately the same. The weight of the 
contents of the valve is based on the I.D. as calculated above. The weight of the insulation is 
the weight calculated from the section O.D. and insulation thickness and density (from 
section properties) multiplied by the insulation weight multiplier. 

Angle/Relief Valve 

Angle and relief valves which have the outlet pipe at some angle (typically 90°) from the inlet 
pipe may be modeled by two valves one after the other and at that angle. The total weight of 
the actual valve must be divided between these two modeled valves. 

Analysis note: For a relief valve, you need to calculate the relief valve force and input it at 
the valve node as a Force (CAEPIPE treats it as a sustained load). Then, input a dummy g-
load (e.g., 0.01g) and select Static Seismic for analysis. In results, review the occasional 
stresses which will include the effects of Sustained and Occasional loads. You will have to 
ignore the excessive Sustained stress at the node where the relief valve load (via a Force) was 
input. Examine the occasional stress with respect to the occasional allowable (1.2Sh), not the 
Sustained allowable (Sh).  

Performing the above analyses in two separate runs will help. 

Also, see discussion towards end of the “Force Spectrum Analysis” topic. 
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Use this data type to input a Weld at a node. Type “w” in the Data column or select “Weld” 
from the Data types dialog. 

 

The Weld dialog is shown. Four types of welds are available: Butt, Fillet, Concave Fillet, and 
a Tapered transition. The type of the weld should be selected from the “Type” drop-down 
combo box. 

 

Butt weld and Tapered transition require the input of weld mismatch. Mismatch is the 
difference in the mean radii across the weld. 

 

The SIF for a weld is calculated according to the selected piping code (see Appendix A for 
details). If you have an unlisted weld type, you could specify the SIF for it using the User SIF 
data type. 
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Allowable Pressure 

At this time, there is no provision in CAEPIPE to specify the type of pipe construction, i.e., 
whether the pipe is a seamless or longitudinal welded or spiral welded. Accordingly, 
irrespective of the type of pipe construction, CAEPIPE calculates allowable pressure as 
follows. 

For straight pipes and bends with seamless construction or designed for sustained operation 
below the creep range, Eq. (9) of para.104.1.2 is used as given below to compute allowable 
pressure. 

𝑃𝑃𝑎𝑎 =
2𝑆𝑆𝐸𝐸𝑑𝑑𝑎𝑎

𝑝𝑝𝑑𝑑 − 2𝑌𝑌𝑑𝑑𝑎𝑎
 

For straight pipes and bends designed for sustained operation within the creep range, Eq. 
(11) of para.104.1.4 is used as given below to calculate allowable pressure. 

𝑃𝑃𝑎𝑎 =
2𝑆𝑆𝐸𝐸𝑊𝑊𝑑𝑑𝑎𝑎
𝑝𝑝𝑑𝑑 − 2𝑌𝑌𝑑𝑑𝑎𝑎

 

where 
𝑃𝑃𝑎𝑎  =  allowable pressure 
𝑆𝑆𝐸𝐸 =  allowable stress as given in Appendix A of B31.1 (2012) Code, where 
𝐸𝐸 = weld joint efficiency factor or casting quality factor as given in Table 102.4.3 
𝑑𝑑𝑎𝑎  = available thickness for pressure design = 𝑑𝑑𝑑𝑑× (1 - mill tolerance/100) - corrosion 

 allowance 
(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 

included in corrosion allowance in CAEPIPE) 
𝑑𝑑𝑑𝑑  = nominal pipe thickness 
𝑝𝑝𝑑𝑑  = outside diameter of pipe 
𝑑𝑑 = inside diameter of pipe 
The Pressure coefficient Y is implemented as per Table 104.1.2 (A). In addition, 
𝑌𝑌 = 0.0, for cast iron and non-ferrous materials. 
𝑌𝑌 = 𝑌𝑌 = 𝑑𝑑

𝑑𝑑+𝑝𝑝𝑑𝑑
 ,if Do/ta<6, for ferritic and austenitic steels designed for temperatures of 

 900oF (480oC) and below 
𝑊𝑊 = weld strength reduction factor as per Table 102.4.7. Refer to Annexure B for details 

 on Weld strength reduction factor implemented in CAEPIPE. 

For closely spaced miter bends, the allowable pressure is calculated from Eq. (C.3.1) of 
para.104.3.3. 

𝑃𝑃𝑎𝑎 =
𝑆𝑆𝐸𝐸𝑑𝑑𝑎𝑎(𝑅𝑅 − 𝑃𝑃)
𝑃𝑃(𝑅𝑅 − 𝑃𝑃/2)  

where 
𝑃𝑃 = mean radius of pipe = (𝑝𝑝𝑂𝑂 − 𝑑𝑑𝑑𝑑)/2 
𝑅𝑅 = equivalent bend radius of the miter 

For widely spaced miter bends, the allowable pressure is calculated from Eq. (C.3.2) of para. 
104.3.3. 

𝑃𝑃𝑎𝑎 =
𝑆𝑆𝐸𝐸𝑑𝑑𝑎𝑎2

𝑃𝑃�𝑑𝑑𝑎𝑎 + 1.25 tan𝜃𝜃�𝑃𝑃𝑑𝑑𝑎𝑎�
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Where, 𝜃𝜃 = miter half angle 

Sustained Stress 

The stress (SL) due to sustained loads (pressure, weight and other sustained mechanical loads) 
is calculated from Eq. 15 of para.104.8.1 

𝑆𝑆𝐿𝐿 =
𝑃𝑃𝑝𝑝𝑑𝑑
4𝑑𝑑𝑑𝑑

+
0.75𝑑𝑑𝑀𝑀𝐴𝐴

𝑍𝑍
≤ 𝑆𝑆ℎ  

 
where 
𝑃𝑃 = maximum of CAEPIPE pressures P1 through P10 
𝑝𝑝𝑑𝑑  = outside diameter 
𝑑𝑑𝑑𝑑  = nominal wall thickness 
𝑑𝑑 = stress intensification factor. The product 0.75i shall not be less than 1.0. 
𝑀𝑀𝐴𝐴 = resultant bending moment due to weight and other sustained loads 
𝑍𝑍 = uncorroded section modulus; for reduced outlets, effective section modulus as per  

 para. 104.8.4 
𝑆𝑆ℎ  = hot allowable stress at maximum CAEPIPE temperature [i.e., at max (Tref, T1 

 through T10)] 

Occasional Stress 

The stress (𝑆𝑆𝐿𝐿𝑑𝑑) due to occasional loads is calculated from Eq. 16 of para.104.8.2 as the sum 
of stress due to sustained loads (𝑆𝑆𝐿𝐿) and stress due to occasional loads (𝑆𝑆𝑑𝑑) such as 
earthquake or wind. Wind and earthquake are not considered concurrently. 

𝑆𝑆𝐿𝐿𝑑𝑑 =
𝑃𝑃𝑝𝑝𝑃𝑃𝑎𝑎𝐺𝐺 𝑝𝑝𝑑𝑑

4𝑑𝑑𝑑𝑑
+

0.75𝑑𝑑𝑀𝑀𝐴𝐴

𝑍𝑍
+

0.75𝑑𝑑𝑀𝑀𝐵𝐵

𝑍𝑍
≤ 1.2𝑆𝑆ℎ  

where 
𝑀𝑀𝐵𝐵  = resultant bending moment on the cross-section due to occasional loads such  

 as thrusts from relief / safety valve loads, from pressure and flow transients, 
 earthquake, wind etc. 

𝑃𝑃𝑝𝑝𝑃𝑃𝑎𝑎𝐺𝐺   = peak pressure = (peak pressure factor in CAEPIPE) x P 

Expansion Stress Range(i.e., Stress due to Displacement Load Range) 

The stress (SE) due to thermal expansion is calculated from Eq. 17 of para.104.8.3. 

𝑆𝑆𝐸𝐸 =
𝑑𝑑𝑀𝑀𝐶𝐶

𝑍𝑍
≤ 𝑆𝑆𝐴𝐴 

where 
𝑀𝑀𝐶𝐶 = resultant moment due to thermal expansion 
𝑆𝑆𝐴𝐴 = 𝑓𝑓(1.25𝑆𝑆𝐶𝐶 + 0.25𝑆𝑆ℎ), from Eq. (1A) of para. 102.3.2 (B) 

 
𝑓𝑓 = cyclic stress range reduction factor from Eq.(1C) of para. 102.3.2(B), 
𝑓𝑓 = 6

N0.2 ≤ 1.0 and f ≥ 0.15 with N being the total number of equivalent reference 
 displacement stress range cycles expected during the service life of the piping 

𝑆𝑆𝐶𝐶 = basic allowable stress as minimum metal temperature expected during the 
 displacement cycle under analysis 

𝑆𝑆ℎ  = basic allowable stress as maximum metal temperature expected during the 
 displacement cycle under analysis 

When 𝑆𝑆ℎ  is greater than 𝑆𝑆𝐿𝐿, the allowable stress range may be calculated as  
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𝑆𝑆𝐴𝐴 = 𝑓𝑓[1.25(𝑆𝑆𝐶𝐶 + 𝑆𝑆ℎ) − 𝑆𝑆𝐿𝐿], from Eq. (1B) of para. 102.3.2 (B) 

This is specified as an analysis option: “Use liberal allowable stresses”, in the menu Options-
>Analysis on the Code tab of CAEPIPE.  

Note: 

Refer to Thickness and Section Modulus towards the end of this appendix. 
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Weld Strength Reduction Factors applied for calculating the Allowable Design 
Pressure of components (extracted from Table 102.4.7 of ASME B31.1-2012). 

Sl. 
No. Steel Group 

Weld Strength Reduction Factor for Temperature,  °F (°C) 

700 750 800 850 900 950 1000 1050 1100 1150 1200 

(371) (399) (427) (454) (482) (510) (538) (566) (593) (621) (649) 

1 Carbon 
Steel (CS) 
with Max. 
Temp in 
CAEPIPE 
is <= 800 
[see note 1 
below] 

1.00 0.95 0.91 NP NP NP NP NP NP NP NP 

2 Carbon 
Steel (CS) 
with Max. 
Temp in 
CAEPIPE 
> 800 

- - 1.00 0.95 0.91 0.86 0.82 0.77 0.73 0.68 0.64 

3 Ferritic 
Steels (FS) 

1.00 1.00 1.00 1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 

4 Austenitic 
Steel (AS) 
[contd. in 
note 2 
below] 

1.00 1.00 1.00 1.00 1.00 1.00 0.95 0.91 0.86 0.82 0.77 

5 Materials 
other than 
those stated 
from Sl. 
Nos. 1 to 4 

1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 1.00 

Notes: 

1. NP = Not permitted 
2. For Austenitic Steels (including 800H and 800 HT) the values up to 1500°F are as 

follows: 
Temperature, °F  Temperature, °C Weld Strength Reduction Factor 

 1250    677    0.73 
 1300    704    0.68 
 1350    732    0.64 
 1400    760    0.59 
 1450    788    0.55 
 1500    816    0.50
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Allowable Internal Pressure 

For straight pipes and bends, the allowable pressure is calculated using Eq. (3a) for straight 
pipes and Eq. (3c) with I = 1.0 for bends from paras. 304.1.2. and 304.2.1. respectively. 

𝑃𝑃𝑎𝑎 =
2𝑆𝑆𝐸𝐸𝑊𝑊𝑑𝑑𝑎𝑎
𝑝𝑝 − 2𝑌𝑌𝑑𝑑𝑎𝑎

 

where 
𝑃𝑃𝑎𝑎  = allowable pressure 
𝑆𝑆 = allowable stress as provided in para. 302.3.1 (a) and as per Table A-1 
𝐸𝐸 = joint factor (input as material property) from Table A-1A or A-1B from para. 302.3.3. 

 and para. 302.3.4. 
𝑊𝑊 = Weld Joint Strength Reduction Factor from para. 302.3.5 (e) and as per Table 302.3.5 

 is implemented in CAEPIPE as follows. Tmax  below denotes maximum operating 
 temperature (i.e., max of T1 through T10  and Tref  in CAEPIPE). 

  
  With Material Type in CAEPIPE = CS [CrMo] 
  𝑊𝑊 = 1.0 with Tmax  ≤ 8000 F (or 4270 C) 
  𝑊𝑊 = 0.64 with Tmax > 12000F (or 6490 C) and  
  For Tmax > 8000 F (or 4270 C) and ≤  12000 F (or 6490 C), the values of 𝑊𝑊 are taken 

 from Table 302.3.5.  
  𝑊𝑊 for intermediate temperatures are linearly interpolated. 
  With Material Type in CAEPIPE = FS [CSEF (Subcritical)] 
  𝑊𝑊 = 1.0 with Tmax  ≤  9000 F (or 4820 C) 
  𝑊𝑊 = 0.5 with Tmax > 9000 F (or 4820 C) 
  With Material Type in CAEPIPE = AS or NA 
  𝑊𝑊 = 1.0 with Tmax  ≤ 9500 F (or 5100 C) 
  For Tmax > 9500 F (or 5100 C), the values of 𝑊𝑊 are taken as per Table 302.3.5.  
  𝑊𝑊 for intermediate temperatures are linearly interpolated. 
  With Material Type in CAEPIPE = SS 
  𝑊𝑊 = 1.0 with Tmax  ≤ 15000 F (or 8160 C) 
  For Other Material Types in CAEPIPE 
  𝑊𝑊 = 1.0 with Tmax  ≤ 8000 F (or 4270 C) 
  𝑊𝑊 = 1 – 0.000909 (Tmax − Tcr ) for Tmax > 8000 F (or 4270 C) and≤ 15000F (or 

 8100C) 
  where, Tcr  is taken as 8000 F 
 
𝑑𝑑𝑎𝑎  = available thickness for pressure design  
 = 𝑑𝑑𝑑𝑑× (1 - mill tolerance/100) - corrosion allowance “c” 
(Any additional thickness required for threading, grooving, erosion, corrosion, etc. should be 
included in corrosion allowance in CAEPIPE) 
𝑑𝑑𝑑𝑑  = nominal pipe thickness 
𝑝𝑝 = outside diameter 
𝑑𝑑 = inside diameter 
𝑌𝑌 = Pressure coefficient from Table 304.1.1, valid for 𝑑𝑑𝑎𝑎 < 𝑝𝑝/6, and  

𝑌𝑌 = 
𝑑𝑑+2𝑐𝑐

𝑝𝑝+𝑑𝑑+2𝑐𝑐
 , valid for 𝑑𝑑𝑎𝑎 ≥ 𝑝𝑝/6 
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For closely spaced miter bends, the allowable pressure is calculated using Eq. (4b) from para. 
304.2.3. 

𝑃𝑃𝑎𝑎 =
𝑆𝑆𝐸𝐸𝑊𝑊𝑑𝑑𝑎𝑎(𝑅𝑅 − 𝑃𝑃)
𝑃𝑃(𝑅𝑅 − 𝑃𝑃/2)  

where 
𝑃𝑃 = mean radius of pipe = (D- tn)/2 
𝑅𝑅 = effective bend radius of the miter (see para. 304.2.3 of code for definition) 
For widely spaced miter bends, the allowable pressure is calculated using Eq. (4c) from para. 
304.2.3 as 

𝑃𝑃𝑎𝑎 =
𝑆𝑆𝐸𝐸𝑊𝑊𝑑𝑑𝑎𝑎2

𝑃𝑃�𝑑𝑑𝑎𝑎 + 1.25 tan𝜃𝜃 �𝑃𝑃𝑑𝑑𝑎𝑎� 
where 
𝜃𝜃 = miter half angle 

Sustained Stress 

The stress (𝑆𝑆𝐿𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated using Eq. (23a) and (23b) from para. 320.2 and para. 302.3.5 (c). 

𝑆𝑆𝐿𝐿 = �(|𝑆𝑆𝑎𝑎 | + 𝑆𝑆𝑏𝑏)2 + (2𝑆𝑆𝑑𝑑)2 ≤ 𝑆𝑆ℎ  

where 

𝑆𝑆𝑎𝑎 = �
𝐼𝐼𝑎𝑎𝐹𝐹𝑎𝑎
𝐴𝐴𝑝𝑝

�
𝑆𝑆𝑃𝑃𝑃𝑃𝑑𝑑𝑎𝑎𝑑𝑑𝑑𝑑𝑃𝑃𝑑𝑑

= �
𝑃𝑃𝑝𝑝
4𝑑𝑑𝑃𝑃

+
𝑅𝑅
𝐴𝐴𝑝𝑝
�
𝑆𝑆𝑃𝑃𝑃𝑃𝑑𝑑𝑎𝑎𝑑𝑑𝑑𝑑𝑃𝑃𝑑𝑑

 

𝑆𝑆𝑏𝑏 = �
�(𝐼𝐼𝑑𝑑𝑀𝑀𝑑𝑑)2 + (𝐼𝐼𝑑𝑑𝑀𝑀𝑑𝑑)2

𝑍𝑍𝑚𝑚
�
𝑆𝑆𝑃𝑃𝑃𝑃𝑑𝑑𝑎𝑎𝑑𝑑𝑑𝑑𝑃𝑃𝑑𝑑

 

𝑆𝑆𝑑𝑑 = �
𝐼𝐼𝑑𝑑𝑀𝑀𝑑𝑑

2𝑍𝑍𝑚𝑚
�
𝑆𝑆𝑃𝑃𝑃𝑃𝑑𝑑𝑎𝑎𝑑𝑑𝑑𝑑𝑃𝑃𝑑𝑑  

𝑃𝑃 = maximum of CAEPIPE input pressures P1 through P10 
𝑝𝑝 = outside diameter 
𝑑𝑑𝑆𝑆 = wall thickness used for sustained stress calculation after deducting corrosion 

 allowance from the nominal thickness  
𝑑𝑑𝑆𝑆 = nominal thickness – corrosion allowance in CAEPIPE, as per para. 320.1 
𝐴𝐴𝑝𝑝  = corroded cross-sectional area of the pipe computed using ts as per para. 320.1. 
𝐼𝐼𝑎𝑎  = longitudinal force index = 1.0 
𝐹𝐹𝑎𝑎  = longitudinal force due to sustained loads (pressure and weight) 
𝑅𝑅 = axial force due to weight 
𝐼𝐼𝑑𝑑  = in-plane stress intensification factor; the product of0.75𝑑𝑑𝑑𝑑shall not be less than 1.0 
𝐼𝐼𝑑𝑑  = out-of-plane stress intensification factor; the product of 0.75𝑑𝑑𝑑𝑑shall not be less than 

 1.0 
𝐼𝐼𝑑𝑑  = torsional moment index = 1.0 
𝑀𝑀𝑑𝑑  = in-plane bending moment due to sustained loads e.g., pressure and weight 
𝑀𝑀𝑑𝑑  = out-of-plane bending moment due to sustained loads e.g., pressure and weight 
𝑀𝑀𝑑𝑑  = torsional moment due to sustained loads e.g., pressure and weight 
𝑍𝑍𝑚𝑚  = corroded section modulus as per para. 320.1; for reduced outlets / branch 

 connections, effective section modulus 
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𝑍𝑍𝑚𝑚  = hot allowable stress at maximum temperature [i.e., at Max(Tref, T1 through T10)] 

Sustained plus Occasional Stress 

The stress (𝑆𝑆𝐿𝐿𝑑𝑑) due to sustained and occasional loads is calculated as the sum of stress due 
to sustained loads such as due to pressure and weight (𝑆𝑆𝐿𝐿) and stress due to occasional loads 
(𝑆𝑆𝑑𝑑) such as due to earthquake or wind. Wind and earthquake are not considered 
concurrently (see para. 302.3.6(a)). 

For temp ≤ 4270 C or 8000 F 

𝑆𝑆𝐿𝐿𝑂𝑂 ≤ 1.33𝑆𝑆ℎ  

For temp > 4270 C or 8000 F 

𝑆𝑆𝐿𝐿𝑂𝑂 ≤ 0.9𝑊𝑊𝑆𝑆
 

where 
𝑆𝑆𝐿𝐿𝑂𝑂 = 𝑆𝑆𝐿𝐿 + 𝑆𝑆𝑂𝑂 , where 𝑆𝑆𝐿𝐿 is computed as above, and 

𝑆𝑆𝑂𝑂 = �(|𝑆𝑆𝑎𝑎𝑑𝑑 | + 𝑆𝑆𝑏𝑏𝑑𝑑 )2 + (2𝑆𝑆𝑑𝑑𝑑𝑑 )2 

𝑆𝑆𝑎𝑎𝑑𝑑 = �
𝐼𝐼𝑎𝑎𝐹𝐹𝑎𝑎
𝐴𝐴𝑝𝑝

�
𝑂𝑂𝑐𝑐𝑐𝑐𝑎𝑎𝑃𝑃𝑑𝑑𝑑𝑑𝑑𝑑𝑎𝑎𝑑𝑑

= �
�𝑃𝑃𝑝𝑝𝑃𝑃𝑎𝑎𝐺𝐺 − 𝑃𝑃�𝑝𝑝

4𝑑𝑑𝑃𝑃
+
𝑅𝑅
𝐴𝐴𝑝𝑝
�
𝑂𝑂𝑐𝑐𝑐𝑐𝑎𝑎𝑃𝑃𝑑𝑑𝑑𝑑𝑑𝑑𝑎𝑎𝑑𝑑

 

𝑆𝑆𝑏𝑏𝑑𝑑 = �
�(𝐼𝐼𝑑𝑑𝑀𝑀𝑑𝑑)2 + (𝐼𝐼𝑑𝑑𝑀𝑀𝑑𝑑)2

𝑍𝑍𝑚𝑚
�
𝑂𝑂𝑐𝑐𝑐𝑐𝑎𝑎𝑃𝑃𝑑𝑑𝑑𝑑𝑑𝑑𝑎𝑎𝑑𝑑

 

𝑆𝑆𝑑𝑑𝑑𝑑 = �
𝐼𝐼𝑑𝑑𝑀𝑀𝑑𝑑

2𝑍𝑍𝑚𝑚
�
𝑂𝑂𝑐𝑐𝑐𝑐𝑎𝑎𝑃𝑃𝑑𝑑𝑑𝑑𝑑𝑑𝑎𝑎𝑑𝑑

 

𝑃𝑃𝑝𝑝𝑃𝑃𝑎𝑎𝐺𝐺  = peak pressure = (peak pressure factor in CAEPIPE) x P 
𝑅𝑅 = axial force due to occasional loads such as earthquake or wind 
𝑀𝑀𝑑𝑑  = in-plane bending moment due to occasional loads such as earthquake or wind 
𝑀𝑀𝑑𝑑  = out-of-plane bending moment due to occasional loads such as earthquake or wind 
𝑀𝑀𝑑𝑑  = torsional moment due to occasional loads such as earthquake or wind 
𝑆𝑆𝑦𝑦  = yield strength at maximum temperature, i.e., max (Tref, T1 through T10) 
𝑊𝑊 = 1.0 for Austenetic stainless steel and 0.8 for all other materials as per para. 

302.3.6(a) 

Expansion Stress 

The stress (𝑆𝑆𝐸𝐸) due to thermal expansion is calculated using Eq. 17 from para. 319.4.4 

𝑆𝑆𝐸𝐸 = �(|𝑆𝑆𝑎𝑎 | + 𝑆𝑆𝑏𝑏)2 + (2𝑆𝑆𝑑𝑑)2 

where 

 

𝑆𝑆𝑎𝑎 = �
𝐼𝐼𝑎𝑎𝐹𝐹𝑎𝑎
𝐴𝐴𝑝𝑝

�
𝐸𝐸𝑚𝑚𝑝𝑝𝑎𝑎𝑑𝑑𝑃𝑃𝑑𝑑𝑑𝑑𝑑𝑑
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𝑆𝑆𝑏𝑏 = �
�(𝐼𝐼𝑑𝑑𝑀𝑀𝑑𝑑)2 + (𝐼𝐼𝑑𝑑𝑀𝑀𝑑𝑑)2

𝑍𝑍
�
𝐸𝐸𝑚𝑚𝑝𝑝𝑎𝑎𝑑𝑑𝑃𝑃𝑑𝑑𝑑𝑑𝑑𝑑

 

𝑆𝑆𝑑𝑑 = �
𝐼𝐼𝑑𝑑𝑀𝑀𝑑𝑑

2𝑍𝑍
�
𝐸𝐸𝑚𝑚𝑝𝑝𝑎𝑎𝑑𝑑𝑃𝑃𝑑𝑑𝑑𝑑𝑑𝑑

 

𝐴𝐴 = un-corroded cross-sectional area of the pipe/fitting computed using nominal 
 thickness 𝑑𝑑𝑑𝑑  and outer diameter D, as per para. 319.3.5. 

𝐼𝐼𝑎𝑎  = axial stress intensification factor = 1.0 for elbows, pipe bends and miter bends and 
 𝐼𝐼𝑎𝑎 = 𝐼𝐼𝑑𝑑for other components as listed in Appendix D of B31.3 (2012) 

𝐹𝐹𝑎𝑎  = range of axial forces due to displacement strains between any two thermal conditions 
 being evaluated 

𝐼𝐼𝑑𝑑  = in-plane stress intensification factor; the product of 0.75𝑑𝑑𝑑𝑑  shall not be less than 1.0 
𝐼𝐼𝑑𝑑  = out-of-plane stress intensification factor; the product of 0.75𝑑𝑑𝑑𝑑  shall not be less than 

 1.0 
𝐼𝐼𝑑𝑑  = torsional stress intensification factor = 1.0 
𝑀𝑀𝑑𝑑  = in-plane bending moment  
𝑀𝑀𝑑𝑑  = out-of-plane bending moment  
𝑀𝑀𝑑𝑑  = torsional moment 
𝑍𝑍 = uncorroded section modulus as per para. 319.3.5; for reduced outlets/branch

 connections, effective section modulus as per para. 319.4.4 (c) 
𝑆𝑆𝐴𝐴 = 𝑆𝑆𝐴𝐴 = 𝑓𝑓(1.25𝑆𝑆𝐶𝐶 + 0.25𝑆𝑆ℎ), Eq. (1a) of para. 302.3.5(d) 
𝑓𝑓 = stress range reduction factor from Eq. (1c) of para. 302.3.5 (d) = 6N-0.2 
  where f ≥ 0.15 and f ≤ 1.0 (see Note 1 below) 
𝑆𝑆𝐶𝐶 = basic allowable stress as minimum metal temperature expected during the 

 displacement cycle under analysis 
𝑆𝑆ℎ  = basic allowable stress as maximum metal temperature expected during the 

 displacement cycle under analysis 
When 𝑆𝑆ℎ  is greater than 𝑆𝑆𝐿𝐿, the allowable stress range may be calculated as  
𝑆𝑆𝐴𝐴 = 𝑓𝑓[1.25(𝑆𝑆𝐶𝐶 + 𝑆𝑆ℎ) − 𝑆𝑆𝐿𝐿], Eq. (1b) of para. 302.3.5(d).

 

This is specified as an analysis option “Use liberal allowable stresses”, in the menu Layout > 
Options > Analysis > Code tab. 

 Notes: 

1. As per para. 302.3.5 (d), f = maximum value of stress range factor; 1.2 for ferrous 
materials with specified minimum tensile strengths ≤ 517 MPa (75 ksi) and at Metal 
temperatures ≤ 3710°C (7000°F). This criterion is not implemented in CAEPIPE as the 
provision for entering the minimum tensile strength in material property is not available 
at this time. Hence f ≤ 1.0 for all materials including Ferrous materials. 

2. Refer end of this appendix for the details of “Thickness and Section Modulus used for 
weight, pressure and stress calculations”.
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from 104.1.2. 

𝑃𝑃 =
2𝑆𝑆𝐸𝐸𝑑𝑑𝑚𝑚

𝑝𝑝 − 2𝑌𝑌𝑑𝑑𝑚𝑚
 

where 
𝑃𝑃 = allowable pressure 
𝑆𝑆 = allowable stress 
𝐸𝐸 = joint factor (input as material property) 
𝑑𝑑𝑚𝑚  = minimum required thickness, including mechanical, corrosion, and erosion  
  allowances 
 = 𝑑𝑑 ×(1 – mill tolerance/100) – corrosion allowance 
𝑑𝑑 = nominal pipe thickness 
𝑝𝑝 = outside diameter 
𝑑𝑑 = inside diameter 
𝑌𝑌 = pressure coefficient from Table 104.1.2(a)2  

Sustained Stress 

The stress𝑆𝑆𝐿𝐿due to sustained loads (pressure, weight and other sustained mechanical loads) is 
calculated from 102.3.2(d) 

𝑆𝑆𝐿𝐿 =
𝑃𝑃𝑝𝑝
4𝑑𝑑𝑚𝑚

+
�(𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2 + (𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2

𝑍𝑍
≤ 𝑆𝑆ℎ  

where 
𝑃𝑃 = maximum pressure 
𝑝𝑝 = outside diameter 
𝑑𝑑𝑚𝑚  = minimum wall thickness  
𝑑𝑑𝑑𝑑  = in-plane stress intensification factor 
𝑑𝑑𝑑𝑑  = out of plane stress intensification factor 
𝑀𝑀𝑑𝑑  = in-plane bending moment 
𝑀𝑀𝑑𝑑  = out of plane bending moment 
𝑍𝑍 = section modulus 
𝑆𝑆ℎ  = hot allowable stress 

Occasional Stress 

The stress 𝑆𝑆𝐿𝐿𝑂𝑂  is calculated as the sum of stress due to sustained loads 𝑆𝑆𝐿𝐿 and stress due to 
occasional loads 𝑆𝑆𝑂𝑂  such as earthquake or wind. Wind and earthquake are not considered 
concurrently (102.3.1). 

𝑆𝑆𝐿𝐿𝑂𝑂 = 𝑆𝑆𝐿𝐿 +
�(𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2 + (𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2

𝑍𝑍
≤ 1.2𝑆𝑆ℎ 
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Expansion Stress 

The stress (𝑆𝑆𝐸𝐸) due to thermal expansion is calculated from (119.6.4). 

𝑆𝑆𝐸𝐸 = �𝑆𝑆𝑏𝑏2 + 4𝑆𝑆𝑑𝑑2 ≤ 𝑆𝑆𝐴𝐴 

where 
𝑆𝑆𝑏𝑏  = resultant bending stress = �(𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2 + (𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2/𝑍𝑍 
𝑆𝑆𝑑𝑑  = torsional stress = 𝑀𝑀𝑑𝑑/2Z 
𝑍𝑍 = uncorroded section modulus, for a branch, effective section modulus 
𝑆𝑆𝐴𝐴 = 𝑓𝑓(1.25𝑆𝑆𝑐𝑐 + 0.25𝑆𝑆ℎ) 
𝑆𝑆𝑐𝑐  = allowable stress at cold temperature 
f = stress range reduction factor from Table 102.3.2(c). 
When 𝑆𝑆ℎ  is greater than 𝑆𝑆𝐿𝐿 , the allowable stress range may be calculated as 

𝑆𝑆𝐴𝐴 = 𝑓𝑓[1.25(𝑆𝑆𝑐𝑐 + 𝑆𝑆ℎ) − 𝑆𝑆𝐿𝐿] 

This is specified as an option (Use liberal allowable stresses) in the menu Options > Analysis 
on the Code tab. 
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Allowable Pressure 

For straight pipes and bends (including closely spaced and widely spaced miter bends), the 
allowable pressure is calculated from para. 403.2.1. 

𝑃𝑃𝑑𝑑 =
2𝑆𝑆𝐸𝐸𝑑𝑑𝑎𝑎
𝑝𝑝

 

where 
𝑃𝑃𝑑𝑑  = allowable pressure 
𝑆𝑆 =  allowable stress = 0.72 Sy 

𝑆𝑆𝑦𝑦  =  specified minimum yield strength of pipe 
𝐸𝐸 = weld joint factor as defined in Table 403.2.1-1 
𝑑𝑑𝑎𝑎  =  available thickness for pressure design 
 = 𝑑𝑑𝑑𝑑 ×(1 – mill tolerance/100) – sum of allowances, as per para. 403.2.1, for 

 corrosion, threading, grooving and erosion. 
𝑝𝑝 = outside diameter 

Stress due to Sustained Loads (Unrestrained Piping) 

For Pipes (as per para. 402.6.2) 

𝑆𝑆𝐿𝐿 = �
𝑃𝑃𝑝𝑝
4𝑑𝑑𝑑𝑑

+
𝐹𝐹𝑎𝑎
𝐴𝐴
�
𝑆𝑆𝑃𝑃𝑃𝑃𝑑𝑑𝑎𝑎𝑑𝑑𝑑𝑑𝑃𝑃𝑑𝑑

+ �
�(𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2 + (𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2 + (𝑀𝑀𝑑𝑑)2

𝑍𝑍 �
𝑆𝑆𝑃𝑃𝑃𝑃𝑑𝑑𝑎𝑎𝑑𝑑𝑑𝑑𝑃𝑃𝑑𝑑

≤ 0.75𝑆𝑆𝑦𝑦  

as per Table 403.3.1-1

 where 

𝑑𝑑𝑑𝑑  = in-plane stress intensification factor = 1.0 for pipes 
𝑑𝑑𝑑𝑑  = out-of-plane stress intensification factor = 1.0 for pipes 

For Fittings & Components.(as per para. 402.6.2) 

𝑆𝑆𝐿𝐿(𝑓𝑓𝑐𝑐) = �
𝑃𝑃𝑝𝑝
4𝑑𝑑𝑑𝑑

+
𝐹𝐹𝑎𝑎
𝐴𝐴
�
𝑆𝑆𝑃𝑃𝑃𝑃𝑑𝑑𝑎𝑎𝑑𝑑𝑑𝑑𝑃𝑃𝑑𝑑

+ �
�(0.75𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2 + (0.75𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2 + (𝑀𝑀𝑑𝑑)2

𝑍𝑍 �
𝑆𝑆𝑃𝑃𝑃𝑃𝑑𝑑𝑎𝑎𝑑𝑑𝑑𝑑𝑃𝑃𝑑𝑑

≤ 0.75𝑆𝑆𝑦𝑦  

as per Table 403.3.1-1 

where 
𝑃𝑃 = maximum operating pressure = max of CAEPIPE input pressures (P1 through P10). 

 Due considerations shall be given as per para. 401.2.2.2 while inputting pressure 
 values in CAEPIPE. 

𝑝𝑝 = outside diameter 
𝑑𝑑𝑑𝑑  = nominal thickness as per para. 402.1 
𝑑𝑑𝑑𝑑  = in-plane stress intensification factor; the product 0.75𝑑𝑑𝑑𝑑shall not be less than 1.0 
𝑑𝑑𝑑𝑑  = out-of-plane stress intensification factor; the product 0.75𝑑𝑑𝑑𝑑shall not be less than 1.0 
𝑀𝑀𝑑𝑑  = in-plane bending moment 
𝑀𝑀𝑑𝑑  = out-of-plane bending moment 
𝑀𝑀𝑑𝑑  = torsional moment 
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𝑍𝑍 = uncorroded section modulus; for reduced outlets, effective section modulus 
𝐹𝐹𝑎𝑎  = axial force component for external loads 
𝐴𝐴 = nominal cross-section area 
𝑆𝑆𝑦𝑦  = specified minimum yield strength of pipe 

Stress due to Sustained Loads + Occasional Loads (Unrestrained Piping) 

For Pipes (as per para. 402.6.2) 

𝑆𝑆𝐿𝐿𝑂𝑂 = SL + �
�𝑃𝑃𝑝𝑝𝑃𝑃𝑎𝑎𝐺𝐺 − 𝑃𝑃�𝑝𝑝

4𝑑𝑑𝑑𝑑
+
𝐹𝐹𝑎𝑎
𝐴𝐴 �𝑑𝑑𝑐𝑐𝑐𝑐𝑎𝑎𝑃𝑃𝑑𝑑𝑑𝑑𝑑𝑑𝑎𝑎𝑑𝑑

+ �
�(𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2 + (𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2 + (𝑀𝑀𝑑𝑑)2

𝑍𝑍 �
𝑑𝑑𝑐𝑐𝑐𝑐𝑎𝑎𝑃𝑃𝑑𝑑𝑑𝑑𝑑𝑑𝑎𝑎𝑑𝑑

≤ 0.8𝑆𝑆𝑦𝑦

 
as per Table 403.3.1-1 

For Fittings & Components (as per para. 402.6.2) 

𝑆𝑆𝐿𝐿𝑂𝑂 = 𝑆𝑆𝐿𝐿(𝑓𝑓𝑐𝑐 ) + �
�𝑃𝑃𝑝𝑝𝑃𝑃𝑎𝑎𝐺𝐺 − 𝑃𝑃�𝑝𝑝

4𝑑𝑑𝑑𝑑
+
𝐹𝐹𝑎𝑎
𝐴𝐴 �𝑑𝑑𝑐𝑐𝑐𝑐𝑎𝑎𝑃𝑃𝑑𝑑𝑑𝑑𝑑𝑑𝑎𝑎𝑑𝑑

+ �
�(0.75𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2 + (0.75𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2 + (𝑀𝑀𝑑𝑑)2

𝑍𝑍 �
𝑑𝑑𝑐𝑐𝑐𝑐𝑎𝑎𝑃𝑃𝑑𝑑𝑑𝑑𝑑𝑑𝑎𝑎𝑑𝑑

≤ 0.8𝑆𝑆𝑦𝑦  

as per Table 403.3.1-1 

where 
𝑃𝑃𝑝𝑝𝑃𝑃𝑎𝑎𝐺𝐺  = peak pressure = (peak pressure factor x P) where P = maximum operating 

 pressure, as defined above with 1.0 ≤ peak pressure factor ≥ 1.1 as per para. 
 403.3.4 

Expansion Stress (Unrestrained Piping) 

The stress (𝑆𝑆𝐸𝐸) due to thermal expansion is calculated from para.402.5.2 

𝑆𝑆𝐸𝐸 = �𝑆𝑆𝑏𝑏2 + 4𝑆𝑆𝑑𝑑2 ≤ 𝑆𝑆𝐴𝐴as per Table 403.3.1-1 and para. 403.3.2 

where 
𝑆𝑆𝑏𝑏  = resultant bending stress = �(𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2+(𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑 )2

Z
 

𝑆𝑆𝑑𝑑  = torsional stress = Mt
2Z

 
𝑀𝑀𝑑𝑑  = torsional moment 
𝑍𝑍 = uncorroded section modulus; for reduced outlets, effective section modulus 

Please note, “Liberal allowable” option is always turned ON for ANSI B31.4 

𝑆𝑆𝐴𝐴 = 𝑓𝑓[1.25(𝑆𝑆𝐶𝐶 + 𝑆𝑆ℎ) − 𝑆𝑆𝐿𝐿] 
𝑓𝑓 = stress range reduction factor = 6/N0.2, where N = number of equivalent full range  
  cycles 
where 𝑓𝑓 ≤ 1.2 (from para. 403.3.2). 
𝑆𝑆𝑐𝑐  = 0.67𝑆𝑆𝑦𝑦  at the lower of the installed temperature or minimum operating temperature  
 = 0.67𝑆𝑆𝑦𝑦at the higher of the installed temperature or maximum operating temperature 
where 

𝑆𝑆𝑐𝑐  = specified minimum yield strength of pipe 
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Stress due to Sustained, Thermal and Occasional Loads (Restrained Piping) 

The Net longitudinal stress (SL) due to sustained, thermal expansion and occasional loads for 
restrained piping is calculated from para. 402.6.1 

𝑆𝑆𝐿𝐿 = max��𝑆𝑆𝑝𝑝 + 𝑆𝑆𝑚𝑚 + 𝑆𝑆𝐵𝐵�, �𝑆𝑆𝑝𝑝 + 𝑆𝑆𝑚𝑚 − 𝑆𝑆𝐵𝐵��𝑃𝑃𝑃𝑃𝑃𝑃𝑑𝑑𝑎𝑎𝑑𝑑𝑑𝑑𝑃𝑃𝑑𝑑 + 
  max��𝑆𝑆𝑝𝑝 + 𝑆𝑆𝑚𝑚 + 𝑆𝑆𝐵𝐵�, �𝑆𝑆𝑝𝑝 + 𝑆𝑆𝑚𝑚 − 𝑆𝑆𝐵𝐵��𝑂𝑂𝑐𝑐𝑐𝑐𝑎𝑎𝑃𝑃𝑑𝑑𝑑𝑑𝑑𝑑𝑎𝑎𝑑𝑑 + 
  max(|𝑆𝑆𝑇𝑇|𝑤𝑤𝑎𝑎𝑃𝑃𝑚𝑚𝑃𝑃𝑃𝑃𝑑𝑑 , |𝑆𝑆𝑇𝑇|𝑐𝑐𝑑𝑑𝑑𝑑𝑑𝑑𝑃𝑃𝑃𝑃𝑑𝑑 ) ≤ 0.9𝑆𝑆𝑦𝑦  
where 

Pressure stress = 𝑆𝑆𝑝𝑝 = 𝜐𝜐 𝑃𝑃𝑝𝑝
2𝑑𝑑𝑑𝑑

= where 𝜐𝜐 = 0.3 as per para. 402.2.3 and can be either positive or 
negative 

Stress due to axial loading (other than temperature and pressure)= 𝑆𝑆𝑚𝑚 = 𝐹𝐹𝑎𝑎
𝐴𝐴

 

and can be positive or negative. 

Nominal bending stress SB  from Weight and / or other External loads for  

For Pipes  

𝑆𝑆𝐵𝐵 = �(𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2+(𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2+(𝑀𝑀𝑑𝑑)2

Z
 

For Fittings & Components 

𝑆𝑆𝐵𝐵 = �(0.75𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2+(0.75𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2+(𝑀𝑀𝑑𝑑)2

𝑍𝑍
 

Thermal expansion stress 𝑆𝑆𝑇𝑇 = 𝐸𝐸𝛼𝛼(𝑇𝑇𝑑𝑑 − 𝑇𝑇𝑑𝑑), which can either be positive or negative 

where 
𝑃𝑃 = maximum operating pressure = max (P1 through P10) 
𝑝𝑝 = outside diameter 
𝑑𝑑𝑑𝑑  = nominal thickness 
𝑑𝑑𝑑𝑑  = in-plane stress intensification factor; the product ii75.0  shall not be less than 1.0 
𝑑𝑑𝑑𝑑  = out-of-plane stress intensification factor; the product oi75.0 shall not be less than 1.0 
𝑀𝑀𝑑𝑑  = in-plane bending moment 
𝑀𝑀𝑑𝑑  = out-of-plane bending moment 
𝑀𝑀𝑑𝑑  = torsional moment 
𝐹𝐹𝑎𝑎  = axial force component for external loads 
𝐴𝐴 = nominal cross-section area 
𝑍𝑍 = uncorroded section modulus; for reduced outlets, effective section modulus 
𝑆𝑆𝑦𝑦  = specified minimum yield strength of pipe 
𝑇𝑇𝑑𝑑  = installation temperature = Tref in CAEPIPE 
𝑇𝑇𝑑𝑑  = warmest or coldest operating temperature 
𝛼𝛼 = coefficient of thermal expansion at To defined above 
𝐸𝐸 = young’s modulus at ambient (reference) temperature 
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Note: 

1. Para. 402.6.2 of B31.4 (2012) states that “Longitudinal stress from pressure in an 
unrestrained line should include consideration of bending stress or axial stress that may 
be caused by elongation of the pipe due to internal pressure and result in stress at bends 
and at connections and produce additional loads on equipment and on supports”. 
The above statement seems to imply that “elongation of pipe and opening of bends due 
to Bourdon effect” are to be included in the Sustained load case (and hence in Operating 
case and Sustained plus Occasional load case). 
On the other hand, since the deformation due to Bourdon effect is being constrained by 
piping supports, CAEPIPE includes the Bourdon effect as part of the results for 
Thermal Expansion (when “Solve Thermal Case” is opted) or as part of the Operating 
Case (when “Thermal = Operating – Sustained is opted). 

2. Young’s modulus of elasticity corresponding to reference temperature (Tref) is used to 
form the stiffness matrix in accordance with para. 402.2.2. 

3. Refer Annexure B for the details of “Thickness” and the “Section Modulus” used for 
weight, pressure and stress calculations. 
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Allowable Pressure 

For straight pipes and bends (including closely spaced and widely spaced miter bends), the 
allowable pressure is calculated from para. 504.1.2. 

𝑃𝑃 =
2𝑆𝑆𝐸𝐸𝑑𝑑𝑎𝑎

𝑝𝑝 − 2𝑌𝑌𝑑𝑑𝑎𝑎
 

where 
𝑃𝑃 = allowable pressure 
𝑆𝑆 = basic allowable stress at maximum of CAEPIPE input temperatures T1 through T10 
𝐸𝐸 = longitudinal or spiral joint factor (input as material property) from para. 502.3.1 and  
  Table 502.3.1 
Table 502.3.1 provides maximum allowable hoop stress values (𝑆𝑆𝐸𝐸) as a function of metal 
temperature and includes Longitudinal or Spiral Joint Factor (𝐸𝐸) for various materials. 
Divide 𝑆𝑆𝐸𝐸 value by 𝐸𝐸 value provided in Table 502.3.1 to obtain basic allowable stress 𝑆𝑆. For 
materials where 𝐸𝐸 is not given explicitly in Table 502.3.1, use 𝐸𝐸 = 1.0. 

Hence, 𝑆𝑆𝐸𝐸 in the above formula for allowable pressure 𝑃𝑃 is the allowable hoop stress per 
para. 502.3.1 and Table 502.3.1. 
𝑑𝑑𝑎𝑎  = available thickness for pressure design (as per para. 504.1.1) 
 = 𝑑𝑑𝑑𝑑× (1 - mill tolerance/100) - corrosion allowance 
(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in corrosion allowance) 
𝑑𝑑𝑑𝑑  = nominal pipe thickness 
𝑝𝑝 = outside diameter 
𝑑𝑑 = inside diameter 
𝑌𝑌 = pressure coefficient 
For ductile non-ferrous materials and ferritic and austenitic steels,  

𝑌𝑌 = 0.4 for 𝑝𝑝/𝑑𝑑𝑎𝑎 ≥ 6 and 𝑌𝑌 = 𝑑𝑑
𝑑𝑑+𝑝𝑝

, for 4 ≤ 𝑝𝑝/𝑑𝑑𝑎𝑎 < 6 

For Cast Iron, 𝑌𝑌 = 0.0  

Sustained Stress (in corroded condition) 

The stress (𝑆𝑆𝐿𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from para. 502.3.2(d). Also, refer to Note 1 below. 

𝑆𝑆𝐿𝐿 =
𝑃𝑃𝑝𝑝
4𝑑𝑑𝑐𝑐

+
�(𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2 + (𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2

𝑍𝑍𝑐𝑐
≤ 𝑆𝑆ℎ

 
where 
𝑃𝑃 = maximum of CAEPIPE input pressures P1 through P10 
𝑝𝑝 = outside diameter 
𝑑𝑑𝑐𝑐  = nominal thickness – corrosion allowance, as per para. 502.3.2 (d) 
𝑑𝑑𝑑𝑑  =  in-plane stress intensification factor 
𝑑𝑑𝑑𝑑  = out-of-plane stress intensification factor 
𝑀𝑀𝑑𝑑  =  in-plane bending moment 
𝑀𝑀𝑑𝑑  = out-of-plane bending moment 
𝑍𝑍𝑐𝑐  = corroded section modulus as per para. 502.3.2 (d) 
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𝑆𝑆ℎ  = basic allowable stress at maximum of CAEPIPE input temperatures T1 through T10 

Occasional Stress (in corroded condition) 

The stress (𝑆𝑆𝐿𝐿𝑑𝑑) due to occasional loads is calculated as the sum of stress due to sustained 
loads (𝑆𝑆𝐿𝐿) and stress due to occasional loads (𝑆𝑆𝑑𝑑) such as earthquake or wind. Wind and 
earthquake are not considered concurrently (see para. 502.3.3 (a)). Also, refer to Note 1 
below. 

𝑆𝑆𝐿𝐿𝑂𝑂 =
𝑃𝑃𝑝𝑝𝑃𝑃𝑎𝑎𝐺𝐺 𝑝𝑝

4𝑑𝑑𝑐𝑐
+ �

�(𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2 + (𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2

𝑍𝑍𝑐𝑐
�
𝑃𝑃𝑃𝑃𝑃𝑃𝑑𝑑𝑎𝑎𝑑𝑑𝑑𝑑𝑃𝑃𝑑𝑑

+ �
�(𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2 + (𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2

𝑍𝑍𝑐𝑐
�
𝑑𝑑𝑐𝑐𝑐𝑐𝑎𝑎𝑃𝑃𝑑𝑑𝑑𝑑𝑑𝑑𝑎𝑎𝑑𝑑

≤ 1.33𝑆𝑆ℎ
 where 

𝑃𝑃𝑝𝑝𝑃𝑃𝑎𝑎𝐺𝐺 =  peak pressure = (peak pressure factor) x P, where P is defined above 

Expansion Stress (in uncorroded condition) 

The stress (𝑆𝑆𝐸𝐸) due to thermal expansion is calculated from para. 519.4.5 and para. 519.3.5. 

𝑆𝑆𝐸𝐸 = �𝑆𝑆𝑏𝑏2 + 4𝑆𝑆𝑑𝑑2 ≤ 𝑆𝑆𝐴𝐴  

where 

𝑆𝑆𝑏𝑏  = resultant bending stress = �(𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2+(𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2

𝑍𝑍
 

𝑆𝑆𝑑𝑑  = torsional stress =𝑀𝑀𝑑𝑑
2𝑍𝑍

 
𝑀𝑀𝑑𝑑  = torsional moment 
𝑍𝑍 = uncorroded section modulus; for reduced outlets, effective section modulus 
𝑆𝑆𝐴𝐴 = 𝑓𝑓(1.25𝑆𝑆𝑐𝑐𝑑𝑑𝑑𝑑𝑑𝑑 + 1.25𝑆𝑆ℎ𝑑𝑑𝑑𝑑 )(see para. 502.3.2 (c)) 

 
𝑓𝑓 = stress range reduction factor from Figure 502.3.2  
𝑆𝑆𝑐𝑐𝑑𝑑𝑑𝑑𝑑𝑑  = basic allowable stress as minimum metal temperature expected during the 

 displacement cycle under analysis 
𝑆𝑆ℎ𝑑𝑑𝑑𝑑  = basic allowable stress as maximum metal temperature expected during the 

 displacement cycle under analysis 

When 𝑆𝑆ℎ  is greater than 𝑆𝑆𝐿𝐿 , the allowable stress range may be calculated as 

𝑆𝑆𝐴𝐴 = 𝑆𝑆𝐴𝐴 + 𝑓𝑓(𝑆𝑆ℎ − 𝑆𝑆𝐿𝐿) 

where, 𝑆𝑆ℎ= basic allowable stress at maximum of CAEPIPE input temperatures T1, T2 and 
T3 

This is specified as an analysis option: “Use liberal allowable stresses”, in the CAEPIPE 
menu Options->Analysis on the Code tab. 

Notes: 

1. As per para. 502.3.2 (d), the pressure stress should be calculated using the formula 
𝑃𝑃𝑑𝑑2/(𝑝𝑝2 − 𝑑𝑑2), where d is the internal diameter = 𝑝𝑝 − 2𝑑𝑑𝑐𝑐 . This can be selected 
through Options > Analysis > Pressure 

2. Refer Annexure B for the details of “Thickness” and the “Section Modulus” used for 
weight, pressure and stress calculations. 
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Allowable Pressure 

For straight pipes and bends (including closely spaced and widely spaced miter bends), the 
allowable pressure is calculated from para. 841.1.1. 

𝑃𝑃 =
2𝑆𝑆𝐸𝐸𝑑𝑑𝑑𝑑𝐹𝐹𝑇𝑇

𝑝𝑝  where 
𝑃𝑃 = allowable pressure 
𝑃𝑃 = specified minimum yield strength from para. 817.1.3 (h) and para. 841.1.4 (a) 
𝐸𝐸 = longitudinal joint factor (input as material property), obtained from Table 841.1.7-1 

 and para. 817.1.3 (d) 
𝑑𝑑𝑑𝑑  = nominal pipe thickness 
𝑝𝑝 = nominal outside diameter 
𝐹𝐹 = construction type design factor, obtained from Table 841.1.6-1 
𝑇𝑇 = temperature derating factor, obtained from Table 841.1.8-1 and para. 841.1.8 

Stress due to Sustained and Occasional Loads (Unrestrained Piping) 

The sum of longitudinal pressure stress and the bending stress due to external loads, such as 
weight of the pipe and contents, seismic or wind, etc. is calculated according to paras. 833.6 
(a) and 833.6 (b) along with paras. 805.2.3, 833.2 (b), 833.2 (d), 833.2 (e) and 833.2 (f). 

Please note, the “include axial force in stress calculations” option is turned ON by default for 
ANSI B31.8. 

Sustained Stress 𝑺𝑺𝑳𝑳 (required to compute Expansion Stress Allowable 𝑺𝑺𝑨𝑨): 

For Pipes and Long Radius Bends 

𝑆𝑆𝐿𝐿 = �
𝑃𝑃𝑝𝑝
4𝑑𝑑𝑑𝑑

+
𝑅𝑅
𝐴𝐴�𝑆𝑆𝑃𝑃𝑃𝑃𝑑𝑑𝑎𝑎𝑑𝑑𝑑𝑑𝑃𝑃𝑑𝑑

+ �
�(𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2 + (𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2

𝑍𝑍 �
𝑆𝑆𝑃𝑃𝑃𝑃𝑑𝑑𝑎𝑎𝑑𝑑𝑑𝑑𝑃𝑃𝑑𝑑

 
For other Fittings or Components. 

SL(fc) = �
PD
4tn

+
R
A�Sustained

+ �
�(0.75iiMi)2 + (0.75ioMo)2 + (Mt)2

Z �
Sustained

 
Sustained + Occasional Stress 𝑺𝑺𝑳𝑳𝑳𝑳: 

For Pipes and Long Radius Bends 

𝐒𝐒𝐋𝐋𝐋𝐋 = 𝐒𝐒𝐋𝐋 + �
�𝐏𝐏𝐩𝐩𝐩𝐩𝐩𝐩𝐩𝐩 − 𝐏𝐏�𝐃𝐃

𝟒𝟒𝐭𝐭𝐧𝐧
+
𝐑𝐑
𝐀𝐀�𝐨𝐨𝐨𝐨𝐨𝐨𝐩𝐩𝐨𝐨𝐨𝐨𝐨𝐨𝐧𝐧𝐩𝐩𝐨𝐨

+ �
�(𝐨𝐨𝐨𝐨𝐌𝐌𝐨𝐨)𝟐𝟐 + (𝐨𝐨𝐨𝐨𝐌𝐌𝐨𝐨)𝟐𝟐

𝐙𝐙 �
𝐨𝐨𝐨𝐨𝐨𝐨𝐩𝐩𝐨𝐨𝐨𝐨𝐨𝐨𝐧𝐧𝐩𝐩𝐨𝐨

≤ 𝟎𝟎.𝟕𝟕𝟕𝟕𝐒𝐒𝟕𝟕

 For Fittings or Components 

𝑆𝑆𝐿𝐿𝑂𝑂 = 𝑆𝑆𝐿𝐿(𝑓𝑓𝑐𝑐 ) + �
�𝑃𝑃𝑝𝑝𝑃𝑃𝑎𝑎𝐺𝐺 − 𝑃𝑃�𝑝𝑝

4𝑑𝑑𝑑𝑑
+
𝑅𝑅
𝐴𝐴�𝑑𝑑𝑐𝑐𝑐𝑐𝑎𝑎𝑃𝑃𝑑𝑑𝑑𝑑𝑑𝑑𝑎𝑎𝑑𝑑

+ �
�(0.75𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2 + (0.75𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2 + (𝑀𝑀𝑑𝑑)2

𝑍𝑍 �
𝑑𝑑𝑐𝑐𝑐𝑐𝑎𝑎𝑃𝑃𝑑𝑑𝑑𝑑𝑑𝑑𝑎𝑎𝑑𝑑

≤ 0.75𝑆𝑆𝑇𝑇

 
where 
𝑃𝑃 = maximum operating pressure = max (P1 through P10) 
𝑃𝑃𝑝𝑝𝑃𝑃𝑎𝑎𝐺𝐺  = Peak pressure factor x P 
𝑝𝑝 = nominal outside diameter 
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𝑑𝑑𝑑𝑑  = nominal thickness 
𝑑𝑑𝑑𝑑  = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0 
𝑑𝑑𝑑𝑑  = out-of-plane stress intensification factor; the product 0.75ioshall not be less than 

 1.0 
𝑀𝑀𝑑𝑑  =  in-plane bending moment 
𝑀𝑀𝑑𝑑  = out-of-plane bending moment 
𝑀𝑀𝑑𝑑  = torsional moment 
𝑍𝑍 = uncorroded section modulus; for reduced outlets, effective section modulus  
𝑅𝑅 = axial force component for external loads (other than thermal expansion and 

 pressure) 
𝐴𝐴 = corroded cross-section area (i.e., after deducting for corrosion) 
𝑆𝑆 = specified minimum yield strength from para. 841.1.1(a) 
𝑇𝑇 = temperature derating factor, obtained from para. 841.1.8 and Table 841.1.8-1  

Note:  

Young’s modulus of elasticity corresponding to the lowest operating temperature [=min (T1 
through T10, Tref)] is used to form the stiffness matrix for Sustained and Occasional load 
calculations. 

Expansion Stress (Unrestrained Piping) 

The stress (𝑆𝑆𝐸𝐸) due to thermal expansion is calculated from para.833.8. 

𝑆𝑆𝐸𝐸 = �𝑆𝑆𝑏𝑏2 + 4𝑆𝑆𝑑𝑑2 ≤ 𝑆𝑆𝐴𝐴  
where 

𝑆𝑆𝑏𝑏  = resultant bending stress = �(𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2+(𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2

𝑍𝑍
 

𝑆𝑆𝑑𝑑  = torsional stress = 𝑀𝑀𝑑𝑑
2𝑍𝑍

 
𝑀𝑀𝑑𝑑  = torsional moment 
𝑍𝑍 = uncorroded section modulus; for reduced outlets, effective section modulus 
Please note, “Liberal allowable” option is always turned ON for ANSI B31.8. 
𝑆𝑆𝑏𝑏  = 𝑓𝑓[1.25(𝑆𝑆𝐶𝐶 + 𝑆𝑆ℎ) − 𝑆𝑆𝐿𝐿] 
𝑓𝑓 = stress range reduction factor = 6/N0.2, where N = number of equivalent full range 

 cycles 
where 𝑓𝑓 ≤ 1.0 (from para. 833.8 (b)). 
𝑓𝑓 = 0.33SuT at the minimum installed or operating temperature  
𝑆𝑆ℎ  = 0.33SuT at the maximum installed or operating temperature 
where 
𝑆𝑆𝑃𝑃  = specified minimum ultimate tensile strength = 1.5 𝑆𝑆𝑦𝑦  (assumed), and 
𝑆𝑆𝑦𝑦  = specified minimum yield strength as per para. 841.1.1(a) 
𝑇𝑇 = temperature derating factor, obtained from para. 841.1.8 and Table 841.1.8-1 

Note:  

Young’s modulus of elasticity corresponding to the lowest operating temperature [=min(T1 
through T10,Tref)] is used to form the stiffness matrix for Expansion load calculations. 
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Stress due to Sustained, Thermal and Occasional Loads (Restrained Piping) 

The Net longitudinal stress (𝑆𝑆𝐿𝐿) due to sustained, thermal expansion and occasional loads 
for restrained piping is calculated from paras. 833.3 (a), 833.3 (b) along with paras. 805.2.3, 
833.2 (a), 833.2 (c), 833.2 (d), 833.2 (e) and 833.2 (f) 

𝑆𝑆𝐿𝐿 = max��𝑆𝑆𝑝𝑝 + 𝑆𝑆𝑚𝑚 + 𝑆𝑆𝐵𝐵�, �𝑆𝑆𝑝𝑝 + 𝑆𝑆𝑚𝑚 − 𝑆𝑆𝐵𝐵��𝑃𝑃𝑃𝑃𝑃𝑃𝑑𝑑𝑎𝑎𝑑𝑑𝑑𝑑𝑃𝑃𝑑𝑑 + 
  max��𝑆𝑆𝑝𝑝 + 𝑆𝑆𝑚𝑚 + 𝑆𝑆𝐵𝐵�, �𝑆𝑆𝑝𝑝 + 𝑆𝑆𝑚𝑚 − 𝑆𝑆𝐵𝐵��𝑑𝑑𝑐𝑐𝑐𝑐𝑎𝑎𝑃𝑃𝑑𝑑𝑑𝑑𝑑𝑑𝑎𝑎𝑑𝑑 + 
  max(|𝑆𝑆𝑇𝑇|𝑤𝑤𝑎𝑎𝑃𝑃𝑚𝑚𝑃𝑃𝑃𝑃𝑑𝑑 , |𝑆𝑆𝑇𝑇|𝑐𝑐𝑑𝑑𝑑𝑑𝑑𝑑𝑃𝑃𝑃𝑃𝑑𝑑 ) ≤ 0.9𝑆𝑆𝑇𝑇 

where 
Internal pressure stress =𝑆𝑆𝑝𝑝 = 0.3 𝑃𝑃𝑝𝑝

2𝑑𝑑𝑑𝑑
 

Stress due to axial loading (other than thermal expansion and pressure) =𝑆𝑆𝑚𝑚 = 𝑅𝑅
𝐴𝐴
, and may be 

positive or negative 

Nominal bending stress SB from Weight and / or other External loads for  

For Pipes and Long Radius Bends 

𝑆𝑆𝐵𝐵 =
�(𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2 + (𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2

𝑍𝑍  
For other Fittings or Components. 

𝑆𝑆𝐵𝐵 =
�(0.75𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2 + (0.75𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2 + (𝑀𝑀𝑑𝑑)2

𝑍𝑍  Thermal expansion stress = 𝑆𝑆𝑇𝑇 = 𝐸𝐸𝛼𝛼(𝑇𝑇𝑑𝑑 − 𝑇𝑇𝑑𝑑) , and may be positive or negative 

Where 
𝑃𝑃 = maximum operating pressure = max(P1 through P10) 
𝑝𝑝 = nominal outside diameter 
𝑑𝑑𝑑𝑑  = nominal thickness 
𝑑𝑑𝑑𝑑  = in-plane stress intensification factor; the product 0.75ii shall not be less than 1.0 
𝑑𝑑𝑑𝑑  = out-of-plane stress intensification factor; the product 0.75ioshall not be less than 1.0 
𝑀𝑀𝑑𝑑  = in-plane bending moment 
𝑀𝑀𝑑𝑑  = out-of-plane bending moment 
𝑀𝑀𝑑𝑑  = torsional moment 
𝑅𝑅 = axial force component for external loads (other than thermal expansion and pressure) 
𝐴𝐴 = corroded cross-sectional area (i.e., after deducting for corrosion) 
𝑍𝑍 = uncorroded section modulus; for reduced outlets, effective section modulus 
𝑆𝑆 = Specified Minimum Yield Strength (SMYS) from para. 841.1.1 (a) 
𝑇𝑇 = Temperature derating factor from para. 841.1.8 and Table 841.1.8-1 
𝐸𝐸 = Young’s modulus at ambient (reference) temperature 
𝑇𝑇𝑑𝑑  = installation temperature = Tref in CAEPIPE 
𝑇𝑇𝑑𝑑  = warmest or coldest operating temperature 
𝛼𝛼 = coefficient of thermal expansion at To defined above 
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Allowable Pressure 

For straight pipes and bends, the calculation of allowable pressure is based on Eq. 2 of para. 
904.1 and 904.2.1. 

𝑃𝑃 =
2𝑆𝑆𝐸𝐸(𝑑𝑑𝑚𝑚 − 𝐴𝐴)

𝑝𝑝
 

where 
𝑃𝑃 = allowable pressure 
𝑆𝑆𝐸𝐸 = allowable hoop stress, given in Appendix I of B31.9 (2008) Code, where 
𝐸𝐸 = longitudinal or spiral weld joint efficiency factor or casting quality factor 
𝑑𝑑𝑚𝑚  = minimum required pipe thickness as per para. 904.1.1(a) 
 = 𝑑𝑑𝑑𝑑 × (1 – mill tolerance/100) 
𝑑𝑑𝑑𝑑  = nominal pipe thickness 
𝐴𝐴 = corrosion allowance 
(Any additional thickness required for threading, grooving, erosion, corrosion, etc., should be 
included in “corrosion allowance” in CAEPIPE) 
𝑝𝑝 = outside diameter 

For closely and widely spaced miter bends, the allowable pressure shall be the lower positive 
value calculated from Eqs. (3A) and (3B) of para. 904.2.2(a) 

𝑃𝑃 = 𝑆𝑆𝐸𝐸𝑇𝑇
𝑃𝑃
� 𝑇𝑇
𝑇𝑇+0.64 tan 𝜃𝜃√𝑃𝑃𝑇𝑇

� Eq. (3A) 

𝑃𝑃 = 𝑆𝑆𝐸𝐸𝑇𝑇
𝑃𝑃
� 𝑅𝑅−𝑃𝑃
𝑅𝑅−𝑃𝑃/2

� Eq. (3B) 

where 
𝑃𝑃 = mean radius of pipe = (𝑝𝑝 − 𝑑𝑑𝑑𝑑)/2 � 
𝑇𝑇 = 𝑑𝑑𝑚𝑚 − 𝐴𝐴, where 𝑑𝑑𝑚𝑚  and 𝐴𝐴 are defined above 
𝑅𝑅 = effective bend radius of the miter 
𝜃𝜃 = miter half angle 

Sustained Stress (in uncorroded condition) 

The longitudinal stress (𝑆𝑆𝐿𝐿) due to sustained loads (pressure, weight and other sustained 
mechanical loads) is calculated as mentioned in para. 902.3.2(d) 

𝑆𝑆𝐿𝐿 =
𝑃𝑃𝑝𝑝𝑑𝑑
4𝑑𝑑𝑑𝑑

+
0.75𝑑𝑑𝑀𝑀𝐴𝐴

𝑍𝑍
≤ 𝑆𝑆ℎ  

where 
𝑃𝑃 = maximum of CAEPIPE pressures P1, P2 and P3 
𝑝𝑝𝑑𝑑  = outside diameter 
𝑑𝑑𝑑𝑑  = nominal wall thickness 
𝑑𝑑 = stress intensification factor.  The product 0.75𝑑𝑑 shall not be less than 1.0.  
𝑀𝑀𝐴𝐴 = resultant bending moment due to weight and other sustained loads 
𝑍𝑍 = uncorroded section modulus; for reduced outlets, effective section modulus 
𝑆𝑆ℎ  = hot allowable stress at maximum of CAEPIPE input temperatures T1, T2 and T3 
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Occasional Stress (in uncorroded condition) 

The longitudinal stress (𝑆𝑆𝐿𝐿𝑂𝑂)due to occasional loads is calculated as mentioned in 
para.902.3.3 (a) as the sum of stresses due to pressure, live and dead loads and stress due to 
occasional loads(𝑆𝑆𝑂𝑂) such as earthquake or wind.  Wind and earthquake are not considered 
to occur concurrently. 

𝑆𝑆𝐿𝐿𝑂𝑂 =
𝑃𝑃𝑝𝑝𝑃𝑃𝑎𝑎𝐺𝐺 𝑝𝑝𝑑𝑑

4𝑑𝑑𝑑𝑑
+

0.75𝑑𝑑𝑀𝑀𝐴𝐴

𝑍𝑍
+

0.75𝑑𝑑𝑀𝑀𝐵𝐵

𝑍𝑍
≤ 1.33𝑆𝑆ℎ  

where 
𝑀𝑀𝐵𝐵  = resultant bending moment due to occasional loads 
𝑃𝑃𝑝𝑝𝑃𝑃𝑎𝑎𝐺𝐺  = peak pressure = (peak pressure factor) x P 

Expansion Stress (in uncorroded condition) 

The stress (𝑆𝑆𝐸𝐸) due to thermal expansion is calculated from para. 902.3.2(c), para. 919.2.1 
and para. 914.4.1(b) 

𝑆𝑆𝐸𝐸 =
𝑑𝑑𝑀𝑀𝐶𝐶

𝑍𝑍
≤ 𝑆𝑆𝐴𝐴 

where 
𝑀𝑀𝐶𝐶  = resultant moment due to thermal expansion 
𝑆𝑆𝐴𝐴 = 𝑓𝑓(1.25𝑆𝑆𝐶𝐶 + 0.25𝑆𝑆ℎ) 
𝑓𝑓 = stress range reduction factor 6/𝑁𝑁0.2, where 𝑁𝑁 being the total number of equivalent  

 reference displacement stress range cycles expected during the service life of the 
piping.  Also 0.15 ≤ 𝑓𝑓 ≤ 1.0 

𝑆𝑆𝐶𝐶  = allowable stress at cold temperature, i.e. at minimum of CAEPIPE input  
  temperatures T1, T2, T3 and Tref 

When 𝑆𝑆ℎ  is greater than 𝑆𝑆𝐿𝐿 , the allowable stress range may be calculated as per para. 902.3.2 
(d). 

𝑆𝑆𝐴𝐴 = 𝑓𝑓[1.25(𝑆𝑆𝐶𝐶 + 𝑆𝑆ℎ) − 𝑆𝑆𝐿𝐿] 

This is specified as an analysis option:  “Use liberal allowable stresses”, in the CAEPIPE 
menu Options>Analysis on the “Code” tab. 

Note: 

Refer to the topic towards the end of this appendix for the details of “Thickness” and the 
“Section Modulus” used for weight, pressure and stress calculations. 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from Equation 5 of NC-
3641.1. 

𝑃𝑃 =
2𝑆𝑆𝐸𝐸𝑑𝑑𝑚𝑚

𝑝𝑝 − 2𝑇𝑇𝑑𝑑𝑚𝑚
 

where 
𝑃𝑃 = allowable pressure 
𝑆𝑆 = allowable stress 
𝐸𝐸 = joint factor (input as material property) 
𝑑𝑑𝑚𝑚  = minimum required thickness, including mechanical and corrosion allowances 
 = 𝑑𝑑 × (1 – mill tolerance/100) – corrosion allowance 
𝑑𝑑 = nominal pipe thickness 
𝑝𝑝 = outside diameter 
𝑑𝑑 = inside diameter 
𝑌𝑌 = pressure coefficient 
 = 0.4 for 𝑑𝑑 < 𝑝𝑝/6 
 = 𝑑𝑑/(𝑝𝑝 + 𝑑𝑑) for 𝑑𝑑 < 𝑝𝑝/6 

Sustained Stress 

The stress (𝑆𝑆𝐿𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from Equation 9 of NC-3652. 

𝑆𝑆𝐿𝐿 =
𝑃𝑃𝑝𝑝
4𝑑𝑑

+
0.75𝑑𝑑𝑀𝑀𝐴𝐴

𝑍𝑍
≤ 𝑆𝑆ℎ 

where 
𝑃𝑃 = maximum pressure 
𝑝𝑝 = outside diameter 
𝑑𝑑 = nominal wall thickness 
𝑑𝑑 = stress intensification factor.  The product 0.75i, shall not be less than 1.0 
𝑀𝑀𝐴𝐴 = resultant bending moment due to sustained loads = �𝑀𝑀𝑋𝑋

2 + 𝑀𝑀𝑌𝑌
2 + 𝑀𝑀𝑍𝑍

2 
𝑍𝑍 = section modulus, for reduced outlets, effective section modulus 
𝑆𝑆ℎ  = hot allowable stress 

Occasional Stress 

The stress (𝑆𝑆𝐿𝐿𝑂𝑂) is calculated as the sum of stress due to sustained loads (𝑆𝑆𝐿𝐿) and stress due 
to occasional loads (𝑆𝑆𝑂𝑂) such as earthquake or wind from Equation 10 of NC-3652.2. Wind 
and earthquake are not considered concurrently. 

𝑆𝑆𝐿𝐿𝑂𝑂 = 𝑆𝑆𝐿𝐿 +
0.75𝑑𝑑𝑀𝑀𝐵𝐵

𝑍𝑍
≤ 1.2𝑆𝑆ℎ  

where 
𝑀𝑀𝐵𝐵  = resultant moment due to occasional loads  
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Expansion Stress 

The stress (𝑆𝑆𝐸𝐸) due to thermal expansion is calculated from Equation 11 of NC-3652.3. 

𝑆𝑆𝐸𝐸 =
𝑑𝑑𝑀𝑀𝐶𝐶

𝑍𝑍
≤ 𝑆𝑆𝐴𝐴  

where 
𝑀𝑀𝐶𝐶  = resultant moment due to thermal expansion 
𝑆𝑆𝐴𝐴 = 𝑓𝑓(1.25𝑆𝑆𝑐𝑐 + 0.25𝑆𝑆ℎ) 
𝑆𝑆𝑐𝑐  = allowable stress at cold temperature 
𝑓𝑓 = stress range reduction factor from Table NC-3611.2(e)-1 
The stress due to pressure, weight, other sustained loads and thermal expansion is calculated 
from Equation 13 of NC-3652.2. 

𝑆𝑆𝑇𝑇𝐸𝐸 = 𝑆𝑆𝐿𝐿 + 𝑆𝑆𝐸𝐸 ≤ 𝑆𝑆ℎ + 𝑆𝑆𝐴𝐴 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from Equation 5 of NC-
3641.1. 

𝑃𝑃 =
2𝑆𝑆𝐸𝐸𝑑𝑑𝑚𝑚

𝑝𝑝 − 2𝑌𝑌𝑑𝑑𝑚𝑚
 

where 
𝑃𝑃 = allowable pressure 
𝑆𝑆 = allowable stress 
𝐸𝐸 = joint factor (input as material property) 
𝑑𝑑𝑚𝑚  = minimum required thickness, including mechanical and corrosion allowance 
 = 𝑑𝑑 ×(1 – mill tolerance/100) – corrosion allowance 
𝑑𝑑 = nominal pipe thickness 
𝑝𝑝 = outside diameter 
𝑑𝑑 = inside diameter 
𝑌𝑌 = pressure coefficient 
 = 0.4 for 𝑑𝑑 < 𝑝𝑝/6 
 = 𝑑𝑑/(𝑝𝑝 + 𝑑𝑑) for 𝑑𝑑 ≥ 𝑝𝑝/6 

Sustained Stress 

The stress (𝑆𝑆𝐿𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from Equation 8 of NC-3652. 

𝑆𝑆𝐿𝐿 = 𝐵𝐵1
𝑃𝑃𝑝𝑝
2𝑑𝑑

+ 𝐵𝐵2
𝑀𝑀𝐴𝐴

𝑍𝑍
≤ 1.5𝑆𝑆ℎ  

where 
𝐵𝐵1,𝐵𝐵2 = primary stress indices from NB-3680 
𝑃𝑃 = maximum pressure 
𝑝𝑝 = outside diameter 
𝑑𝑑 = nominal wall thickness 
𝑀𝑀𝐴𝐴 = resultant bending moment due to sustained loads = �𝑀𝑀𝑋𝑋

2 + 𝑀𝑀𝑌𝑌
2 + 𝑀𝑀𝑍𝑍

2 
𝑍𝑍 = section modulus, for reduced outlets, effective section modulus 
𝑆𝑆ℎ  = hot allowable stress 

Occasional Stress 

The stress (𝑆𝑆𝐿𝐿𝑂𝑂) is calculated as the sum of stress due to sustained loads (𝑆𝑆𝐿𝐿) and stress due 
to occasional loads (𝑆𝑆𝑂𝑂) such as earthquake or wind from Equation 9 of NC-3653.1. Wind 
and earthquake are not considered concurrently. 

𝑆𝑆𝐿𝐿𝑂𝑂 = 𝑆𝑆𝐿𝐿 + 𝐵𝐵2
𝑀𝑀𝐵𝐵

𝑍𝑍
≤ 1.8𝑆𝑆ℎ  

where 
𝑀𝑀𝐵𝐵  = resultant moment due to occasional loads 
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Expansion Stress 

The stress (𝑆𝑆𝐸𝐸) due to thermal expansion is calculated from Equation 10 of NC-3653.2. 

𝑆𝑆𝐸𝐸 =
𝑑𝑑𝑀𝑀𝐶𝐶

𝑍𝑍
≤ 𝑆𝑆𝐴𝐴  

where 
𝑑𝑑 = stress intensification factor 
𝑀𝑀𝐶𝐶  = resultant moment due to thermal expansion 
𝑆𝑆𝐴𝐴 = 𝑓𝑓(1.25𝑆𝑆𝑐𝑐 + 0.25𝑆𝑆ℎ) 
𝑆𝑆𝑐𝑐  = allowable stress at cold temperature 
𝑓𝑓 = stress range reduction factor from Table NC-3611.2(e)-1 

The stress due to pressure, weight, other sustained loads and thermal expansion is calculated 
from Equation 11 of NC-3653.2(c). 

𝑆𝑆𝑇𝑇𝐸𝐸 =
𝑃𝑃𝑝𝑝
4𝑑𝑑

+
0.75𝑑𝑑𝑀𝑀𝐴𝐴

𝑍𝑍
+
𝑑𝑑𝑀𝑀𝐶𝐶

𝑍𝑍
≤ 𝑆𝑆ℎ + 𝑆𝑆𝐴𝐴  

0.75i shall not be less than 1.0. 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from Equation 5 of NC-
3641.1. 

𝑃𝑃 =
2𝑆𝑆𝐸𝐸𝑑𝑑𝑚𝑚

𝑝𝑝 − 2𝑌𝑌𝑑𝑑𝑚𝑚
 

where 
𝑃𝑃 = allowable pressure 
𝑆𝑆 = allowable stress 
𝐸𝐸 = joint factor (input as material property) 
𝑑𝑑𝑚𝑚  = minimum required thickness, including mechanical and corrosion allowance 
 = 𝑑𝑑 ×(1 – mill tolerance/100) – corrosion allowance 
𝑑𝑑 = nominal pipe thickness 
𝑝𝑝 = outside diameter 
𝑑𝑑 = inside diameter 
𝑌𝑌 = pressure coefficient 
 = 0.4 for 𝑑𝑑 < 𝑝𝑝/6 
 = 𝑑𝑑/(𝑝𝑝 + 𝑑𝑑) for 𝑑𝑑 ≥ 𝑝𝑝/6 

Sustained Stress 

The stress (𝑆𝑆𝐿𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from Equation 8 of NC-3652. 

𝑆𝑆𝐿𝐿 = 𝐵𝐵1
𝑃𝑃𝑝𝑝
2𝑑𝑑

+ 𝐵𝐵2
𝑀𝑀𝐴𝐴

𝑍𝑍
≤ 1.5𝑆𝑆ℎ  

where 
𝐵𝐵1,𝐵𝐵2 = primary stress indices from NB-3680 
𝑃𝑃 = maximum pressure 
𝑝𝑝 = outside diameter 
𝑑𝑑 = nominal wall thickness 
𝑀𝑀𝐴𝐴 = resultant bending moment due to sustained loads = �𝑀𝑀𝑋𝑋

2 + 𝑀𝑀𝑌𝑌
2 + 𝑀𝑀𝑍𝑍

2 
𝑍𝑍 = section modulus, for reduced outlets, effective section modulus 
𝑆𝑆ℎ  = hot allowable stress 

Occasional Stress 

The stress (𝑆𝑆𝐿𝐿𝑂𝑂) is calculated as the sum of stress due to sustained loads (𝑆𝑆𝐿𝐿) and stress due 
to occasional loads (𝑆𝑆𝑂𝑂) such as earthquake or wind from Equation 9 of NC-3653.1. Wind 
and earthquake are not considered concurrently. 

𝑆𝑆𝐿𝐿𝑂𝑂 = 𝑆𝑆𝐿𝐿 + 𝐵𝐵2
𝑀𝑀𝐵𝐵

𝑍𝑍
≤ 1.8𝑆𝑆ℎ  

where 
𝑀𝑀𝐵𝐵  = resultant moment due to occasional loads 
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Expansion Stress 

The stress (𝑆𝑆𝐸𝐸) due to thermal expansion is calculated from Equation 10 of NC-3653.2. 

𝑆𝑆𝐸𝐸 =
𝑑𝑑𝑀𝑀𝐶𝐶

𝑍𝑍
≤ 𝑆𝑆𝐴𝐴  

where 
𝑑𝑑 = stress intensification factor 
𝑀𝑀𝐶𝐶  = resultant moment due to thermal expansion 
𝑆𝑆𝐴𝐴 = 𝑓𝑓(1.25𝑆𝑆𝑐𝑐 + 0.25𝑆𝑆ℎ) 
𝑆𝑆𝑐𝑐  = allowable stress at cold temperature 
𝑓𝑓 = stress range reduction factor from Table NC-3611.2(e)-1 

The stress due to pressure, weight, other sustained loads and thermal expansion is calculated 
from Equation 11 of NC-3653.2(c). 

𝑆𝑆𝑇𝑇𝐸𝐸 =
𝑃𝑃𝑝𝑝
4𝑑𝑑

+
0.75𝑑𝑑𝑀𝑀𝐴𝐴

𝑍𝑍
+
𝑑𝑑𝑀𝑀𝐶𝐶

𝑍𝑍
≤ 𝑆𝑆ℎ + 𝑆𝑆𝐴𝐴  

0.75i shall not be less than 1.0. 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from 4.2(4). 

𝑃𝑃 =
2𝑓𝑓𝑃𝑃𝑑𝑑𝑓𝑓
𝑝𝑝 − 2𝑑𝑑𝑓𝑓

 

where 
𝑃𝑃 = allowable pressure 
𝑓𝑓 = allowable stress 
𝑃𝑃 = joint factor (input as material property) 
𝑑𝑑𝑓𝑓  = minimum required thickness, including mechanical and corrosion allowances 
 = nominal pipe thickness × (1 – mill tolerance/100) – corrosion allowance 
𝑝𝑝 = outside diameter 

𝑃𝑃 =
𝑓𝑓𝑃𝑃

𝑋𝑋�1 + 0.6427 𝑑𝑑𝑎𝑎𝑑𝑑 𝛼𝛼√𝑋𝑋�
 

where 
𝛼𝛼 = miter angle 
𝑋𝑋 = �𝑝𝑝 − 2𝑑𝑑𝑓𝑓�/2𝑑𝑑𝑓𝑓  

Stresses 

Stresses are calculated according to 4.11. 

Sustained stresses are due to pressure, weight and other sustained mechanical loads. 
Maximum value is 0.8 × proof stress value or rupture stress value in hot condition. 

Expansion stresses are due to thermal (including specified displacements) and pressure 
loadings. Maximum value is lower of 

1) 0.9 × proof stress at room temperature plus 0.9 × proof stress at design temperature.  

2) 0.9 × proof stress at room temperature plus rupture stress at design temperature.  

Hot stresses are due to pressure, deadweight, other sustained mechanical loads, thermal and 
cold pull loadings. Maximum value is the rupture stress at design temperature. 

Occasional stresses (which are due to seismic, dynamic or wind loadings) are not calculated. 
If these are to be evaluated, ASME B31.1 code should be used according to Inquiry Case 
806/2 : November 1986 to BS 806 : 1986. 
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Stresses on Straight Pipes and Bends (4.11.4) 

The combined stress 𝑓𝑓𝑐𝑐 on straight pipes and bends including miter bends is calculated from 
(28). 

𝐹𝐹𝐶𝐶 = 𝐹𝐹2 + 4𝑓𝑓𝑆𝑆2 

where 
𝐹𝐹 = greater of 𝑓𝑓𝑇𝑇 or 𝑓𝑓𝐿𝐿 
𝑓𝑓𝑇𝑇 = transverse stress (4.11.4.2) 
 = transverse pressure stress + transverse bending stress 
𝑓𝑓𝐿𝐿 = longitudinal stress (4.11.4.3) 
 = longitudinal pressure stress + longitudinal bending stress 
𝑓𝑓𝑆𝑆 = torsional stress (4.11.4.4) 

Transverse Stress 𝒇𝒇𝑻𝑻  (4.11.4.2) 

The  transverse  pressure  stress  on  both  straight  pipes  and  bends  excluding  miter  
bends  is calculated from (29). 

𝑝𝑝𝑑𝑑
2𝑑𝑑

+ 0.5𝑝𝑝 

The transverse pressure stress on miter bends is calculated from (30) 

�
𝑝𝑝𝑑𝑑
2𝑑𝑑

+ 0.5𝑝𝑝��1 + 0.6427 𝑑𝑑𝑎𝑎𝑑𝑑 𝛼𝛼�
𝑑𝑑 + 𝑑𝑑

2𝑑𝑑
� 

The transverse bending stress on straight pipe is zero. 

The transverse bending stress on bends including miter bends is calculated from (31) 
𝑃𝑃
𝐼𝐼

(𝑀𝑀𝑑𝑑𝐹𝐹𝑇𝑇𝑑𝑑)2 + (𝑀𝑀𝑑𝑑𝐹𝐹𝑇𝑇𝑑𝑑)2 

where 

𝑑𝑑 = inside diameter 
𝑑𝑑 = thickness 
𝑝𝑝 = pressure 
𝑀𝑀𝑑𝑑  = in-plane bending moment 
𝑀𝑀𝑑𝑑  = out-of-plane bending moment 
𝐹𝐹𝑇𝑇𝑑𝑑  = in-plane transverse stress intensification factor 
𝐹𝐹𝑇𝑇𝑑𝑑  = out-of-plane transverse stress intensification factor 
𝑃𝑃 = mean radius of pipe 
𝐼𝐼 = moment of inertia 
𝑝𝑝 = outside diameter 
𝛼𝛼 = miter angle 
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Longitudinal Stress 𝒇𝒇𝑳𝑳 (4.11.4.3) 

The longitudinal pressure stress on both straight pipes and bends including miter bends is 
calculated form (32) 

𝑝𝑝𝑑𝑑2

4𝑑𝑑(𝑑𝑑 + 𝑑𝑑)
 

The longitudinal bending stress on straight pipe is calculated from (33). 

𝑑𝑑 + 2𝑑𝑑
2𝐼𝐼

�𝑀𝑀𝑑𝑑
2 + 𝑀𝑀𝑑𝑑

2 

The longitudinal bending stress on bends including miter bends is calculated from (34). 
𝑃𝑃
𝐼𝐼
�(𝑀𝑀𝑑𝑑𝐹𝐹𝐿𝐿𝑑𝑑)2 + (𝑀𝑀𝑑𝑑𝐹𝐹𝐿𝐿𝑑𝑑)2 

where 
𝐹𝐹𝐿𝐿𝑑𝑑  = in-plane longitudinal stress intensification factor 
𝐹𝐹𝐿𝐿𝑑𝑑  = out-of-plane longitudinal stress intensification factor 

Torsional Stress𝒇𝒇𝑺𝑺  (4.11.4.4) 
The  torsional  stress  for  both  straight  pipes  and  bends  including  miter  bends  is  
calculated from (35). 

𝑓𝑓𝑆𝑆 = 𝑀𝑀𝑑𝑑
𝑑𝑑 + 2𝑑𝑑

4𝐼𝐼
 

where 
𝑀𝑀𝑑𝑑  = torsional moment 

Stress at Branch Junction (4.11.5) 

The combined stress at a branch junction is calculated from (36) 

𝑓𝑓𝐶𝐶𝐵𝐵 = 𝑓𝑓𝐵𝐵2 + 4𝑓𝑓𝑆𝑆𝐵𝐵2  

where 
𝑓𝑓𝐵𝐵 = transverse pressure stress at the junction plus nondirectional bending stress 
𝑓𝑓𝑆𝑆𝐵𝐵  = torsional stress at the junction 
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Transverse Pressure Stress at Branch Junction (4.11.5.2) 

The transverse pressure stress at branch junction is calculated from (37) 

𝑝𝑝𝑚𝑚 �
𝑑𝑑1 + 𝑑𝑑𝑎𝑎

2𝑑𝑑𝑎𝑎
� 

where 
𝑑𝑑1 = mean radius of main pipe 
𝑑𝑑𝑎𝑎  = minimum thickness of main pipe 
𝑝𝑝 = design pressure 
𝑚𝑚 = stress multiplier, or equal to: 
  (a) for branch junctions where both r2/r1 and t2/t1 are less than or equal to 0.3 

  𝑚𝑚 = 1.8 + 2.8𝑃𝑃2
𝑃𝑃1

�
𝑃𝑃1
𝑑𝑑1

 

  (b) for branch junctions where either r2/r1 and t2/t1 are greater than 0.3 
  𝑚𝑚 = 2.5𝑍𝑍1

0.2042  for 𝑑𝑑2/𝑑𝑑1 ≤ 0.7 
  𝑚𝑚 = 2.5𝑍𝑍1

0.2415  for 𝑑𝑑2/𝑑𝑑1 > 0.7 
  𝑍𝑍1 = (𝑃𝑃2/𝑑𝑑2)2𝑑𝑑1/𝑃𝑃1 
  𝑃𝑃1 = mean radius of main pipe 
  𝑃𝑃2 = mean radius of branch pipe 
  𝑑𝑑1 = thickness of main pipe 
  𝑑𝑑2 = thickness of branch pipe 

Nondirectional Bending Stress at Branch Junction (4.11.5.3) 

For the main pipe, the bending stress is calculated from (40) 
𝑃𝑃1
𝐼𝐼
�(𝑀𝑀𝑑𝑑𝐵𝐵𝑑𝑑)2 + (𝑀𝑀𝑑𝑑𝐵𝐵𝑑𝑑)2 

where 
𝑃𝑃1 = mean radius of pipe 
𝐼𝐼 = moment of inertia of main pipe 
𝑀𝑀𝑑𝑑  = in-plane bending moment 
𝑀𝑀𝑑𝑑  = out-of-plane bending moment 
𝐵𝐵𝑑𝑑  = in-plane branch stress intensification factor (Fig.4.11.1(6)) 
𝐵𝐵𝑑𝑑  = out-of-plane branch stress intensification factor (Fig.4.11.1(6)) 
For the branch pipe, the bending stress is calculated from 

𝑃𝑃2

𝐼𝐼
�(𝑀𝑀𝑑𝑑𝐵𝐵𝑑𝑑)2 + (𝑀𝑀𝑑𝑑𝐵𝐵𝑑𝑑)2 

where 
𝑃𝑃2 = mean radius of branch pipe 
𝐼𝐼 = calculated from 𝜋𝜋𝑃𝑃2

3𝐵𝐵𝑑𝑑𝑑𝑑2 or 𝜋𝜋𝑃𝑃2
3𝑑𝑑1 whichever gives the lower value 
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Allowable Pressure 

The allowable pressure for straight pipes is calculated from equation 6.1-1 or 6.1-3 
depending on the ratio between inner and outer diameter. 

For 𝑝𝑝𝑑𝑑/𝑝𝑝𝑑𝑑 ≤ 1.7 

𝑃𝑃 =
2𝑓𝑓𝑓𝑓𝑃𝑃
𝑝𝑝𝑑𝑑 − 𝑃𝑃

 

For 𝑝𝑝𝑑𝑑/𝑝𝑝𝑑𝑑 > 1.7 

𝑃𝑃 = 𝑓𝑓𝑓𝑓
(1 − 𝑎𝑎2)
(1 + 𝑎𝑎2) 

where 
𝑃𝑃 = allowable pressure  
𝑓𝑓 = allowable stress 
𝑓𝑓 = joint factor (input as material property in CAEPIPE) 
𝑃𝑃 = nominal pipe thickness × (1 – mill tolerance %/100 – corrosion allowance)“c” 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc. should be 
included in corrosion allowance in CAEPIPE) 

𝑝𝑝𝑑𝑑  = outer diameter 
𝑝𝑝𝑑𝑑  = inner diameter 
𝑎𝑎 = 1 − 2𝑃𝑃

𝑝𝑝𝑑𝑑
 

For pipe bends the maximum allowable pressure is calculated using the equivalent pipe wall thickness 
e𝑃𝑃𝑒𝑒𝑃𝑃𝑑𝑑 − 

𝑃𝑃𝑃𝑃𝑒𝑒𝑃𝑃𝑑𝑑 =
𝑃𝑃
𝑑𝑑𝑓𝑓

 

where 

tf = �𝑅𝑅/𝑝𝑝−0.25
𝑅𝑅/𝑝𝑝−0.50

� 

𝑅𝑅 = radius on bend 

For closely spaced miter bends, the allowable pressure is calculated from equations 6.3.4-1 
and 6.3.4-2. 

𝑃𝑃 = 𝑚𝑚𝑑𝑑𝑑𝑑 �
𝑓𝑓𝑓𝑓𝑃𝑃2

𝑃𝑃�𝑃𝑃 + 0.643 𝑑𝑑𝑎𝑎𝑑𝑑 𝜃𝜃 √𝑃𝑃𝑃𝑃�
,
𝑓𝑓𝑓𝑓𝑃𝑃(𝑅𝑅𝑃𝑃 − 𝑃𝑃)
𝑃𝑃(𝑅𝑅𝑃𝑃 − 𝑃𝑃/2)�𝑤𝑤𝑑𝑑𝑑𝑑ℎ 𝜃𝜃 ≤ 22.5  

For widely spaced miter bends, the allowable pressure is calculated from equations 6.3.4-1, 
6.3.4-2 and 6.3.5-1 

𝑃𝑃 = 𝑚𝑚𝑑𝑑𝑑𝑑 �
𝑓𝑓𝑓𝑓𝑃𝑃2

𝑃𝑃�𝑃𝑃 + 0.643 𝑑𝑑𝑎𝑎𝑑𝑑 𝜃𝜃 √𝑃𝑃𝑃𝑃�
,
𝑓𝑓𝑓𝑓𝑃𝑃(𝑅𝑅𝑃𝑃 − 𝑃𝑃)
𝑃𝑃(𝑅𝑅𝑃𝑃 − 𝑃𝑃/2)�𝑤𝑤𝑑𝑑𝑑𝑑ℎ 𝜃𝜃 ≤ 22.5  

𝑃𝑃 =
𝑓𝑓𝑓𝑓𝑃𝑃2

𝑃𝑃�𝑃𝑃 + 1.25 𝑑𝑑𝑎𝑎𝑑𝑑 𝜃𝜃 √𝑃𝑃𝑃𝑃�
𝑤𝑤𝑑𝑑𝑑𝑑ℎ 𝜃𝜃 ≤ 22.5
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where 
𝑃𝑃 = mean radius of pipe = (𝑝𝑝 − t)/2 
𝑅𝑅𝑆𝑆 = effective bend radius of the miter 
θ = miter half angle 

Sustained Stress 

The stress (𝜎𝜎1) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from equation (12.3.2-1) 

𝜎𝜎1 =
𝑃𝑃𝑝𝑝𝑑𝑑
4𝑃𝑃𝑑𝑑

+
0.75𝑑𝑑𝑀𝑀𝐴𝐴

𝑍𝑍
≤ 𝑓𝑓ℎ  

where 
𝑃𝑃 = maximum of CAEPIPE input pressures P1, P2 and P3 
𝑝𝑝𝑑𝑑  = outside diameter 
𝑃𝑃𝑑𝑑  = nominal pipe wall thickness 
𝑑𝑑 = stress intensification factor.  The product 0.75𝑑𝑑, shall not be less than 1.0 
𝑀𝑀𝐴𝐴 = resulting bending moment due to sustained loads 
𝑍𝑍 = uncorroded section modulus; for reduced outlets / branch connections, effective 

 section modulus 
𝑓𝑓ℎ  = hot allowable stress 

Sustained plus Occasional Stress 

The stress (𝜎𝜎2) due to sustained and occasional loads is calculated from equation (12.3.3-1) 
as the sum of stress due to sustained loads such as due to pressure, weight and other 
sustained mechanical loads and stress due to occasional loads such as earthquake or wind. 
Wind and earthquake are not considered concurrently 
 

𝜎𝜎2 =
𝑃𝑃𝑝𝑝𝑑𝑑
4𝑃𝑃𝑑𝑑

+
0.75𝑑𝑑𝑀𝑀𝐴𝐴

𝑍𝑍
+

0.75𝑑𝑑𝑀𝑀𝐵𝐵

𝑍𝑍
≤ 𝐺𝐺𝑓𝑓ℎ  

where 
𝑀𝑀𝐵𝐵  = resultant bending moment due to occasional load 
𝑍𝑍 = 1.2 if the occasional load is acting less than 1% in any 24 hour operating period. In 

 CAEPIPE  
𝐺𝐺 =  1.2; user can change this input in Layout window > Options > Analysis > Code > 

 EN13480. 

Expansion Stress 

The stress (𝜎𝜎3) due to thermal expansion is calculated from equation (12.3.4-1) 

𝜎𝜎3 =
𝑑𝑑𝑀𝑀𝐶𝐶

𝑍𝑍
≤ 𝑓𝑓𝑎𝑎  

where 
𝑀𝑀𝐶𝐶  = resultant moment due to thermal expansion and alternating loads 
𝑍𝑍 = uncorroded section modulus; for reduced outlets / branch connections, effective 

 section modulus 

𝑓𝑓𝑎𝑎 = 𝑈𝑈(1.25𝑓𝑓𝐶𝐶 + 0.25𝑓𝑓ℎ) +
𝐸𝐸ℎ
𝐸𝐸𝑐𝑐
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𝑈𝑈 = cyclic stress range reduction factor taken from table 12.1.3-1 
𝑓𝑓ℎ  = allowable stress at hot temperature 
𝐸𝐸𝑐𝑐  = elastic modulus at cold temperature 
𝐸𝐸ℎ  = elastic modulus at hot temperature 

If the above condition in equation (12.3.4-1) is not met, equation (12.3.4-2) may be used. 

𝜎𝜎4 =
𝑃𝑃𝑝𝑝𝑑𝑑
4𝑃𝑃𝑑𝑑

+
0.75𝑑𝑑𝑀𝑀𝐴𝐴

𝑍𝑍
+
𝑑𝑑𝑀𝑀𝐶𝐶

𝑍𝑍
≤ 𝑓𝑓ℎ + 𝑓𝑓ℎ  

Additional Conditions for the Creep Range 

For piping operating within the creep range, the stress, (𝜎𝜎5) , due to sustained, thermal and 
alternating loadings shall satisfy the equation (12.3.5-1) below. 

𝜎𝜎5 =
𝑃𝑃𝑝𝑝𝑑𝑑
4𝑃𝑃

+
0.75𝑑𝑑𝑀𝑀𝐴𝐴

𝑍𝑍
+

0.75𝑑𝑑𝑀𝑀𝐶𝐶

𝑍𝑍
≤ 𝑓𝑓𝑐𝑐𝑃𝑃  

where 
𝑓𝑓𝑐𝑐𝑃𝑃  = allowable creep stress value 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from Equation 6.3. 

𝑝𝑝 =
2𝑓𝑓𝑓𝑓𝐿𝐿𝑇𝑇𝑃𝑃𝑓𝑓𝑓𝑓
𝑝𝑝𝑚𝑚 − 𝑇𝑇𝑃𝑃𝑓𝑓𝑓𝑓

 

where 
𝑝𝑝 = allowable pressure 
𝑓𝑓 = allowable stress 
𝑓𝑓𝐿𝐿 = joint efficiency of longitudinal weld (input as material property) 
𝑇𝑇𝑃𝑃𝑓𝑓𝑓𝑓= nominal pipe thickness × (1 – mill tolerance/100) – corrosion allowance 
𝑝𝑝 = outside diameter 
𝑑𝑑 = inside diameter 
𝑚𝑚 = pressure coefficient 
 = 1.0 for 𝑝𝑝/d<1.6 
 = 0.25(𝑝𝑝/d)+0.6 for 1.6 ≤ 𝑝𝑝/d≤2.0 

Sustained Stress 

Stress (𝑆𝑆𝐿𝐿) due to sustained loads (pressure, weight and other sustained mechanical loads) is 
calculated from Equation 9.32. 

𝑆𝑆𝐿𝐿 =
𝑝𝑝𝑝𝑝

4𝑇𝑇𝑃𝑃𝑓𝑓𝑓𝑓 𝑓𝑓𝐶𝐶
+

0.75𝐺𝐺1𝑀𝑀𝐴𝐴

𝑊𝑊
≤ 𝑓𝑓2 

where 
𝑝𝑝 = maximum pressure 
𝑓𝑓𝐶𝐶  = joint efficiency of circumferential weld (input as material property) 
𝐺𝐺1 = stress intensification factor. The product 0.75𝐺𝐺1 shall not be less than 1.0 
𝑀𝑀𝐴𝐴 = resultant bending moment due to sustained loads 
𝑊𝑊 = section modulus, for reduced outlets, effective section modulus 
𝑓𝑓2 = hot allowable stress 

Occasional Stress 

The stress (𝑆𝑆𝐿𝐿𝑂𝑂) is calculated as the sum of the stress due to sustained loads (𝑆𝑆𝐿𝐿) and the 
stress (𝑆𝑆𝑂𝑂) due to occasional loads such as earthquake or wind from Equation 9.33. Wind 
and earthquake are not considered concurrently. 

𝑆𝑆𝐿𝐿𝑂𝑂 =
𝑝𝑝𝑝𝑝

4𝑇𝑇𝑃𝑃𝑓𝑓𝑓𝑓 𝑓𝑓𝐶𝐶
+

0.75𝐺𝐺1(𝑀𝑀𝐴𝐴 + 𝑀𝑀𝐵𝐵)
𝑊𝑊

≤ 1.2𝑓𝑓2 

where 
𝑀𝑀𝐵𝐵  = resultant bending moment due to occasional loads 
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Expansion Stress 

The stress (𝑆𝑆𝐸𝐸) due to thermal expansion is calculated from Equation 9.34. 

𝑆𝑆𝐸𝐸 =
𝐺𝐺1𝑀𝑀𝐶𝐶

𝑊𝑊
≤ 𝑆𝑆𝑃𝑃  

Alternatively, Equation 9.35 may be used. 

𝑆𝑆𝐿𝐿 + 𝑆𝑆𝐸𝐸 ≤ 𝑓𝑓2 + 𝑆𝑆𝑃𝑃  

where 
𝑀𝑀𝐶𝐶  = resultant bending moment due to thermal expansion. 
𝑆𝑆𝑃𝑃  = 𝑓𝑓𝑃𝑃(1.17𝑅𝑅1 + 0.17𝑅𝑅2) 
𝑓𝑓𝑃𝑃  = stress range reduction factor taken from Table 9.1. 
𝑅𝑅1 = smaller of 𝑓𝑓1 and 0.267𝑅𝑅m  
𝑅𝑅2 = smaller of 𝑓𝑓2 and 0.367𝑅𝑅m  
𝑓𝑓1 = allowable stress at cold condition 
𝑓𝑓2 = allowable stress at hot condition 
𝑅𝑅m  = tensile strength at room temperature 
At moderate temperatures (up to 370º C) for carbon steel, low alloy steel and chromium steel 
(specified as CS material type) and up to 425º C for austenitic stainless steel (specified as AS 
material type), the limits 0.267𝑅𝑅m  and 0.367𝑅𝑅m  are disregarded and 𝑆𝑆𝑃𝑃  is selected as smaller 
of 𝑆𝑆𝑃𝑃′  and 𝑆𝑆𝑃𝑃′′ , 

where 
𝑆𝑆𝑃𝑃′  = 1.17𝑓𝑓1 + 0.20𝑓𝑓2 
𝑆𝑆𝑃𝑃′′  = 290𝑓𝑓r − 𝑓𝑓2 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from Equation 6.3. 

𝑝𝑝 =
2𝑓𝑓𝑓𝑓𝐿𝐿𝑇𝑇𝑃𝑃𝑓𝑓𝑓𝑓
𝑝𝑝𝑚𝑚 − 𝑇𝑇𝑃𝑃𝑓𝑓𝑓𝑓

 

where 
𝑝𝑝 = allowable pressure 
𝑓𝑓 = allowable stress 
𝑓𝑓𝐿𝐿 = joint efficiency of longitudinal weld (input as material property) 
𝑇𝑇𝑃𝑃𝑓𝑓𝑓𝑓= nominal pipe thickness × (1 – mill tolerance/100) – corrosion allowance 
𝑝𝑝 = outside diameter 
𝑑𝑑 = inside diameter 
𝑚𝑚 = pressure coefficient 
 = 1.0 for 𝑝𝑝/d<1.6 
 = 0.25(𝑝𝑝/d)+0.6 for 1.6 ≤ 𝑝𝑝/d≤2.0 

Sustained Stress 

Stress (𝑆𝑆𝐿𝐿) due to sustained loads (pressure, weight and other sustained mechanical loads) is 
calculated from Equation 10.7. 

𝑆𝑆𝐿𝐿 =
𝑝𝑝𝑝𝑝

4𝑇𝑇𝑃𝑃𝑓𝑓𝑓𝑓 𝑓𝑓𝐶𝐶
+

0.75𝐺𝐺1𝑀𝑀𝐴𝐴

𝑊𝑊
≤ 𝑓𝑓2 

where 
𝑝𝑝 = maximum pressure 
𝑓𝑓𝐶𝐶  = joint efficiency of circumferential weld (input as material property) 
𝐺𝐺1 = stress intensification factor. The product 0.75𝐺𝐺1 shall not be less than 1.0 
𝑀𝑀𝐴𝐴 = resultant bending moment due to sustained loads 
𝑊𝑊 = section modulus, for reduced outlets, effective section modulus 
𝑓𝑓2 = hot allowable stress 

Occasional Stress 

The stress (𝑆𝑆𝐿𝐿𝑂𝑂) is calculated as the sum of the stress due to sustained loads (𝑆𝑆𝐿𝐿) and the 
stress (𝑆𝑆𝑂𝑂) due to occasional loads such as earthquake or wind from Equation 10.8. Wind 
and earthquake are not considered concurrently. 

𝑆𝑆𝐿𝐿𝑂𝑂 =
𝑝𝑝𝑝𝑝

4𝑇𝑇𝑃𝑃𝑓𝑓𝑓𝑓 𝑓𝑓𝐶𝐶
+

0.75𝐺𝐺1(𝑀𝑀𝐴𝐴 + 𝑀𝑀𝐵𝐵)
𝑊𝑊

≤ 1.2𝑓𝑓2 

where 
𝑀𝑀𝐵𝐵  = resultant bending moment due to occasional loads 
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Expansion Stress 

The stress (𝑆𝑆E) due to thermal expansion is calculated from Equation 10.9. 

𝑆𝑆𝐸𝐸 =
𝐺𝐺1𝑀𝑀𝐶𝐶

𝑊𝑊
≤ 𝑆𝑆𝑃𝑃  

Alternatively, Equation 10.10 may be used. 

𝑆𝑆𝐿𝐿 + 𝑆𝑆𝐸𝐸 ≤ 𝑓𝑓2 + 𝑆𝑆𝑃𝑃  

where 
𝑀𝑀𝐶𝐶  = resultant bending moment due to thermal expansion. 
𝑆𝑆𝑃𝑃  = smaller of 𝑆𝑆𝑃𝑃′  and 𝑆𝑆𝑃𝑃′′  
𝑆𝑆𝑃𝑃′  = 1.25𝑓𝑓1 + 0.25𝑓𝑓2 
𝑆𝑆𝑃𝑃′′  = 𝑓𝑓𝑃𝑃𝑅𝑅𝑃𝑃 − 𝑓𝑓2 
𝑓𝑓𝑃𝑃  = stress range reduction factor 
𝑓𝑓1 = allowable stress at cold condition 
𝑓𝑓2 = allowable stress at hot condition 
𝑅𝑅𝑃𝑃 = permissible extent of stress for 7000 load cycles for different materials 
 𝑅𝑅𝑃𝑃 is determined by material type as follows: 
  
 Material   Type RS 
 Carbon and low alloy steel CS 290 
 Austenitic stainless steel AS 400 
 Copper alloys, annealed CA 150 
 Copper alloys, cold worked CC 100 
 Aluminum   AL 130 
 Titanium   TI 200 

The stress range reduction factor 𝑓𝑓𝑃𝑃  depends on the number of thermal cycles (NE). For 
moderate high temperatures (≤ 370º C for carbon, low alloy and chromium steel and ≤ 425º 
C for austenitic stainless steel), 𝑓𝑓𝑃𝑃  is calculated from 

𝑓𝑓𝑃𝑃 = (7000/𝑁𝑁𝐸𝐸)0.2𝑁𝑁𝐸𝐸 > 100 (𝑑𝑑. 𝑃𝑃. , 𝑓𝑓𝑃𝑃 ≤ 2.34) 

At higher temperatures, 𝑆𝑆𝑃𝑃  shall not be greater than 𝑓𝑓𝑃𝑃(1.25𝑅𝑅1 + 0.25𝑅𝑅2) and 𝑓𝑓𝑃𝑃  shall not 
be greater than 1.0. 

where 
𝑅𝑅1 = smaller of 𝑓𝑓1 and 0.25𝑅𝑅𝑚𝑚  
𝑅𝑅2 = smaller of 𝑓𝑓2 and 0.25𝑅𝑅𝑚𝑚  
𝑅𝑅𝑚𝑚  = tensile strength at room temperature 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from Equation 2 of C 
3641.1. 

𝑃𝑃 =
2𝑆𝑆𝐸𝐸𝑑𝑑𝑚𝑚

𝑝𝑝 − 2𝑌𝑌𝑑𝑑𝑚𝑚
 

where 
𝑃𝑃 = allowable pressure 
𝑆𝑆 = allowable stress 
𝐸𝐸 = joint factor (input as material property) 
𝑑𝑑𝑚𝑚  = minimum required thickness, including mechanical and corrosion allowance 
 = 𝑑𝑑 ×(1 – mill tolerance/100) – corrosion allowance 
𝑑𝑑 = nominal pipe thickness 
𝑝𝑝 = outside diameter 
𝑑𝑑 = inside diameter 
𝑌𝑌 = pressure coefficient 
 = 0.4 for 𝑑𝑑 < 𝑝𝑝/6 
 = 𝑑𝑑/(𝑝𝑝 + 𝑑𝑑) for 𝑑𝑑 ≥ 𝑝𝑝/6 

Sustained Stress 

The stress (𝑆𝑆𝐿𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from Equation 6 of C 3652. 

𝑆𝑆𝐿𝐿 =
𝑃𝑃𝑝𝑝
4𝑑𝑑

+
0.75𝑑𝑑𝑀𝑀𝐴𝐴

𝑍𝑍
≤ 𝑆𝑆ℎ  

where 
𝑃𝑃 = maximum pressure 
𝑝𝑝 = outside diameter 
𝑑𝑑 = nominal wall thickness 
𝑑𝑑 = stress intensification factor. The product 0.75𝑑𝑑, shall not be less than 1.0 
𝑀𝑀𝐴𝐴 = resultant bending moment due to sustained loads = �𝑀𝑀𝑋𝑋

2 + 𝑀𝑀𝑌𝑌
2 + 𝑀𝑀𝑍𝑍

2 
𝑍𝑍 = section modulus, for reduced outlets, effective section modulus 
𝑆𝑆ℎ  = hot allowable stress 

Occasional Stress 

The stress (𝑆𝑆𝐿𝐿𝑂𝑂) is calculated as the sum of stress due to sustained loads (𝑆𝑆𝐿𝐿) and stress due 
to occasional loads (𝑆𝑆𝑂𝑂), such as earthquake or wind from Equation 10 of C 3654. Wind and 
earthquake are not considered concurrently. 

𝑆𝑆𝐿𝐿𝑂𝑂 = 𝑆𝑆𝐿𝐿 +
0.75𝑑𝑑𝑀𝑀𝐵𝐵

𝑍𝑍
≤ 1.2𝑆𝑆ℎ  

where 
𝑀𝑀𝐵𝐵  = resultant moment due to occasional loads 
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Expansion Stress 

The stress (SE) due to thermal expansion is calculated from Equation 7 of C 3653.2. 

𝑆𝑆𝐸𝐸 =
𝑑𝑑𝑀𝑀𝐶𝐶

𝑍𝑍
≤ 𝑆𝑆𝐴𝐴  

where 
𝑀𝑀𝐶𝐶  = resultant moment due to thermal expansion 
𝑆𝑆𝐴𝐴 = 𝑓𝑓(1.25𝑆𝑆𝑐𝑐 + 0.25𝑆𝑆ℎ) 
𝑆𝑆𝑐𝑐  = allowable stress at cold temperature 
𝑓𝑓 = stress range reduction factor from Table C 3653.3 
The stress due to pressure, weight, other sustained loads and thermal expansion is calculated 
from Equation 8 of C 3653.2. 

𝑆𝑆𝑇𝑇𝐸𝐸 = 𝑆𝑆𝐿𝐿 + 𝑆𝑆𝐸𝐸 ≤ 𝑆𝑆ℎ + 𝑆𝑆𝐴𝐴 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from 

𝑃𝑃 =
2𝑓𝑓𝑓𝑓𝑃𝑃
𝑝𝑝 − 𝑃𝑃

 

where 

𝑃𝑃 = allowable pressure 
𝑆𝑆 = allowable stress 
𝐸𝐸 = joint factor (input as material property in CAEPIPE) 
𝑑𝑑𝑚𝑚  = nominal pipe thickness× (1 – mill tolerance/100) – corrosion allowance “c” 

(Any additional thickness required for threading, grooving, erosion, corrosion, etc.  should 
be included in corrosion allowance in CAEPIPE) 

𝑝𝑝 = outside diameter 

For pipe bends the maximum allowable pressure is calculated using the equivalent pipe wall 
thickness 𝑃𝑃𝑃𝑃𝑒𝑒𝑃𝑃𝑑𝑑 − 
 
𝑃𝑃𝑃𝑃𝑒𝑒𝑃𝑃𝑑𝑑 − = 

𝑃𝑃
𝑑𝑑𝑓𝑓

 

Where 

𝑑𝑑𝑓𝑓 =
𝑅𝑅(𝑝𝑝 − 0.25)
𝑅𝑅(𝑝𝑝 − 0.25) 

For closely spaced miter bends, the allowable pressure is calculated from 

𝑃𝑃 = min �
𝑓𝑓𝑓𝑓𝑃𝑃2

𝑃𝑃�𝑃𝑃 + 0.643 tan 𝜃𝜃√𝑃𝑃𝑃𝑃�
,
𝑓𝑓𝑓𝑓𝑃𝑃2(R − r)
𝑃𝑃(R − r/2) �  with 𝜃𝜃 ≤ 22.5 

For widely spaced miter bends, the allowable pressure is calculated from 

𝑃𝑃 = min �
𝑓𝑓𝑓𝑓𝑃𝑃2

𝑃𝑃�𝑃𝑃 + 0.643 tan 𝜃𝜃√𝑃𝑃𝑃𝑃�
,
𝑓𝑓𝑓𝑓𝑃𝑃2(R − r)
𝑃𝑃(R − r/2) �  with 𝜃𝜃 ≤ 22.5 

𝑃𝑃 =
𝑓𝑓𝑓𝑓𝑃𝑃2

𝑃𝑃�𝑃𝑃 + 1.25 tan 𝜃𝜃√𝑃𝑃𝑃𝑃�
 with 𝜃𝜃 ≤ 22.5 

Where 

𝑃𝑃 = mean raidu of pipe = (D-t)/2 
𝑅𝑅𝑆𝑆 = effective bend radius of the miter 

𝜃𝜃 = miter half angle 
𝑌𝑌 = pressure coefficient
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Sustained Stress 

The stress (𝜎𝜎1) due to sustained loads (pressure, weight and other sustained mechanical 
loads) iscalculated from 

𝜎𝜎1 =
𝑃𝑃𝑝𝑝𝑑𝑑
4𝑃𝑃

+
0.75𝑑𝑑𝑀𝑀𝐴𝐴

𝑍𝑍
≤ 𝑓𝑓ℎ  

Where  

𝑃𝑃 = maximum of CAEPIPE input pressures P1, P2 and P3 
𝑝𝑝𝑑𝑑  = outside diameter 
𝑃𝑃 = nominal pipe thickness x [1 - mill tolerance%/100] - corrosion allowance “c” 
𝑑𝑑 = stress intensification factor; the product of 0.75i shall not be less than 1.0 
𝑀𝑀𝐴𝐴 = resulting bending moment due to sustained loads 
𝑍𝑍 = uncorroded section modulus; for reduced outlets / branch connections, effective 

 section modulus 
𝑓𝑓ℎ  = hot allowable stress 

Sustained plus Occasional Stress 

The stress (𝜎𝜎2) due to sustained and occasional loads is calculated as the sum of stress due 
to sustained loads such as due to pressure, weight and other sustained mechanical loads and 
stress due to occasional loads such as earthquake or wind. Wind and earthquake are not 
considered concurrently 

𝜎𝜎2 =
𝑃𝑃𝑝𝑝𝑑𝑑
4𝑃𝑃

+
0.75𝑑𝑑𝑀𝑀𝐴𝐴

𝑍𝑍
+

0.75𝑑𝑑𝑀𝑀𝐵𝐵

𝑍𝑍
≤ 𝐺𝐺𝑓𝑓ℎ  

𝑀𝑀𝐵𝐵  = resultant bending moment due to occasional load 
𝐺𝐺 = 1.2 if the occasional load is acting less than 1% in any 24 hour operating period. In 

 CAEPIPE k =1.2 is used for occasional loading. 

Expansion Stress 

The stress (𝜎𝜎3) due to thermal expansion is calculated from 

𝜎𝜎3 =
𝑑𝑑𝑀𝑀𝐶𝐶

𝑍𝑍
+≤ 𝑓𝑓𝑎𝑎  

 
𝑍𝑍 = uncorroded section modulus; for reduced outlets / branch connections, effective 

 section modulus 
𝑓𝑓𝑎𝑎  = 𝑈𝑈(1.25𝑓𝑓𝐶𝐶 + 0.25𝑓𝑓ℎ) 𝐸𝐸ℎ

𝐸𝐸𝑐𝑐
 

𝑈𝑈 = cyclic stress range reduction factor as mentioned below 
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Number of cycle Stress range reduction factor 𝑈𝑈 
𝑓𝑓𝑎𝑎 <= 7000  1.0 
7001 to 140000 0.9 
14001 to 220000 0.8 
22001 to 0.7 0.7 
45001 to 100000 0.6 
100001 to 2000000 0.5 

 
𝑓𝑓𝐶𝐶  = allowable stress at cold temperature 
𝑓𝑓𝐶𝐶  =  allowable stress at hot temperature 
𝐸𝐸𝐶𝐶  = elastic modulus at cold temperature 
𝐸𝐸ℎ  = elastic modulus at hot temperature 

𝜎𝜎4 =
𝑃𝑃𝑝𝑝𝑑𝑑
4𝑃𝑃

+
0.75𝑑𝑑𝑀𝑀𝐴𝐴

𝑍𝑍
+
𝑑𝑑𝑀𝑀𝐶𝐶

𝑍𝑍
≤ 𝑓𝑓ℎ + 𝑓𝑓𝑎𝑎  

Additional Conditions for the Creep Range 

For piping operating within the creep range, the stress, (𝜎𝜎5) , due to sustained, thermal and 
alternating loadings shall satisfy the equation below. 

𝜎𝜎5 =
𝑃𝑃𝑝𝑝𝑑𝑑
4𝑃𝑃

+
0.75𝑑𝑑𝑀𝑀𝐴𝐴

𝑍𝑍
+

0.75𝑑𝑑𝑀𝑀𝐶𝐶

3𝑍𝑍
≤ 𝑓𝑓𝑐𝑐𝑃𝑃  

Where 

𝑓𝑓𝑐𝑐𝑃𝑃  =  allowable creep stress value 
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Sustained Stress 

The stress (𝑆𝑆𝐿𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) is calculated from 

𝑆𝑆𝐿𝐿 =
𝑃𝑃(𝑝𝑝 − 𝑑𝑑)

4𝑑𝑑
+

0.75𝑑𝑑𝑀𝑀𝐴𝐴

𝑍𝑍
≤ 𝑆𝑆ℎ  

where 
𝑃𝑃 = maximum pressure 
𝑝𝑝 = outside diameter 
𝑑𝑑 = nominal wall thickness 
𝑑𝑑 = stress intensification factor. The product 0.75𝑑𝑑, shall not be less than 1.0 
𝑀𝑀𝐴𝐴 = resultant bending moment due to sustained loads = �𝑀𝑀𝑋𝑋

2 + 𝑀𝑀𝑌𝑌
2 + 𝑀𝑀𝑍𝑍

2 
𝑍𝑍 = section modulus, for reduced outlets, effective section modulus 
𝑆𝑆ℎ  = hot allowable stress: smaller of: 
  0.67 yield stress at temperature 
  0.44 tensile strength at 20º C 
  0.67 rupture stress (after 100,000 hours at temperature) 

Occasional Stress 

The stress (𝑆𝑆𝐿𝐿𝑂𝑂) is calculated as the sum of stress due to sustained loads (𝑆𝑆𝐿𝐿) and stress due 
to occasional loads (𝑆𝑆𝑂𝑂),such as earthquake or wind. Wind and earthquake are not 
considered concurrently. 

𝑆𝑆𝐿𝐿𝑂𝑂 = 𝑆𝑆𝐿𝐿 +
0.75𝑑𝑑𝑀𝑀𝐵𝐵

𝑍𝑍
≤ 1.2𝑆𝑆ℎ  

where 
𝑀𝑀𝐵𝐵  = resultant moment due to occasional loads 

Expansion Stress 

The stress (𝑆𝑆𝐸𝐸) due to thermal expansion is calculated from 

𝑆𝑆𝐸𝐸 =
𝑑𝑑𝑀𝑀𝐶𝐶

𝑍𝑍
≤ 𝑆𝑆𝐴𝐴  

where 
𝑀𝑀𝐶𝐶  = resultant moment due to thermal expansion  
𝑆𝑆𝐴𝐴 = smaller of: 
  𝐶𝐶𝑓𝑓  (0.8 yield strength at 20º C + 0.13 hot yield strength) 
  𝐶𝐶𝑓𝑓  (0.8 yield strength at 20º C + 0.2 x 0.67 rupture stress) 
𝐶𝐶𝑓𝑓  = stress range reduction factor 
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Allowable Pressure 

The allowable pressure for straight pipes and bends is calculated from Equation 6.3. 

𝑝𝑝 =
2𝜎𝜎𝑑𝑑𝑑𝑑 𝑓𝑓𝐿𝐿𝑃𝑃𝑃𝑃𝑓𝑓𝑓𝑓
𝑝𝑝𝑦𝑦𝑚𝑚 − 𝑃𝑃𝑃𝑃𝑓𝑓𝑓𝑓

 

where 
𝑝𝑝 = allowable pressure 
𝜎𝜎𝑑𝑑𝑑𝑑  = allowable stress 
𝑓𝑓𝐿𝐿 = joint efficiency of longitudinal weld (input as material property) 
𝑃𝑃𝑃𝑃𝑓𝑓𝑓𝑓= nominal pipe thickness × (1 – mill tolerance/100) – corrosion allowance 
𝑝𝑝𝑦𝑦  = outside diameter 
𝑝𝑝𝑑𝑑  = inside diameter= 𝑝𝑝𝑦𝑦 − 𝑃𝑃𝑃𝑃𝑓𝑓𝑓𝑓  
𝑚𝑚 = pressure coefficient 
 = 1.0 for 𝑝𝑝𝑦𝑦/𝑝𝑝𝑑𝑑<1.6 
 = 0.25�𝑝𝑝𝑦𝑦/𝑝𝑝𝑑𝑑�+0.6 for 1.6≤𝑝𝑝𝑦𝑦/𝑝𝑝𝑑𝑑≤2.0 

Sustained Stress 

Stress (𝑆𝑆𝐿𝐿) due to sustained loads (pressure, weight and other sustained mechanical loads) is 
calculated from Equation 9.37. 

𝑆𝑆𝐿𝐿 =
𝑝𝑝𝑚𝑚𝑎𝑎𝑚𝑚 𝑝𝑝𝑦𝑦
4𝑃𝑃𝑃𝑃𝑓𝑓𝑓𝑓 𝑓𝑓𝐶𝐶

+
0.75𝐺𝐺1𝑀𝑀𝐴𝐴

𝑊𝑊𝑦𝑦
≤ 𝜎𝜎𝑑𝑑𝑑𝑑2 

 
where 
𝑝𝑝𝑚𝑚𝑎𝑎𝑚𝑚  = maximum pressure 
𝑓𝑓𝐶𝐶  = joint efficiency of circumferential weld (input as material property) 
𝐺𝐺1 = stress intensification factor. The product 0.75𝐺𝐺1shall not be less than 1.0 
𝑀𝑀𝐴𝐴 = resultant bending moment due to sustained loads 
𝑊𝑊𝑦𝑦  = section modulus, for reduced outlets, effective section modulus 
𝜎𝜎𝑑𝑑𝑑𝑑2 = hot allowable stress 

Occasional Stress 

The stress (𝑆𝑆𝐿𝐿𝑂𝑂) is calculated as the sum of the stress due to sustained loads (𝑆𝑆𝐿𝐿) and the 
stress (𝑆𝑆𝑂𝑂) due to occasional loads such as earthquake or wind from Equation 9.38. Wind 
and earthquake are not considered concurrently. 

𝑆𝑆𝐿𝐿𝑂𝑂 =
𝑝𝑝𝑚𝑚𝑎𝑎𝑚𝑚 𝑝𝑝𝑦𝑦
4𝑃𝑃𝑃𝑃𝑓𝑓𝑓𝑓 𝑓𝑓𝐶𝐶

+
0.75𝐺𝐺1(𝑀𝑀𝐴𝐴 + 𝑀𝑀𝐵𝐵)

𝑊𝑊𝑦𝑦
≤ 1.2𝜎𝜎𝑑𝑑𝑑𝑑2 

where 
𝑀𝑀𝐵𝐵  = resultant bending moment due to occasional loads 
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Expansion Stress 

The stress (𝑆𝑆𝐸𝐸) due to thermal expansion is calculated from Equation 9.39. 

𝑆𝑆𝐸𝐸 =
𝐺𝐺1𝑀𝑀𝐶𝐶

𝑊𝑊𝑦𝑦
≤ 𝑆𝑆𝑃𝑃  

where 
𝑀𝑀𝐶𝐶  = resultant bending moment due to thermal expansion 
𝑆𝑆𝑃𝑃  = 𝑓𝑓(1.17𝜎𝜎1 + 0.17𝜎𝜎2) from Equation 9.43 
𝑓𝑓 = stress range reduction factor taken from Table 9.1 
𝜎𝜎1 = smaller of 𝜎𝜎𝑑𝑑𝑑𝑑1 and 0.267𝑅𝑅𝑚𝑚  
𝜎𝜎2 = smaller of 𝜎𝜎𝑑𝑑𝑑𝑑2 and 0.367𝑅𝑅𝑚𝑚  
𝜎𝜎𝑑𝑑𝑑𝑑1= allowable stress at cold condition 
𝜎𝜎𝑑𝑑𝑑𝑑2= allowable stress at hot condition 
𝑅𝑅𝑚𝑚  = tensile strength at room temperature 
At moderate temperatures (up to 370º C) for carbon steel, low alloy steel and chromium steel 
(specified as CS material type) and up to 425º C for austenitic stainless steel (specified as AS 
material type), the limits 0.267𝑅𝑅𝑚𝑚  and 0.367𝑅𝑅𝑚𝑚  are disregarded and 𝑆𝑆𝑃𝑃  is selected as smaller 
of 𝑆𝑆𝑃𝑃′  and 𝑆𝑆𝑃𝑃′′ , 

where 
𝑆𝑆𝑃𝑃′  = 1.17𝜎𝜎𝑑𝑑𝑑𝑑1 + 0.20𝜎𝜎𝑑𝑑𝑑𝑑2 
𝑆𝑆𝑃𝑃′′  = 290𝑓𝑓 − 𝜎𝜎𝑑𝑑𝑑𝑑2 
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Allowable Pressure 

The allowable pressure is calculated from 5.3.2.1. 

𝑃𝑃 = 2𝑆𝑆𝑑𝑑𝐹𝐹𝐿𝐿𝐺𝐺𝑇𝑇/D 

where 
𝑃𝑃 = allowable pressure 
𝑆𝑆 = specified minimum yield strength 
𝑑𝑑 = minimum wall thickness 
 = nominal wall thickness × (1 − mill tolerance/100) − corrosion allowance 
𝐹𝐹 = design factor = 0.8 for steel pipe (from 5.2.3) 
𝐿𝐿 = location factor (from Table 5.1) 
𝐺𝐺 = joint factor (from Table 5.2), input as material property 
𝑇𝑇 = temperature derating factor for steel pipe (from Table 5.3) 
𝑝𝑝 = outside diameter 

Sustained Stress 

The stress (𝑆𝑆𝐿𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) and wind loads, is calculated from (5.6.3.5) 

𝑆𝑆𝐿𝐿 =
𝑃𝑃𝑝𝑝
4𝑑𝑑

+ 𝑑𝑑
𝑀𝑀
𝑍𝑍
≤ 𝑆𝑆𝐹𝐹𝐿𝐿𝐺𝐺𝑇𝑇 

 
where 
𝑃𝑃 = maximum pressure 
𝑝𝑝 = outside diameter 
𝑑𝑑 = minimum wall thickness 
𝑑𝑑 = stress intensification factor 
𝑀𝑀 = resultant bending moment due to sustained loads 
𝑍𝑍 = corroded section modulus 
𝑆𝑆 = specified minimum yield strength 
𝐹𝐹 = design factor 
𝐿𝐿 = location factor 
𝐺𝐺 = joint factor 
𝑇𝑇 = temperature derating factor 

Occasional Stress 

The stress (𝑆𝑆𝐿𝐿𝑂𝑂) is calculated as the sum of stress due to sustained and wind loads (𝑆𝑆𝐿𝐿) and 
stress due to occasional loads (𝑆𝑆𝑂𝑂), such as earthquake. The allowable stress for occasional 
stress is not given in the code, therefore it is conservatively taken the same as the sustained 
stress allowable. 

𝑆𝑆𝐿𝐿𝑂𝑂 = 𝑆𝑆𝐿𝐿 + 𝑑𝑑
𝑀𝑀
𝑍𝑍
≤ 𝑆𝑆𝐹𝐹𝐿𝐿𝐺𝐺𝑇𝑇 

where 
𝑀𝑀 = resultant bending moment due to occasional loads 
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Expansion Stress 

The stress (𝑆𝑆𝐸𝐸) due to thermal expansion is calculated from (5.6.3.3). 

𝑆𝑆𝐸𝐸 = �𝑆𝑆𝑏𝑏2 + 4𝑆𝑆𝑑𝑑2 ≤ 0.72𝑆𝑆𝑇𝑇 

where 
𝑆𝑆𝑏𝑏  = resultant bending stress= 𝑑𝑑𝑀𝑀𝑏𝑏/Z 
𝑆𝑆𝑑𝑑  = torsional stress  = 𝑀𝑀𝑑𝑑/2Z 
𝑀𝑀𝑏𝑏  = resultant bending moment due to expansion loads 
𝑀𝑀𝑑𝑑  = torsional moment due to expansion loads 
Z = uncorroded section modulus 
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Allowable Pressure 

The allowable pressure is calculated from 5.4.2.1. 

𝑃𝑃 = 2𝑆𝑆𝑑𝑑𝐹𝐹𝐿𝐿𝐺𝐺𝑇𝑇/D 

where 
𝑃𝑃 = allowable pressure 
𝑆𝑆 = specified minimum yield strength 
𝑑𝑑 = minimum wall thickness 
 = nominal wall thickness × (1 − mill tolerance/100) − corrosion allowance 
𝐹𝐹 = design factor = 0.8 for steel pipe (from 5.2.3) 
𝐿𝐿 = location factor (from Table 5.1) 
𝐺𝐺 = joint factor (from Table 5.2), input as material property 
𝑇𝑇 = temperature derating factor for steel pipe (from Table 5.3) 
𝑝𝑝 = outside diameter 

Sustained Stress 

The stress (𝑆𝑆𝐿𝐿) due to sustained loads (pressure, weight and other sustained mechanical 
loads) and wind loads, is calculated from (5.19.3.5) 

𝑆𝑆𝐿𝐿 =
𝑃𝑃𝑝𝑝
4𝑑𝑑

+ 𝑑𝑑
𝑀𝑀
𝑍𝑍
≤ 𝑆𝑆𝐹𝐹𝐿𝐿𝐺𝐺𝑇𝑇 

where 
𝑃𝑃 = maximum pressure 
𝑝𝑝 = outside diameter 
𝑑𝑑 = minimum wall thickness 
𝑑𝑑 = stress intensification factor 
𝑀𝑀 = resultant bending moment due to sustained loads 
𝑍𝑍 = corroded section modulus 
𝑆𝑆 = specified minimum yield strength 
𝐹𝐹 = design factor 
𝐿𝐿 = location factor 
𝐺𝐺 = joint factor 
𝑇𝑇 = temperature derating factor 

Occasional Stress 

The stress (𝑆𝑆𝐿𝐿𝑂𝑂) is calculated as the sum of stress due to sustained and wind loads (𝑆𝑆𝐿𝐿) and 
stress due to occasional loads (𝑆𝑆𝑂𝑂), such as earthquake. The allowable stress for occasional 
stress is not given in the code, therefore it is conservatively taken the same as the sustained 
stress allowable. 

𝑆𝑆𝐿𝐿𝑂𝑂 = 𝑆𝑆𝐿𝐿 + 𝑑𝑑
𝑀𝑀
𝑍𝑍
≤ 𝑆𝑆𝐹𝐹𝐿𝐿𝐺𝐺𝑇𝑇 

where 
𝑀𝑀 = resultant bending moment due to occasional loads 
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Expansion Stress 

The stress (𝑆𝑆𝐸𝐸) due to thermal expansion is calculated from (5.6.3.3). 

𝑆𝑆𝐸𝐸 = �𝑆𝑆𝑏𝑏2 + 4𝑆𝑆𝑑𝑑2 ≤ 0.72𝑆𝑆𝑇𝑇 

where 
𝑆𝑆𝑏𝑏  = resultant bending stress= 𝑑𝑑𝑀𝑀𝑏𝑏/Z 
𝑆𝑆𝑑𝑑  = torsional stress  = 𝑀𝑀𝑑𝑑/2Z 
𝑀𝑀𝑏𝑏  = resultant bending moment due to expansion loads 
𝑀𝑀𝑑𝑑  = torsional moment due to expansion loads 
Z = uncorroded section modulus 
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FRP Stress 
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Fiber Reinforced Plastic Pipe Stress 

Hoop stress: 𝑆𝑆𝐻𝐻 = 𝑃𝑃𝑝𝑝
2𝑑𝑑𝑚𝑚

 

Longitudinal stress: 𝑆𝑆𝐿𝐿 = 𝑃𝑃𝑝𝑝
4𝑑𝑑𝑚𝑚

+ 𝐹𝐹
𝐴𝐴

+ �(𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2+(𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2

𝑍𝑍
 

Torsional stress: 𝑆𝑆𝑇𝑇 = 𝑀𝑀𝑑𝑑
2𝑍𝑍

 

Shear stress: 𝑆𝑆𝑆𝑆𝐻𝐻 = ��𝑆𝑆𝐿𝐿−𝑆𝑆𝐻𝐻
2

�
2

+ �𝑀𝑀𝑑𝑑
2𝑍𝑍
�

2
 

Maximum principal stress: 𝑆𝑆𝑃𝑃 = 𝑆𝑆𝐿𝐿+𝑆𝑆𝐻𝐻
2

+ 𝑆𝑆𝑆𝑆𝐻𝐻  

Maximum shear stress: 𝑆𝑆𝑆𝑆 = max �𝑆𝑆𝑃𝑃
2

, 𝑆𝑆𝑆𝑆𝐻𝐻� 

Octahedral shear stress: 𝑆𝑆𝑂𝑂 = √2
3
��𝑆𝑆𝐿𝐿+𝑆𝑆𝐻𝐻

2
�

2
+ 3(𝑆𝑆𝑆𝑆𝐻𝐻)2 

where 
𝑃𝑃 = pressure 
𝑝𝑝 = outside diameter 
𝑑𝑑𝑚𝑚  = minimum thickness 
 = nominal thickness x (1 – mill tolerance/100) – corrosion allowance 
𝑑𝑑𝑑𝑑  = in-plane stress intensification factor 
𝑑𝑑𝑑𝑑  = out of plane stress intensification factor 
𝑀𝑀𝑑𝑑  = in plane bending moment 
𝑀𝑀𝑑𝑑  = out of plane bending moment 
𝑀𝑀𝑑𝑑  = torque 
𝑍𝑍 = section modulus 
𝐹𝐹 = axial force 
𝐴𝐴 = cross-section area 
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This function is available to users who wish to inspect or examine high stress areas (Non-
Destructive Evaluation, NDE) of piping that have high “operating stresses.” 

While B31.1 and B31.3 piping codes do not consider the operating condition (W+P+T) as a required load 
case for code compliance, you may, however, evaluate this load case the same way as you would 
the other code compliance cases such as Sustained (W+P) and Expansion (T). CAEPIPE 
will show columns displaying Operating Stress (Sopr) and Allowable stress (Sall) alongside the 
code required stresses even though the Operating Stress is not a code requirement. 

To display these columns, you will have to turn them on first: (mouse right click) > Show 
Operating Stress for NDE. 
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This allowable stress is NOT specified nor recommended by B31.1/B31.3 piping codes but, 
as mentioned above, may aid you in identifying regions of high combined stress in your 
piping system, which may warrant a closer examination in your engineering judgment. 
 
The equation used to calculate the operating stresses is modeled along the lines of a piping 
code specified stress equation. The three components of the equation are: 

1. Axial stress combined with the longitudinal pressure stress, 
2. Bending stress from in-plane and out-of-plane bending moments, and 
3. A torsional stress from the torsion term. 

The allowable stress for this case is simply a combination of the sustained and the thermal 
allowable stresses. 

Note that the Operating Stress is calculated and shown only for the first Operating case (W+P1+T1). 
Details follow. 
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The stress (Sopr) due to operating loads (pressure, weight and thermal load T1) is calculated as 
 

𝑆𝑆𝑑𝑑𝑝𝑝𝑃𝑃 = 𝑆𝑆𝑎𝑎 + �(𝑆𝑆𝑎𝑎)2 + (2𝑆𝑆𝑑𝑑)2 ≤ 𝑆𝑆𝑎𝑎𝑑𝑑𝑑𝑑  
where 
𝑆𝑆𝑎𝑎  = �𝑃𝑃𝑝𝑝

4𝑑𝑑
+ 𝐹𝐹

𝐴𝐴
�
𝑂𝑂𝑝𝑝𝑃𝑃𝑃𝑃𝑎𝑎𝑑𝑑𝑑𝑑𝑑𝑑𝐹𝐹 1

 

𝑆𝑆𝑏𝑏  = ��(𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2+(𝑑𝑑𝑑𝑑𝑀𝑀𝑑𝑑)2

𝑍𝑍
�
𝑂𝑂𝑝𝑝𝑃𝑃𝑃𝑃𝑎𝑎𝑑𝑑𝑑𝑑𝑑𝑑𝐹𝐹 1

 

𝑆𝑆𝑑𝑑  = �𝑀𝑀𝑑𝑑
2𝑍𝑍
�
𝑂𝑂𝑝𝑝𝑃𝑃𝑃𝑃𝑎𝑎𝑑𝑑𝑑𝑑𝑑𝑑𝐹𝐹 1

 

𝑃𝑃 = maximum of CAEPIPE input pressures P1, P2 and P3 
𝑝𝑝 = outside diameter 
𝑑𝑑 = nominal wall thickness 
𝐴𝐴 = un-corroded cross-sectional area of the pipe 
𝐹𝐹 = longitudinal force  
𝑑𝑑𝑑𝑑  = in-plane stress intensification factor according to analysis code selected in 

 CAEPIPE 
𝑑𝑑𝑑𝑑  = out-of-plane stress intensification factor according to analysis code selected in 

 CAEPIPE 
Note: If the analysis code selected provides only the stress intensification i, then 𝑑𝑑𝑑𝑑 = 𝑑𝑑𝑑𝑑 = 𝑑𝑑. 
𝑀𝑀𝑑𝑑  = in-plane bending moment 
𝑀𝑀𝑑𝑑  = factor for loose type flanges (from Fig. 2-7.5) 
𝑀𝑀𝑑𝑑  = factor for loose type flanges (from Fig. 2-7.4) 
𝑍𝑍 = un-corroded section modulus; for reduced outlets / branch connections, effective 

 section modulus 
𝑆𝑆𝑎𝑎𝑑𝑑𝑑𝑑  = 𝑓𝑓(1.25𝑆𝑆𝑐𝑐𝑑𝑑𝑑𝑑𝑑𝑑 + 0.25𝑆𝑆ℎ𝑑𝑑𝑑𝑑 ) + 𝑆𝑆ℎ𝑑𝑑𝑑𝑑   
𝑓𝑓 =  stress range reduction factor  = 6/N0.2 
𝑁𝑁 =  Number of equivalent full-range thermal cycles 
𝑆𝑆𝑐𝑐𝑑𝑑𝑑𝑑𝑑𝑑  = basic allowable stress at Tref 
𝑆𝑆ℎ𝑑𝑑𝑑𝑑  = basic allowable stress at CAEPIPE input temperature T1 
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Particulars Allowable Pressure Pipe Weight Sustained Stress Expansion Stress Occasional Stress 

B31.1 (2012) 

Pipe Thickness 
used 
 

Nominal Thk. x (1-mill 
tolerance/100) – Corrosion 
allowance 

Nominal Thickness Nominal Thickness - Nominal Thickness 

Section Modulus 
used - - 

Uncorroded Section Modulus; 
For Branch, effective section 
modulus 

Uncorroded Section Modulus; 
For Branch, effective section modulus 

Uncorroded Section Modulus; 
For Branch, effective section 
modulus 

B31.3 (2012) 

Pipe Thickness 
used 
 

Nominal Thk. x (1-mill 
tolerance/100) – Corrosion 
allowance 

Nominal Thickness Nominal Thickness - Corrosion 
allowance - Nominal Thickness – Corrosion 

allowance 

Section Modulus 
used - - 

Corroded Section Modulus; 
For Branch, effective section 
modulus 

Uncorroded Section Modulus; 
For Branch, effective section modulus 

Corroded Section Modulus; 
For Branch, effective section 
modulus 

B31.4 (2012) 

Pipe Thickness 
used 
 

Nominal Thk. x (1-mill 
tolerance/100) – Corrosion 
allowance 

Nominal Thickness Nominal Thickness - Nominal Thickness 

Section Modulus 
used - - 

Uncorroded Section Modulus; 
For Branch, effective section 
modulus 

Uncorroded Section Modulus; 
For Branch, effective section modulus 

Uncorroded Section Modulus; 
For Branch effective section 
modulus 

B31.5 (2013) 

Pipe Thickness 
used 
 

Nominal Thk. x (1-mill 
tolerance/100) – Corrosion 
allowance 

Nominal Thickness Nominal Thickness – Corrosion 
allowance - Nominal Thickness – Corrosion 

allowance 
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Particulars Allowable Pressure Pipe Weight Sustained Stress Expansion Stress Occasional Stress 

Section Modulus 
used - - 

Corroded Section Modulus; 
For Branch, effective section 
modulus 

Uncorroded Section Modulus; 
For Branch, effective section modulus 

Corroded Section Modulus; 
For Branch, effective section 
modulus 

B31.8 (2012) 

Pipe Thickness 
used 
 

Nominal Thk. Nominal Thickness Nominal Thickness - Nominal Thickness 

Section Modulus 
used - - 

Uncorroded Section Modulus; 
For Branch, effective section 
modulus 

Uncorroded Section Modulus; 
For Branch, effective section modulus 

Uncorroded Section Modulus; 
For Branch, effective section 
modulus 

B31.9 (2008) 

Pipe Thickness 
used 
 

Nominal Thk. x (1-mill 
tolerance/100) – Corrosion 
allowance 

Nominal Thickness Nominal Thickness - Nominal Thickness 

Section Modulus 
used - - 

Uncorroded Section Modulus; 
For Branch, effective section 
modulus 

Uncorroded Section Modulus; 
For Branch, effective section modulus 

Uncorroded Section Modulus; 
For Branch, effective section 
modulus 

Note: 
1. Corrosion allowance includes thickness required for threading, grooving, erosion, corrosion etc. 
2. Uncorroded section modulus = section modulus calculated using the nominal thickness. 
3. Corroded section modulus = section modulus calculated using the “corroded thickness” 
corroded thickness = nominal thickness – corrosion allowance 
4. Effective section modulus = section modulus calculated using effective branch thickness, which is lesser of iitb or th 
where, tb = branch nominal thickness, th = header nominal thickness, ii = in-plane SIF at branch 
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API 610 (Tenth Edition, 2004) / ISO 13709 for Pumps 

The allowable nozzle forces and moments for pumps are taken from Table 4 of the tenth 
edition of API Standard 610 / ISO 13709. 
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The coordinate systems and nozzle orientations for various pump configurations are shown next. 
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Criteria for Piping Design  

The criteria for piping design are taken from Appendix F of the API 610. 
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NEMA SM-23 (1991) for Turbines 

There are two types of allowables. 

1. Allowables for each nozzle and  
2. Combined allowables for each turbine.  

1. Allowables for each Nozzle 

The resultant force and the resultant moment at any connection must not exceed 

3𝐹𝐹𝑅𝑅 + 𝑀𝑀𝑅𝑅 ≤ 500𝑝𝑝𝑃𝑃  

where 
𝐹𝐹𝑅𝑅  = resultant force at the nozzle (lb) 
𝑀𝑀𝑅𝑅  = resultant moment at the nozzle (ft.-lb) 
𝑝𝑝𝑃𝑃  = nominal pipe size (inches) of the connection up to 8” in diameter 
 = (16 + 𝑝𝑝𝑑𝑑𝑑𝑑𝑚𝑚 )/3  If the size is greater than 8” 

2. Combined Allowables for the Turbine  

The combined resultants of the forces and moments at the inlet, exhaust and extraction 
nozzles resolved at the centerline of the exhaust nozzle must not exceed the following two 
conditions: 

(a) These resultant should not exceed: 

2𝐹𝐹𝐶𝐶 + 𝑀𝑀𝐶𝐶 ≤ 250𝑝𝑝𝐶𝐶  

where 
𝐹𝐹𝐶𝐶  = combined resultant of inlet, exhaust and extraction forces (lb) 
𝑀𝑀𝐶𝐶  = combined resultant of inlet, exhaust and extraction moments (ft.-lb.) 
𝑝𝑝𝐶𝐶  = diameter (in inches) of a circular opening equal to the total areas of the inlet, exhaust  
  and extraction nozzles up to a value of 9” in diameter 
 = (18 + Equivalent diameter) / 3 (in.) For values > 9” 

(b) The components of these resultants shall not exceed:  

𝐹𝐹𝑋𝑋 = 50𝑝𝑝𝐶𝐶𝑀𝑀𝑋𝑋 = 250𝑝𝑝𝐶𝐶  
𝐹𝐹𝑌𝑌 = 125𝑝𝑝𝐶𝐶𝑀𝑀𝑌𝑌 = 125𝑝𝑝𝐶𝐶  
𝐹𝐹𝑍𝑍 = 100𝑝𝑝𝐶𝐶𝑀𝑀𝑍𝑍 = 125𝑝𝑝𝐶𝐶  

where 
𝐹𝐹𝑋𝑋  = horizontal component of 𝐹𝐹𝑅𝑅  parallel to the turbine shaft 
𝐹𝐹𝑌𝑌 = vertical component of 𝐹𝐹𝑅𝑅  
𝐹𝐹𝑍𝑍 = horizontal component of 𝐹𝐹𝑅𝑅  at right angles to the turbine shaft 
𝑀𝑀𝑋𝑋  = horizontal component of 𝑀𝑀𝑅𝑅  parallel to the turbine shaft 
𝑀𝑀𝑌𝑌  = vertical component of 𝑀𝑀𝑅𝑅  
𝑀𝑀𝑍𝑍  = horizontal component of 𝑀𝑀𝑅𝑅  at right angles to the turbine shaft 



NEMA SM-23 
 

573 
 

 



API 617 
 

574 
 

API 617 (Seventh edition, June 2003) for Compressors 

1. Allowables for each Nozzle 

The total resultant force and resultant moment imposed on the compressor at any 
connection should not exceed 

3𝐹𝐹𝑃𝑃 + 𝑀𝑀𝑃𝑃 ≤ 927𝑝𝑝𝑃𝑃  
Where  
𝐹𝐹𝑃𝑃  =  resultant force at the Nozzle (lb)  
𝑀𝑀𝑃𝑃  =  resultant moment at the Nozzle (ft.-lb)  
𝑝𝑝𝑃𝑃  =  nominal pipe size (inches) of the connection up to 8” in diameter  
 =  (16 + Dnom)/3 If the size is greater than 8” 

2. Combined Allowables for Compressors 

The combined resultants of the forces and moments of the inlet, sidestream, and discharge 
connections resolved at the centerlines of the largest connection should not exceed the 
following two conditions:  
(a) The resultant should not exceed: 

2𝐹𝐹𝑐𝑐 + 𝑀𝑀𝑐𝑐 ≤ 462𝑝𝑝𝑐𝑐  

Where  
𝐹𝐹𝑐𝑐  =  combined resultant of inlet, sidestream, and discharge forces (lb)  
𝑀𝑀𝑐𝑐  =  combined resultant of inlet, sidestream, and discharge moments, and moments  
  resulting from forces (ft.-lb) 
𝑝𝑝𝑐𝑐  = diameter of one circular opening equal to the total areas of the inlet, sidestream, and 

 discharge openings. If the equivalent nozzle diameter is greater than 9”, use a value
 of Dc equal to (18 + Equivalent Diameter) / 3 

(b) The components of these resultants shall not exceed: 

𝐹𝐹𝑚𝑚 = 92𝑝𝑝𝑐𝑐  𝑀𝑀𝑚𝑚 = 462𝑝𝑝𝑐𝑐  

𝐹𝐹𝑦𝑦 = 231𝑝𝑝𝑐𝑐  𝑀𝑀𝑦𝑦 = 231𝑝𝑝𝑐𝑐  

𝐹𝐹𝑓𝑓 = 185𝑝𝑝𝑐𝑐  𝑀𝑀𝑓𝑓 = 231𝑝𝑝𝑐𝑐  

Where  
𝐹𝐹𝑚𝑚  = horizontal component of F

c
 parallel to the compressor shaft (lb)  

𝐹𝐹𝑦𝑦  = vertical component of F
c
 (lb)  

𝐹𝐹𝑓𝑓  = horizontal component of F
c
 at right angles to be compressor shaft (lb)  

𝑀𝑀𝑚𝑚  = component of M
c
 around the horizontal axis (ft-lb)  

𝑀𝑀𝑦𝑦  = component of M
c
 around the vertical axis (ft-lb)  

𝑀𝑀𝑓𝑓  = component of M
c
 around the horizontal axis at right angles to the compressor (ft-lb) 
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Z: Perpendicular to compressor shaft    X: Parallel to compressor shaft 
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Appendix C 
Import / Export 
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CAEPIPE can import model data from a text file, which may be created using a text editor 
and should have the extension: .mbf (model batch file). This text file may also be created for 
an existing model using the Export command from the Layout window. 

To import a model, select the menu command File > Import from the Main window. 

 

The Import Model dialog is shown. 
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Select the model batch file (.mbf) and then click on the Import button. The batch file will be 
read and the corresponding model file (.mod) will be created and then shown in the Layout 
window which can be further modified or analyzed. 

For detailed information on the .pnf and .cii file import capabilities please contact us at 
support@sstusa.com.  

Command line operation 

Dragging and dropping an .mbf file on CAEPIPE.exe will import, analyze and produce the 
results in .csv format and close the program. On the other hand, dragging and dropping the 
.mod file on CAEPIPE.exe will open the .mod file. Using the command line, you may have 
CAEPIPE analyze and produce a CSV results file thus: 

C:\CAEPIPE\681> caepipe.exe sample.mbf (Enter)  

Format of .MBF 

The above command will produce a “sample.csv” file in the same folder as the .mbf file. 

The input data is given in the following order. Except for the heading the start of each 
section is indicated by a keyword. The data for that section follow. Only the first three 
characters of the keyword are significant. See an example MBF at the end of this appendix. 

Keyword Data 
 Heading 
OPTIONS Program options 
MATERIAL Material properties 
SOILS Soil properties 
PIPE Section properties 
LOADS Loads data 
BMATERIALS Beam Materials 
BSECTIONS Beam section properties 
BLOADS Beam loads 
LAYOUT Layout data 
PUMPS Pump data 
COMPRESSORS Compressor data 
TURBINES Turbine data 
SEISMIC Seismic load 
WIND Wind load 

Heading 

Any number of heading lines may be given.  Only the first will be used as Title in the 
CAEPIPE model. 

OPTIONS 

Hanger design 

HGRA Grinnell (Default) 
HGRB Bergen-Paterson 
HGRC Fee and Mason 
HGRD Basic Engineers 
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HGRE Power Piping 
HGRF Nordon 
HGRG Carpenter and Paterson 
HGRH NPS 
HGRI PTP 
HGRJ Corner and Lada 
HGRK Elcen 

Piping Code 

B311 ANSI B31.1 
B311-67 USAS B31.1 (1967) 
B313 ANSI B31.3 
B314 ANSI B31.4 
B315 ANSI B31.5 
B318 ANSI B31.8 
B319 ANSI B31.9 
ASME ASME Section III, Class 2 (1980) 
ASME-86 ASME Section III, Class 2 (1986) 
ASME-92 ASME Section III, Class 2 (1992) 
BS806 British code 
NORWEIGIAN-83 Norwegian code (1983) 
NORWEIGIAN-90 Norwegian code (1990) 
RCC-M French code (1985) 
SNCT CODETI (1995) 
SWEDISH Swedish code (1978) 
STOOMWEZEN Dutch code (1989) 
Z183 Z183 (1990) 
Z184 Z183 (1992) 
EUROPEAN EN 13480 (2002) 

Units 

SI SI units (default is English units) 
RAD Radians for angles (default is degrees) 

Vertical Axis 

Z Vertical axis is Z (Default is Y) 

OPTIONS Example 

OPTIONS 
HGRA,B311,RAD 

MATERIAL 

Name is Material Name (up to 3 characters). The values in square brackets ([...]) are optional. 

English units 

First line: Name, Density (lb/in3), Poisson’s ratio, [Long. joint factor], [circ. joint factor] 
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Following lines: Name, Temp (F), E (psi), alfa (in/in/F), [allowable stress (psi)], [yield stress 
(psi)], [rupture stress (psi)] 
. 
. 
. 

SI units 

First line: Name, Density (kg/m3), Poisson’s ratio, [Long. joint factor], [circ.joint factor] 

Following lines: Name, Temp (C), E (N/mm2), alfa (mm/mm/C), [allowable stress 
(N/mm2)], [yield stress (N/mm2)], [rupture stress (N/mm2)] 
. 
. 
. 

MATERIAL Example (English units) 

MATERIAL 
A53,0.283,0.300,1.00 
A53,70,29.5E+6,6.07E-6,20000 
A53,200,28.8E+6,6.38E-6,20000 
A53,300,28.3E+6,6.60E-6,20000 
A53,400,27.7E+6,6.82E-6,20000 
A53,500,27.3E+6,7.02E-6,18900 
ALU,0.098,0.330,1.00 
ALU,70,10.0E+6,12.25E-6,10000 
ALU,150,9.80E+6,12.67E-6,10000 
ALU,200,9.60E+6,12.95E-6,9800 
ALU,250,9.40E+6,13.12E-6,9000 
ALU,300,9.20E+6,13.28E-6,6600 

SOILS (Soil properties) 

Soil properties are input as follows: 

Note: 
Name is Soil Name (up to 3 characters) 
Type must be 0 or 1 (1 = Cohesive; 0 = Cohesive less) 
If Type = 0, then Delta and Ks is required 
If Type = 1, then Strength is required 

English units 

Name, Type (0 or 1), Density (lb/ft3), Ground level (ft’in”), [Strength (psi) /Delta (deg or 
rad], [Ks] 

SI units 

Name, Type (0 or 1), Density (kg/m3), Ground level (mm), [Strength (N/mm2) / Delta (deg 
or rad ], [Ks] 

PIPE (Section properties) 

Section properties are input as follows for pipe sections: 



Import 
 

583 

Note: 

Name is Section Name (up to 5 characters). 
OD must be actual OD and not Nominal pipe size (e.g., input 2.125 and not 2.0 for 2” NPS) 
Thk must be an actual numerical value and not a schedule. 
Soil name is Name of the soil (up to 3 characters). It should be defined in the soil section 
before use in this section. 

English units 

Name, OD (inch), Thk (inch), Corrosion allowance (inch), Mill tolerance (%), Insulation 
density (lb/ft3), Insulation Thk (inch) 

SI units 

Name, OD (mm), Thk (mm), Corrosion allowance (mm), Mill tolerance (%), Insulation 
density (kg/m3), Insulation Thk (mm), Lining density (kg/m3), Lining Thk (mm), Soil name 

PIPE Example (English units) 

PIPE 
8,8.625,0.5,0,0.0,11,2 
6,6.625,0.28,0,0.0,11,2 

LOADS (Load data) 

Load data are input as follows: 

Note: 
Name is Load Name (up to 3 characters). 
T2, P2, T3 and P3 are Temperature 2, Pressure 2, Temperature 3 and Pressure 3 respectively. 

English units 

Name, Temperature 1 (F), Pressure 1 (psi), Specific Gravity, [T2,P2,T3,P3, Additional weight 
(lb/ft)] 

SI units 

Name, Temperature 1 (c), Pressure 1 (bar), Specific Gravity, [T2,P2,T3,P3, Additional weight 
(kg/m)] 

BMATERIALS (Beam Materials) 

Name is Material Name (up to 3 characters). The values in square brackets ([...]) are optional. 

English units 

Name, Young’s Modulus (psi), [Poisson’s ratio, Density (lb/in3), Alfa (in/in/F)] 

SI units 

Name, Young’s Modulus (Mpa), [Poisson’s ratio, Density (kg/m3), Alfa (mm/mm/c)] 

BSECTIONS (Beam Sections) 

Name is Beam Section name (up to 3 characters). The values in square brackets ([...]) are 
optional. 
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English units 

Name, Axial area (in2), Major moment of inertia (in4), Minor moment of inertia (in4), 
[Torsional inertia (in4), Major shear area (in2), Minor shear area (in2), Depth (inch), Width 
(inch)] 

SI units 

Name, Axial area (mm2), Major moment of inertia (mm4), Minor moment of inertia (mm4), 
[Torsional inertia (mm4), Major shear area (mm2), Minor shear area (mm2), Depth (mm), 
Width (mm)] 

BLOADS (Beam Loads) 

Name is Beam Load name (up to 3 characters). The values in square brackets ([...]) are 
optional. 

English units 

Name, T1 (F), [T2 (F), T3 (F), Additional weight (lb/ft)] 

SI units 

Name, T1 (c), [T2 (c), T3 (c), Additional weight (kg/m)] 

LAYOUT 

The piping layout is entered as a (key letter-data) pair, which may be input in any order. The 
exceptions to this convention are the comments which must always appear last. The pairs are 
separated by commas. A data line which contains only continued comments (from the 
previous line) is acceptable. A list of key letters follows: 

F From node 
T To node 
H Hydro test Load 
L Location node 
K Code for node 
M Material number 
P Pipe (Section) property number 
J Joint code 
X X offset 
Y Y offset 
Z Z offset 
B Bend radius 
C Comments (separated by commas) 
* Model comments (Example: * Node 230 = P-427B Suction) 

LAYOUT Example (English units) 

LAYOUT 
F10,KA,M5,P12,CT=650,P=500 
T20,KI,X10’8-1/2,B20 
T30,Z8 
T40,JR,X1’6,CWGT=250 
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F (From) From node is specified.  When a new branch is started, the first node of 
the branch is specified as a “From” node.  The X, Y and the Z fields are 
taken as coordinates rather than offsets from the previous node. 

T (To) To node is specified. This is a “To” node from the previous “From” node 
or the previous “To” node (but not from the previous “Location node”). 

L (Location) Location node is used to input additional data at a node when the node has 
more than one data item such as a hanger/force, etc. 

K (Code) The following codes may be used: 

 Code Description 

 A Anchor 
 B Branch connection 
 H Hinge (To node only) 
 M Miter bend (To node only) 
 I Tangent intersection (To node only) 
 T Welding Tee 
 S Sweepolet 
 W Weldolet 
 F Fabricated Tee 
 E Extruded Tee 
 R Radiused branch 
 P Branch on thickened pipe 

M (Material) A material is retained until altered.  Another material should be entered 
only when there is a change. 

P (Pipe) A pipe (section property) is retained until altered.  Another section 
property should be entered only when there is a change. 

J (Joint Code) Code Description 

 B Ball joint 
 C Cut pipe 
 D Reducer 
 E Expansion 
 I Jacket bend 
 L Elastic element 
 M Beam 
 P Jacket pipe 
 R Rigid 
 S Slip joint 
 T Tierod 
 V Valve 

 The weight of a rigid joint or a valve should be entered using a WGT 
comment. The stiffnesses of the expansion joint should be entered using 
an ES comment and the pressure thrust area should be entered using the 
TA comment. 
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X, Y and Z The offsets May be entered in combination of feet, inches and fractions of 
an inch for English units and mm for SI units. 

 Example (English units) 

 Entry  Value 
 -10  -10 ft 
 10’8 or 10-8 10 ft 8 in 
 0’8 or 0-8 8 in 
 10.5  10 ft 6 in 
 1’6-3/8 or 1-6-3/8 1 ft 6.375 in 

B (Bend Radius) The bend radius (inch or mm) is entered only if a tangent intersection(i.e., 
Bend, Jbend and Miter Bend) has been specified.  The default is the long 
radius for the bend and jacketed bend. 

C (Comment) The comment section allows entry of data related to a particular node or 
element.  For example, a pipe end specified as a hinge would have the 
rotational spring constant and the direction vector entered in the comment 
section. A line temperature can be entered as comment and is retained 
until changed. Multiple comments may be entered separated by commas.  
If the last comment is followed by a comma, the comment is continued on 
the next line. 

*(Model comment) The model comment section allows entry of notes relevant to analysis 
model.  The model comment can e up to 70 characters. 

 Example:  *Load cases considered for analysis are T1 and P1. 
  
The comments are as follows: 

AMB Ambient or reference temperature (F or C) 
 Default is 70 F. 
 Example: AMB=80 

AWGT Additional weight for valve (lb. or kg) 
 Use only for valve. 
 Example: AWGT=100 

BTHK Bend thickness (inch or mm) 
 Use for Bend and Jbend (core). 
 Example:  BTHK=6.01 

BMAT Name of Bend Material (Up to 3 characters) 
 Should be defined in Material section before use. 
 Example: BMAT=BM1 

BK Bending stiffness (in-lb/deg or Nm/deg) 
 Use only for Bellows 
 Example:  BK=10000 

BSIF Bend SIF 
 In-plane 
 Out-plane 



Import 
 

587 

 Example:  BSIF(1.5,2.0) 
 For Piping code with one SIF, use in-plane=Out-plane=SIF 
 Example:  BSIF (2.0,2.0) 

BETA Beta angle for Beam (deg or rad) 
 Use only for Beam 
 Example:  BETA=90  

CONE Cone angle for reducer (deg. or rad.) 

CNOD Connected to Node  
 Use for Guide, Hanger, Limit Stop, Rod Hanger, Skewed Restraint, User  
 Hanger and Constant Support  
 Example: CNOD=150 

CLD  Cold load  
 Use only for User Hanger.  
 Example: CLD=1 

CRTCH Crotch radius for an extruded tee (inch or mm) 
 Example: CRTCH=1.25 

CS Constant support spring 
 Example: CS=2: Two constant support springs 

CWGT Concentrated weight (lb or kg) 
 Use only for concentrated weight. 
 Example: CWGT=200 

D or DIS Specified displacements (Inch or mm) 
 Note: Entry of zero is ignored and not treated as a specified displacement. 
 Example: D(0.1,-0.25,0) or DIS(0.1,-0.25,0) 
 DX=0.1,DY=-0.25 or DISX=0.1,DISY=-0.25 

DV Direction vector. DV(xcomp, ycomp, zcomp)  
 Use for Hinge, Snubber and Nozzle  

 Example: DV(1,-2,0)  

DIS2  Specified Displacement for Temperature 2 (inch or mm)  
 Use only for Anchor  
 Note: Entry of zero is ignored and not treated as a specified displacement.  
 Example: DIS2(1,-2,0)  

DIS3  Specified Displacement for Temperature 3 (inch or mm)  
 Use only for Anchor  
 Note: Entry of zero is ignored and not treated as a specified displacement.  
 Example: DIS3(1,-2,0) 

E  Young’s modulus (psi or Mpa)  
 Use only for Nozzle  
 Example: E=28E6 

ES Expansion joint stiffnesses 
 Axial(lb/in or N/mm) 



Import 
 

588 

 Lateral(lb/in or N/mm) 
 Torsional(in-lb/deg or NM/deg) 
 Example: ES(1000,5000,200) 

F or FIXD Translational restraint 
 Example: FIXD(1,0,1) : Restrain X and Z translations 
 FIXDX=1 or FX or FIXDX 

FF  Bend Flexibility factor  
 Use for Bends and Miter bends 
 Example: FF=1.5 

FIXR Rotational restraint 
 Example: FIXR(0,1,0) : Restrain Y rotation. 
 FIXRY=1 or FIXRY 

FLANGE FLANGE = Type, where 

 Type Description 

 WN Weld neck flange 
 SO Single welded slip on 
 DW Double welded slip on 
 SW Socket welded 
 FW Fillet welded 
 LJ Lap joint 
 TH Threaded 
 Example: FLANGE=TH (Threaded flange) 

FOR Force (lb or N) 
 Use for Force and Harmonic load. 
 Example: FOR(100,0,-200) or FORX=100,FORZ=-200 

FFOR  Friction force (lb or N)  
 Use for Slip joint  
 Example: FFOR=100  

FTOR Friction torque (ft-lb or Nm)  
 Use for Slip joint  
 Example: FTOR=100  

FRCT Bending and Torsional friction Torque (ft-lb or Nm).  
 FCRT(Bending, Torsional)  
 Use only for Ball joint  
 Example: FCRT(100,150) 

FREE Free anchor during hanger design 
 Example: FREE: Free all directions 
 FREEY: Free Y direction 

FRE  Frequency (Hz)  
 Use only for Harmonic Load.  
 Example: FRE=30 
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G Guide 

GAP  Tension and Compression gap (inch or mm)  
 GAP(Tension, Compression)  
 Use only for Tie rod.  
 Example: GAP(10,15)  

GGAP  Guide Gap (inch or mm)  
 Use only for guide  
 Example: GGAP=5  

HSG  Hydrotest Specific Gravity  
 Use only for Hydrotest Load  
 Example: HSG=0.7  

HPRES Hydrostatic Pressure (psi or bar)  
 Use only for Hydrotest Load  
 Example: HPRES=3  

HTYP  Defines the Hanger Type. Refer to end of this appendix for details.  
 Use only for Hanger  
 Example: HTYP=16 (Grinnell)  

IN1  Intermediate Node 1 for Bends  
 Node Number (>1 and < 9999)  
 Angle (deg or rad)  
 Use for Bend and Jbend  
 Example: IN1(300,30) 

IN2  Intermediate Node 2 for Bends  
 Node Number (>1 and < 9999)  
 Angle (deg or rad)  
 Use for Bend and Jbend  
 Example: IN2(400,30)  

INSF  Insulation factor  
 Use only for Valve  
 Example: INSF=3.0  

JCAP  Jacked End Cap  
 Defines the data type Jacked End Cap  
 Example: JCAP  

JMAT  Jacket Material (up to 3 characters)  
 Use for Jpipe and Jbend  
 Example: JMAT=A53  

JSEC  Jacket Section (up to 3 characters)  
 Use for Jpipe and Jbend  
 Example: JSEC=N10  

JLOAD  Jacket Load (up to 3 characters)  
 Use for Jpipe and Jbend  
 Example: JLOAD=L3  
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JTHK  Jacket Thickness (inch or mm)  
 Use only for Jbend  

JR  Jacket Radius (inch or mm)  
 Use only for Jbend.  
 Example: JR=6.75 

K Translational stiffness (lb/inch or N/mm) 
 Use for Skewed restraint 
 Example: K=500,DV(1.5,-0.75,0.25) 

KR Rotational stiffness (in.-lb./deg. or N-m/deg) 
 Use for Skewed restraint 
 Example: KR=1200,DV(1.2,2.5,0) 

KTIE  Tension and Compression stiffness. KTIE(Tension, Compression) (lb/in 
or  

 N/mm). Use only for Tie rod  
 Example: KTIE(1000,1500) 

LS Limit stop 
 LS(M1,M2) 
 M1=allowable movement in negative direction (in. or mm) 
 M2=allowable movement in positive direction (inch or mm) 
 Example : LS(-1.0,1.5), DV(0,1,0), MU=0.3 

LOAD  Beam load reference (up to 3 characters)  
 Note: Beam load should be defined in BLOADS section before use.  
 Example: LOAD=B1 

LEN  Length (inch or mm)  
 Use only for Branch SIF with type Branch on Thickened Pipe  
 Example: LEN=5  

L1  Length 1 (ft-in or mm)  
 Use to define “L” for API 650 Nozzle and “L1” for WRC 297 Nozzle  
 Example: L1=3’0” or L1=900  

L2  Length 2 (ft-in or mm)  
 Use only for WRC 297 Nozzle to define “L2” 
 Example: L2=4’0” or L2=1200  

LONG  Cut long (inch or mm)  
 Use only for Cut pipe.  
 Example: LONG=100  

LXAX  Local X axis. LXAX(xcomp, ycomp, zcomp)  
 Use only for Elastic Element  
 Example: LXAX(1,0,0)  

LYAX  Local Y axis. LYAX(xcomp, ycomp, zcomp)  
 Use only for Elastic Element  
 Example: LYAX(0,1,0)  
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MAT  Beam material reference (up to 3 characters)  
 Note: Beam material should be defined in Beam material (BMATERIALS)  
 section before use.  
 Example: MAT=M1  

MM  Mismatch (inch or mm)  
 Use only for weld  
 Example: MM=5 

MLV Maximum load variation (%) in hanger design 
 Default is 25%. 
 Example: MLV=30 

MOM Moment (ft-lb or NM) 
 Example: MOM(200,-100,0) or MOMX=200, MOMY=-100 

MU Friction co-efficient 
 Example: MU=0.3 

NOD  Nozzle outside diameter (inch or mm)  
 Example: NOD=104  

NTHK  Nozzle thickness (inch or mm)  
 Example: NTHK=6.01  

NOZZLE  Defines the Nozzle data type. (650 or 297)  
 Example: NOZZLE=650 (API 650) or NOZZLE=297 (WRC 297) 

OD1 Outer diameter at from end for the reducer (inch or mm) 

OD2 Outer diameter at to end for reducer (inch or mm) 

OFFSET Offset of concentrated weight from node or additional weight of valve 
from the center of valve (inch or mm) 

 OFFSET(X offset, Y offset, Z offset). 
 Example: OFFSET(0,18,0) 

PAD Thickness of reinforcement for fabricated tee (inch or mm) 
 Example: PAD=0.25 

PH  Phase (deg or rad)  
 Use only for Harmonic Load  
 Example: PH=10 

P or PRES Pressure (psig or bar) 
 Example: P=500 

ROT Specified rotation (deg or rad) 
 Note: Entry of zero is ignored and not treated as a specified rotation. 
 Example: ROT(1.5,0,-0.25) 
 ROTX=1.5,ROTZ=-0.25 

RLIM  Rotation limit (deg or rad)  
 Use only for Hinge  
 Example: RLIM=10  
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ROTL  Rotational limit in Bending and Torsion  
 ROTL(Bending, Torsion) (deg or rad)  
 Use only for Ball joint  
 Example: ROTL(10,20)  

ROTK  Rotational stiffness. ROTK(kxx, kyy, kzz) (deg or rad)  
 Use for Anchor and Elastic element  
 Example: ROTK(5,6,3)  

ROT2  Rotational Displacement for Temperature 2. (deg or rad)  
 ROT2(kxx, kyy, kzz)  
 Use only for Anchor  
 Example: ROT2(10,15,10)  

ROT3  Rotational Displacement for Temperature 3. (deg or rad)  
 ROT3(kxx,kyy,kzz)  
 Use only for Anchor  
 Example: ROT3(10,15,10)  

R  Fillet radius (inch or mm)  
 Use only for Branch SIF (Radiused Branch and Branch Connection)  
 Example: R=10  

RPAD  Reinforcing Pad (0 or 1)  
 Use only for Nozzle (API 650)  
 Example RPAD=1  

RK  Rotational Stiffness in Bending and Torsion.  
 RK(Bending, Torsion) (ft-lb or Nm)  
 Use only for Ball joint  
 Example: RK(100,150) 

SG Specific Gravity 
 Example: SG=0.8 

SIF Stress intensification factor at node. SIF=value or SIF(in-plane, Out-plane)  
 Example: SIF=1.3 or SIF(1.5,2.0)  

SHORT  Cut short (inch or mm). Use only for Cut pipe.  
 Example: SHORT=100  

SEC  Beam section reference (up to 3 characters)  
 Note: Beam section should be defined in Beam section (BSECTIONS) 

before  use.  
 Example: SEC=BS1 

SEIS Seismic displacement (inch or mm) (x,y,z) 
 Example: SEIS (-0.25, 0.00, -0.25) 

SERO Seismic rotation (deg or rad) (rx,ry,rz) 
 Example: SERO (0.25, 0.00, 0.25) 

SETT Settlement displacement (inch or mm) (x,y,z) 
 Example: SETT (-0.25, -0.25, -0.25)  
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SPIDER  Defines the data type SPIDER 
 Example: SPIDER 

SR  Turn on the option Short range.  
 Use only for Hanger.  
 Example: SR  

STIFF  Stiffness (lb/in or N/mm)  
 Use for Guide, Limit stop and Snubbers  
 Example: STIFF=1000 

STRO Settlement rotation (deg or rad) (rx,ry,rz) 
 Example: STRO (0.15, 0.15, 0.15) 

T or TEMP Temperature (F or C) 
 Example: T=650 

TA Pressure thrust area for bellows and Slip joints (in2 or mm2). 
 Example: TA=12.3 

THK  Thickness (inch or mm)  
 Use only for Branch SIF (Radiused Branch & Branch on Thickened Pipe)  
 Example: THK=10 

THK1 Thickness at from end for reducer (inch or mm) 

THK2 Thickness at to end for reducer (inch or mm) 

THKF  Thickness factor  
 Use only for Valve.  
 Example: THKF=3.0  

TRAK  Translational Stiffness (lb/in or N/mm). TRAK(kx,ky,kz)  
 Use for Anchor and Elastic element.  
 Example: TRAK(1000,1500,2000)  

TJOINT  Defines the Threaded Joint  
 Example: TJOINT 

U or UNIF Uniform load (lb/ft or Kg/m) 
 Example: U=200 

US User-defined spring hanger 
 US(No. of hangers, spring rate(lb./inch or N/mm), hot load(lb. or N)) 
 Examples: US(2,600,1540) 
 US(1,0,2300) : Constant support 

VS Variable spring hanger 
 Example : VS, VS=2: two variable spring hangers 

VOD  Vessel outside diameter (inch or mm)  
 Use only for Nozzle.  
 Example: VOD=250  

VTHK  Vessel thickness (inch or mm)  
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 Use only for Nozzle  
 Example: VTHK=10  

VWGT  Valve weight (lb or kg)  
 Example: VWGT=100 

WGT Weight of an item (ball joint, flange, Slip joint, etc.) (lb or kg)  
 Example: WGT=50  

WS  Widely Spaced  
 Use only for Miter bend  
 Example: WS  

WTYPE  Weld type  
 Example: WTYPE=1  
 (1 = Butt weld, 2 = Fillet weld, 3 = Concave fillet weld, 4 = Tapered  
 Transition) 

PUMPS  

Description (up to 16 characters)  
Suction/Discharge location (0 = Top, 1 = Side, 2 = End)  
Shaft axis (xcomp, ycomp, zcomp)  
Center of pump (x, y, z) 

English units  

Desc, Horizontal / Vertical inline (0 or 1), Shaft axis, Center of pump (ft-in), Suction node, 
Suction location, Discharge Node, Discharge Location  

SI units 

Desc, Horizontal / Vertical inline (0 or 1), Shaft axis, Center of pump (mm), Suction node, 
Suction location, Discharge Node, Discharge Location  

Horizontal Pumps  

Desc, 0, Shaft axis, Center of pump, Suction node, Suction location, Discharge Node, 
Discharge Location  

Vertical Inline Pumps  

Desc, 1, Suction node, Discharge Node  

Example 

PUMPS  
427BSOUTH,1,350  
427ANORTH,0,0.0000,1.0000,0.0000,-3.8299,-13'8”,44.33,390,2,410,2  
427WEST,1,300  

COMPRESSORS  

Description (up to 16 characters)  
Shaft axis (xcomp, ycomp, zcomp)  
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Description, Shaft axis direction, Inlet Node, Exhaust Node, Extraction Node 1, Extraction 
Node 2.  

Example  

COMPRESSORS  
Compressor1,1.0000,0.0000,0.0000,210,300  

TURBINES  

Description (up to 16 characters)  
Shaft axis (xcomp, ycomp, zcomp)  

Description, Shaft axis direction, Inlet Node, Exhaust Node, Extraction Node 1, Extraction 
Node 2.  

Example  

TURBINES  
TURBINE1,1.0000,0.0000,0.0000,250,360 

SEISMIC 

X,Y,Z Static equivalent seismic loads in g’s. 

SEISMIC Example: Static seismic loads of 0.25 and 0.3 g’s in X and Z directions. 

SEISMIC 
0.25,0.00,0.30 

WIND 

Wind velocity (MPH or m/s), Shape factor (defaults to 0.6), X, Y, Z components of wind 
direction. 

WIND Example: A wind load of 100 mph in the X direction. 

WIND 
100,0.600,1.000,0.000,0.000 

Example: 

An example of a model batch file (.mbf file) is shown below: 

Desalter Pumps 
 
OPTIONS  
HGRA,B313  
MATERIAL  
A53,0.283,0.300,1.00  
A53,-325,31.4E+6,5.00E-6,20000  
A53,-200,30.8E+6,5.35E-6,20000  
A53,-100,30.2E+6,5.65E-6,20000  
A53,70,29.5E+6,6.07E-6,20000  
A53,200,28.8E+6,6.38E-6,20000  
A53,300,28.3E+6,6.60E-6,20000  
A53,400,27.7E+6,6.82E-6,20000  
A53,500,27.3E+6,7.02E-6,18900  
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A53,600,26.7E+6,7.23E-6,17300  
A53,650,26.1E+6,7.33E-6,17000  
A53,700,25.5E+6,7.44E-6,16500  
A53,750,24.9E+6,7.54E-6,13000  
A53,800,24.2E+6,7.65E-6,10800  
A53,850,23.3E+6,7.75E-6,8700  
A53,900,22.4E+6,7.84E-6,6500  
A53,950,21.4E+6,7.91E-6,4500  
A53,1000,20.4E+6,7.97E-6,2500  
A53,1050,19.2E+6,8.05E-6,1600  
A53,1100,18.0E+6,8.12E-6,1000  
PIPE  
4,4.5,0.237,0,12.5,11,2  
6,6.625,0.28,0,12.5,11,2  
8,8.625,0.322,0,12.5,11,2  
10,10.75,0.365,0,12.5,11,2  
12,12.75,0.406,0,12.5,11,2  
LOADS  
1,400,280,0.85,400,280,350,190  
1N,400,280,0.85,100,280,350,190  
1S,100,280,0.85,400,280,350,190  
1C,100,280,0.85,100,280,100,190  
4,400,600,0.85,400,600,285,450  
4N,400,600,0.85,100,600,285,450  
4S,100,600,0.85,400,600,285,450  
SO1,350,190,0.85,70,0,70,0  
SOA,230,145,0.85,70,0,70,0  
SD1,400,280,0.85,70,0,70,0  
DO1,285,450,0.85,70,0,70,0  
DOA,225,485,0.85,70,0,70,0  
DD1,400,600,0.85,70,0,70,0  
LAYOUT  
F10,CNOZZLE=297,L2=10'0”,NOD=17.5,NTHK=1.3125,VOD=144,VTHK=1.375,  
L1=10'0”,E=29.0E+6,DV(0.0000,0.0000,1.0000)  
L10,CFLANGE=WN,WGT=220  
 
T20,JV,MA53,P10,Y1'6-1/4”,CL=1,VWGT=625,THKF=3.0000,INSF=1.7500,  
FLANGE=WN,WGT=220  
T30,Y0'4-5/8”  
T40,JD,P8,Y0'7”,COD1=10.75,THK1=0.365,OD2=8.625,THK2=0.322  
T50,KI,B12,Y6'0-1/8”  
T60,KI,B12,X-1.0017,Z1.0017  
T70,KI,B12,X-5'8-15/16  
T80,KI,B12,Y-11'3”  
T90,Z6'6”,CLS(0.000,None),DV(0.0000,1.0000,0.0000),STIFF=Rigid  
T100,Z20'0”,CLS(0.000,None),DV(0.0000,1.0000,0.0000),STIFF=Rigid  
T110,JI,B6.75,P4,Z17'6”,CJMAT=A53,JSEC=12,JLOAD=1,JR=19.125  
T120,P8,X10'11”,CLS(0.000,None),DV(0.0000,1.0000,0.0000),  
STIFF=Rigid  
T130,KI,B12,X2'0”  
*  
T240,KT,JE,Z6'4-9/16”,CES(100,400,300),TA=500,BK=11459  
*  
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T160,X-2'0”,CLS(0.000,None),DV(0.0000,1.0000,0.0000),STIFF=Rigid  
T170,KI,B12,X-8'0”  
T180,Y-8'2-13/16,CFLANGE=WN,WGT=152  
T190,JV,Y-1'4-3/4”,CVWGT=590,THKF=3.0000,INSF=1.7500,FLANGE=WN,  
WGT=152  
T200,KI,B12,Y-1'4-3/8”,CL=1N  
T210,JS,Z-1'0”,CFFOR=1000  
T220,JD,P6,Y0'0-15/16”,Z-0'6”,COD1=8.625,THK1=0.322,OD2=6.625,  
THK2=0.28,FRE=30.000  
L200A,CUS(1,900,2250)  
*  
F240  
T250,KT,P8,Z1'2”,CL=1  
*  
T260,KT,Z1'2”  
T270,Z0'11”  
*  
F260  
T280,X-2'0”,CLS(0.000,None),DV(0.0000,1.0000,0.0000),STIFF=Rigid  
T290,KI,B12,X-8'0”  
T300,Y-8'2-13/16,CFLANGE=WN,WGT=96  
T310,JV,Y-1'4-3/4”,CVWGT=590,THKF=3.0000,INSF=1.7500,  
FLANGE=WN,WGT=152  
T320,KI,B8,Y-1'4-3/8”,CL=1S  
T330,Z1'0”  
T340,JD,Y0'0- 
15/16”,Z0'6”,COD1=8.625,THK1=0.322,OD2=6.625,THK2=0.28  
*Node 230 = P-427B Suction  
T350,KA,P6,Z1'5-3/16”,CDIS(0,0.027,0),DIS2(0,0.027,0),  
DIS3(0,0.027,0)  
L350,CFLANGE=WN,WGT=96  
*Node 550 = P-427A Suction  
F220  
T390,KA,Z-2'7”,CL=1N,DIS(0,0.027,0),DIS3(0,0.027,0)  
L390,CFLANGE=WN,WGT=96  
 
T400,Z-1'6-3/8”  
T410,JL,Z-1'5-3/8”,CTRAK(1,1,1),ROTK(1,1,1),  
LXAX(1.0000,0.0000,0.0000),LYAX(0.0000,1.0000,0.0000)  
*From node 200 2'11.5” in the Z direction  
F370,KA,X-3.8300,Y-13'8”,Z59.6267,CDIS(0,0.027,0),  
DIS2(0,0.027,0),DIS3(0,0.027,0)  
L370,CFLANGE=WN,WGT=58  
T420,P4,Z0'3-3/8”,CL=4S  
T430,JD,P6,Z0'5-1/2”,COD1=4.5,THK1=0.237,OD2=6.625,THK2=0.28  
T440,KI,B9,Z2'0-5/8”  
T450,Y1'0-7/8”,CFLANGE=WN,WGT=96  
T460,JV,Y1'5-5/8”,CVWGT=204,THKF=3.0000,INSF=1.7500,  
FLANGE=WN,WGT=96  
T470,JV,Y1'4-1/8”,CVWGT=334,THKF=3.0000,  
INSF=1.7500,FLANGE=WN,WGT=96  
T480,KI,B9,Y7'0-3/8”  
T490,X8'0”,CLS(0.000,None),DV(0.0000,1.0000,0.0000),STIFF=Rigid  
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T500,KT,X3'6”  
*  
*From node 340 -2'11.5” in the -Z direction  
F410,KA,CDIS(0,0.027,0),DIS3(0,0.027,0)  
L410,CFLANGE=WN,WGT=58  
T510,P4,Z-0'3-3/8”,CL=4N  
T520,JD,P6,Z-0'5-1/2”,COD1=4.5,THK1=0.237,OD2=6.625,THK2=0.28  
T530,KI,B9,Z-4'0-5/8”  
T540,Y1'0-7/8”,CFLANGE=WN,WGT=96  
T550,JV,Y1'5-5/8”,CVWGT=204,THKF=3.0000,  
INSF=1.7500,FLANGE=WN,WGT=96  
T560,JV,Y1'4-1/8”,CVWGT=334,THKF=3.0000,  
INSF=1.7500,FLANGE=WN,WGT=96  
T570,KI,B9,Y7'0-3/8”  
T580,X8'0”,CLS(0.000,None),DV(0.0000,1.0000,0.0000),STIFF=Rigid  
T590,KI,B9,X3'6”  
T500  
L530B,CUS(1,520,1392)  
F500  
T600,KI,B9,Z1'7”,CL=4  
T610,X-3'6”,CLS(0.000,None),DV(0.0000,1.0000,0.0000),STIFF=Rigid  
T620,KI,B9,X-10'11”  
T630,KI,B9,Y-4'6-11/16  
T640,KI,B9,Z7'4”  
T650,Y1'1”,CFLANGE=WN,WGT=96  
T660,Y0'11”  
T670,JD,P8,Y0'6”,COD1=6.625,THK1=0.28,OD2=8.625,THK2=0.322  
T680,KT,Y0'7”  
*  
F250  
T685,P4,X-2'0”,CL=1C,LS(0.000,None),DV(0.0000,1.0000,0.0000),  
STIFF=Rigid  
T690,KI,B6,X-10'11”  
T700,KI,B6,Y-1'5-11/16  
T710,Z1'10”,CFLANGE=WN,WGT=58  
 
*  
F680  
T720,Z-1'6”,CL=4,FLANGE=WN,WGT=58  
T730,JV,Z-1'0-1/4”,CVWGT=170,THKF=3.0000,  
INSF=1.7500,FLANGE=WN,WGT=58  
T735,Z-6'6-3/4”,CL=1C,LS(0.000,None),DV(0.0000,1.0000,0.0000),  
STIFF=Rigid  
T710,CL=1  
*  
F680  
T800,KI,B12,P8,Y3'0”,CL=4  
T810,Z6'1-5/8”,CFLANGE=WN,WGT=152  
T820,Z0'4-3/8”,CLS(0.000,None),DV(0.0000,1.0000,0.0000),  
STIFF=Rigid  
T830,KI,B12,Z1'0”  
T840,KI,B12,X7'0”  
T850,KI,B12,X1'6”,Y-1'6”  
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T860,X6'0”,CFLANGE=WN,WGT=152  
T870,JV,X1'4-3/4”,CVWGT=410,THKF=3.0000,INSF=1.7500,  
FLANGE=WN,WGT=152  
T880,KT,X1'4”  
*  
T890,KI,B12,Y1'7”  
T900,KI,B12,Z2'0”  
T910,Y-1'1-1/4”,CFLANGE=WN,WGT=152  
T920,JV,Y-1'4-3/4”,CVWGT=410,THKF=3.0000,INSF=1.7500,FLANGE=WN,  
WGT=152  
T930,KI,B12,Y-1'1-1/4”  
T940,KT,Z-2'0”  
*  
T950,X1'0”,CLS(0.000,None),DV(0.0000,1.0000,0.0000),STIFF=Rigid  
T960,X1'0”  
*  
F940  
T970,X-1'4”  
*  
F880  
T980,KI,B12,X10'6”  
T990,KI,B12,Y4'6”  
T1000,X1'10”,CLS(0.000,None),DV(0.0000,1.0000,0.0000),STIFF=Rigid  
T1010,X26'8”,CLS(0.000,None),DV(0.0000,1.0000,0.0000),STIFF=Rigid  
T1020,KI,B12,X6'2”  
T1030,KI,B12,Z2'0”  
T1040,Y4'2”  
T1050,JD,P10,Y0'7”,COD1=6.625,THK1=0.28,OD2=8.625,THK2=0.322  
T1060,KI,B15,Y1'3”  
T1070,Z7'2”,CLS(0.000,None),DV(0.0000,1.0000,0.0000),STIFF=Rigid  
T1080,Z18'8”,CLS(0.000,None),DV(0.0000,1.0000,0.0000),STIFF=Rigid  
T1090,KI,B15,Z15'2”  
T1100,KI,B15,Y-25'6”  
T1110,KI,B15,X-3.8971,Z-2'3”  
T1120,Y1'7-7/8”,CFLANGE=WN,WGT=220  
 
PUMPS  
427BSOUTH,1,350 
427ANORTH,0,0.0000,1.0000,0.0000,3.8299,13'8”,44.3351,390,2,410,2  
COMPRESSORS  
Compressor_1,1.0000,0.0000,0.0000,210,300  
SEISMIC  
0.25,0.00,0.30  
WIND  
100,0.600,1.000,0.000,0.000 
 
Hanger Type  

This section describes the hanger type (HTYP under comments section) number to be used 
for defining variable spring hanger type.  

Hanger Description Type  Value  

ABB-PBS   1  
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Basic Engineers   2  
Bergen Paterson   3  
Bergen Paterson (L)  4  
BHEL Hyderabad  5  
BHEL Trichy   6  
Borrello   7  
Carpenter & Paterson  8  
Corner & Lada   9  
Dynax   10  
Elcen   11  
Fee and Mason   12  
Flexider (30-60-120)  13  
Flexider (50-100-200)  14  
Fronek   15  
Grinell   16  
Hydra   17  
Lisega   18  
Mitsubishi (30-60-120)  19  
Mitsubishi (80-160)  20  
Myricks   21  
NHK (30-60-120)  22  
NHK (80-160)   23  
Nordon   24  
NPS Industries   25  
Piping Services   26  
Piping Tech & Products   27  
Power Piping   28  
Sanwa Tekki (30-60-120)   29  
Sanwa Tekki (85-170)  30  
Sarathi   31  
Spring Supports   32  
SSG   33  
Comet   34 

CAEPIPE can export model data from inside the Layout window to a text file with the 
extension .mbf (model batch file), which may be edited using a text editor. The edited text 
file may then be read back into CAEPIPE by using the Import feature. But note that the 
existing .mod file will be overwritten. So, you must rename the edited text file before 
importing it back into CAEPIPE. 

To export a model, select the menu command File > Export from the Layout window. 
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The Export Model dialog is shown.  Click on Export button to write to a .mbf file. 
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Appendix D 
Nozzle Stiffness Calculations
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Six stiffnesses are shown below at the nozzle-vessel interface — three are calculated and the 
other three are assumed rigid. 

 

 

 

 

The coordinate system is as shown in the figure. The six components of the forces and 
moments at the nozzle-vessel interface are: 

P = Radial load MC  = Circumferential moment 
VC  = Circumferential load MT  = Torsional moment 
VL  = Longitudinal load ML  = Longitudinal moment 

Of the six components of stiffnesses, only three stiffnesses, axial (Kx), circumferential (Kyy), 
and longitudinal (Kzz), are calculated. The remaining three are assumed to be rigid. 

Several graphs are given at the end of this appendix. The stiffness coefficients are obtained 
by interpolating logarithmically from these graphs. 

The first two, Figures D-1 and D-2, are used to calculate nozzle stiffness coefficients for 
Nozzles on cylindrical vessels. Figure D-1 is used to calculate the axial stiffness coefficient 
and Figure D-2 is used to calculate circumferential and longitudinal stiffness coefficients. 
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Nomenclature 

𝑝𝑝 = mean diameter of vessel 
𝑑𝑑 = outside diameter of nozzle 
𝑇𝑇 = thickness of vessel 
𝑑𝑑 = thickness of nozzle 
λ = (𝑑𝑑/D)�𝑝𝑝/T 
Λ = 𝐿𝐿/√𝑝𝑝𝑇𝑇 
𝐿𝐿 = unsupported length of cylinder 

 = 8𝐿𝐿1𝐿𝐿2/��𝐿𝐿1 + �𝐿𝐿2�
2
 

𝐿𝐿1 = distance from nozzle center line to vessel end 
𝐿𝐿2 = distance from nozzle center line to vessel end 
𝐸𝐸 = modulus of elasticity of vessel material 

Axial Stiffness(𝑲𝑲𝒙𝒙) 

𝐾𝐾𝑚𝑚 = 𝛼𝛼 ×
4.95𝐸𝐸𝑇𝑇2

𝑝𝑝√𝛬𝛬
 

where 
𝛼𝛼 = stiffness coefficient read from Figure D-1 

Circumferential Stiffness�𝑲𝑲𝒚𝒚𝒚𝒚� 

𝐾𝐾𝑦𝑦𝑦𝑦 = 𝛽𝛽 × 𝐸𝐸𝑇𝑇3 

where 
𝛽𝛽 =1stiffness coefficient read from Figure D-2. 
The bottom three curves in Figure D-2, marked Circumferential moment MCare used to 
find𝛽𝛽. 

Longitudinal Stiffness(𝑲𝑲𝒛𝒛𝒛𝒛) 

𝐾𝐾𝑓𝑓𝑓𝑓 = 𝛾𝛾 × 𝐸𝐸𝑇𝑇3 

where 
γ = stiffness coefficient read from Figure D-2. 
The top two curves in Figure D-2, marked Longitudinal moment MLare used to findγ. 

(1) 

(2) 

 (3) 
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Calculation of Nozzle stiffnesses for Nozzles on Flat-bottom tanks 

This procedure is similar to the previous one. 

 

As before, only three stiffnesses are calculated as the other three are assumed to be rigid. The 
ones that are calculated are axial(𝐾𝐾𝑚𝑚), circumferential�𝐾𝐾𝑦𝑦𝑦𝑦 �, and longitudinal (𝐾𝐾𝑓𝑓𝑓𝑓). 

For Nozzles on flat-bottom tanks, twelve graphs are given at the end of this appendix, 
Figures D-3 through D-14. Six are for “with reinforcing pad (on vessel)” with the other six 
for no reinforcing pad on the vessel. The stiffness coefficients are obtained using the 
appropriate graph. 
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Nomenclature 

𝑅𝑅 = Mean radius of vessel  
𝑑𝑑 = thickness of vessel 
2𝑎𝑎 = outside diameter of nozzle 

Axial Stiffness(𝑲𝑲𝒙𝒙) 

𝐾𝐾𝑚𝑚 = 𝐾𝐾𝑅𝑅 × 𝐸𝐸 × (2𝑎𝑎) 

where 
𝐾𝐾𝑅𝑅 = axial stiffness coefficient. 

Circumferential Stiffness�𝑲𝑲𝒚𝒚𝒚𝒚� 

𝐾𝐾𝑦𝑦𝑦𝑦 = 𝐾𝐾𝐶𝐶 × 𝐸𝐸 × (2𝑎𝑎)3 

where 
𝐾𝐾𝐶𝐶  = circumferential stiffness coefficient. 

Longitudinal Stiffness(𝑲𝑲𝒛𝒛𝒛𝒛) 

𝐾𝐾𝑓𝑓𝑓𝑓 = 𝐾𝐾𝐿𝐿 × 𝐸𝐸 × (2𝑎𝑎)3 

where 
𝐾𝐾𝐿𝐿 =longitudinal stiffness coefficient. 

The graphs for stiffness coefficients follow: 

(4) 

(5) 

(6) 
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Figure D-1:Stiffness coefficient for axial load on nozzle 
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Figure D-2:Stiffness coefficients for moment loads on nozzle 
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Figure D-3:Stiffness coefficient for axial load (with reinforcing pad)(L/2a = 1.0) 

 

Figure D-4:Stiffness coefficient for circumferential moment (with reinforcing 
pad)(L/2a=1.0) 
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Figure D-5: Stiffness coefficient for longitudinal moment (with reinforcing pad)(L/2a = 1.0) 

 

Figure D-6:Stiffness coefficient for axial load (with reinforcing pad)(L/2a = 1.5) 
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Figure D-7:Stiffness coefficient for circumferential moment (with reinforcing pad) 
(L/2a = 1.5) 

 

Figure D-8:Stiffness coefficient for longitudinal moment (with reinforcing pad)(L/2a=1.5) 
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Figure D-9:Stiffness coefficient for axial load (no reinforcing pad)(L/2a = 1.0) 

 

Figure D-10:Stiffness coefficient for circumferential moment (no reinforcing pad)(L/2a= 
1.0) 
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Figure D-11:Stiffness coefficient for longitudinal moment (no reinforcing pad)(L/2a = 1.0) 

 

Figure D-12:Stiffness coefficient for axial load (no reinforcing pad)(L/2a = 1.5) 
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Figure D-13:Stiffness coefficient for circumferential moment (no reinforcing pad) 
(L/2a = 1.5) 

 

Figure D-14:Stiffness coefficient for longitudinal moment (no reinforcing pad)(L/2a=1.5) 
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The “Dynamic Susceptibility” Method for Piping Vibration –A Screening Tool for 
Potentially Large Alternating Stresses 

Dr. R. T. Hartlen, Plant Equipment Dynamics, Ontario, CANADA 

Summary 

The enhanced output of the “Modal Analysis” load case in CAEPIPE shows modal 
frequencies and mode shapes AND now two new outputs called “dynamic stresses” and 
“dynamic susceptibility.” The dynamic stresses are the dynamic bending stresses associated 
with vibration in a natural mode. That is to say, the modal analysis result has been generalized to 
include the alternating bending stresses associated with the vibration in a natural mode. The 
dynamic susceptibility for any mode is the ratio of the maximum alternating bending stress to 
the maximum vibration velocity. This “susceptibility ratio” provides an indicator of the 
susceptibility of the system to large dynamic stresses. Also, the associated animated mode 
shapes include color-spot-markers identifying the respective locations of maximum vibration 
and maximum dynamic bending stress. The susceptibility ratio and the graphics feature 
provide incisive insights into the reasons for high susceptibility and how to make 
improvements. This new feature is illustrated by application to the CAEPIPE “Sample 
problem” system. 

1. Dynamic Susceptibility: New Analytical Tool Available for Vibration of Piping 

When addressing vibration issues, the piping designer does not have the specific 
requirements, nor the analytical tools and technical references typically available for other 
plant equipment such as rotating machinery. Typically, piping vibration problems only 
become apparent at the time of commissioning and early operation, after a fatigue failure or 
degradation of pipe supports. Discovery of a problem is then followed by an ad hoc effort to 
assess, diagnose and correct as required. The “Dynamic Susceptibility” analysis, now 
included in CAEPIPE, provides a new analytical tool to assist the piping designer at any 
stage, from preliminary layout to resolution of field problems. 

CAEPIPE’s Dynamic Susceptibility feature utilizes the “Stress per Velocity” method, an 
incisive analytical tool for “screening” the vibration modes of a system. It readily identifies 
which modes, if excited, could potentially cause large dynamic stresses. Furthermore, it 
reveals which features of the system layout and support are responsible for the susceptibility 
to large dynamic stresses. At the design stage, the method allows the designer to quickly 
identify and correct features that could lead to large dynamic stresses at frequencies likely to 
be excited. Where problems are encountered in the field, the method provides quick and 
incisive support to efforts of observation, measurement, assessment, diagnosis and 
correction. 

The technical foundation of this method lies in an underlying fundamental relationship 
between the kinetic energy of vibratory motion, and the corresponding potential energy 
stored in elastic stresses. That is to say, the kinetic energy at zero displacement and maximum 
system velocity must equal the stored elastic energy at zero velocity and maximum 
displacement. This implies a fundamental relationship between vibration velocity and 
dynamic bending stresses, which is the foundation of the stress per velocity approach for 
“susceptibility screening” of vibration modes. 

The key analytical step is to determine, mode by mode, the ratio of maximum dynamic stress 
to maximum vibration velocity. This ratio will lie in a lower “baseline range” for 
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uncomplicated systems such as classical uniform-beam configurations. For more complex 
systems, the stress / velocity ratio will increase due to typical complications such as three-
dimensional layout, discrete heavy masses, changes of cross-section and susceptible branch 
connections. System modes with large stress-velocity ratios are the potentially susceptible modes. 

The Stress / Velocity method, implemented in CAEPIPE as the Dynamic Susceptibility 
feature, automatically and quickly finds these modes and quantifies the susceptibility. Evaluation of the 
results, including special-purpose color animation, helps to identify which details of layout 
and support are responsible for the large stresses. 

This technical note is to present and explain the “dynamic susceptibility” outputs now 
included in the modal analysis load case, and to illustrate by application to the standard 
CAEPIPE “Sample problem” system. 

2. Underlying Fundamental Basis of the Method 

2.1 Kinetic Energy and Potential Energy; Vibration Velocity and Dynamic 
Stresses 

The underlying theoretical basis for the Stress / Velocity method is a deceptively 
straightforward but universally-applicable relationship between kinetic energy and potential 
(elastic) energy for vibrating systems. Stated simply, for vibration at a system natural frequency, the 
kinetic energy at maximum velocity and zero displacement must then be stored as 
elastic (strain) energy at maximum displacement and zero velocity. Since the strain 
energy and kinetic energy are respectively proportional to the squares of stress and velocity, it 
follows that dynamic stress, σ, will be proportional to vibration velocity, v. For idealized 
straight-beam systems, consisting of thin-walled pipe and with no contents, insulation or 
concentrated mass, the ratio σ / v is dependent primarily upon material properties, (density ρ and 
modulus E) ,and is remarkably independent of system-specific dimensions, natural-mode number and 
vibration frequency. For real continuous systems of course, the kinetic and potential energies are 
distributed over the structure in accordance with the respective modes shapes. However, 
integrated over the structure, the underlying energy- equality holds true. Provided the spatial 
distributions are sufficiently similar, i.e. harmonic functions, the RMS or maximum stress will 
still be directly related to the RMS or maximum vibration velocity. 

2.2 The “Screening” Approach 

As stated above, for idealized pure beam systems the stress-velocity ratio will depend 
primarily upon material properties. 

For real systems, the spatial patterns of the mode shapes will depart from the idealized 
harmonic functions, and the stress-velocity ratios accordingly increase above the theoretical minimum or 
baseline value. System details causing the ratios to increase would include the three-
dimensional layout, large unsupported masses, high-density contents in thin-walled pipe, 
susceptible branch connections, changes of cross section, etc. The more “unfavorable "the system 
layout and details are, the larger the σ / v ratios for some modes will be. 

Thus, the general susceptibility of a system to large dynamic stresses can be assessed by 
determining the extent to which the σ / v ratios for any mode exceed the baseline range. 

Furthermore, by determining which particular modes have the high ratios, and whether these 
modes are known or likely to be excited, the at-risk vibration frequencies and mode shapes 
are identified for further assessment and attention. This is the basis of the Stress / Velocity 
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method of analysis and its implementation as the “dynamic susceptibility” feature in 
CAEPIPE. 

2.3 Relation to Velocity-based Vibration Acceptance Criteria 

There are various general and application-specific acceptance criteria based upon vibration 
velocity as the quantity of record. Some, in order to cover the worst case scenarios, are 
overly conservative for many systems. Others are presented as being applicable only to the 
first mode of simple beams, leading to the misconception that the stress / velocity 
relationship does not apply at all to higher modes. In any case, there are real and perceived 
limitations on the use of screening acceptance criteria based upon a single value of vibration 
velocity. 

The dynamic susceptibility method turns this apparent limitation into a useful 
analytical tool! Specifically, large stress / velocity ratios, well above the baseline values, are 
recognized as a “warning flag.” Large values indicate that some feature(s) of the system make 
it particularly susceptible to large dynamic stresses in specific modes. 

3 What the Dynamic Susceptibility Method Does  

3.1 General Approach  

The Dynamic Susceptibility method is essentially a post processor to fully exploit the modal 
analysis results of the system. Mode shape tables of dynamic bending stress and vibration 
velocity are searched for their respective maxima. Dividing the maximum stress by the 
maximum velocity yield the “σ/v ratio” for each mode. That ratio is the basis for assessing 
the susceptibility to large dynamic stresses. Larger values indicate higher susceptibility 
associated with specific details of the system. 

3.2 Specific Implementation in CAEPIPE 

The Stress / Velocity method has been implemented as additional analysis and output of the 
CAEPIPE modal analysis. The modal analysis load case now includes additional outputs and 
features as follows: 

Dynamic Stresses  This output provides the “mode shapes” of dynamic bending 
stresses, tabulated along with the conventional mode shape of 
vibration magnitude. 

Dynamic Susceptibility  This output is a table of s/v ratios, in psi / ips, mode by 
mode, in rank order of decreasing magnitude. In addition to 
modal frequencies and s/v ratios, the table also includes the 
node locations of the maxima of vibration amplitude and 
bending stresses. 

 With the dynamic susceptibility output selected, the animated 
graphic display of the vibration mode shape includes the 
added feature of color spot markers showing the locations of 
maximum vibration and maximum dynamic bending stress. 

These outputs will assist the designer through a more-complete understanding of the 
system’s dynamic characteristics. They provide incisive quantified insights into how specific 
details of components, layout and support could contribute to large dynamic stresses, and 
into how to make improvements. 
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4 What the Dynamic Susceptibility Method Does Not Do Directly 

The Stress / Velocity method of assessment, and its implementation in CAEPIPE as 
dynamic susceptibility, is based entirely upon the system’s dynamic characteristics per se. Thus the 
vibration velocities and dynamic stresses employed in the analysis, although directly related 
to each other, are of arbitrary magnitude. There is no computation of the response to a 
prescribed forcing function, and no attempt to calculate actual dynamic stresses. Thus the 
dynamic susceptibility results do not factor directly into a pass-fail code compliance 
consideration. Rather, they assist the designer to assess and reduce susceptibility to large 
dynamic stresses if necessary, in order to meet whatever requirements have been specified. 

An example follows next. 

5 Illustrative Example of the Dynamic Susceptibility Analysis 

The “dynamic susceptibility” feature of CAEPIPE will be illustrated here by application to 
the standard CAEPIPE Example system. The modal analysis was performed for frequencies 
up to 200 Hz, resulting in a reporting-out for 12 modes. 

 

The frequencies range from mode 1 at 14.5 Hz to mode 12 at 192 Hz. In two instances, very 
similar horizontal and vertical modes appear in pairs, i.e. modes 3 & 4 and 7 & 8. 

The relevant features of this system can be readily identified and understood, by reference to 
the dynamic-susceptibility table and the animated graphic display of mode shape. Results will 
be considered here in the order of decreasing susceptibility. 
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5.1 Axial movement of long pipe run (large added mass in motion) 

From the dynamic susceptibility table, the top of the list is mode 2 at 20.8 Hz, having a 
dynamic susceptibility of 649 psi / ips. 

 

From the animated graphic display, note that the maximum dynamic bending stresses are at 
the anchored point, node 50. Note also that the dominant motion is a “Z” motion of the 
straight run between nodes 20 and 40 (i.e., in effect an axial motion of that run as a rigid 
body). The designer’s interpretation here is that the vertical rise from node 50 to node 40 is 
effectively a cantilevered beam with an effective large added mass at the tip; that feature of 
layout accounts for the high susceptibility. 

5.2 Effects associated with the valve (local rigidity to bending, and added mass) 

The next-highest values of susceptibility are for the two pairs of modes, modes 7 & 8 at 129 
and 133 Hz, and modes 3 & 4 at 27.8 and 31.2 Hz. As will be shown here, these are 
associated with effects of the valve, 
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The susceptibility for modes 7 & 8, respectively 594 and 589 psi / ips, is attributable to the 
rigidity of the valve element within an otherwise flexible pipe run. This can be seen from a 
close look at the animated graphic. Notice that these relatively high frequency modes feature 
a reversal of bending curvature along the run between nodes 30 and 80. Notice also that 
there is a stronger localized curvature on approach to the valve body. The designer’s 
interpretation here is that, since there cannot be any curvature of the rigid valve itself, there 
must be a more concentrated curvature of the adjacent pipe. 

The dynamic susceptibility of modes 3 & 4, respectively 521 and 526 psi / ips, is associated 
with the more straightforward “concentrated mass” effect of the valve. 

 

 

From the animated graphic, these modes feature a large amplitude vibration at the valve. The 
kinetic energy of this added mass must be stored as strain energy in the flexing (i.e., spring) 
element, resulting in elevated dynamic stresses. 

5.3 Beam modes with “moderate” added mass effects of adjacent spans 

Modes 1,5 and 6, with frequencies of 14.5, 47.4 and 52.4 Hz, show progressively decreasing 
“intermediate to low” values of susceptibility at respectively 456, 383 and 339 psi / ips. 
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Reference to the animated graphics shows that these modes involve predominantly transverse 
vibration (as contrasted with the prominent axial movement of mode 2) and involve little 
participation at the valve (which accounted for the elevated susceptibility of modes7 & 8 and 3 
& 4). Notice that these modes, 1, 5, and 6, involve varying degrees of the influence of 
effective added mass of adjacent spans, and of length of the cantilevered span contributing 
most to stiffness. 

5.4 Modes approaching the “simple-beam baseline” behavior 

Modes 10, 11 and 12 have significantly higher frequencies, 164 to 192 Hz, and 
correspondingly short wavelengths. Consequently, the vibration pattern tends to be 
transverse beam vibration “within the span,” with little or no effect from connected spans or 
the valve. For these modes, the susceptibility ratios range from 256 to 272 psi / ips. These 
values are approaching the baseline values for uncomplicated mode shapes of the pipe 
section and pipe contents of this system. 
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NOTE: Mode 9, at 138 Hz, is clearly an exception, with a susceptibility of only 104 psi / ips, 
well below the baseline level. From the animated display, it can be seen that this is not really a 
“bending” mode; rather, the spring effect for this mode is an axial stretching of the run 
between nodes 80 and 30. Consequently, the bending stresses are low, as reflected in the 
abnormal susceptibility ratio. In effect, this mode lies outside the intended application of the 
dynamic susceptibility approach. Notice however, that the low susceptibility ratio has in 
effect “flagged” this mode as “not a bending mode”; that in itself provides the designer 
additional insight into system characteristics and behavior. 

5.5 Summary Comment 

As per paragraphs 5.1 to 5.4, the dynamic susceptibility method has incisively identified the 
key features of the Sample model, with respect to potentially large dynamic stresses. This of 
course is a relatively simple system. An experienced designer, with some appreciation of 
dynamics, might view the results as obvious. However, the method will do the same job, 
automatically and directly, on any larger or more complex system for which nothing is 
obvious! 

6 Summary of “Dynamic Susceptibility” Analytical Capability 

The stress / velocity method, implemented in CAEPIPE as the “Dynamic Susceptibility” 
feature, provides quantified insights into the stress versus vibration characteristics of the 
system layout per se. 

In particular, the dynamic susceptibility table identifies specific modes that are susceptible to 
large dynamic stresses for a given level of vibration. The larger the stress / velocity ratio, the 
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stronger the indication that some particular feature of layout, mass distribution, supports, 
stress raisers, etc., is causing susceptibility to large dynamic stresses. 

The animated mode-shape display identifies, by the color-spot-markers, the locations of the 
respective maxima in dynamic stress and vibration velocity. Review of these animated plots 
will reveal the offending pattern of motion, and provide immediate insight into what features 
of the system are responsible for the large dynamic stresses. 

Finally, the “dynamic stresses” table provides the distribution of dynamic stresses around the 
system, i.e., in effect, the mode shape of dynamic stresses to go along with the conventional 
mode shape of vibration. This information allows identification of other parts of the system, 
if any, with dynamic stresses comparable to the identified maximum. 

7 Suggested Applications and Associated Benefits  

7.1 At the Design Stage 

At the design stage, the dynamic susceptibility feature allows the designer to quickly 
determine whether the system may be susceptible to very large dynamic stresses. This could 
be a broad look at all frequencies, or could be focused on particular frequencies where excitation is likely 
to occur. On identifying high susceptibility, the designer can then make changes to improve 
the design. It is important to note that this method is based upon the dynamic-stress versus 
vibration-velocity characteristics of the system per se. There is no need to specify a forcing 
function and perform a response calculation and stress / fatigue analysis. However, where such 
analysis is a requirement, the dynamic susceptibility module can assist the designer to achieve a 
system layout that will meet the requirements and criteria. 

7.2 Commissioning, Acceptance Testing 

The dynamic susceptibility feature can also contribute to planning acceptance testing and 
associated measurements where these are undertaken whether by formal requirement or by 
choice. Locations for measurement of vibration or dynamic strain can be selected based 
upon knowing the locations of the maxima and the distribution of vibration and dynamic 
stress. Reference to the dynamic susceptibility results can help assure that the modes of most 
potential concern are well covered by the minimum set of practically-achievable measurements. Furthermore, 
mode-specific acceptance criteria can be readily established to avoid the restrictions of generally 
over-conservative guideline type criteria, while providing assurance that any highly-susceptible situations are 
identified and addressed. 

7.3 Troubleshooting and Correction 

As mentioned earlier, when vibration and/or fatigue problems are recognized at start up or 
early operation, there is typically an ad hoc program of observation, measurement, 
assessment, diagnosis and correction. It is not uncommon for there to be some uncertainty 
about what to measure and what is acceptable. The dynamic susceptibility module can 
contribute very effectively in these situations. 

Normally, the overall symptoms, approximate frequency and pattern of vibration are known 
to some extent from observation and/or a few measurements. After modeling the system, 
and obtaining the dynamic susceptibility results, the subsequent steps can be highly focused on 
specific frequencies and locations, the optimum measurements, and system-specific acceptance 
criteria. 
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Equally or more importantly, the proposed solution options can be modeled and evaluated to make 
sure they will achieve the required improvement. 

7.4 General 

The dynamic susceptibility module does not apply directly to meeting code or other formal stress analysis 
requirements. However, it is an incisive analytical tool to help the designer understand the 
stress / vibration relationship, assess the situation and to decide how to modify the design if 
necessary. It can be used for design, planning acceptance tests, and troubleshooting and 
correction. 

8 Information for Reference 

The Stress /Velocity method for screening piping system modes was developed and brought 
to the attention of SST Systems by Dr. R.T Hartlen of Plant Equipment Dynamics Inc. 

The background material provided here is intended to provide only a concise summary of 
the underlying fundamentals, the universality for idealized systems, and the expected detail-
dependent variations for real systems. The stress / velocity method, although not yet widely 
known and applied, is fundamentally theoretically sound. However, complete theoretical 
rigor is beyond the scope of this note. 

For users who may wish to independently examine and validate the underlying theoretical 
fundamentals, a few key references are provided. References 1, 2 and 3 deal with 
fundamentals. References 4 and 5 deal with application to piping. The CEA research projects 
reported in References 3 and 4 were initiated and guided by Dr. Hartlen. 
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Notation based on ASME Section VIII, Division 1, Appendix 2 

The symbols described below are used in the formulas for the design of flanges 
𝐴𝐴 = outside diameter of flange 
𝐴𝐴𝑏𝑏  = cross-sectional area of the bolts using the root diameter of the thread 
𝐴𝐴𝑚𝑚  =  total required cross-sectional area of bolts taken as greater of 𝐴𝐴𝑚𝑚1 and 𝐴𝐴𝑚𝑚2 
𝐴𝐴𝑚𝑚1 =  total cross-sectional area of bolts at root of thread or section of least diameter under  
 stress, required for the operating conditions 

=
𝑊𝑊𝑚𝑚1

𝑆𝑆𝑏𝑏
 

𝐴𝐴𝑚𝑚2 = total cross-sectional area of bolts at root of thread or section of least diameter under 
 stress 

=
𝑊𝑊𝑚𝑚2

𝑆𝑆𝑎𝑎
 

𝐵𝐵 = inside diameter of flange 
𝐵𝐵′ = inside diameter of reverse flange 
𝑏𝑏 =  effective gasket or joint-contact-surface seating width 
𝑏𝑏0 =  basic gasket seating width (from Table 2-5.2) 
𝐶𝐶 =  bolt-circle diameter 
𝑐𝑐 =  basic dimension used for the minimum sizing of welds 
𝑃𝑃 =  factor = 𝐹𝐹

ℎ𝑑𝑑
 

𝑑𝑑 =  factor = 𝑈𝑈
𝑉𝑉
ℎ𝑑𝑑𝐹𝐹0

2 for integral type flanges 

𝑑𝑑 =  factor = 𝑈𝑈
𝑉𝑉𝐿𝐿
ℎ𝑑𝑑𝐹𝐹0

2 for loose type flanges 

𝑃𝑃 =  factor = 𝐹𝐹
ℎ𝑑𝑑

 for integral type flanges 

𝑐𝑐 =  factor =𝐹𝐹𝐿𝐿
ℎ𝑑𝑑

 for loose type flanges 

𝐹𝐹 = factor for integral type flanges (from Fig. 2-7.2) 
𝐹𝐹𝐿𝐿 = factor for loose type flanges (from Fig. 2-7.4) 
𝑓𝑓 = hub stress correction for integral flanges from Fig. 2-7.6 (when greater than one, this 

 is the ratio of the stress in the small end of hub to the stress in the large end), (for 
 values below limit of figure, use f = 1.) 

𝐺𝐺 = diameter at location of gasket load reaction 
𝐹𝐹0 = thickness of hub at small end 
𝐹𝐹1 = thickness of hub at back of flange 
𝐻𝐻 = total hydrostatic end force = 0.785𝐺𝐺2𝑃𝑃 
𝐻𝐻𝑝𝑝 = hydrostatic end force on area inside of flange =0.785𝐵𝐵2𝑃𝑃 
𝐻𝐻𝐺𝐺  = gasket load (difference between flange design bolt load and total hydrostatic end 

 force) = W – H 
𝐻𝐻𝑃𝑃 = total joint-contact surface compression load = 2b x 3.14 𝐺𝐺𝑚𝑚𝑃𝑃 
𝐻𝐻𝑇𝑇 = difference between total hydrostatic end force and the hydrostatic end force on area 

 inside of flange = 𝐻𝐻 − 𝐻𝐻𝑝𝑝 
ℎ = hub length 
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ℎ𝑝𝑝 =  radial distance from the bolt circle, to the circle on which HD acts, as prescribed in 
 Table 2-6 

ℎ𝐺𝐺  =  radial distance from gasket load reaction to the bolt circle = 𝐶𝐶−𝐺𝐺
2

 
ℎ𝑂𝑂  =  factor = �𝐵𝐵𝐹𝐹0 
ℎ𝑇𝑇 =  distance from the bolt circle, to the circle on which 𝐻𝐻𝑇𝑇 acts, as prescribed in Table  

 2-6 
𝐾𝐾 =  ratio of outside diameter of flange to inside diameter of flange = A / B 

𝐿𝐿 = factor = (𝑑𝑑𝑃𝑃+1)
𝑇𝑇

+ 𝑑𝑑3

𝑑𝑑
 

𝑀𝑀𝑝𝑝  =  component of moment due to 𝐻𝐻𝑝𝑝 = 𝐻𝐻𝑝𝑝ℎ𝑝𝑝 
𝑀𝑀𝐺𝐺  =  component of moment due to 𝐻𝐻𝐺𝐺  = 𝐻𝐻𝐺𝐺ℎ𝐺𝐺  
𝑀𝑀𝑇𝑇  =  component of moment due to 𝐻𝐻𝑇𝑇 = 𝐻𝐻𝑇𝑇ℎ𝑇𝑇 
𝑀𝑀𝑂𝑂  =  total moment acting upon the flange for the operating conditions or gasket seating as 

 may apply 
𝑀𝑀𝑂𝑂  =  𝑊𝑊 (𝐶𝐶−𝐺𝐺)

2
for gasket seating condition 

𝑀𝑀𝑂𝑂  = 𝐻𝐻𝑝𝑝ℎ𝑝𝑝 + 𝐻𝐻𝐺𝐺ℎ𝐺𝐺 + 𝐻𝐻𝑇𝑇ℎ𝑇𝑇for operating condition 
𝑁𝑁 =  width used to determine the basic gasket seating with 𝑏𝑏0, based upon the possible  

 contact width of the gasket (see Table 2-5.2) 
𝑃𝑃 =  internal design pressure 
𝑅𝑅 =  radial distance from bolt circle to point of intersection of hub and back of flange. For 

 integral and hub flanges, R = (C-B / 2) – g1 
𝑆𝑆𝑎𝑎  =  allowable bolt stress at reference temperature 
𝑆𝑆𝑏𝑏  =  allowable bolt stress at design temperature 
𝑆𝑆𝑓𝑓  =  allowable stress for material of flange at design temperature (operating condition) 
𝑆𝑆𝐻𝐻  =  calculated longitudinal stress in hub 
𝑆𝑆𝑅𝑅  =  calculated radial stress in flange 
𝑆𝑆𝑇𝑇  =  calculated tangential stress in flange 
𝑇𝑇 =  factor involving K (from Fig. 2-7.1) 
𝑑𝑑 =  flange thickness 
𝑈𝑈 =  factor involving K (from Fig. 2-7.1) 
𝑉𝑉 =  factor for integral type flanges (from Fig. 2-7.3) 
𝑉𝑉𝐿𝐿 =  factor for loose type flanges (from Fig. 2-7.5) 
𝑊𝑊 =  flange design bolt load, for the operating condition or gasket seating 
 =  𝑊𝑊𝑚𝑚1 for operating condition 
 = (𝐴𝐴𝑚𝑚+𝐴𝐴𝑏𝑏 )𝑆𝑆𝑎𝑎

2
for gasket seating condition 

𝑊𝑊𝑚𝑚1= minimum required bolt load for the operating conditions 
𝑊𝑊𝑚𝑚1= minimum required bolt load for gasket seating 
𝑤𝑤 = width used to determine the basic gasket seating width 𝑏𝑏0, based upon the contact 

 width between the flange and the gasket (see Table 2-5.2) 
𝑌𝑌 =  factor involving K (from Fig. 2-7.1) 
𝑦𝑦 =  gasket or joint-contact-surface unit seating load 
𝑍𝑍 =  factor involving K (from Fig. 2-7.1) 
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Calculation of Flange Stresses 

The stresses in the flange shall be determined for both the operating conditions and gasket 
seating condition, in accordance with the following formulas: 

(1) Integral type flanges 

Longitudinal hub stress 𝑆𝑆𝐻𝐻  = 𝑓𝑓𝑀𝑀𝑂𝑂
𝐿𝐿𝐹𝐹1

2𝐵𝐵
< 1.5𝑆𝑆𝑓𝑓  

Radial flange stress 𝑆𝑆𝑅𝑅  = (1.33𝑑𝑑𝑃𝑃+1)𝑀𝑀𝑂𝑂
𝐿𝐿𝑑𝑑2𝐵𝐵

< 𝑆𝑆𝑓𝑓  

Tangential flange stress 𝑆𝑆𝑇𝑇  = 𝑌𝑌𝑀𝑀𝑂𝑂
𝑑𝑑2𝐵𝐵

− 𝑍𝑍𝑆𝑆𝑅𝑅 < 𝑆𝑆𝑓𝑓  

Combined stress  
𝑆𝑆𝐻𝐻+𝑆𝑆𝑅𝑅

2
< 𝑆𝑆𝑓𝑓and 

𝑆𝑆𝐻𝐻 + 𝑆𝑆𝑇𝑇
2

< 𝑆𝑆𝑓𝑓  

(2) Loose type flanges with hubs 

Longitudinal hub stress 𝑆𝑆𝐻𝐻  = 𝑓𝑓𝑀𝑀𝑂𝑂
𝐿𝐿𝐹𝐹1

2𝐵𝐵
< 1.5𝑆𝑆𝑓𝑓  

Radial flange stress 𝑆𝑆𝑅𝑅  = (1.33𝑑𝑑𝑃𝑃+1)𝑀𝑀𝑂𝑂
𝐿𝐿𝑑𝑑2𝐵𝐵

< 𝑆𝑆𝑓𝑓  

Tangential flange stress 𝑆𝑆𝑇𝑇  =𝑌𝑌𝑀𝑀𝑂𝑂
𝑑𝑑2𝐵𝐵

− 𝑍𝑍𝑆𝑆𝑅𝑅 < 𝑆𝑆𝑓𝑓  

Combined stress  
𝑆𝑆𝐻𝐻+𝑆𝑆𝑅𝑅

2
< 𝑆𝑆𝑓𝑓and 

𝑆𝑆𝐻𝐻 + 𝑆𝑆𝑇𝑇
2

< 𝑆𝑆𝑓𝑓  

where, 

𝐿𝐿 =  factor = (𝑑𝑑𝑃𝑃+1)
𝑇𝑇

+ 𝑑𝑑3

𝑑𝑑
 

𝑑𝑑 =  factor = 𝑈𝑈
𝑉𝑉𝐿𝐿
ℎ𝑑𝑑𝐹𝐹0

2 for integral type flanges 

𝑃𝑃 =  factor =𝐹𝐹𝐿𝐿
ℎ𝑑𝑑

 

𝑉𝑉𝐿𝐿 = factor for loose type flanges (from Fig. 2-7.5) 
𝐹𝐹𝐿𝐿 =  factor for loose type flanges (from Fig. 2-7.4) 

(3) Loose type flanges without hubs 

Longitudinal hub stress 𝑆𝑆𝐻𝐻  = 0 
Radial flange stress 𝑆𝑆𝑅𝑅  = 0 
Tangential flange stress 𝑆𝑆𝑇𝑇 = 𝑌𝑌𝑀𝑀𝑂𝑂

𝑑𝑑2𝐵𝐵
< 𝑆𝑆𝑓𝑓  
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Combined stress  
𝑆𝑆𝐻𝐻+𝑆𝑆𝑅𝑅

2
< 𝑆𝑆𝑓𝑓and 

𝑆𝑆𝐻𝐻 + 𝑆𝑆𝑇𝑇
2

< 𝑆𝑆𝑓𝑓  

where, 

𝐿𝐿 = factor = d
t

T
te 3)1(

+
+

 

𝑑𝑑 = factor = 2
00 gh

V
U

L

 

𝑃𝑃 = factor = 
o

L

h
F

 

𝑉𝑉𝐿𝐿 =  factor for loose type flanges (from Fig. 2-7.5) 
𝐹𝐹𝐿𝐿 =  factor for loose type flanges (from Fig. 2-7.4) 

(4) Optional type flanges (calculated as loose flanges without hubs) 

Longitudinal hub stress 𝑆𝑆𝐻𝐻  = 0 
Radial flange stress 𝑆𝑆𝑅𝑅  = 0 
Tangential flange stress 𝑆𝑆𝑇𝑇 = 𝑌𝑌𝑀𝑀𝑂𝑂

𝑑𝑑2𝐵𝐵
< 𝑆𝑆𝑓𝑓  

Combined stress  
𝑆𝑆𝐻𝐻+𝑆𝑆𝑅𝑅

2
< 𝑆𝑆𝑓𝑓and 

𝑆𝑆𝐻𝐻 + 𝑆𝑆𝑇𝑇
2

< 𝑆𝑆𝑓𝑓  

where, 

𝐿𝐿 = factor = d
t

T
te 3)1(

+
+

 

𝑑𝑑 = factor = 2
00 gh

V
U

L

 

𝑃𝑃 = factor = 
o

L

h
F

 

𝑉𝑉𝐿𝐿 = factor for loose type flanges (from Fig. 2-7.5) 
𝐹𝐹𝐿𝐿 = factor for loose type flanges (from Fig. 2-7.4) 
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(5) Reverse type flanges 

Longitudinal hub stress 𝑆𝑆𝐻𝐻  = 𝑓𝑓𝑀𝑀𝑂𝑂
𝐿𝐿𝑃𝑃𝐹𝐹1

2𝐵𝐵′
< 1.5𝑆𝑆𝑓𝑓  

Radial flange stress 𝑆𝑆𝑅𝑅  = (1.33𝑑𝑑𝑃𝑃𝑃𝑃+1)𝑀𝑀𝑂𝑂
𝐿𝐿𝑃𝑃𝑑𝑑2𝐵𝐵′

< 𝑆𝑆𝑓𝑓  

Tangential flange stress 𝑆𝑆𝑃𝑃  =𝑌𝑌𝑀𝑀𝑂𝑂
𝑑𝑑2𝐵𝐵

− 𝑍𝑍𝑆𝑆𝑅𝑅
0.67𝑑𝑑𝑃𝑃𝑃𝑃+1
1.33𝑑𝑑𝑃𝑃𝑃𝑃+1

< 𝑆𝑆𝑓𝑓  

Combined stress  
𝑆𝑆𝐻𝐻+𝑆𝑆𝑅𝑅

2
< 𝑆𝑆𝑓𝑓and 

𝑆𝑆𝐻𝐻 + 𝑆𝑆𝑇𝑇
2

< 𝑆𝑆𝑓𝑓  

where, 

𝐿𝐿𝑃𝑃  = factor = (𝑑𝑑𝑃𝑃𝑃𝑃+1)
𝑇𝑇

+ 𝑑𝑑3

𝑑𝑑𝑃𝑃
 

𝑑𝑑𝑃𝑃  = factor = 𝑈𝑈𝑃𝑃
𝑉𝑉
ℎ𝑑𝑑𝐹𝐹0

2 

𝑃𝑃𝑃𝑃  = factor = 𝐹𝐹
ℎ𝑑𝑑

 

ℎ𝑑𝑑  = factor =�𝐴𝐴𝐹𝐹0 

𝛼𝛼𝑃𝑃  = 
1+0.668(𝐾𝐾+1)

𝑌𝑌
𝐾𝐾2  

𝑇𝑇𝑃𝑃  = 𝑍𝑍+0.3
𝑍𝑍−0.3

𝛼𝛼𝑃𝑃𝑇𝑇 
𝑈𝑈𝑃𝑃  = 𝛼𝛼𝑌𝑌𝑈𝑈 
𝑌𝑌𝑃𝑃  = 𝛼𝛼𝑌𝑌𝑌𝑌 
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Problem 2: 

(Example from “Taylor Forge & Pipe Works, 1961”) 

Flange Details: 

Flange Type : Loose Flanges with Hubs 
Flange Outside Diameter [A] = 40.375 (inch) 
Flange Inside Diameter [B]  = 33.25 (inch) 
Inside Diameter of Reverse Flange [B']  = 20 (inch) 
Flange Thickness [t] = 2.125 (inch) 
Small End Hub Thickness [g0] = 0.875 (inch) 
Large End Hub Thickness [g1] = 1.125 (inch) 
Hub Length [h] = 2.5 (inch) 
All. Stress @ Design Temp [sf] = 17500 (psi) 
All. Stress @ Ref. Temp [sfa] = 17500 (psi) 
Modulus @ Design Temp [E] = 2.7E+7 (psi) 
Modulus @ Ref. Temp [Ea] = 2.92E+7 (psi) 

Bolting Information: 

Bolt Circle Diameter = 38.25 (inch) 
Number of Bolts = 44 
Bolt Diameter = 1 (inch) 
All. Stress @ Ref. Temp [sa] = 20000 (psi) 
All. Stress @ Design Temp [sb] = 20000 (psi) 

Gasket Information: 

Gasket Outside Diameter = 35.75 (inch) 
Gasket Inner Diameter = 34.25 (inch) 
Leak Pressure Ratio [m] = 2.75 
Gasket Seating Stress [y] = 3700 (psi) 
Facing Sketch = 1 
Facing Column = 1 

Load Data: 

Design Pressure = 400 (psi) 
Design Temperature = 500 (F) 
Axial Force = 1000 (lb) 
Bending Moment = 200 (ft-lb) 
Allowable Pressure = 665 (psi) 
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Comparison of Results: 
Flange Stresses Text Book Results 

(psi) 
CAEPIPE 
(psi) 

CAESAR II 
(psi) 

Operating condition    
Longitudinal Hub (SH) 20800 21153 21214 
Radial Flange (SR)              11100 11110 11155 
Tangential Flange (ST) 13800 13826 13797 
0.5(SH + SR) 15950 16132 16185 
0.5(SH + ST) 17300 17489 17506 
Gasket Seating Condition    
Longitudinal Hub (SH) 14400 14623 15095 
Radial Flange (SR)              7660 7681 7938 
Tangential Flange (ST) 9500 9558 9818 
0.5(SH + SR) 11030 11152 11517 
0.5(SH + ST) 11950 12091 12457 

Problem 3: 

(Example 10.5 on page 209 Chapter 10 on “CASTI Guidebook to ASME Section VIII Div.1 
– Pressure Vessels – Third Edition”) 

Flange Details: 

Flange Type : Reverse Flanges 
Flange Outside Diameter [A] = 49 (inch) 
Flange Inside Diameter [B]  = 48.25 (inch) 
Inside Diameter of Reverse Flange [B']  = 20.25 (inch) 
Flange Thickness [t] = 5.25 (inch) 
Small End Hub Thickness [g0] = 0.375 (inch) 
Large End Hub Thickness [g1] = 1.375 (inch) 
Hub Length [h] = 6 (inch) 
All. Stress @ Design Temp [sf] = 12000 (psi) 
All. Stress @ Ref. Temp [sfa] = 20000 (psi) 
Modulus @ Design Temp [E] = 2.7E+7 (psi) 
Modulus @ Ref. Temp [Ea] = 2.92E+7 (psi) 

Bolting Information: 

Bolt Circle Diameter = 44 (inch) 
Number of Bolts = 32 
Bolt Diameter = 1.25 (inch) 
All. Stress @ Ref. Temp [sa] = 25000 (psi) 
All. Stress @ Design Temp [sb] = 21000 (psi) 

Gasket Information: 

Gasket Outside Diameter = 24 (inch) 
Gasket Inner Diameter = 22 (inch) 
Leak Pressure Ratio [m] = 2.50 
Gasket Seating Stress [y] = 10000 (psi) 
Facing Sketch = 1 
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Facing Column = 1 

Load Data: 

Design Pressure = 150 (psi) 
Design Temperature = 800 (F) 
Axial Force = 1000 (lb) 
Bending Moment = 200 (ft-lb) 
Allowable Pressure = 665 (psi) 

Comparison of Results: 
Flange Stresses Text Book Results 

(psi) 
CAEPIPE 
(psi) 

CAESAR II 
(psi) 

Operating condition    
Longitudinal Hub (SH) 2060 2257 2055 
Radial Flange (SR)              280 307 280 
Tangential Flange (ST) 1340 1314 1336 
0.5(SH + SR) 1170 1282 1168 
0.5(SH + ST) 1700 1785 1695 
Gasket Seating Condition    
Longitudinal Hub (SH) 9220 10082 9220 
Radial Flange (SR)              1260 1372 1257 
Tangential Flange (ST) 6000 7004 5997 
0.5(SH + SR) 5240 5727 5239 
0.5(SH + ST) 7610 8543 8703 

 

Problem 4: 

(Example from KEDKEP CONSULTING, INC. dated May 27, 2008) 

Flange Details: 

Flange Type : Loose Flanges without Hubs / Optional Flanges 
Flange Outside Diameter [A] = 38.4 (inch) 
Flange Inside Diameter [B] = 32 (inch) 
Inside Diameter of Reverse Flange [B'] = 32 (inch) 
Flange Thickness [t] = 4 (inch) 
Small End Hub Thickness [g0] = 0.001 (inch) 
Large End Hub Thickness [g1] = 0.001 (inch) 
Hub Length [h] = 0.001 (inch) 
All. Stress @ Design Temp [sf] = 20000 (psi) 
All. Stress @ Ref. Temp [sfa] = 20000 (psi) 
Modulus @ Design Temp [E] = 2.7E+7 (psi) 
Modulus @ Ref. Temp [Ea] = 2.92E+7 (psi) 

Bolting Information: 

Bolt Circle Diameter = 36 (inch) 
Number of Bolts = 28 
Bolt Diameter = 1 (inch) 
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All. Stress @ Ref. Temp [sa] = 25000 (psi) 
All. Stress @ Design Temp [sb] = 25000 (psi) 

Gasket Information: 

Gasket Outside Diameter = 32.75 (inch) 
Gasket Inner Diameter = 32 (inch) 
Leak Pressure Ratio [m] = 0.50 
Gasket Seating Stress [y] = 0 (psi) 
Facing Sketch = 2 
Facing Column = 2 

Load Data: 

Design Pressure = 300 (psi) 
Design Temperature = 295 (F) 
Axial Force = 1000 (lb) 
Bending Moment = 200 (ft-lb) 
Allowable Pressure = 665 (psi) 

Comparison of Results: 
Flange Stresses Text Book Results 

(psi) 
CAEPIPE 
(psi) 

CAESAR 
II 
(psi) 

Operating Condition 
Longitudinal Hub (SH) 0 0 3 
Radial Flange (SR) 0 0 0 
Tangential Flange (ST) 10577 10569 10618 
0.5(SH + SR) 0 0 1.5 
0.5(SH + ST) 0 0 5310.5 
Bolt Stress 16378 16371 16445 
Gasket Seating Condition 
Longitudinal Hub (SH) 0 0 3 
Radial Flange (SR) 0 0 0 
Tangential Flange (ST) 12147 11987 12166 
0.5(SH + SR) 0 0 1.5 
0.5(SH + ST) 0 0 6085 
Bolt Stress 0 0 124 
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A 
absolute sum, 72, 82, 201, 202 
acceleration, 72, 73, 74, 331 

spectral, 331 
vector, 198, 202, 203, 331 

additional weight, 149, 311, 314, 396, 429, 430 
analyze, 27 
anchor, 134 

displacements, 135 
releases for hanger selection, 135 
settlement, 136 
stiffness, 134 

angle 
valve, 434 

animate 
deflected shape, 130 
mode shape, 131, 205 

ANSI pipe sizes, 158, 401 
API, 189, 355 
API 610 (Tenth Edition, 2004), 564 
API 610 report, 355, 362 
API 617, 355 
API 617 report, 189, 574 
API 650, 347, 350 
automatic 

save, 15 
automatic node renumbering, 16, 43 
axes, 111 

elastic element, 207 
local beam, 143 
local coordinate system, 315 
symbol location in graphics, 111 

axial force, 59, 233 
axial stiffness, 345, 587, 590 

B 
B31.1 (1967) code, 455 
B31.1 (2012) code, 438 
B31.3 (2012) code, 447 
B31.4 (2012) code, 458 
B31.5 (2013) code, 465 
B31.8 (2012) code, 470 
B31.9 (2008) code, 477 
backup, 15 
ball joint, 139 

displacements, 387 
friction, 343 
rotation limit, 140 
stiffness, 139 

batch file, 580 
example, 595 
export, 25, 600 
import, 578 

beam, 142 
additional weight, 149 
AISC library, 146 

beta angle, 143 
end releases, 143 
load, 148 
local coordinate system, 150 
material, 143 
orientation, 150 
section, 145 

beam section library 
files, 19 

bellows, 155 
displacements, 387 
stiffness, 155 
tie rods, 420 

bend, 157 
check, 85 
examples, 159 

180° bend, 162 
45° bend, 161 
90° bend, 160 
base supported, 170 
flanged, 163 
reducing, 166 
supported by a hanger, 168 

flexibility factor, 158 
incomplete, 85 
intermediate nodes, 159 
invalid, 85 
long radius, 157, 158 
material, 158 
pressure correction, 64 
pressure stiffening, 64 
radius, 158 
short radius, 157, 158 
SIF, 159, 166 
tangent intersection point, 157 
thickness, 158 

bottomed-out springs, 415 
Bourdon effect, 63 
branch connection, 298 

nonstandard, 428 
stresses, 374 

branch line, 39, 175, 254 
branch nodes, 295 
branch SIF, 174 
BS 806 code, 494 
buried piping, 177 

general procedure, 177 
ground level, 178 
nomenclature, 179 

C 
center, 106 
center of gravity, 132 
change, 42 
check 

bend, 85 
connections, 88 
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circumferential 
joint factor, 322, 324, 328 
stiffness, 347, 604, 605, 606, 607 

closely spaced modes, 202 
code compliance, 374 
cold load, 273 
cold spring, 186 
color code stresses, 126 
combine, 42 
command line operation, 580 
comment, 188 
compressor, 189 
concentrated mass, 192 
cone angle, 363, 364 
connected node, 303, 398 

hanger, 272 
skewed restraint, 404 

constant support, 193 
user defined hanger, 426 

coordinates, 84, 254, 342 
copy graphics, 103 
core pipe, 284, 288, 319, 413 
core properties, 287 
corrosion allowance, 400 
cut pipe, 71, 186, 297 
cutoff frequency, 291, 293 

D 
damping 

harmonic load, 82 
time history, 80 

data types, 194, 298 
deflected shape, 130 

animated, 130 
delete, 35 
density, 327 
design 

factor, 57 
hanger, 271 
pressure, 313 
temperature, 313 

DIN pipe sizes, 158, 401 
direction, 195 
direction sum, 79 
disable graphics editing, 15 
displacement vector, 198, 201 
displacements 

anchor, 135 
nozzle, 348 

drawing size, 103 
duplicate last row, 51 
DXF file, 102, 267 
dynamic analysis, 198 

closely spaced modes, 202 
effective modal mass, 201 
friction, 66, 344 
modal analysis, 198 
modal equations, 199 
orthogonality, 199 

participation factors, 200 
response spectrum, 201 
support motion, 200 
time history, 202 

dynamic susceptibility, 205 
environment variable, 205 
method, 618 

E 
earthquake, 201 
edit 

copy, 29 
data, 29 
find and replace, 31 
menu, 29 
paste, 31 
type, 29 

effective modal mass, 201 
eigenvalues, 198 
eigenvector, 198 

normalized, 331 
elastic element, 207 

stiffness, 207 
elastic modulus, 63 
elbow, 157 

pressure balanced, 217 
element forces, 123, 381 
element forces and moments 

in local coordinate system, 318 
element stresses 

FRP, 225 
element types, 296 
EMF file, 101, 267 
EN 13480 (2012) code, 498 
environment variable 

BOURDONP, 64 
CPITER, 346 
dynamic susceptibility, 205 
HARTLEN, 205 

EPS file, 101, 267 
exit, 346, 393 
expansion joints, 155, 208 

bellows, 208 
dual gimbal, 213 
gimbal, 213 
slotted hinge, 220 
tied bellows, 208 
universal joint, 211 

export 
3D Plant Design, 26 
mbf, 25 

F 
fiber reinforced plastic piping (FRP), 225, 226 

flexibility factor, 226 
moduli, 226 
SIF, 226 
siffness matrix, 226 
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find and replace, 31 
find node, 55 
flange, 230 

allowable pressure, 231 
equivalent pressure, 231 
flange and bolt stresses, 234 
gasket diameter, 231 
library, 231 
model 

files, 19 
rating, 231 
report, 375 

flange and bolt stresses, 234 
flange module, 234 
flexibility factor 

bend, 158 
FRP, 226 
miter bend, 335 

font 
graphics, 16, 111 

printer, 100 
printer, 26, 116 
text, 15, 16, 69, 395 

force, 246 
force spectrum, 93, 248 

convert time function, 251 
load, 252 
read from a text file, 251 

frequencies, 388 
closely spaced, 202 

frequency 
circular, 200, 331 
natural, 619 

friction, 344 
ball joint, 345 
guide, 344 
hinge joint, 345 
in dynamic analysis, 66, 344 
limit stop, 344 
slip joint, 345 

friction coefficient, 29, 269, 303, 343, 415 
friction force, 269, 301, 303, 344, 409 
friction torque, 139, 277, 344, 345, 409 
From node, 254 
FRP Stress, 557 

G 
gasket diameter, 231 
generate, 46 
generic support, 256 
g-load, 72, 434 
global 

axes, 38 
coordinate system, 315 
forces, 382 
origin, 178, 292 
vertical axis, 67 

graphics, 54 
background, 111 

center, 106 
context menu, 260 
editing, 261 
font, 111 
hotkeys, 264 
previous view, 105 
print, 100 
recover, 113 
render, 107 
rotate, 264 
show, 106 
turn, 106 
viewpoint, 105, 264 
zoom, 106 

graphics window, 259, 264 
guide 

friction, 344 
friction coefficient, 269 
gap, 269 
local coordinate system, 270 
stiffness, 269 

H 
hanger, 271 

below, 272 
catalog, 273, 414 
cold load, 272 
connected node, 272 
constant support, 193 
design procedure, 273 
hot load, 273 
load variation, 273 
manufacturer, 273 
number of, 272 
report, 375, 398 
rod, 398 
short range, 272 
stiffness, 272 
to be designed, 271, 298 
travel, 273, 343, 415 
type, 272 
user, 426 

harmonic analysis, 203 
harmonic load, 81 

combination, 82 
damping, 82 
frequency, 82 
phase angle, 81 

harmonic response, 82 
hinge joint, 276 

angular stiffness, 277 
axis direction, 278 
displacements, 387 
example, 279 
friction, 345 
friction torque, 277 
rotational limit, 277 
rotational stiffness, 277 
Weight, 278 
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hotkeys 
graphics window, 264 
layout window, 294 
results window, 393 

hydrotest 
load, 282 
load case, 283 

I 
import, 14 
import model, 578 
increase digits, 292 
input 

new material, 324 
insert, 35 
installation, 2 
insulation, 402 

density, 402 
thickness, 402 

intermediate nodes, 159 
internal nodes, 288 

J 
jacket end cap, 284 
jacket pipe, 321 
jacket properties, 287 
jacketed bend, 286 

internal nodes, 288 
jacketed pipe, 285 

internal nodes, 286 
jacketed piping 

jacketed bend, 286 
jacketed reducer, 288 

JIS pipe sizes, 158, 401 
joint factor, 328 

circumferential, 328 
longitudinal, 324, 328 

K 
knuckles 

reducer, 364 

L 
lateral tee, 176 
layout window, 291 
left out force, 331 
liberal allowable stresses, 59 
limit stop, 301 

friction, 344 
nonlinearities, 343 

solution procedure, 343 
lining, 402 
list, 54 
load 

additional weight, 314 
combinations, 76 

pressure, 313 
snow, 314 
specific gravity, 314 
spectrum, 78 
static seismic, 72 
temperature, 313 
wind, 314 

load cases, 71 
cold spring, 186 
force spectrum, 252 
hydrotest, 283 
print results, 115 

loads 
acceleration, 73 
force spectrum, 249 
thermal, 71 

local coordinate system, 315 
element forces and moments, 318 
for a beam, 150 
for a bend, 317 
for a guide, 270 
for a pipe, 315 

local forces, 318 
location, 319 
logarithmic interpolation, 201, 604 
long radius, 157, 158, 586 
longitudinal 

joint factor, 324, 328 
pressure stress, 63, 328 

longitudinal stiffness, 347, 604, 605, 607 

M 
material 

create library, 328 
define, 321 
density, 327 
description, 327 
input, 324 
name, 327 
selectr from library, 326 
type, 327 

menus, 11 
graphics window menus, 100 

file menu, 100 
options menu, 111 
view menu, 105 

layout window menus, 19 
edit menu, 29, 293 
file menu, 19, 293 
help menu, 294 
loads menu, 71, 294 
misc menu, 83, 294 
options menu, 56, 293 
view menu, 54, 293 
window menu, 98, 294 

results window menus, 114 
merge, 20 
missing mass correction, 331 
miter bend 
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closely spaced, 335 
flexibility factor, 335 
modeling procedure, 336 
parameters, 335 
widely spaced, 334, 335 

modal analysis, 198 
modal displacements, 199 
mode shapes, 101, 124, 131, 265 
mode sum, 79 
model file 

automatic save, 15 
backup, 15 
save, 19 

modulus 
cold, 63 
elastic, 63 
hot, 63 

multiple split, 37 

N 
NDE, 558 
NEMA SM-23 report, 572 
node, 342 

find, 55 
increment, 70 
internal, 288 
list coordinates, 342 
specifying coordinates, 342 

nominal diameter, 401 
nonlinearities, 343 

ball joint, 345 
friction, 344 
guide, 344 
hinge joint, 345 
limit stop, 344 
misconvergence, 346 
number of iterations, 346 
slip joint, 345 
types, 343 

nonstandard 
branch connection, 428 
pipe, 401 

Norwegian (1983) code, 507 
Norwegian (1990) code, 515 
nozzle, 347 

axial stiffness, 347, 604, 605, 607 
circumferential stiffness, 347, 604, 605, 607 
coordinate system, 347, 604 
displacements, 350 
example 

on a cylindrical vessel, 351 
on a flat-bottom storage tank, 352 

longitudinal stiffness, 347, 604, 605, 607 
on a cylindrical vessel, 347 
reinforcing pad, 350 
settlement, 351 
stiffness calculations, 604 
stiffness coefficients, 604 

NRC Guide 1.92, 202 

number of modes, 331 
number of thermal cycles, 516 
number of thermal loads, 61, 149, 311 
number of time steps, 80 

O 
occasional load, 63, 72, 253 
occasional load., 74 
Operating Stress for NDE, 558 
options menu, 56 
other element forces, 129 

P 
pad thickness, 174 
participation factor, 200, 331, 388 
period, 201, 388 
phase angle 

harmonic load, 81 
pipe skirt, 415 
pipe sleeve, 414 
pipe slide assembly, 415 
pipe slide/shoe assembly, 306 
piping code, 56 
plot title, 104 
PLT file, 101, 267 
Poisson’s ratio, 328 
Postscript, 101, 267 
pressure 

gauge, 313 
negative, 313 

pressure correction for bends, 64 
pressure stiffening in bends, 64 
pressure stress, 63 
previous view, 54, 105 
print, 100 

graphics, 100 
model, 26 
preview, 101, 103 
results, 115 

load cases, 115 
misc, 116 
model, 114 
to file, 119 

to file, 101 
printer, 100, 116 

font, 26, 116 
pump, 355 

Q 
QA block, 27 

R 
recover graphics, 113 
redo, 52 
redraw, 107 
reducer, 363 
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concentric, 363 
example, 365 

cone angle, 363, 364 
delta, 365 
eccentric, 363 

example, 366 
example 

concentric, 365 
eccentric, 366 

jacketed, 368 
knuckles, 364 
SIF, 364 
stresses, 365 
weight, stiffness and stress calculation, 365 

reducing tee, 175 
reference temperature, 60, 291, 293, 586 
regenerate, 51 
releases for hanger selection, 134 
relief valve, 434 
render, 107 
renumber nodes, 43 
report 

flange, 233, 375 
hanger, 375 
rotating equipment, 375 

response spectrum, 65, 71, 93, 201, 351 
restraint, 370 

stiffness, 370 
results window, 371 
rigid body force, 331 
rigid element, 396 

stiffness, 396 
weight, 396 

rod hanger, 398 
stiffness, 398 

rotate, 39 
rotation limit 

ball joint, 140 
hinge joint, 277 

S 
save, 27, 294 

automatic, 15 
section, 400 

ANSI pipe sizes, 401 
corrosion allowance, 401 
DIN pipe sizes, 401 
insulation, 402 
JIS pipe sizes, 401 
lining, 402 
mill tolerance, 401 
name, 401 
nominal diameter, 401 
nonstandard, 401 
schedule, 401 

section modulus, 401 
settlement 

anchor, 136 
nozzle, 351 

shape factor, 77 
shear 

area, 146 
deflection, 146 

shear deflection, 146 
short radius, 157, 158 
show nodes, 107 
SIF 

branch, 174, 298 
FRP, 226 
reducer, 364 
user, 299, 428 
weld, 435 

sign conventions, 318 
skewed restraint, 403 

connected node, 405 
direction, 404 
example 

sway brace, 405 
rotational, 404 
stiffness, 404 
translational, 404 
type, 404 

slip joint, 409 
friction, 345 
friction force, 409 
friction torque, 409 
pressure thrust area, 409 

slope, 38 
snow load, 149, 311, 314 
snubber, 412 

stiffness, 412 
soil restraints, 376 
sorted stresses, 122, 126, 260, 372, 374, 394 
specific gravity, 314 
spectrum 

direction sum, 79 
load, 78 
mode sum, 79 

spectrum library, 90, 91 
files, 19, 114, 293 

spectrums, 90 
spider, 413 
split, 36 

multiple, 37 
spring rate, 66, 193, 273, 398, 426, 593 
SRSS, 72, 74, 79, 201 
static analysis, 57 
static seismic analysis, 74 
static seismic load, 72 
stiffness 

anchor, 134 
ball joint, 139 
bellows, 155 
elastic element, 207 
guide, 269 
hanger, 272 
hinge joint, 277 
include hanger stiffness, 66 
limit stop, 303 
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nozzle, 347, 604 
reducer, 365 
restraint, 370 
rigid element, 396 
rod hanger, 398 
snubber, 412 
tie rod, 420 
user hanger, 426 
valve, 430 

stiffness matrix, 66, 198, 202, 203, 273, 343, 344 
FRP, 226 

Stoomwezen code, 543 
stress range reduction factor, 59, 61 
stresses 

color coded, 126 
FRP, 227 
liberal allowable, 59 
occasional, 74, 401 
reducer, 365 
sorted, 122, 126, 260 
sustained, 401 
thresholds, 128 

support load summary, 376 
support loads, 379 
support motion, 200 
supports, 414 

anchor, 414 
generic, 256 
guide, 415 
hangers, 414 
limit stop, 415 
restraint, 414 
skewed restraint, 414 

sway brace, 403, 405, 414 
sway struts, 403, 414 
Swedish code, 545 
sweepolet, 585 

T 
tangent intersection point, 157, 299, 317, 585 
tee 

extruded, 585 
fabricated, 585 
pressure-balanced, 216 
SIF, 174 
welding, 298, 585 

Tee, 215, 417 
tensile strength, 328 
thermal cycles, 516 
thermal loads, 71, 135, 311, 351 
threaded joint, 295, 299 
tie rod, 420 

modeling, 222 
stiffness, 420 

time functions, 94 
time history, 202 

damping, 80 
output interval, 80 
time step, 80 

time history load, 79 
title 

plot, 104 
turbine, 422 
turn, 106 

U 
u-bolt, 415 
undo, 51 
units 

English, 68 
Metric, 69 
SI, 68 

user allowables, 96 
user hanger, 426 

constant support, 426 
load, 426 
spring rate, 426 
stiffness, 426 

user SIF, 428 
u-strap, 415 

V 
valve, 429 

additional weight, 430 
angle, 434 
calculation of moment of inertia, 434 
insulation weight X, 430 
length, 429 
library, 431 

files, 19 
relief, 434 
stiffness, 430 
thickness X, 430 
weight, 429 

velocity vector, 202 
view 

previous, 105 
viewpoint, 54, 105 

W 
weight multiplier, 434 
weld, 435 
weldolet, 585 
wind load, 76, 314 

shape factor, 77 
wind pressure, 78 
wind profile, 77 
WRC 297, 347 

Y 
Y factor, 327 

Z 
Z183 code, 549 
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Z184 code, 553 
zero length element, 139, 276 
zoom 

all, 54, 106 

in, 106 
out, 106 
window, 266 
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